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This documentation is protected by copyright. All rights reserved.

This documentation is an original document.

This documentation has been prepared with great care. However, errors
can never be entirely ruled out. Please send comments regarding possible
errors to the address above.

Disclaimer

Deficiencies arising from circumstances that are not the responsibility of
Metrohm, such as improper storage or improper use, etc., are expressly
excluded from the warranty. Unauthorized modifications to the product
(e.g. conversions or attachments) exclude any liability on the part of the
manufacturer for resulting damage and its consequences. Instructions and
notes in the Metrohm product documentation must be strictly followed.
Otherwise, Metrohm's liability is excluded.

Melody for the BEEP command: excerpt from "En Altfrentsche", with kind
permission of the Laseyer Quartett, Appenzell.
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1 Introduction

1.1 Instrument description

The 900 Touch Control is an operating unit with a touch-sensitive screen.
You can operate the following control instruments with the 900 Touch
Control:

￭ Titrandos
￭ Sample Processors
￭ 846 Dosing Interface
￭ 867 pH Module
￭ 856 Conductivity Module

With the 900 Touch Control, you can conveniently manage all of your
titrants, sensors, methods, etc. For example, you can connect a USB flash
drive to the USB connector as an external storage medium. You can use
this additional memory not only to store your methods and determina-
tions, but also to create a backup together with all of the data and set-
tings of your system. Thanks to the integrated Ethernet connector, the
device can be connected to your network, thus offering you the following
options, among others:

￭ Saving data to a computer within the network
￭ Printing reports on a network printer
￭ Sending displayed messages as e-mails

1.2 Titration and measuring modes

The 900 Touch Control supports the following titration and measuring
modes. Whether a particular mode is available or not depends on the type
of the control instrument connected.

￭ DET
Dynamic equivalence point titration. The reagent is added in variable
volume steps.
Measuring modes:

– pH (pH measurement)
– U (potentiometric voltage measurement)
– Ipol (voltametric measurement with selectable polarization cur-

rent)
– Upol (amperometric measurement with selectable polarization

voltage)
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￭ MET
Monotonic equivalence point titration. The reagent is added in con-
stant volume steps.
Measuring modes:

– pH (pH measurement)
– U (potentiometric voltage measurement)
– Ipol (voltametric measurement with selectable polarization cur-

rent)
– Upol (amperometric measurement with selectable polarization

voltage)
￭ SET

Endpoint titration at one or two specified endpoints.
Measuring modes:

– pH (pH measurement)
– U (potentiometric voltage measurement)
– Ipol (voltametric measurement with selectable polarization cur-

rent)
– Upol (amperometric measurement with selectable polarization

voltage)
￭ STAT

Titration with constant maintenance of the measured value.
Measuring modes:

– pH (pH measurement)
– U (potentiometric voltage measurement)

￭ MAT
Manual titration with manual dosing and manual ending.
Measuring modes (optional):

– pH (pH measurement)
– U (potentiometric voltage measurement)

￭ KFT
Volumetric water content determination according to Karl Fischer.
Measuring modes:

– Ipol (voltametric measurement with selectable polarization cur-
rent)

– Upol (amperometric measurement with selectable polarization
voltage)

￭ KFC
Coulometric water content determination according to Karl Fischer.
Measuring mode:

– Ipol (voltametric measurement with selectable polarization cur-
rent)
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￭ BRC
Coulometric bromine index determination. Determining the amount of
double bonds in e.g. mineral oils.
Measuring mode:

– Ipol (voltametric measurement with selectable polarization cur-
rent)

￭ MEAS
Measuring modes:

– pH (pH measurement)
– U (potentiometric voltage measurement)
– Ipol (voltametric measurement with selectable polarization cur-

rent)
– Upol (amperometric measurement with selectable polarization

voltage)
– T (temperature measurement)
– Conc (concentration measurement with or without standard

addition)
– Cond (conductivity measurement)

￭ CAL
Electrode calibration.
Measuring mode:

– pH (calibration of pH electrodes)
– Conc (calibration of ion-selective electrodes)
– Cond (calibration of conductivity measuring cells)
– ELT (Electrode test for pH electrodes)

1.3 About the documentation

CAUTION

Please read through this documentation carefully before putting the
instrument into operation. The documentation contains information
and warnings which the user must follow in order to ensure safe opera-
tion of the instrument.

1.3.1 Symbols and conventions
The following symbols and formatting may appear in this documentation:

Cross-reference to figure legend

The first number refers to the figure number, the
second to the instrument part in the figure.
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Instruction step

Perform the steps one after the other.

Method Dialog text, parameter in the software

File ▶ New Menu or menu item

[Continue] Button or key

WARNING

This symbol draws attention to a possible life-threat-
ening hazard or risk of injury.

WARNING

This symbol draws attention to a possible hazard due
to electrical current.

WARNING

This symbol draws attention to a possible hazard due
to heat or hot instrument parts.

WARNING

This symbol draws attention to a possible biological
hazard.

WARNING

Warning of optical radiation

CAUTION

This symbol draws attention to possible damage to
instruments or instrument parts.

NOTICE

This symbol highlights additional information and
tips.
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2 Safety

2.1 Intended use

This 900 Touch Control is designed for use as an operating unit for the
Titrandos, USB Sample Processors, 856 Conductivity Module, 867 pH
Module, and 946 Dosing Interface. Its main area of use is the operation of
titrators.

This device is suitable for processing chemicals and flammable samples.
Therefore, the use of the device requires the user to have basic knowledge
and experience in handling toxic and caustic substances. Knowledge of
the application of the fire prevention measures prescribed for laboratories
is also mandatory.

2.2 Responsibility of the operator

The operator must ensure that basic regulations on occupational safety
and accident prevention in chemical laboratories are observed. The opera-
tor has the following responsibilities:

￭ Instruct personnel in the safe handling of the product.
￭ Train personnel in the use of the product according to the user docu-

mentation (e.g. install, operate, clean, eliminate faults).
￭ Train staff on basic occupational safety and accident prevention regula-

tions.
￭ Provide personal protective equipment (e.g. protective glasses, gloves).
￭ Provide suitable tools and equipment to carry out the work safely.

The product may be used only when it is in perfect condition. The follow-
ing measures are required to ensure the safe operation of the product:

￭ Check the condition of the product before use.
￭ Remedy defects and malfunctions immediately.
￭ Maintain and clean the product regularly.
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2.3 Requirements for operating personnel

Only qualified personnel may operate the product. Qualified personnel are
persons who meet the following requirements:

￭ Basic regulations on occupational safety and accident prevention for
chemical laboratories are known and complied with.

￭ Knowledge of handling hazardous chemicals is present. Personnel have
the ability to recognize and avoid potential dangers.

￭ Knowledge regarding the application of fire prevention measures for
laboratories is available.

￭ Safety-relevant information is communicated and understood. The per-
sonnel can operate the product safely.

￭ The user documentation has been read and understood. The personnel
operate the product according to the instructions in the user documen-
tation.

2.4 Safety instructions

2.4.1 General notes on safety

WARNING

Operate this instrument only according to the information contained in
this documentation.

This instrument left the factory in a flawless state in terms of technical
safety. To maintain this state and ensure non-hazardous operation of the
instrument, the following instructions must be observed carefully.

2.4.2 Electrical safety
The electrical safety when working with the instrument is ensured as part
of the international standard IEC 61010.

WARNING

Only personnel qualified by Metrohm are authorized to carry out service
work on electronic components.
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WARNING

Never open the housing of the instrument. The instrument could be
damaged by this. There is also a risk of serious injury if live components
are touched.

There are no parts inside the housing which can be serviced or replaced
by the user.

Supply voltage

WARNING

An incorrect supply voltage can damage the instrument.

Only operate this instrument with a supply voltage specified for it (see
rear panel of the instrument).

Protection against electrostatic charges

WARNING

Electronic components are sensitive to electrostatic charges and can be
destroyed by discharges.

Do not fail to pull the power cord out of the power socket before you
set up or disconnect electrical plug connections at the rear of the
instrument.

2.4.3 Tubing and capillary connections

CAUTION

Leaks in tubing and capillary connections are a safety risk. Tighten all
connections well by hand. Avoid applying excessive force to tubing con-
nections. Damaged tubing ends lead to leakage. Appropriate tools can
be used to loosen connections.

Check the connections regularly for leakage. If the instrument is used
mainly in unattended operation, then weekly inspections are manda-
tory.
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2.4.4 Flammable solvents and chemicals

WARNING

All relevant safety measures are to be observed when working with
flammable solvents and chemicals.

￭ Set up the instrument in a well-ventilated location (e.g. fume cup-
board).

￭ Keep all sources of flame far from the workplace.
￭ Clean up spilled liquids and solids immediately.
￭ Follow the safety instructions of the chemical manufacturer.

2.4.5 Recycling and disposal
Properly dispose of chemicals and of the product to reduce negative
effects on the environment and public health. Local authorities, waste dis-
posal companies or dealers provide more detailed information on disposal.
Observe the WEEE EU directive (WEEE = Waste Electrical and Electronic
Equipment) for the proper disposal of waste electronic equipment within
the European Union.
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3 Overview of the instrument

8765432
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Figure 1 Front 900 Touch Control

1 Display
Touch screen.

2 Fixed key [Home]
Opens the main dialog.

3 Fixed key [Back]
Opens the next-higher dialog page.

4 Fixed key [Help]
Opens the online help for the dialog dis-
played.

5 Fixed key [Print]
Opens the print dialog.

6 Fixed key [Manual]
Opens the manual control.

7 Fixed key [STOP]
Cancels the running determination.

8 Fixed key [START]
Starts a determination.
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Figure 2 Rear 900 Touch Control

1 Ethernet connector (RJ-45)
For connecting to a network.

2 USB connector (type A)
For connecting printers, USB flash drives,
USB hubs, 885 Compact Oven SC, etc.

3 Power switch
Switches the instrument on/off.

4 Type plate
Contains the serial number.

5 Connection cable
For the connection of the Touch Control to a
control instrument (socket "Controller").
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4 Installation

The connection between the Touch Control and the control instrument
(Titrando, etc.) is described in the respective manual, as is the configura-
tion of the titration system with its peripheral devices, e.g. stirrers and
dosing devices.

4.1 Setting up the instrument

4.1.1 Packaging
The instrument is supplied in protective packaging together with the sepa-
rately packed accessories. Keep this packaging, as only this ensures safe
transportation of the instrument.

4.1.2 Checks
Immediately after receipt, check whether the shipment has arrived com-
plete and without damage by comparing it with the delivery note.

4.1.3 Location
The instrument has been developed for operation indoors and may not be
used in explosive environments.

Place the instrument in a location of the laboratory which is suitable for
operation and free of vibrations and which provides protection against
corrosive atmosphere and contamination by chemicals.

The instrument should be protected against excessive temperature fluctua-
tions and direct sunlight.
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5 Titrations

5.1 Dynamic equivalence point titration (DET)

Dynamic equivalence point titration is a titration mode for all standard
titrations with an s-shaped curve progression. The reagent is added in vari-
able volume steps. The volume steps vary as a function of the slope of the
curve. An attempt is made to reach constant measured value changes
with each dosing. The optimal volume for dosing is determined from the
measured value changes of the previous dosings. Measured value accept-
ance is measured value drift-controlled (equilibrium titration) or after a
waiting time. Equivalence points are evaluated automatically.

U/mV

V/mL

Figure 3 Reagent dosing for DET

5.2 Monotonic equivalence point titration (MET)

Monotonic equivalence point titration is a robust titration mode for titra-
tions with any curve shape and for slow titrations or slow-response elec-
trodes. The reagent is added in constant volume steps. Measured value
acceptance is measured value drift-controlled (equilibrium titration) or
after a waiting time. Equivalence points are evaluated automatically.

U/mV

V/mL

Figure 4 Reagent dosing for MET
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5.3 Endpoint titration (SET)

Endpoint titration is a titration mode for rapid routine determinations to a
preset endpoint (e.g. titrations in accordance with special standards) and
titrations for which reagent overflow must be avoided. The titration termi-
nation at the endpoint takes place either volume drift-controlled or after a
waiting time. The volume dosed until the endpoint can be used for further
calculations (e.g. the content of the sample).

t/s

Continuous
dosing

Initial
dosing

V/mL

V/mL

U/mV
Endpoint

Control range

Figure 5 Reagent dosing for SET

5.4 Water determination according to Karl Fischer (KFT)

Karl Fischer Titration is a method for volumetric water determination. Con-
ditioning is carried out automatically both before and after the actual titra-
tion. The reagent dosing is controlled in such a way that a predefined end-
point is reached as quickly and as accurately as possible. The volume steps
and the rate of reagent dosing are regulated by the difference between
the current measured value and the predefined endpoint. This means that
titration is performed more slowly in the control range and that smaller
volumes are added. The titration is stopped at the endpoint either drift-
controlled or after a waiting time. The volume dosed until the endpoint is
used to calculate the water content of the sample.
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EP

KFT Ipol

KFT Upol
EP

V/mL

Continuous
dosing

Initial
dosing

V/mL

V/mL

U/mV

t/s

I/µA

Control range

Control range

Figure 6 Reagent dosing for KFT

5.5 Titration with constant maintenance of the
measured value (STAT)

In STAT titrations, reagent is added until a preset measured value (control
point) has been reached, which is then maintained at a constant level.
Because the substance that is released as a result of the reaction is imme-
diately titrated off with the titrant, the STAT controller has to be able to
maintain a preset control point at a constant level until the preset stop
condition has been reached, i.e. without oscillating around the control
point.

STAT titrations are used, for example, in enzyme analysis where the
enzyme activity can be determined from the resulting dosing rate (in
mL/min).

Reagent dosing takes place in two phases during the titration:

￭ Dosing outside the control range
The dosing rate increases continuously during this phase. It starts with
the Min. rate and increases to the Max. rate. The dosing continues to
be carried out at the Max. rate until the Control range is reached. In
this range, STAT mode and SET mode control equally.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 5 Titrations

900 Touch Control ￭￭￭￭￭￭￭￭ 15

￭ Dosing inside the control range
The STAT controller compensates minimal measured value deviations
from the control point quickly by dosing in the control range faster
than for the SET controller.

Figure 7 Reagent dosing for STAT

5.6 Manual titration (MAT)

Manual titration is a titration mode that is suitable in particular for titra-
tions that are carried out conventionally manually with a Schellbach buret
or a Dosimat.

The reagent is added by manual dosing. The endpoint is detected by a
color change or with an electrode connected over a measuring signal. The
command always has to be canceled manually with the Cancel com-
mand button or with the [FILL] key on the Manual Dosing Controller.

An advantage of the MAT titration mode is that the manual reagent addi-
tion as well as the measuring signal can be recorded optionally. These data
points (time, volume, measured value) can be evaluated after the titration,
e.g. to assess the titration quality, especially the accuracy of reaching the
transition point.

In addition, the method can be equipped with further commands, e.g.
calculating a result, creating a report or scanning sample data.

The system is FDA compliant and enables a manual titration according to
the FDA guidelines with this mode.
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5.7 Coulometric water content determination according
to Karl Fischer (KFC)

The coulometric Karl Fischer titration is a variation of the classic water
content determination method according to Karl Fischer.

The conventional method works with a methanolic solution of iodine, sul-
fur dioxide and a base as buffer substance. When titrating a sample con-
taining water several reactions take place, which can be summarized by
the following equation:

H2O + I2 + [RNH]SO3CH3 + 2 RN <=> [RNH]SO4CH3 + 2 [RNH]I

According to the equation above, the I2 reacts quantitatively with H2O.
This chemical relation is the base for the water content determination.

With the coulometric Karl Fischer titration, the necessary iodine is directly
and electrochemically generated in the submitted electrolyte ("electronic
buret"). Between the amount of electric charge and the amount of gener-
ated iodine, there is a strictly quantitative relationship, which is used for
high-precision dosing of the iodine. No titer needs to be determined as
the coulometric Karl Fischer method is an absolute determination. It must
only be ensured that the reaction generating the iodine runs with a 100%
current efficiency. This is the case with all the reagents available at pres-
ent.

The endpoint indication is effected voltametrically by modulating an alter-
nating current of constant strength to a double Pt electrode. This produ-
ces a voltage difference between the Pt wires, which significantly declines
when lowest amounts of free iodine are present. This circumstance is used
for detecting the endpoint of the titration.

5.8 Bromine index determination (BRC)

The bromine index is a measure for the content of olefins in a sample.

The basis for the bromine index determination is the addition of bromine
to the double bond of olefins. A bromine molecule is used for every car-
bon-carbon double bond.

With the bromine index determination, the necessary bromine is directly
and electrochemically generated in the submitted electrolyte ("electronic
buret"). Between the amount of electric charge and the amount of gener-
ated bromine, there is a strictly quantitative relationship, which is used for
high-precision dosing of the bromine. No titer needs to be determined as
the bromine index determination is an absolute determination.

The bromine index is usually indicated in mg bromine per 100 g sample.
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6 Operation

6.1 Switching the instrument on and off

Switching on the instrument

CAUTION

Peripheral devices (e.g., printers, 885 Compact Oven SC, etc) must be
connected and switched on before you switch on the 900 Touch Con-
trol.

NOTE

English is set as the default dialog language when the instrument is
switched on for the first time.

Proceed as follows:

 

1 ￭ Press the power switch on the left-hand side of the back panel of
the 900 Touch Control.
The 900 Touch Control and the control instrument are initialized
and a system test is carried out. This process takes some time.

NOTE

If a buret unit is connected, then a request appears to carry out
the Prepare function:

All tubings and the cylinder are rinsed with the Prepare function.
The preparing of the buret unit is described in chapter 28.3.3,
page 267.
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￭ Confirm the message with [OK].

The main dialog is displayed:

Switching off the instrument

CAUTION

The 900 Touch Control must be switched off by pressing the power
switch on the rear of the instrument before the electricity supply is
interrupted. If this is not done, then there is a danger of data loss.
Because the power supply for the Touch Control is provided through
the control instrument (Titrando, etc.) you must never disconnect the
control instrument from the mains (e.g., by switching off with a con-
nector strip) before you have switched off the Touch Control.

Proceed as follows:

 

1 Press the power switch on the left-hand side of the back panel of the
900 Touch Control.

The current data is saved and the system is shut down. This process
takes just a short time. At the same time, all other instruments
connected to the 900 Touch Control via a USB cable are also being
switched off (except the 885 Compact Oven SC).

6.2 Fundamentals of operation

6.2.1 Touch-sensitive screen
The entire 900 Touch Control user interface is touch-sensitive. Simply
touch a few of the buttons on the interface to learn how a touch-sensitive

screen reacts. You can always return to the main dialog by touching [ ].

In order to enable an element on the 900 Touch Control user interface,
just touch the screen with your fingertip, the eraser of a pencil or a stylus
(special tool for operating instruments with touch-sensitive screens).

CAUTION

Never touch the touch screen with a pointed or sharp object such as a
ballpoint pen.

In the default setting, the software is configured in such a way that an
acoustic signal will be generated every time an active control is touched.
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This setting can be deactivated in the system settings (see chapter 7.5,
page 42).

6.2.2 Display elements and controls

The following display elements and controls are available:

Table 1 Fixed keys which are always available

[Home] always opens the main dialog.

[Back] saves the entry and opens the next-higher dialog
page.

[Help] opens the online help for the dialog displayed.

[Print] opens the printing dialog.

[Manual] opens the manual control.

[Stop] cancels the running determination.

[Start] starts a determination.

The file name of the loaded method, the time and the system status are
displayed in the main dialog in the Title bar.

In the other dialogs, the title bar shows the headings of the next upper
level and of the displayed dialog. This is an aid for orientation during navi-
gation through the user dialog.
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Table 2 Screen elements

Buttons open a new dialog when they are tap-
ped.

Inactive buttons with gray lettering indicate
that the respective function is not available at the
moment.

Input fields open an input dialog when tapped.

Tapping on the selection symbol opens a selec-
tion list.

A check box can also be activated or deactiva-
ted by tapping on it.

6.2.3 Status display
The current status of the system is displayed in the upper right-hand cor-
ner of the title bar.

Table 3 Status displays

The instrument is in normal status.

The working medium is being conditioned.

Conditioning has been paused.

The working medium is conditioned.

A method has been started.
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A method has been paused.

An action has been started in manual control.

6.2.4 Entering text and numbers
In the editing dialog for text or numerical input, enter the individual char-
acters by tapping in the input field. The following functions are available:

Text editor

Table 4 Editing functions

Editing function Description

[OK] The modification is applied and the editing dialog
is exited.

[Cancel] The editing dialog is exited without applying the
modification.

[Delete entry] The content of the input field is deleted com-
pletely.

[⌫] The character in front of the cursor is deleted.

[⇦] The cursor within the input field is shifted to the
left by one character.

[⇨] The cursor within the input field is shifted to the
right by one character.
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Editing function Description

[a…z] The lower-case letters are displayed. The label
changes to [A…Z]. The upper-case letters are
displayed again by tapping.

[0–9] Numbers and mathematical characters are dis-
played.

[Special charac-
ters]

Special characters are displayed. You can use the
button [More] to navigate through all available
characters.

Number editor

Table 5 Editing functions

Editing function Description

[OK] The modification is applied and the editing dialog
is exited.

[Cancel] The editing dialog is exited without applying the
modification.

[Delete entry] The content of the input field is deleted com-
pletely.

[off] If not only numbers but also special values (e.g.,
off) can be entered, then the corresponding but-
tons will be shown to the right of the numerical
keypad.

[R1] For many parameters, a result previously defined
in the method can also be entered in place of a
number (see chapter 32.6, page 507). You can
select the result variable by touching [R1].
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NOTE

A commercially available USB keyboard can be connected to make text
and numerical input easier. The key assignment is described in chapter
11.11, page 122.
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7 System settings

Main dialog: System ▶ System settings

This chapter describes the various system settings and configurations.

￭ Selecting the dialog language (see chapter 7.1.1, page 24).
￭ Setting the date and time (see chapter 7.1.2, page 25).
￭ Defining system-specific dialog options (see chapter 7.2, page 26).
￭ User administration (see chapter 7.3, page 30).
￭ Defining settings for the measured value display (see chapter 7.4, page

42).
￭ Configuring settings for acoustic signals (see chapter 7.5, page 42).

7.1 General system settings

7.1.1 Selecting the dialog language
The user interface is available in several languages. In addition to the two
default dialog languages English and German, additional languages can
be selected.

Proceed as follows to select the dialog language:

 

1 Opening the system settings

￭ In the main dialog, tap on [System].
￭ Tap on [System settings].

The System / System settings dialog is displayed.
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2 Selecting the dialog language

￭ Tap on the Dialog language list box and select the desired lan-
guage.

 

3 Saving the settings

Tap on the fixed keys [ ] or [ ].

The main dialog is displayed in the respective dialog language.

7.1.2 Setting the date, time and local time
The Touch Control displays the date and time in accordance with ISO
standard 8601.

Proceed as follows to set the date and time:

 

1 Opening the system settings

￭ In the main dialog, tap on [System].
￭ Tap on [System settings].

The System / System settings dialog is displayed.

 

2 Entering the date

￭ Tap on the input field for the date.
The editor opens.

￭ Enter the current date in the format YYYY-MM-DD and confirm
with [OK].
The arrow keys [⇦] and [⇨] are used to move the cursor to the
left or to the right by one character.

The input is saved and the editor is closed.

 

3 Entering the time

￭ Tap on the input field for the time.
The editor opens.

￭ Enter the current time in the format hh:mm:ss (24-hour format)
and confirm with [OK].
The arrow keys [⇦] and [⇨] are used to move the cursor to the
left or to the right by one character.

The input is saved and the editor is closed.
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4 Enter the local time

￭ Tap on the list box Local time - UTC and select the difference
from the UTC (Coordinated Universal Time).
The selection off means that the time is saved with no difference
from the UTC.

 

5 Saving the settings

Tap on the fixed keys [ ] or [ ].

The time settings are saved.

7.2 System-specific dialog options

Main dialog: System ▶ System settings ▶ Dialog options

A wide array of different titration systems can be operated with Touch
Control. Accordingly, the Touch Control displays far more functions than
are required for any particular system.

If you work without a login function, in this dialog you can define
whether the system should generally be operated in expert mode or in
routine mode. If you work with the login function activated, you must
define this setting separately for each user (see chapter 7.3.1, page 31).

Dialog

Dialog mode in which the user may operate the system.

Selection Expert dialog | Routine dialog

Expert dialog
All functions that are supported by the connected system are available.
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Routine dialog
The user dialog can be limited for routine operations. Only selected
functions are available (see Configuring the routine dialog, page 28).

[Command list]

Block unneeded method commands (see "Blocking unneeded commands
and fixed keys", page 27).

[Fixed keys]

Block unneeded fixed keys (see "Blocking unneeded commands and fixed
keys", page 27).

[Routine dialog]

Configure functions for the routine dialog (see "Configuring the routine
dialog", page 28).

Selecting the dialog mode

Proceed as follows to change the dialog mode:

 

1 Select the dialog mode

Open the selection list Dialog and select either Expert dialog or
Routine dialog.

 

2 Saving the settings

Tap on the fixed keys [ ] or [ ].

The setting will apply to all dialogs.

NOTE

If you have selected Routine dialog and if the routine dialog was
configured in such a way that the dialog System settings / Dia-
log options is blocked, then you can switch back over to the
expert dialog as follows:

￭ Operation without login function:
In the main dialog, enter User = Metrohm.

￭ Operation with login function:
A user who works with expert dialog must log in.

Blocking unneeded commands and fixed keys

This following configurations apply for both dialog modes: routine dialog
and expert dialog.
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Blocking commands

Proceed as follows to block unneeded commands:

 

1 Display the command list

Tap on the [Command list] button.

The list of all command groups is displayed.

 

2 Deactivate command groups

Deactivate those command groups which are not permitted to be
used.

 

3 Saving the settings

Tap on the fixed keys [ ] or [ ].

All deactivated commands appear grayed out in the method editor
and cannot be used for creating methods.

Blocking fixed keys

Proceed as follows to block unneeded fixed keys:

 

1 Display fixed keys which can be blocked

Tap on the [Fixed keys] button.

All fixed keys which can be blocked are displayed.

 

2 Deactivate fixed keys

Deactivate those fixed keys which are not permitted to be used.

 

3 Saving the settings

Tap on the fixed keys [ ] or [ ].

Deactivated fixed keys cannot be used.

Configuring the routine dialog

A suitable Standard configuration has already been saved for routine
operations:

￭ Methods can only be loaded, but not modified or created.
￭ Determinations cannot be recalculated.

You can readjust this standard configuration by disabling additional func-
tions or re-enabling disabled functions.
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NOTE

The configuration of the routine dialog applies for all routine users. You
also have the option of defining user-specific routine settings. To do
this, you must work with the login function activated and create an
identification profile for each user (see chapter 7.3.2, page 35).

Proceed as follows to modify the configuration for the routine dialog:

 

1 Opening the dialog

Tap on the [Routine dialog] button.

The list of all buttons in the main dialog, in the manual control, etc. is
displayed:

 

2 Deactivate buttons

Deactivate those buttons which are not permitted to be used.

All deactivated buttons will appear grayed-out, i.e. they are inactive.

 

3 Deactivate other functions

Many additional buttons and parameters can be disabled in the dia-
logs of [System], [Load method], [Control], [Edit parameters]
and [Results]. The corresponding option must be activated in order
to enable these buttons.

 

4 Saving the settings

Tap on the fixed keys [ ] or [ ].

All deactivated functions will appear grayed-out, i.e. they are inac-
tive.
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7.3 User administration

Main dialog: System ▶ System settings ▶ User admin.

All of the functions of the user administration are described in this chap-
ter. No user administration is mandatory for the simple operation of a
titration system. If, however, you wish to be in compliance with FDA Guid-
ance 21 CFR Part 11, then you must use the functions of the user adminis-
tration. Additional information regarding the requirements of the FDA
Guidance can be found in the document Compliance Guide Touch Con-
trol.

NOTE

If you work with the login function activated, then the user administra-
tion is accessible only for users with administrator rights. This means
that you must ensure that at least two users have administrator rights
so at least one of them will be available. Keep the access rights for a
user with administrator rights in a safe place so that they are accessible
in an emergency.

The following data is displayed in the user list for each user:

￭ Name
￭ Dialog mode in which the user may operate the system.
￭ Status

You can use the user list two different ways:
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￭ Operation with login function:
If you work with the login function activated, i.e. if each user must log
into the system before starting work, then only those users entered in
the list can log in. The user who is currently logged in is shown in the
main dialog.

￭ Operation without login function:
If you work without the login function, the users whose names are
entered in the list can be selected in the main dialog or a user name
can be entered. This makes it possible to document who has operated
the titration system.

[Login options]

Define the settings for the login, Audit Trail, etc. (see chapter 7.3.3, page
35).

[Create ID profile]

Create an identification profile for the selected user on a storage medium
(see chapter 7.3.2, page 35).

[New]

Adding a new user to the list (see chapter 7.3.1, page 31).

[Delete]

Delete the selected user from the list.

NOTE

Once users have worked with the login function and password protec-
tion, they can no longer be deleted, even if the password protection is
disabled again. The status of these users must be set to inactive
(requirement of FDA Guidance 21 CFR Part 11).

The last user with administrator rights cannot be deleted.

[Edit]

Editing the data of the selected user (see chapter 7.3.1, page 31).

7.3.1 Editing the user configuration
User list: User ▶ New / Edit
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User

The designation of the user is used for unambiguous identification, e.g.
the company internal shorthand symbol or the personal number. The user
name is printed out in all reports containing determination data and
stored in the determination file. Each file always contains the name of the
user who created it and the name of the last user to edit it.

Entry 24 characters maximum
Default value empty

Full name

Complete name of the user.

Entry 24 characters maximum
Default value empty

Dialog

Dialog mode in which the user may operate the system.

Selection Expert dialog | Routine dialog

Expert dialog
All functions that are supported by the connected system are available.

Routine dialog
The user dialog can be limited for routine operations. Only selected
functions are available (see Configuring the routine dialog, page 28).

Status

Status of the user. Users can be deactivated. This function is useful, for
instance, if the user is no longer authorized to operate the system or no
longer works for the company.

Selection active | inactive
Default value active
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active
The user is authorized to operate the system.

inactive
The user is not authorized to operate the system and can no longer log
in.

Admin. rights

on | off (Default value: off)

If this option is activated, then the user has administrator rights.

NOTE

The last user with administrator rights cannot be deleted anymore.

[Favorites]

Saving methods and sample tables as user-specific favorites (see chapter
19, page 195).

[Signature method]

Assign the permission to use and sign methods (see ""Edit user / Signature
method" dialog", page 33).

[Signature determ.]

Assign the permission to use and sign determinations (see ""Edit user /
Signature determination" dialog", page 34).

"Edit user / Signature method" dialog

User: Edit ▶ Signature method

Authorizations for using and signing methods can be defined in this dia-
log. These settings are only effective if you are working with the login
function enabled and password protection.

Use only released methods

on | off (Default value: off)

If this option is activated, then the user may only start methods that have
been released.

Review methods (signature level 1)

on | off (Default value: off)

If this option is activated, then the user may only sign methods which
have the status saved. The method is assigned the status reviewed.
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Release methods (signature level 2)

on | off (Default value: off)

If this option is activated, then the user may only sign methods which
have the status reviewed. The method is assigned the status released.

NOTE

If the two options Review methods and Release methods are
selected for a user, then this user can sign different methods at either
level 1 or level 2, but not the same method at both level 1 and level 2.

Delete signatures

on | off (Default value: off)

If this option is activated, then the user may delete the signatures of a
method which has been released. The method is assigned the status
saved. The signatures of a method can only be deleted if it has the status
released.

"Edit user / Signature determination" dialog

User: Edit ▶ Signature determ.

Authorizations for signing determinations can be defined in this dialog.
These settings are only effective if you are working with the login function
enabled and password protection.

Review determinations (signature level 1)

on | off (Default value: off)

If this option is activated, then the user may only sign determinations at
the first level. The determination is assigned the status reviewed.

Release determinations (signature level 2)

on | off (Default value: off)

If this option is activated, then the user may only sign determinations at
the second level. The determination is assigned the status released.

Delete signatures

on | off (Default value: off)

If this option is activated, then the user may delete the signatures of a
determination which has been released. The signatures of a determination
can only be deleted if it has the status released.
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7.3.2 Creating an identification profile
User list: User ▶ Create ID profile

If you plan to carry out the login with an identification profile (see chapter
7.3.3, page 35), then you must first create an identification profile on a
storage medium for each user. A check can then be made at the time of
login as to whether or not the user does exist and whether or not he or
she is working in the expert dialog or in the routine dialog. After a suc-
cessful login the routine dialog settings stored on the card are loaded.

NOTE

In addition to the user name, the current routine dialog settings are also
stored in this identification profile. This means you can define user-spe-
cific routine dialog settings for each user. However, you must configure
them (see "Configuring the routine dialog", page 28), before you cre-
ate the identification profile.

Before you create the identification profile, check whether the desired rou-
tine dialog settings are active.

 

1 Plug in a storage medium

Plug in the USB storage medium.

 

2 Select a user

In the user list, select the user for whom the profile is to be created.

 

3 Create the identification profile

Tap on [Create ID profile].

The user configuration and the current routine dialog settings are
saved.

7.3.3 Defining login options
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options

There are a number of different ways to log onto the system:

￭ Without login
￭ Login via user name
￭ Login via user name and password
￭ Login via identification profile
￭ Login via identification profile and password
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NOTE

If you work with the login function activated, then the user administra-
tion is accessible only for users with administrator rights. This means
that you must ensure that at least two users have administrator rights
so at least one of them will be available. Keep the access rights for a
user with administrator rights in a safe place so that they are accessible
in an emergency.

NOTE

If you exit this dialog with [ ] or [ ], and if you have selected one
of the login variants Login via user name or Login via identifica-
tion profile, then the login dialog will open automatically and you
must also log in to the system.

This means that you must make sure that you have first defined all the
users and created the identification profiles before you activate the
login function.

Login via user name

on | off (Default value: off)

If this option is activated, then the user must log in with his or her unam-
biguous identification.

Login via identification profile

on | off (Default value: off)

If this option is activated, then the login will take place via USB storage
medium with the identification profile stored on it.
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Password required

on | off (Default value: off)

If this option is activated, then the user must enter a password in addition
to his or her user name or identification profile.

Logout automatically

on | off (Default value: off)

If this option is activated, then the user will be logged out automatically
after the specified time.

Input range 1 to 60 min

Login only for the same user

on | off (Default value: off)

If this option is activated, then only the same user may log in again after
he or she has logged out. Users with administrator rights can, however,
log in at any time.

[Audit Trail]

Define the settings for recording an Audit Trail (see chapter 7.3.7, page
41).

[Reasons]

Predefining a list of reasons which can be selected for the modification/
signature of a method or determination (see chapter 7.3.6, page 40).

[Modific. options]

Defining the modifications for which a reason is required (see chapter
7.3.5, page 39).

[Password options]

Define the settings for the password, see following chapter.

7.3.4 Password options
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Password options

You can make various settings for password entry in the password
options.
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Minimum password length

Minimum number of characters of the passwords.

Input range 1 to 10 
Default value 1 

No. of entry attempts

If the user has logged in incorrectly this many times, then it will automat-
ically be deactivated. It can only be reactivated by a user with administra-
tor rights.

Input range 2 to 5 
Selection off
Default value off

Special characters required

on | off (Default value: off)

If this option is activated, then the password must contain one of the fol-
lowing special characters: ° § + ¦ @ * # ç % & ¬ ( ) = ' ^ ` ~ ] [ } { - _ : . ; , >
< £ !

Password expires

on | off (Default value: off)

If this option is activated, then the user must define a new password after
the time specified. A password that has already been used cannot be used
again.

Input range 1 to 999 days
Default value 365 days
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Forgotten password

CAUTION

If a user has forgotten his password, a new user name must be defined.
The same user name can only be used again after a re-installation and
re-creating the user list.

Proceed as follows:

 

1 Create a backup

Create a backup (see chapter 12.3, page 132).

 

2 Executing a system initialization

Switch off the Touch Control and execute a system initialization (see
chapter 30.1, page 493).

 

3 Restore backed-up data

Use the function Restore to reload the data from the backup into
your system (see chapter 12.3.1, page 132).

Deactivate the options User list and System settings / User
admin..

 

4 Switch on the Touch Control

Switch the Touch Control back on again after a few seconds.

 

5 Restore the user list

Create the user list again and redefine the login options.

7.3.5 Modification options
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Modific. options

In the dialog Login options / Modification options, you can define for
which actions a reason must be entered. These reasons are documented
in the Audit Trail (see chapter 7.3.7, page 41) together with the modifi-
cation. The reason for the last modification is shown in the properties of
the method or determination.
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NOTE

The reasons are only requested when working with activated login
function and password.

Saving modified method

on | off (Default value: off)

If this option is activated, then a reason must be given when saving a
method modification.

Recalculating determination

on | off (Default value: off)

If this option is activated, then a reason must be given when determina-
tions are being recalculated.

7.3.6 Reasons
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Reasons

In the dialog Login options / Reasons, you can create a selection list
containing reasons from which a selection can be made when signing and
modifying methods and determinations. Some reasons have already been
provided.

[New]

Add a new reason to the list.

[Delete]

Delete the selected reason from the list.
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[Edit]

Change the designation of the selected reason.

7.3.7 Audit Trail
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Audit Trail

An Audit Trail is an automatically generated log of all user activities. An
Audit Trail contains precise logs of user actions (date, time, user, action,
etc.). Recording an Audit Trail is important for compliance with FDA Guid-
ance 21 CFR Part 11 when using PC programs. A step-by-step description
of how you must proceed to remain in compliance with the FDA Guidance
is included in the document Compliance Guide Touch Control. The Audit
Trail is saved to the internal memory.

You can also use the Audit Trail function specifically to record the data
which are of interest to you.

You can view, filter and export the Audit Trail on a PC with the supplied
software program AuditTrailViewer. Details concerning utilization of the
AuditTrailViewer can be found in the Appendix (chapter 32.9, page 526).

If necessary, you can delete all of the entries in the Audit Trail with
[Delete Audit Trail]. Do not fail to create a backup before doing so,
however.

Security log

on | off (Default value: off)

If this option is activated, then the following events will be recorded: user
login/logout, password changes, automatic deactivation of users and mes-
sages displayed during the login procedure.

User administration log

on | off (Default value: off)

If this option is activated, then all changes with respect to user administra-
tion will be recorded (modifying user list/user data, changing login
options, etc.).

Method log

on | off (Default value: off)

If this option is activated, then all changes with respect to methods and
determinations will be recorded (saving, deleting, renaming, copying and
loading methods; editing method parameters; starting, stopping, pausing
determinations).
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Data log

on | off (Default value: off)

If this option is activated, then the following events will be recorded:
changing sample data; settings in the Control dialog, recalculating deter-
minations, changing statistics data, changing the titer/concentration of a
titrant, changing the calibration data of a sensor, changing the value of a
common variable.

System log

on | off (Default value: off)

If this option is activated, then the program start and the displayed mes-
sages of the following types will be recorded:

￭ : General warning messages

￭ : Error messages

7.4 Measured value display

Main dialog: System ▶ System settings ▶ Meas. value display

The number of decimal places can be defined for pH values and voltages.

This setting refers exclusively to the display of the measured values in the
live display and in the manual control. The values will, however, always be
stored with their full accuracy.

7.5 Acoustic signals

Main dialog: System ▶ System settings ▶ Acoustic signals

You can define acoustic signals in order to direct attention to particular
events. You can define signals for the following events:

￭ Wrong manipulation
An acoustic signal will sound each time an invalid action is attempted
(e.g. pressing [ ] again when Help is open).

￭ Display a message
A short beep will sound each time a message appears on the display.
This informs the user that the message must be confirmed.

￭ Button contact
Each time a button is touched on the touch screen, this will be con-
firmed by an acoustic signal.

￭ External data input
An acoustic signal will provide confirmation each time data is received
from external devices (e.g. balance, barcode reader).
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8 Titrants

Main dialog: System ▶ Titrants

This chapter describes how you can create a list of titrants used in the sys-
tem. Titrants can be used in intelligent buret units or in nonintelligent
buret units. Intelligent buret units have a built-in data chip on which the
data for the titrant is stored. This data is automatically read out during
attachment and entered in the titrant list.

The titrant list can contain a maximum of 30 titrants. The following data is
specified for each titrant:

￭ Designation
￭ Cylinder volume
￭ Type

– EU: exchange unit without data chip
– IEU: exchange unit with integrated data chip
– DU: dosing unit without data chip
– IDU: dosing unit with integrated data chip

￭ MSB connector of the dosing device/control instrument (only when
exchange unit/dosing unit is attached)

Titrants in exchange units/dosing units with integrated data chips are
depicted in green lettering.

The following titrant data is stored in the titrant list:

￭ Name
Each titrant in the system is identified by its unambiguous name.

￭ Concentration
￭ Current titer
￭ Working life



8.1 Adding a new titrant ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

44 ￭￭￭￭￭￭￭￭ 900 Touch Control

￭ Data on exchange/dosing unit:
– Parameters for the function PREP
– Length and diameter of the tubings
– Port assignment of the dosing unit
– Cylinder volume
– Serial number
– etc.

￭ etc.

NOTE

If data is read out from the data chip, then a check is made whether
the titrant list already contains a titrant of the same type with the iden-
tical serial number. If this is the case, then the older data set will
always be overwritten by the new data set, no matter whether the
data set in the titrant list or the data set on the data chip is the most
recent one.

[New]

Adding a new titrant to the list(see chapter 8.1, page 44).

[Delete]

Delete the selected titrant from the list.

[Edit]

Editing the data of the selected titrant (see chapter 8.2, page 45).

8.1 Adding a new titrant

Before you can use a titrant, you must add it to the titrant list. To do this,
use the button [New].

￭ Exchange unit/dosing unit with data chip:
The exchange unit or dosing unit must be attached. All dosing devices
on which non-configured exchange or dosing units have been detec-
ted are included in a selection list. Tapping on the button [Edit] opens
the properties dialog, see following chapter.

￭ Exchange unit/dosing unit without data chip:
The properties dialog is opened after the dosing unit type has been
selected, see following chapter.
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8.2 Editing titrant data

Titrant list: Titrants ▶ New / Edit

All of the data for the selected titrant is displayed in the dialog Titrants /
Edit.

Titrant

The designation of the titrant is used for unambiguous identification.

Entry 24 characters maximum
Selection Selection of frequently used titrants

Concentration

Concentration of the titrant.

Input range –999999999 to 9999999999 
Default value 1.000 

Unit of the concentration.

Entry 10 characters maximum
Selection µmol/mL | mmol/L | mol/L | g/L | mg/L | mg/mL |

 µg/L | ppm | % | mEq/L
Default value mol/L

Comment

Entry 24 characters maximum

Titer

Titer of the titrant.

Input range –999999999 to 9999999999 
Default value 1.000 
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Unit of the titer.

Entry 10 characters maximum
Default value empty
Selection µmol/mL | mmol/L | mol/L | g/L | mg/L | mg/mL |

 µg/L | ppm | % | mEq/L

NOTE

If you modify the titer or the concentration of the titrant in a loaded
determination at a later date and would then like to recalculate the
determination with the corrected value, then you must modify the value
in the determination data under View data / Titrant data (see "Cali-
bration and titrant data", page 223).

Date titer det.

Date and time of the last titer determination. For new titrants, the time
the preparation was made is specified until after the first time a titer deter-
mination has been carried out.

[Working life]

Defining the working life of the titrant (see chapter 8.3, page 47).

[Dosing unit]

This button is only displayed for Type = IDU or DU.

Defining the properties of the dosing unit used (see chapter 8.4, page
48).

[Exchange unit]

This button is only displayed for Type = IEU or EU.

Defining the properties of the exchange unit used (see chapter 8.5, page
54).

[Titer options]

Displaying the properties for titer determination (see chapter 8.7, page
60).
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8.3 Monitoring the working life

Titrant: Edit ▶ Working life

In the dialog Edit titrant / Working life, you can define the time inter-
val after which the titrant must be replaced. This is particularly important if
your titrant has a limited working life. If you do not wish to monitor the
working life, then you can enter only the date of manufacture for docu-
mentation purposes.

Preparation date

Date on which the reagent was manufactured or the bottle was opened.
For new titrants, the time the preparation was made will be specified.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the working life will be monitored.

Working life

If you define a time interval for the working life, then the Expiry date will
be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Expiry date

If you define an expiry date, then the Working life will be tracked auto-
matically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.
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Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

8.4 Dosing unit

Titrant: Edit ▶ Dosing unit

You can edit data for the dosing unit of the titrant in this dialog.

Name

Designation of the exchange or dosing unit.

Entry 24 characters maximum
Default value empty

Order number

Order number of the exchange or dosing unit. It will be read out automat-
ically on units with integrated data chips.

Entry 24 characters maximum
Default value empty

Serial number

Serial number of the exchange or dosing unit. It will be read out automat-
ically on units with integrated data chips.

Entry 8 digits maximum
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Cylinder volume

Cylinder volume of the dosing unit. It will be read out automatically on
dosing units with integrated data chips.

Selection 2 | 5 | 10 | 20 | 50
Default value 20

Serial no. cyl.

Serial number of the dosing cylinder. It will be read out automatically on
exchange or dosing units with integrated data chips. The number can be
changed manually at any time, e.g. when a cylinder is replaced.

Entry 8 digits maximum

[Valve disk]

Specifying the shift direction of the valve disk (see chapter 8.4.3, page
54).

[GLP test]

Defining the time interval for the GLP test (see chapter 8.6, page 58).

[PREP param.]

Entering the parameters for the preparation (see chapter 8.4.1, page
49).

[Tubing param.]

Entering the parameters for the connected tubing (see chapter 8.4.2,
page 51).

8.4.1 Parameters for preparing (PREP) and emptying (EMPTY)
Titrant: Edit ▶ Dosing unit ▶ PREP param.

In the dialog Dosing unit / PREP parameters, you can adjust the
parameters for the execution of the Prepare (command PREP) and
Empty (command EMPTY) functions. The Prepare function is used to
rinse the cylinder and tubing of the dosing unit and fill it air bubble-free.
You should carry out this function before the first determination or once a
day. The EMPTY function empties the cylinder and the tubings of the
dosing unit.

Dosing port PREP/EMPTY

Dosing port through which the cylinder contents are ejected.

Selection Dosing port 1 | Dosing port 2 | Fill port | Spe-
cial port

Default value Dosing port 1



8.4 Dosing unit ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

50 ￭￭￭￭￭￭￭￭ 900 Touch Control

Dosing rate Dos. port 1

Rate used for the aspiration and ejection of the reagent via dosing port 1.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32.2, page 504).

Dosing rate Dos. port 2

Rate used for the aspiration and ejection of the reagent via dosing port 2.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32.2, page 504).

Dosing rate Fill port

Rate used for the aspiration and ejection of the reagent via fill port.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32.2, page 504).

Dosing rate Spec.port

Rate used for the aspiration and ejection of the reagent via the special
port.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32.2, page 504).
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8.4.2 Tubing parameters
Titrant: Edit ▶ Dosing unit ▶ Tubing param.

You can enter the length and diameter of the connected tubings in the
dialog Dosing unit / Tubing parameters. The values which have
already been entered correspond to the dimensions of the supplied
standard tubings. In addition, the port assignment can be modified.

NOTE

These parameters are important for the correct execution of the Pre-
paring (PREP command) and Emptying (EMPTY command) functions,
because the volumes of the tubing connections are taken into account.

Dosing port 1

Port

Port to be used as dosing port 1 for the PREP and EMPTY (see figure 8,
page 53) functions.

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 1

Length

Length of the tubing.

Input range 0.0 to 999.9 cm
Default value 40.0 cm

The setting 0.0 means that this tubing will neither
be rinsed nor emptied.

Diameter

Diameter of the tubing.

Input range 0.0 to 9.9 mm
Default value 2.0 mm

Dosing port 2

Port

Port to be used as dosing port 2 for the PREP and EMPTY functions (see
figure 8, page 53).

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 3
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Length

Length of the tubing.

Input range 0.0 to 999.9 cm
Default value 0.0 cm

The setting 0.0 means that this tubing will neither
be rinsed nor emptied.

Diameter

Diameter of the tubing.

Input range 0.0 to 9.9 mm
Default value 2.0 mm

Fill port

Port

Port to be used as fill port for the PREP and EMPTY functions (see figure
8, page 53).

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 2

Length

Length of the tubing.

Input range 0.0 to 999.9 cm
Default value 25.0 cm

The setting 0.0 means that this tubing will neither
be rinsed nor emptied.

Diameter

Diameter of the tubing.

Input range 0.0 to 9.9 mm
Default value 2.0 mm

Special port

Port

Port to be used as special port for the PREP and EMPTY functions (see
figure 8, page 53).

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 4

Length

Length of the tubing.
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Input range 0.0 to 999.9 cm
Default value 0.0 cm

The setting 0.0 means that this tubing will neither
be rinsed nor emptied.

Diameter

Diameter of the tubing.

Input range 0.0 to 9.9 mm
Default value 2.0 mm

5

4

3

2

1

Figure 8 Dosing unit – port assignment

1 VENT
This port is set up for the deaeration of the
reagent bottle. An adsorber tube (filled with
desiccant) is usually mounted here.

2 Port 1
The default definition of this port is dosing
port 1.

3 Port 2
The default definition of this port is the fill-
ing port. A riser tube is usually mounted to
it.

4 Port 4
Air is suctioned through this port during the
Emptying function.

5 Port 3
The default definition of this port is dosing
port 2.
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8.4.3 Shift direction of the valve disk
Titrant: Edit ▶ Dosing unit ▶ Valve disk

In this dialog, you can specify the shift direction of the valve disk.

Direction

Shift direction of the valve disc.

Selection descending | ascending | automatic | not over
Default value automatic

descending
The ports are moved to in descending order.

ascending
The ports are moved to in ascending order.

automatic
The ports are moved to by the shortest path.

not over
Define a protected port.

Not over port

This parameter can only be edited with Direction = not over.

Define a protected port if the valve disc is not to be rotated over this port
(useful with pipetting functions). The protected port can, however, be
moved to directly.

Selection 1 | 2 | 3 | 4
Default value 4

8.5 Exchange unit

Titrant: Edit ▶ Exchange unit
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You can edit data for the exchange unit of the titrant in this dialog.

Name

Designation of the exchange or dosing unit.

Entry 24 characters maximum
Default value empty

Order number

Order number of the exchange or dosing unit. It will be read out automat-
ically on units with integrated data chips.

Entry 24 characters maximum
Default value empty

Serial number

Serial number of the exchange or dosing unit. It will be read out automat-
ically on units with integrated data chips.

Entry 8 digits maximum

Cylinder volume

Cylinder volume of the exchange unit. It will be read out automatically on
exchange units with integrated data chips.

Selection 1 | 5 | 10 | 20 | 50
Default value 20

Serial no. cyl.

Serial number of the dosing cylinder. It will be read out automatically on
exchange or dosing units with integrated data chips. The number can be
changed manually at any time, e.g. when a cylinder is replaced.

Entry 8 digits maximum

[GLP test]

Defining the time interval for the GLP test (see chapter 8.6, page 58).

[PREP param.]

Entering the parameters for the preparation (see chapter 8.5.1, page
56).

[Tubing param.]

Entering the parameters for the connected tubing (see chapter 8.5.2,
page 57).
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8.5.1 Parameters for the preparation (PREP)
Titrant: Edit ▶ Exchange unit ▶ PREP param.

In the dialog Exchange unit / PREP parameters, you can adjust the
parameters for the execution of the Prepare function (command PREP).
This function is used to rinse the cylinder and tubings of the exchange unit
and fill it air bubble-free. You should carry out this function before the first
determination or once a day.

Volume

Volume of titrant dosed during a rinsing cycle.

Input range 0.00000 to 99999.9 mL
Selection Cylinder volume
Default value Cylinder volume

Cylinder volume
The entire cylinder volume is being dosed.

Cycles

Number of rinsing cycles. We recommend carrying out at least two rinsing
cycles in order to remove all air bubbles.

Selection 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9
Default value 2

Dosing rate

The rate at which dosing takes place.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).
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8.5.2 Tubing parameters
Titrant: Edit ▶ Exchange unit ▶ Tubing param.

You can enter the length and diameter of the connected tubings in the
dialog Exchange unit / Tubing parameters. The values which have
already been entered correspond to the dimensions of the supplied
standard tubings.

Dosing tip

Tubing to the dosing tip (9-2).

Length

Length of the tubing.

Input range 0.0 to 999.9 cm
Default value 40.0 cm

Diameter

Diameter of the tubing.

Input range 0.0 to 9.9 mm
Default value 2.0 mm

Dosing cylinder

Tubing to the dosing cylinder (9-3).

Length

Length of the tubing.

Input range 0.0 to 999.9 cm
Default value 13.0 cm

Diameter

Diameter of the tubing.

Input range 0.0 to 9.9 mm
Default value 2.0 mm

Reagent bottle

Tubing to the reagent bottle (9-1).

Length

Length of the tubing.

Input range 0.0 to 999.9 cm
Default value 25.0 cm
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Diameter

Diameter of the tubing.

Input range 0.0 to 9.9 mm
Default value 2.0 mm

1

2

3

Figure 9 Exchange unit – tubing connections

1 Tubing to the reagent bottle 2 Tubing to the dosing tip

3 Tubing to the dosing cylinder

8.6 GLP test for exchange unit and dosing unit

Titrant: Edit ▶ Dosing unit / Exchange unit ▶ GLP test

In the dialog Exchange unit / GLP test or Dosing unit / GLP test,
respectively, you can define the time interval after which a GLP test must
be carried out again for the exchange unit or dosing unit.

GLP test date

Date on which the last GLP test was carried out.

Format: YYYY:MM:DD
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Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a GLP test
has to be carried out again will be monitored.

GLP test interval

If you define a time interval for the GLP test, then the date in Next GLP
test will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next GLP test

If you define a date for the next GLP test, then the GLP test interval will
be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.
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8.7 Titer determination options and data

Titrant: Edit ▶ Titer options

Detailed information concerning the titer determination is displayed in the
Edit titrant / Titer options dialog:

￭ Titer method
Method by which the titer was determined. If the titer was entered
manually, then manual will be displayed.

￭ User
User who carried out the titer determination.

￭ Statistical data
The following information is also displayed for automatically assigned
titers if the mean value of the results has been saved as the titer (see
"Save as titer", page 158):

– n (titer det.)
Number of titer determinations.

– s abs
Absolute standard deviation

– s rel
Relative standard deviation

[Validity]

Defining the time interval for the titer validity (see chapter 8.7.1, page
60).

[History]

Displaying information about the last ten titer determinations (see chapter
8.7.2, page 61).

8.7.1 Titer validity
Titrant: Edit ▶ Titer options ▶ Validity

In the dialog Titer options / Validity, you can define the time interval
after which the titer must be determined again.

Date titer det.

Date and time of the last titer determination. For new titrants, the time
the preparation was made is specified until after the first time a titer deter-
mination has been carried out.

Monitoring

on | off (Default value: off)

If this parameter is activated, then the titer validity will be monitored.
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Titer validity

If you define a time interval for the validity of the titer, then the date in
Next titer determ. will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next titer determ.

If you define a date for the next titer determination, then the time interval
for the Titer validity will be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

8.7.2 Properties of the previous titer determinations

Dialog "Titer options / History"

Titrant: Edit ▶ Titer options ▶ History

The date, time and titer of the last ten titer determinations are displayed in
tabular form in the dialog Titer options / History. Titers that were deter-
mined automatically will be displayed in green; manually entered titer val-
ues will be displayed in black with the designation (m). You can delete
these entries, e.g. if you have opened a new bottle.
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NOTE

If multiple determinations have been carried out in order to determine
the titer, then only one entry will be made in the history.

[Delete History]

Delete the entire history.

[Graph]

Open the diagram of the titer values, see following chapter.

Dialog "History / Graph"

Titrant: Edit ▶ Titer options ▶ History ▶ Graph

In this diagram, titer values are plotted against the date of the titer deter-
mination. You can define warning limits (blue dashed lines) and interven-
tion limits (red dashed lines). These limits will not, however, be monitored.

[Limits]

Define warning and intervention limits.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 9 Reagents

900 Touch Control ￭￭￭￭￭￭￭￭ 63

9 Reagents

Main dialog: System ▶ Reagents

This chapter describes how you can create a list of the reagents used in
the system. Depending on the usage a distinction is made between two
types of reagents:

￭ Reagent for volumetric determinations
￭ Reagents for coulometric determinations

The list of reagents gives the designation and type of each reagent.

[New]

Add a new reagent to the list, see following chapter.

[Delete]

Delete the selected reagent from the list.

[Edit]

Edit the data of the selected reagent, see following chapter.
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9.1 Editing reagent data

Main dialog: System ▶ Reagents ▶ New / Edit

Reagent

The designation of the reagent is used for unambiguous identification.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

[Reagent monitoring]

Set the parameters for the reagent monitoring, see following chapter.

9.2 Reagent monitoring

The conditions for the monitoring of the reagent are defined in the dialog
Edit reagent / Reagent monitoring.
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If one of the following values is reached, then the reagent must be
replaced. The values are checked in the following cases:

￭ at the start of the determination.
￭ at the end of the determination.

Number of determ.

The number of determinations to be carried out with a certain amount of
reagent depends on the type of sample and its amount.

Input range 1 to 999 
Selection off
Default value off

Working life

Working life of the reagent.

Input range 1 to 999 days
Selection off
Default value off

Volume

This parameter is only visible for volumetric reagents.

Volume of titrant dosed.

Input range 1.0 to 999.9 mL
Selection off
Default value off

Reagent capacity

This parameter is only visible with coulometric reagents.

Water capacity of the reagent.

Input range 1 to 9999 mg
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Selection off
Default value off

Drift

This parameter is only visible with coulometric reagents.

During conditioning the measured drift has to be in the following range
for 2 min: 'specified drift value + 50 µg/min'.

Input range 1 to 999 µg/min
Selection off
Default value off

[Status]

Display the status overview of the current values of the reagent monitor-
ing.

[Reagent replacement]

Edit the parameters for the reagent exchange.

"Reagent monitoring / Status" dialog

The current reagent monitoring values are displayed in this dialog.

[Reset]

Reset the values to zero.

Dialog "Reagent monitoring / Reagent replacement"

The parameters for the reagent replacement are defined in this dialog.

Reagent replacement

The reagent can either be exchanged manually or automatically.

Selection manual | auto
Default value manual

manual
If a monitored parameter has reached the limit set, a message is being
displayed. Then the reagent has to be exchanged manually.

auto
If a monitored parameter has reached the limit set, the method defined
below is started automatically.

Memory

This parameter can only be edited with Reagent replacement = auto.

Memory location the method is loaded from. All memory locations are
selectable, even if they are currently not accessible.
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Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
Shared directory in the network.

Method

This parameter can only be edited with Reagent replacement = auto.

Method used for emptying the titration cell.

NOTE

Make sure that the memory is accessible.

Entry 32 characters maximum
Selection Selection of stored methods



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

68 ￭￭￭￭￭￭￭￭ 900 Touch Control

10 Sensors

Main dialog: System ▶ Sensors

This chapter describes how you can create a list of the sensors used in the
system.

Five standard sensors are defined in the sensor list: pH electrode, Metal
electrode, Fluoride electrode, Temperature sensor and Conductiv-
ity sensor. These sensors cannot be deleted or renamed. A maximum of
25 additional sensors can be added to these sensors.

For each sensor, the following data is displayed in the sensor list:

￭ Designation
￭ Type

– pH: pH electrode
– Metal: Metal electrode
– ISE: Ion-selective electrode
– Temp.: Temperature sensor
– Cond.: Conductivity measuring cell
– Other: Other sensor type

￭ Measuring input/control instrument (only for intelligent sensors if they
are connected)

Intelligent sensors are also indicated by IS and are depicted in green letter-
ing.

The following sensor data is stored in the list of sensors:

￭ Name
Each sensor in the system is identified by its unambiguous name.

￭ Calibration data (for pH electrodes, ISE electrodes and conductivity
measuring cells only)
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￭ Calibration interval (for pH electrodes, ISE electrodes and conductivity
measuring cells only)

￭ Working life
￭ etc.

NOTE

If data is read out from the data chip of an intelligent sensor, then a
check is made whether the sensor list already contains a sensor of the
same serial number. If this is the case, then the older data set will
always be overwritten by the new data set, no matter whether the
data set in the sensor list or the data set on the data chip is the most
recent one.

[New]

Adding a new sensor to the list (see chapter 10.1, page 69).

[Delete]

Delete the selected sensor from the list.

[Edit]

Editing the data of the selected sensor (see chapter 10.2, page 70).

10.1 Adding a new sensor

Before you can use a sensor, you must add it to the sensor list. To do this,
use the button [New].

￭ Conventional sensors:
The properties dialog is opened after the sensor type has been
selected, see following chapter. The following sensor types can be
selected:

– pH electrode
– Metal electrode (Pt electrode, Ag Titrode, Ag/AgCl reference

electrode, etc.)
– Ion-selective electrode
– Other sensor, e.g. Spectrosense
– Temperature sensor
– Conductivity measuring cell

￭ Intelligent sensors (also known as iTrodes):
If the 854 iConnect with iTrode is connected to a control instrument,
then the sensor is automatically entered in the sensor list and can be
configured, see following chapter.
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10.2 Editing the sensor data

Sensor list: Sensor ▶ New / Edit

All of the data for the selected sensor is displayed in the dialog Sensors /
Edit.

Sensor

The designation of the sensor is used for unambiguous identification.

Entry 24 characters maximum

Ion

This parameter is only visible for electrodes of the type ISE.

Display of the ion and its charge.

Order number

Order number of the sensor. With intelligent sensors it is read out auto-
matically.

Entry 24 characters maximum
Default value empty

Serial number

Serial number of the sensor. With intelligent sensors it is read out auto-
matically.

Entry 8 digits maximum

Comment

Entry 24 characters maximum
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[Working life]

Defining the working life of the sensor (see chapter 10.3, page 71).

[Limit values]

This button is displayed only for pH and ISE electrodes and conductivity
measuring cells.

Define the limit values for monitoring the slope, the electrode zero point
or the cell constant (see chapter 10.5, page 77).

[Calibration interval]

This button is displayed only for pH and ISE electrodes and conductivity
measuring cells.

Define the time interval for the next calibration (see chapter 10.6, page
79).

[Calibration data]

This button is displayed only for pH and ISE electrodes and conductivity
measuring cells.

Display the properties for titer determination (see chapter 10.4, page
72).

10.3 Monitoring the working life

Sensor: Edit ▶ Working life

In the dialog Edit sensor / Working life, you can define the time inter-
val after which the sensor must be replaced. If you do not wish to monitor
the working life, then you can enter only the date of manufacture for doc-
umentation purposes.

Start-up

Date on which the sensor was used for the first time.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the working life will be monitored.

Working life

If you define a time interval for the working life, then the Expiry date will
be tracked automatically.

Input range 1 to 999 days
Default value 999 days
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Expiry date

If you define an expiry date, then the Working life will be tracked auto-
matically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

10.4 Calibration data (for pH- and ISE electrodes and con-
ductivity measuring cells only)

Sensor: Edit ▶ Calibration data
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Detailed information concerning calibration is displayed in this dialog Edit
sensor / Calibration data.

Slope

Slope of the electrode.

pH electrodes:
Input range –999.9 to 999.9 %
Default value 100.0 %

ISE electrodes:
Input range –999.9 to 999.9 mV

The default value depends on the charge of the ion.

pH(0)

This parameter is only visible with pH electrodes.

pH value of the electrode at 0 mV. Apart from the slope, pH(0) is the
second characteristic of the calibration curve.

Input range –20.000 to 20.000 
Default value 7.000 

E(0)

This parameter is only visible with ISE electrodes.

Electrode zero point. Apart from the slope, E(0) is the second characteristic
of the calibration curve.

Input range –2000.0 to 2000.0 mV
Default value 0.0 mV

c(blank)

This parameter is only visible with ISE electrodes.

Blank value concentration.

Input range –999999999 to 9999999999 
Default value 0.00 

Variance

This parameter is only visible with ISE electrodes.

The variance is only calculated, if the calibration has been carried out with
at least three standards.

Cell constant

This parameter is only visible for conductivity measuring cells.

Cell constant.
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Input range 0.001 to 500.000 /cm
Default value 1.000 /cm

The following data cannot be edited:

￭ Electrode test (only with intelligent sensors)
Result of the electrode test.

￭ Calibration temp
Temperature at which the calibration was carried out.
If the temperature was measured manually during the calibration, then
(manual) will also be displayed. If the temperature was measured with
a connected temperature sensor, then the sensor type ((Pt1000) or
(NTC)) will be displayed.

￭ Calibration date
Date and time of the last calibration. For new sensors, the time the
preparation was made is specified until after the first time a calibration
has been carried out.

￭ Cal. method
Method with which the sensor was calibrated. If the calibration data
was entered manually, then manual will be displayed.

￭ User
User who carried out the calibration.

￭ Measuring input (only with intelligent sensors)
The type and the serial number of the measuring input with which the
calibration was carried out.

[Initial data]

This button is only displayed for intelligent sensors.

Display the initial calibration data determined at the time of the Metrohm
quality control.

[GLP test]

This button is displayed only for pH electrodes.

Define the time interval for the GLP test (see "Dialog "Calibration data /
GLP test"", page 75).

[History]

Display information about the last ten calibrations (see "Dialog "Calibra-
tion data / History"", page 74).

10.4.1 Properties of the previous calibrations

Dialog "Calibration data / History"

Sensor: Edit ▶ Calibration data ▶ History

The date, time and calibration data of the last ten calibrations are dis-
played in tabular form in the dialog Calibration data / History. Calibra-
tions that were carried out automatically will be displayed in green; man-
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ually entered calibration data will be displayed in black with the designa-
tion (m).

[Delete History]

Delete the entire history.

[Graph slope]

Open the diagram of the electrode slopes, see following chapter.

[Graph pH(0)]

Open the diagram of the electrode zero points, see following chapter.

[Graph E(0)]

Open the diagram of the electrode zero points, see following chapter.

[Graph cell const.]

Open the diagram of the cell constants, see following chapter.

Dialog "History / Graph"

Sensor: Edit ▶ Calibration data ▶ History ▶ Graph Slope / pH(0) /
E(0) / Cell const.

In this diagram, either slope, pH(0), E(0) or the cell constant is plotted
against the date of the calibration. You can define warning limits (blue
dashed lines) and intervention limits (red dashed lines). These limits will
not, however, be monitored.

[Limits]

Define warning and intervention limits.

Dialog "Calibration data / GLP test"

Sensor: Edit ▶ Calibration data ▶ GLP test

In the dialog Calibration data / GLP test, you can define the time inter-
val after which a GLP test must be carried out again for the sensor.
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GLP test date

Date on which the last GLP test was carried out. After you have carried
out an electrode test (ELT command), the date of the electrode test is
automatically entered into this field. However, you also can enter the date
manually.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a GLP test
has to be carried out again will be monitored.

GLP test interval

If you define a time interval for the GLP test, then the date in Next GLP
test will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next GLP test

If you define a date for the next GLP test, then the GLP test interval will
be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.
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10.5 Limit values for the calibration data

Sensor: Edit ▶ Limit values

You can define the following limit values in the dialog Edit sensor /
Limit values:

￭ Slope (pH and ion-selective electrodes)
￭ Electrode zero point (pH and ion-selective electrodes)
￭ Cell constant (conductivity measuring cells)

These values are monitored during the calibration. If these limits are
infringed, then a message will be displayed and you can decide whether
to accept the calibration data or not.

Monitoring slope

on | off (Default value: off)

If this parameter is activated, then the slope will be monitored.

Lower limit

pH electrodes:
Input range –999.9 to 999.9 %
Default value 96.0 %

ISE electrodes:
Input range –999.9 to 999.9 mV

The default value depends on the charge of the ion:
–25.0 mV (–2), –55.0 mV (–1), 55.0 mV (+1), 25.0
mV (+2).
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Upper limit

pH electrodes:
Input range –999.9 to 999.9 %
Default value 101.0 %

ISE electrodes:
Input range –999.9 to 999.9 mV

The default value depends on the charge of the ion:
–31.0 mV (–2), –61.0 mV (–1), 61.0 mV (+1), 31.0
mV (+2).

Monitoring pH(0)

on | off (Default value: off)

This parameter is only available with pH electrodes.

If this parameter is activated, then the electrode zero point pH(0) will be
monitored.

Lower limit

Input range –20.000 to 20.000 
Default value 6.750 

Upper limit

Input range –20.000 to 20.000 
Default value 7.250 

Monitoring E(0)

on | off (Default value: off)

This parameter is only available with ISE electrodes.

If this parameter is activated, then the electrode zero point E(0) will be
monitored.

Lower limit

Input range –2000.0 to 2000.0 mV
Default value –2000.0 mV

Upper limit

Input range –2000.0 to 2000.0 mV
Default value 2000.0 mV

Monitoring cell constant

on | off (Default value: off)

This parameter is only available for conductivity measuring cells.
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If this parameter is activated, then the cell constant will be monitored.

Lower limit

Input range 0.001 to 500.000 /cm
Default value 0.850 /cm

Upper limit

Input range 0.001 to 500.000 /cm
Default value 1.150 /cm

10.6 Monitoring the calibration interval (only for pH and
ion-selective electrodes and conductivity measuring
cells)

Sensor: Edit ▶ Calibration interval

In the dialog Edit sensor / Calibration interval, you can define the time
interval after which the sensor must be recalibrated.

Calibration date

Date of the last calibration.

Monitoring

on | off (Default value: off)

If this parameter is activated, then the validity of the calibration will be
monitored.

Calibration interval

If you define a time interval for the validity of the calibration, then the
date in Next calibration will be tracked automatically.

Input range 1 to 999 days
Default value 7 days

Next calibration

If you define a date for the next calibration, then the Calibration inter-
val will be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.
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Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.
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11 Device manager

Main dialog: System ▶ Device manager

This chapter describes how you can configure the Touch Control, the con-
trol instruments (Titrando, Sample Processor etc.) and the connected
peripheral devices. A detailed description of the hardware installation can
be found in the installation manual for the control instrument.

The instrument list gives the name and type of every instrument.
Connected control instruments (Titrando, Dosing Interface, Sample Pro-
cessor, etc.) with the peripheral devices (dosing devices, stirrers, etc.)
connected to the MSB connector are entered in the list automatically. A
USB/RS-232 adapter will also be automatically recognized and entered in
the instrument list with default settings. A printer is entered in the instru-
ment list in the default settings. You must enter a PC keyboard, a barcode
reader or a balance in the instrument list yourself.

[New]

Add a new device to the list (see chapter 11.1, page 82).

[Delete]

Delete the selected device from the list.

NOTE

Devices which are recognized automatically cannot be deleted from the
list while they are still connected.

[Edit]

Configure the selected device (see chapter 11.2, page 82).
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11.1 Adding a new device

Of the following device types, you can enter one device each in the device
list, even if it is not yet connected:

￭ Titrando (3 instruments maximum)
￭ Sample Processor
￭ Balance
￭ Barcode reader
￭ USB/RS-232 adapter
￭ PC keyboard

Proceed as follows:

 

1 Displaying the device selection

Tap on [New].

 

2 Selecting the instrument

Tap on the button for the desired device.

The new device is entered in the list.

11.2 Configuring the device

Instrument list: Instrument ▶ Edit

The data stored for an instrument depends on the type of instrument. You
can define an instrument name and a comment for each instrument. The
instrument name of the Touch Control is printed out in the standard
report header.

The description of the individual instruments can be found in the follow-
ing specific chapters:

￭ Touch Control (see chapter 11.3, page 83)
￭ Metrohm control instruments (see chapter 11.4, page 89)
￭ Sample Processor (see chapter 11.5, page 94)
￭ Printer (see chapter 11.8, page 114)
￭ Balance (see chapter 11.9, page 118)
￭ PC keyboard (see chapter 11.11, page 122)
￭ USB/RS-232 adapter (see chapter 11.10, page 120)
￭ Barcode reader (see chapter 11.12, page 123)
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11.3 Touch Control

Instrument list: 900 Touch Control ▶ Edit

Device name

This designation is used for identification purposes when selecting control
devices (command, manual control).

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Switch off display

If this time interval has expired without the Touch Control having been
operated, then the display will be switched off. Touching the display will
switch it back on again at any time.

The function is no longer available with program version 5.900.0046 or
higher.

Input range 1 to 999 min
Selection off
Default value off

Program version

Program version of the software.

Serial number

Shows the serial number of the device.
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Control Remote Box

Shows to which control device and MSB connector the Remote Box is
connected.

The "Control Remote Box" is the interface via which the system can be
started and stopped externally. If multiple Remote Boxes are connected,
then the one that is recognized first when the program starts will be used
as the "Control Remote Box."

Selection Name of the control device / Number of the
MSB connector | Not available

11.3.1 E-mail
900 Touch Control: Edit ▶ E-mail

The system allows you to send displayed messages as e-mails. The Touch
Control must be connected to a network for this to function. The follow-
ing types of messages can be sent:

￭ : general warning messages

￭ : error messages

Configuring e-mail dispatch

Proceed as follows so that messages can be sent as e-mails:

 

1 Activating the option

￭ In the instrument properties of the 900 Touch Control, tap on the
[E-mail] button.

￭ In the Edit device / E-mail dialog, activate the Send the fol-
lowing messages as e-mail: option.

 

2 Configuring e-mail addresses

￭ Tap on the [E-mail settings] button.
The E-mail / Settings dialog is displayed.

￭ Enter the addresses of the mail server, the sender and the desired
recipient.

Parameter description

Send the following messages as e-mail:

on | off (Default value: off)

If this parameter is activated, then messages with the following symbols
will be sent as e-mails:

￭ : General warning messages
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￭ : Error messages

Send only during running determination

on | off (Default value: on)

If this parameter is activated, then messages will be sent as e-mails only if
a determination is running. Deactivate this parameter if messages are also
to be sent in normal status.

Mail server

Address of the mail server for outgoing mail, e.g. mail.metrohm.ch. You
can find the address of the mail server either in your e-mail program set-
tings or obtain it from your IT department.

Entry 50 characters maximum
Default value empty

Sender

E-mail address of the sender. This address must be formatted as an e-mail
address, but need not necessarily correspond to an existing e-mail
account, e.g. touchcontrol@metrohm.com.

Entry 50 characters maximum
Default value empty

Recipient

The messages will be sent to this e-mail address.

Entry 50 characters maximum
Default value empty

11.3.2 PC/LIMS report
900 Touch Control: Edit ▶ PC/LIMS report

You can generate a machine-readable report with all of the important
data concerning a determination, which is referred to as a PC/LIMS report.
This report can be saved as a TXT file (according to ISO/IEC 8859-1) or as a
UTF-8 file or sent to a terminal program or a LIMS via an RS-232 interface:

￭ manually with the [ ] fixed key (see chapter 27, page 247).
￭ automatically at the end of a determination (see chapter 16.5.6, page

187).

The file name of the report file is constructed as follows: PC_LIMS_Report-
ID1-YYYYMMDD-hhmmss.txt. A detailed description of the contents of
the PC/LIMS report can be found in the PC/LIMS Report Guide.
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Memory

Memory location where the PC/LIMS report is stored as a file. The report
will be saved in the directory pc_lims_report. This directory will be created
the first time a PC/LIMS report is generated. All three memory locations
are listed as possible selections, even if they cannot be accessed at the
moment.

Selection off | External memory 1 | External memory 2 |
 Shared memory

Default value off

off
The report will not be saved as a file.

Shared memory
The report will be saved in a shared directory on the network. The
shared directory is selected in the Edit device / Shared memory dia-
log (see chapter 11.3.3, page 87).

RS-232

The RS-232 interface via which the PC/LIMS report is sent. The interface
parameters are adjusted in the Edit device / Port parameters dialog
(see chapter 11.10, page 120).

Selection off | COM 1 | COM 2
Default value off

off
The report will not be sent via an RS-232 interface.

COM 2
This interface is inactive.

Coding

Format in which the PC/LIMS report is coded and stored.

Selection ISO 8859-1 | UTF-8
Default value ISO 8859-1

ISO 8859-1
This format is recommended for all languages that use the extended
ASCII code (e.g. German, English, Spanish, etc.).

UTF-8
This format is required for all languages that do not use the extended
ASCII code (e.g. Russian, Chinese, Korean, etc.).
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11.3.3 Shared memory
900 Touch Control: Edit ▶ Shared memory

If you have your Touch Control connected to your network, then you can
define in this dialog a shared memory location on a computer within your
network for the purpose of saving data (methods, determinations, etc.).

CAUTION

If the computer on which you share a memory location does not have
the same subnet as the Touch Control, then a WINS server must be
present. The computer must be entered in this server. In order for the
communication to work, the SMB protocol version 1 (SMBv1) must be
activated. Since this function is not standard anymore in Windows 10, it
has to be activated manually. From firmware version 5.900.0044, the
SMB protocol version 2 and 3 is also supported.

Computer

Host name of the computer on which a memory location is to be shared.
If you are working with Windows, then you will find the host name of the
computer as follows: In the Windows command prompt window, enter
the command ipconfig -all. The host name is listed together with other
parameters of the computer.

Do not under any circumstances enter an IP address in this input field.

Entry max. 32 characters
Default value empty

Share name

Share name of the shared memory location (file directory) on the above-
specified computer. Please note that the Share name of a file directory
often does not match the name of the file directory. The share name can
be found on the Release tab in the Properties dialog of the shared file
directory.

Entry max. 32 characters
Default value empty

Domain

Network domain in which the above-specified computer is located. If you
are working with Windows, then you will find the domain name as fol-
lows: In the Windows command window, enter the command ipconfig
-all. The domain is listed together with other parameters of the computer.
Leave the field empty if the computer is not located within a domain.
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Entry max. 32 characters
Default value empty

User

User name of the user authorized to access the shared memory location.

Entry max. 32 characters
Default value empty

Password

Password of the user configured on the computer.

Entry max. 32 characters
Default value empty

[Connect]

Establish the network connection. If the connection has been set up cor-
rectly, then all of the input fields will become inactive and the label
switches to [Disconnect]. The network connection can be disconnected
with this.

11.3.4 TCP/IP settings
900 Touch Control: Edit ▶ TCP/IP settings

If you have connected your Touch Control to your network, then you will
have to define the network-relevant settings in this dialog. The Touch
Control requires an IP address so that it is identifiable on the network. The
Touch Control can acquire the IP address either dynamically from a DHCP
server or you can enter the address directly.

Get IP address automatically (DHCP)

on | off (Default value: on)

If this parameter is activated, then the Touch Control will obtain its IP
address directly from a DHCP server. In this case, the remaining parame-
ters can no longer be edited.

IP address

IP address for the Touch Control. IP addresses are 32-bit numbers and are
written as sequences of four decimals, each separated by a period, e.g.
"10.157.212.8".

Entry x.x.x.x
Default value 192.168.10.11

"x" is a decimal between 0 and 255.
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Subnet mask

The net mask or subnet mask, together with the IP address, indicates to
which network the device to be connected belongs. Subnet masks are 32-
bit numbers and are written as sequences of four decimals, each separa-
ted by a period.

Entry x.x.x.x
Default value 255.255.255.0

Default gateway

IP address for the standard gateway. A gateway sets up connections to
several networks. It is located in the same subnet as the device to be con-
figured.

Entry x.x.x.x
Default value 192.168.10.10

MAC address

Unambiguous address of the network adaptor for identification within a
network. This parameter cannot be edited.

NetBIOS name

Unambiguous designation of the device within the network. This parame-
ter cannot be edited.

11.4 Metrohm control instruments

The following Metrohm devices can be used as control instruments:

￭ Titrandos
￭ Sample Processors
￭ 846 Dosing Interface
￭ 867 pH Module
￭ 856 Conductivity Module

The following specifications apply for all of the control instruments men-
tioned above.

Additional device configurations for the Sample Processor are described in
a separate chapter (see chapter 11.5, page 94).
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The dialog shows the control instrument with its measuring inputs, the
MSB connectors and connected peripheral devices (dosing device, stirrer,
Remote Box). If the control instrument is not connected, then the proper-
ties dialog of the control instrument will be displayed directly (see chapter
11.4.1, page 90).

[Properties]

Open the properties dialog of the highlighted entry.

The following properties can be displayed and edited to a certain extent:

￭ Properties of the control instrument (see chapter 11.4.1, page 90)
￭ Properties of the measuring inputs (see chapter 11.4.2, page 91)

This dialog is available only for devices which have a built-in measuring
input.

￭ Properties of the MSB connectors (see chapter 11.4.3, page 92)
￭ Properties of the peripheral devices on the MSB connector (see chapter

11.4.4, page 93)

11.4.1 Properties – Control instrument
Instrument list: Control instrument ▶ Edit ▶ Properties

Device name

This designation is used for identification purposes when selecting control
devices (command, manual control).

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Program version

Program version of the instrument software.
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Serial number

Shows the serial number of the device.

11.4.2 Properties – Measuring input
Instrument list: Control instrument ▶ Edit ▶ Measuring input
1/2 ▶ Properties

In this dialog, you define the type of temperature sensor you have
connected to the selected measuring input.

ADC type

Type of analog-digital converter.

Serial number

Serial number of the measuring interface.

Thick film type

Type of the thick film.

Temperature sensor

Type

The instrument supports the use of two different temperature measure-
ment techniques:

￭ NTC (Negative Temperature Coefficient)
￭ Pt1000 (Platinum resistance)

Select here the type that has been connected to the instrument. If an NTC
sensor is used, then it is also necessary to enter two sensor characteristics.
These characteristics are listed in the specifications of the sensor.

Selection Pt1000 | NTC
Default value Pt1000
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R (25 °C)

This parameter can only be edited with Type = NTC.

Nominal resistance of the NTC sensor at 25 °C.

Input range 1000 to 99999 ohm
Default value 30000 ohm

The default value applies to Metrohm sensors with
an NTC sensor.

B value

This parameter can only be edited with Type = NTC.

Material constant of the NTC sensor. B values of NTC sensors are fre-
quently based on different reference temperatures (usually 25 °C and
50…100 °C). When entering the B value the influence of the second ref-
erence temperature is negligible in comparison with the measuring accu-
racy of an NTC sensor.

Input range 1000 to 9999 K
Default value 4100 K

The default value applies to Metrohm sensors with
an NTC sensor. If no B value is given for your sensor
then you can retain the default value.

11.4.3 Properties – MSB connector
Instrument list: Control instrument ▶ Edit ▶ MSB connector 1…
4 ▶ Properties

In this dialog, you can define when the request to carry out the Prepare
function for connected dosing devices is to be displayed. This setting
applies for all dosing devices of the selected MSB connector. The manual
control contains a description of how to prepare the exchange unit and/or
the dosing unit (see chapter 28.3.3, page 267).
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Switch on

on | off (Default value: on)

If this parameter is activated, then you will be requested to prepare the
dosing device when the Touch Control is switched on.

Attach an exchange or dosing unit

on | off (Default value: on)

If this parameter is activated, then you will be requested to prepare the
dosing device when the exchange/dosing unit is attached.

Time interval

on | off (Default value: off)

Activate this parameter if you wish to receive a regular request to prepare
the dosing unit.

Input range 0.1 to 999.9 h
Default value 12.0 h

11.4.4 Properties – Peripheral devices
Instrument list: Control instrument ▶ Edit ▶ Peripheral
device ▶ Properties

The following data is displayed for the connected dosing devices and stir-
rers:

￭ Type
The display includes the device number, e.g. "800" (Dosino) or "804"
(Ti Stand)

￭ Serial number
In the case of the 700 Dosino and the 685 Dosimat, the serial number
cannot be read out.
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11.5 Sample Processor

NOTE

The following settings apply to all Sample Processors.

The dialog shows the Sample Processor with its tower (or towers), the
MSB connectors and connected peripheral devices (dosing device, stirrer,
Remote Box). If the control instrument is not connected, then the proper-
ties dialog of the control instrument will be displayed directly (see chapter
11.5.1, page 95).

The settings of the MSB connectors and the connected peripheral devices
are described in Chapter "Properties – MSB connector", page 92.

[Racks]

Configure sample racks (see chapter 11.6, page 102).

[Running time]

Configure the running time meter.

The running time meter adds together the time while the Sample Pro-
cessor is "busy" i.e. when an action is being carried out. A message with
the prompt to service the device is displayed after expiry of the time limit
set here. We recommend to carry out a service after 1,000 operating
hours. A reset of the running time meter can only be carried out by a
Metrohm service engineer.

[Properties]

Open the properties dialog of the highlighted entry.
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11.5.1 Properties – Sample Processor
Instrument list: Sample Processor ▶ Edit ▶ Properties

Device name

This designation is used for identification purposes when selecting control
devices (command, manual control).

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Program version

Program version of the instrument software.

Serial number

Shows the serial number of the device.

Rack name

Name of the currently attached sample rack.

[Adjustment data]

Display the internal adjustment data (EEPROM data) of the Sample Pro-
cessor.

CAUTION

Do not modify and save these settings under any circumstances. This
data is required by the service engineer in case of positioning problems.

11.5.2 Properties – Tower
Instrument list: Sample Processor ▶ Edit ▶ Tower 1/2 ▶ Properties
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NOTE

In the case of a Sample Processor with 2 towers, Tower 1 is the tower
on the right and Tower 2 is the tower on the left, when viewed from
the front.

Maximum stroke path

Lowest permissible lift position for automatic and manual operation.

This is a safety setting. A correct specification of this value can prevent the
glass of an electrode from breaking, because a titration head can not be
moved below the position specified.

Input range 1 to 235 mm
Default value 235 mm

Min. beaker radius

Smallest permissible radius of the sample vessels for automatic and man-
ual operation.

This is a safety setting. It is intended to prevent a completely loaded, wide
titration head from being moved into a narrow sample vessel.

Input range 1.0 to 100.0 mm (Increment: 0.1)
If the lift is to be moved to the work position, a
check is made to see whether the beaker radius
defined for the attached rack (see "Beaker radius
samples", page 104) is less than this value.

Selection off
Default value off

off
No check takes place.
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Rotation increment

Amount by which the sample rack can be rotated forward or backward
relative to its current position. This parameter is required in the command
MOVE for the settings Destination = rotate + and rotate -.

Input range 0 to 353.99 °
Default value 5.00 °

Axial distance

Distance between the axis of rotation of the sample rack and the swing
axis of the robotic arm.

for 814 USB Sample Processor:
Input range 100.0 to 300.0 mm
Default value 166.0 mm

for 815 Robotic USB Sample Processor XL, 855 Robotic Titrosampler:
Input range 100.0 to 300.0 mm
Default value 196.0 mm

11.5.3 Properties – Swing Head
Instrument list: Sample Processor ▶ Edit ▶ Swing Head ▶ Proper-
ties

The dialog Edit device / Properties shows a list of all external positions
with the assigned swing angle and the specific work position for each.

[Ext. pos. 1-4]

Edit the settings that apply for all external positions (see "Properties –
External positions 1-4", page 98).

[Robotic arm]

Edit the robotic arm settings (see "Properties – Robotic arm", page 99).
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[Adjustment data]

Display the overview of the EEPROM data of the Swing Head. This dialog
cannot be edited.

[Edit]

Edit specific settings of the selected external position (see "Properties –
External position", page 100).

Properties – External positions 1-4

Swing Head: Properties ▶ Ext. pos. 1-4

Properties which apply to all four external positions can be defined in the
dialog Properties / Edit external positions 1-4.

Shift position

Lift position at which the robotic arm rotates to the external positions.

Input range 0 to 'Maximum stroke path' mm
Default value 0 mm

A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).

Rinse position

Lift position used for rinsing.
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Input range 0 to 'Maximum stroke path' mm
Default value 0 mm

A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).

Swing increment

Amount by which the robotic arm can be swung relative to its current
position. This parameter is used in the command MOVE for the settings
Destination = swing + and swing -.

Input range 0.00 to 180.00 °
Default value 10.00 °

Properties – Robotic arm

Swing Head: Properties ▶ Robotic arm

Properties of the robotic arm can be defined in the dialog Properties /
Robotic arm.

Swing offset

The swing offset is a physical angle offset of a specific robotic arm model.
The required values can be found in the leaflet for the robotic arm.

Input range –270.00 to 270.00 °
Default value 0.00 °

Maximum swing angle

Useable swing range of the robotic arm. Each robotic arm model displays
a different value on the basis of its construction. The range can also be
reduced if necessary. You will find the required values in the leaflet for the
robotic arm.
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Input range 0.00 to 330.00 °
Default value 60.00 °

Swing radius

Maximum swing radius of the robotic arm. The swing radius is dependent
on the length of the robotic arm and is, together with the axial distance
(see "Axial distance," page 97), the most important variable for precise
movement to a rack position. You will find the required values in the leaf-
let for the robotic arm.

Input range 30.00 to 300.00 mm
Default value 110.00 mm

Rotation offset

The rotation offset is the offset from the center of the tower to the center
of the robotic arm. This value does not usually need to be changed. If a
Swing Head is to be mounted on the tower with a lateral offset, then this
value can be determined by the service technician when the rack is adjus-
ted.

Input range –270.00 to 270.00 °
Default value 0.00 °

Swing direction

The swing direction of the robotic arm depends on its type. For a 2-tower
model, the robotic arm must be defined as right-swinging on Tower 1 and
as left-swinging on Tower 2.

Selection + | -
Default value -

+
Left-swinging.

-
Right-swinging.

Properties – External position

Swing Head: Properties ▶ Edit
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Properties which apply only to the selected external position can be
defined in the dialog Properties / Edit external position.

Angle

Swing angle for the selected external position.

Input range (Offset) to (Offset + max. swing range) °
Default value 60.00 °

The offset is made up of a design-dependent angle
(approx. 8…9°) together with the robotic arm off-
set from the robotic arm properties. The maximum
swing range is also defined under the robotic arm
properties (see "Properties – Robotic arm", page
99).

Work position

Work position for the selected external position.

Input range 0 to 'maximum stroke path' mm
A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).
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11.6 Sample racks

Instrument list: Sample Processor ▶ Edit ▶ Racks

In the dialog Edit device / Sample racks, you will find the list of config-
ured racks. The attached rack is displayed in green. New racks can be loa-
ded or created and existing ones can be edited or deleted in this dialog
window.

The following data is displayed in the list:

￭ Rack
Name of the sample rack. Metrohm standard racks are designated by
their order numbers.

￭ Positions
Number of positions on the rack.

￭ Code
The rack code corresponds to the arrangement of magnets on the base
of the rack and is read in by the Sample Processor in order to recognize
the rack.

[Load]

Load a new sample rack (see "Loading the sample rack", page 103).

[Copy]

Create a new sample rack by copying an existing rack (see "Creating a
new sample rack", page 104).

[Delete]

Delete the selected sample rack from the list.

[Edit]

Edit the data of the selected sample rack (see chapter 11.6.1, page 104).
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Loading the sample rack

When you receive the file for a new sample rack from your Metrohm rep-
resentative, you can easily import this file into your existing system. Pro-
ceed as follows:

 

1 Copying the file to an external storage medium

￭ Copy the file to a subdirectory of "Files".

If this structure is not maintained, the new rack will not be found
because the software directly accesses subdirectories of "Files".

￭ Plug in the external storage medium at the Touch Control.

 

2 Display the list of saved sample racks

￭ In the Edit device / Sample racks dialog, tap on the [Load]
button.
The selection of file groups on the external storage medium is dis-
played. If only one group is available, then the list of the saved
sample rack files will be displayed directly.

￭ Select the group with the desired sample rack.
￭ Tap on [Show files].

The list with the saved sample rack files is opened.

 

3 Load the sample rack file

￭ Select the desired file.
￭ Tap on [Load].

The new sample rack is now loaded and appears in the list of avail-
able racks.
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Creating a new sample rack

Own sample racks can be simply and conveniently created by copying an
existing sample rack. Proceed as follows:

 

1 Copy the existing rack

￭ In the dialog Edit device / Sample racks, select a sample rack
which is to be used as a template.

￭ Tap on [Copy].

The Sample rack / Copy dialog is displayed.

 

2 Enter the rack name and rack code

￭ In the field New rack name, enter a name for the new rack.
￭ In the field New rack code, 110000 is suggested. As a rule, this

rack code is used for special racks. Apply this code or enter a new
rack code and confirm with [OK].

The new sample rack appears in the list of available racks.

11.6.1 Editing rack data
Sample rack list: Rack ▶ Edit

You can edit the data of the selected rack in the dialog Sample rack /
Edit rack data.

Beaker radius samples

Actual radius of the sample vessels at the general sample positions of the
rack.

This beaker radius may not be less than the minimum beaker radius
defined in the tower properties (see "Min. beaker radius," page 96). If the
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lift is to be moved to the work position, then these two values will be
compared with one another.

Input range 1.0 to 100.0 mm
Selection off
Default value off

off
No check takes place.

Beaker sensor

Each time a sample position is to be moved to with the MOVE command,
the beaker sensor checks whether a vessel is present. In the MOVE com-
mand, you define the action that takes place if the beaker sensor does not
detect a vessel at the position being moved to.

Selection Tower | Robotic arm | off
Default value off

Robotic arm
A Swing Head with beaker sensor must be mounted. In addition, a
suitable work position must be defined for the lift, so that the robotic
arm touches the sample vessel. The work position is moved to for the
purpose of beaker detection.

off
No check takes place.

1. Calibration pos.

Position of the first calibration solution for automatic calibration with a
Sample Processor(see "Definition of the calibration positions", page 509) .

Input range 1 to "highest rack position" 
It is imperative that the remaining buffers/standards
be placed on the rack positions directly following.

Selection Special beaker 1…n | off
Default value off

Special beaker 1…n
If a special beaker is selected as the first calibration position, then the
number of buffers/standards used for calibration will determine the
number of special beakers to be defined. Any rack position can be
defined as a special beaker. It is, however, preferable to set them at
high rack positions in order to be able to begin sample series at rack
position 1. The special beakers are moved to in ascending order.

Rack offset

The rack offset is a production-related tolerance value between the upper
and lower sections of the rack. This value is determined when the rack is
adjusted and is displayed here. It can be changed if necessary.
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Input range –10.00 to 10.00 °
Default value 0.00 °

[Adjust rack]

Adjust the rack (see chapter 11.6.2, page 110).

[Lift pos. tower 1]/[Lift pos. tower 2]

Define rack specific lift positions (see "Lift positions Tower 1/2", page
106).

[Special beakers]

Define rack positions as special beakers (see "Editing special beakers",
page 107).

Lift positions Tower 1/2

Sample rack list: Rack ▶ Edit ▶ Lift pos. tower 1 / Lift pos. tower 2

You can define rack-specific lift positions in the dialog Edit rack data /
Lift positions tower 1/2. These then apply for all rack positions except
those that have been defined as special beakers.

These positions can be moved to directly under manual control and with
the LIFT command. Only lift positions within the maximum stroke path can
be entered. This is defined in the device properties of the tower.

NOTE

These lift positions can also be assigned directly in manual control after
moving to the desired lift height (see chapter 28.7.1, page 275).

Work position

At this lift position the electrodes, stirrer and buret tips are optimally posi-
tioned for work.
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Input range 0 to 'maximum stroke path' mm
A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).

Rinse position

Lift position used for rinsing.

Input range 0 to 'Maximum stroke path' mm
Default value 0 mm

A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).

Shift position

The lift is raised to this position with each rotational movement of the rack
whenever it is located at a lower lift position.

Input range 0 to 'maximum stroke path' mm
A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).

Special position

For sample positions, you can define an additional lift position for special
applications.

Input range 0 to 'maximum stroke path' mm
A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).

Editing special beakers

Sample rack list: Rack ▶ Edit ▶ Special beakers
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A maximum of 16 rack positions can be defined as special beakers for
each sample rack. The dialog Edit rack data / Special beakers shows a
list of all special beakers with their assigned rack positions.

[Edit]

Edit the data of the selected special beaker, see the following.

You can edit the data of the selected special beaker in the dialog Special
beaker / Edit.

Rack position

Number of rack position for selected special beaker. Any rack position can
be defined as a special beaker. It is, however, preferable to set them at
high rack positions in order to be able to begin sample series at rack posi-
tion 1. Rack positions defined as special beakers can no longer be used as
sample positions.

Input range 0 to 'maximum number of rack positions' 
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Work pos. tower 1/2

Work position for the selected special beaker. One specific work position
can be defined for tower 1 and tower 2.

Input range 0 to 'maximum stroke path' mm
A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96).

Beaker radius

Actual radius of the selected special beaker.

This beaker radius may not be less than the minimum beaker radius
defined in the tower properties (see "Min. beaker radius," page 96). If the
lift is to be moved to the work position, then these two values will be
compared with one another.

Input range 1.0 to 100.0 mm
Selection off
Default value off

off
No check takes place.

Beaker sensor

Each time this special beaker is to be moved to with the MOVE com-
mand, the beaker sensor checks whether a vessel is present. In the MOVE
command, you define the action that takes place if the beaker sensor
does not detect a vessel at the position being moved to.

Selection Tower | Robotic arm | off
Default value off

Robotic arm
A Swing Head with beaker sensor must be mounted. In addition, a
suitable work position must be defined for the lift, so that the robotic
arm touches the sample vessel. The work position is moved to for the
purpose of beaker detection.

off
No check takes place.
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11.6.2 Rack adjustment
Instrument list: Sample Processor ▶ Edit ▶ Racks ▶ Edit ▶ Adjust
rack

If necessary, each sample rack can be finely adjusted, i.e. the rack offset is
determined in the direction of rotation. The adjustment of a rack is usually
not necessary. However, if the exact positioning of a robotic arm is neces-
sary for a high degree of accuracy (e.g. for very small sample beakers),
then a fine adjustment can be carried out.

Proceed as follows:

 

1 Open the dialog for rack adjustment

￭ In the device properties of the Sample Processor, open the list of
the configured sample racks.

￭ Select the attached rack and tap on [Edit].
The Sample rack / Edit rack data dialog is displayed.

￭ Tap on the [Adjust rack] button.

The Edit rack data / Adjust rack dialog is displayed:

 

2 Carry out the adjustment

￭ Tap on the [Start] button (NOT on the [ ] fixed key).
The rack is being initialized. The rack then moves to position 1
and the lift is lowered to the work position.

￭ If necessary, the lift position can be corrected with the arrow keys
[⇧] and [⇩].

￭ Now use the arrow keys [⇦] and [⇨] to rotate the rack so that
the robotic arm or the center of the titration head is positioned
exactly above the center of rack position 1.

￭ Finish the adjustment with [OK].
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The lift is moved to the uppermost stop.

11.7 885 Compact Oven SC 

NOTE

In order for the 885 Compact Oven SC to be controlled with the 900
Touch Control, at least the following firmware versions must be
installed on the instruments:

￭ 900 Touch Control 5.900.0045
￭ 885 Compact Oven SC 5.885.0013

The dialog displays the 885 Compact Oven SC with its tower and the oven
module. If the control instrument is not connected, then the properties
dialog of the control instrument will be displayed directly (see chapter
11.7.1, page 111).

Properties

Open the Properties dialog of the highlighted entry.

11.7.1 Properties - 885 Compact Oven SC
Instrument list: 885 Compact Oven SC ▶ Edit ▶ Properties

Device name

This designation is used for identification purposes when selecting control
instruments (command, manual control).

Entry 24 characters maximum
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Comment

Entry 24 characters maximum

Program version

Program version of the device software.

Serial number

Display of the serial number of the device.

11.7.2 Properties - Tower
Instrument list: 885 Compact Oven SC ▶ Edit ▶ Tower ▶ Properties

Sample beaker

Work position

At this lift position, the sample beaker is optimally placed in the oven and
the needle has completely pierced the septum.

Input range 0 to 96 mm (Increment: 6)
Default value 78 mm

A lift height of 0 mm corresponds to the "home position". The lift is
located at the upper stop position.

Conditioning beaker (special beaker 1)

Work position

At this lift position, the needle has completely pierced the septum of the
conditioning beaker at the conditioning position. In the method run, the
[MOVE] command is used to move the conditioning bucket with the
Objective Special beaker 1.

Input range 0 to 96 mm (Increment: 6)
Default value 36 mm
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A lift height of 0 mm corresponds to the "home position". The lift is
located at the upper stop position.

11.7.3 Properties - Oven module
Instrument list: 885 Compact Oven SC ▶ Edit ▶ Oven mod-
ule ▶ Properties

Program version

Program version of the oven module.

Serial number

Display of the serial number of the oven module.

Initial temperature

Entering an initial temperature means that the oven will heat up to the set
temperature when the 900 Touch Control is switched on.

Input range 50 to 250 °C (Increment: 1)
Default value 110 °C
Selection off

off
The oven is not switched on.

Action when switching off the touch device.

Switch off heater

Setting for the behavior of the heater of the oven module when the Touch
Control is switched off.

Selection on | off
Default value on
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Switch off the gas flow

Setting for the behavior of the gas flow of the oven module when the
Touch Control is switched off.

Selection on | off
Default value on

11.8 Printer

Instrument list: Printer ▶ Edit

The list of devices always includes a printer, even if no corresponding
device is connected. In this dialog, you also define when you would like to
have a report generated as a PDF file.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Printer

Selection of the printer type.

Selection PCL Inkjet | PCL Laser | HP | Epson | Epson
new | Canon | CUSTOM NEOS | off

PCL Inkjet
for HP DeskJet printers.

PCL Laser
for HP LaserJet printers.
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CUSTOM NEOS
Due to the narrow paper size, only reports marked with # in the "List
of all printable reports" (see chapter 27.3, page 251) can be printed.

off
The reports will not be printed out on paper.

Connector

Selection of the connection type for the printer.

Selection USB | Ethernet
Default value USB

USB
Local printer at a USB interface.

Ethernet
Network printer.

NOTE

The Touch Control prints the reports with a fixed resolution of 300
dpi. If you are using a printer with a resolution of 360 dpi (or a multiple
thereof, e.g. an Epson), then the text will be printed out somewhat
smaller than with printers with a resolution of 300 dpi (or a multiple
thereof, e.g. a Canon or HP).

11.8.1 PDF settings
Printer: Edit ▶ PDF settings

The settings for saving a report as a PDF file are defined in this dialog.

Memory

Memory location where the PDF file will be saved. The report will be saved
in the directory PDF_Report. This directory is created when a PDF file is
generated. The file name is appended with the date and time when the
determination was started and the date and time when the PDF was gen-
erated (e.g.: Identification 1-20130320-141044-20130320-141220).
The first date and time set indicates the start of the determination, the
second date and time set indicates the generation of the PDF file. This pre-
vents previously created PDF files from being overwritten each time a new
file is created, e.g. when a result is recalculated and the report is gener-
ated again.

All three memory locations are listed as possible selections, even if they
cannot be accessed at the moment.
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Selection off | External memory 1 | External memory 2 |
 Shared memory

Default value off

off
The report will not be saved as a PDF file.

Shared memory
The report will be saved in a shared directory on the network. The
shared directory is selected in the Edit device / Shared memory dia-
log (see chapter 11.3.3, page 87).

Copy or extract content allowed

on | off (Default value: on)

If this option is activated, then content can be copied or deleted from the
PDF file.

Printing allowed

on | off (Default value: on)

If this option is activated, then the PDF file can be printed.

Change the document allowed

on | off (Default value: off)

If this option is activated, then the PDF file can be edited.

Add or change comments allowed

on | off (Default value: on)

If this option is activated, then comments can be added to the PDF file.

11.8.2 Network printer
Printer: Edit ▶ Network printer

If you have connected your Touch Control to your network, then you can
specify a network printer for your reports in this dialog.

NOTE

If you have shared a memory location on a PC within your network and
if you have configured the Touch Control accordingly (see chapter
11.3.3, page 87), then the settings for the parameters Domain, User
and Password will be applied and can then no longer be modified in
this dialog.
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CAUTION

If the computer on which the network printer is configured does not
have the same subnet as the Touch Control, then a WINS server must
be present. The computer must be entered in this server. In order for
the communication to work, the SMB protocol version 1 (SMBv1) must
be activated. Since this function is not standard anymore in Windows
10, it has to be activated manually. From firmware version 5.900.0044,
the SMB protocol version 2 and 3 is also supported.

Print server

Host name of the print server or the computer on which the network
printer is configured. If you are working with Windows, then you will find
the host name as follows: In the Windows command prompt window,
enter the command ipconfig -all. The host name is listed together with
other parameters of the print server or the computer.

Do not under any circumstances enter an IP address in this input field.

Entry max. 32 characters
Default value empty

Share name

Share name of the network printer on the above-specified computer.
Please note that the Share name of a network printer often does not
match the name of the printer. The share name can be found on the
Release tab in the Properties dialog of the released network printer.

Entry max. 32 characters
Default value empty

Domain

Network domain in which the above-specified computer is located. If you
are working with Windows, then you will find the domain name as fol-
lows: In the Windows command window, enter the command ipconfig
-all. The domain is listed together with other parameters of the computer.
Leave the field empty if the computer is not located within a domain.

Entry max. 32 characters
Default value empty

User

User name of the user authorized to access the shared network printer.

Entry max. 32 characters
Default value empty
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Password

Password of the user configured on the computer.

Entry max. 32 characters
Default value empty

11.8.3 More options

Paper size

Selection of the paper size.

NOTE

The paper size selected will be ignored when the report is printed on a
CUSTOM NEOS printer.

Selection A4 (210 mm x 297 mm) | Letter (216 mm x
279 mm)

Default value A4 (210 mm x 297 mm)

Color

on | off (Default value: off)

If this option is activated, then the report will be printed out in color.

Spooler

on | off (Default value: on)

If this option is activated, then you can continue to work while the printer
is printing. If this option is deactivated, then the Touch Control will be
blocked while the printout is being produced.

11.9 Balance

List of devices: Balance ▶ Edit
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You define the type of balance and its connector in the dialog Device
manager / Edit.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Balance type

If you have connected a balance, then you have to specify the balance
type here.

Selection AND | Mettler | Mettler AT | Mettler AX |
 Ohaus | Precisa | Sartorius | Shimadzu

Default value Sartorius

RS-232

RS-232 interface to which the balance is connected. The interface
parameters are adjusted in the Edit device / Port parameters dialog
(see chapter 11.10, page 120).

Selection COM 1 | COM 2
Default value COM 1

COM 2
The interface is disabled.

The following table indicates the balance type that needs to be selected
for the balance model:
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Balance Balance type

AND AND

Mettler AB, AE, AG, AM,
AJ, PE, PM, PJ, PR, XP, XS

Mettler

Mettler AT Mettler AT

Mettler AX, MX, UMX, PG,
AB-S, PB-S

Mettler AX

Ohaus Voyager, Explorer,
Analytical Plus

Ohaus

Precisa Precisa

Sartorius Sartorius

Shimadzu BX, BW Shimadzu

11.10 USB/RS-232 adapter

Instrument list: USB/RS-232 adapter ▶ Edit ▶ COM interface ▶ Edit

As a rule, balances are equipped with a serial RS-232 interface. To connect
a balance, you will require the 6.2148.050 cable. You can adjust the inter-
face parameters in the dialog Edit device / Port parameters. These set-
tings must match the settings on the connected device.

NOTE

If you make changes to parameter settings in this dialog, then you must
switch the Touch Control off and back on in order for the changes to
take effect.
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Baud rate

Transfer rate in characters per second.

Selection 1200 | 2400 | 4800 | 9600 | 19200 | 38400 |
 57600 | 115200

Default value 9600

Data bits

Number of data bits.

Selection 7 | 8
Default value 8

Parity

Type of parity testing.

Selection even | odd | none
Default value none

Stop bits

Number of stop bits.

Selection 1 | 2
Default value 1

Handshake

Type of data transfer protocol.

NOTE

In case of communication problems, try the software handshake (Soft-
ware (XON/XOFF)).

Selection none | Software (XON/XOFF) | Hardware (DTR/
CTS)

Default value Hardware (DTR/CTS)

Software (XON/XOFF)
Use the software handshake when you send a PC/LIMS report via an
RS-232 interface.
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11.11 PC keyboard

Instrument list: PC keyboard ▶ Edit

A commercially available USB keyboard can be connected to make text
and numerical input easier. It will be recognized automatically and entered
in the list of devices with default settings.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Keyboard layout

Define the country-specific keyboard layout here.

Selection English US | German DE | French FR | Spanish
ES | German CH

Default value English US

To enter texts and numbers with the PC keyboard, the appropriate text
and number input dialog must be opened on the Touch Control. Only the
following keys on the PC keyboard have a function:

Table 6 Key assignment

Function in the editing dialog PC keyboard key

[Cancel] [Esc]
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Function in the editing dialog PC keyboard key

Enter respective character Numbers, letters and special char-
acters + Shift

[OK] [Enter] / [↲]

[⌫] [←] (backspace)

Line break (for multi-line text
input)

[Enter] / [↲]

The cursor is moved up or down
by one character.

[↑] [↓]

The cursor is moved to the left or
to the right by one character.

[←] [→]

[F1]

[F2]

[F3]

[F4]

[F5]

[F6]

[F7]

NOTE

The lettering of the USB keyboard may differ from above lettering,
depending on the country-specific keyboard used.

11.12 Barcode reader

List of devices: Barcode reader ▶ Edit
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A barcode reader can be connected to read in sample data or other texts.
A connected barcode reader will be recognized automatically and entered
in the list of devices with default settings.

You will hear an acoustic signal as confirmation that a character string has
been transmitted by the barcode reader and accepted.

NOTE

The data will be read only if the system is in normal status, i.e. when no
determination is running.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Barcode input target

Selection of the input field for the character string read in by the barcode
reader.

Selection Active input field | Method | Identification 1 |
 Identification 2 | Sample size

Active input field
The character string is entered in the input field of the opened text- or
number-input dialog.

Method
The character string is entered in the input field Method.

Identification 1
The character string is entered in the input field Identification 1.
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Identification 2
The character string is entered in the input field Identification 2.

Sample size
The character string is entered in the input field Sample size. Charac-
ter strings containing characters other than numbers and decimal sepa-
rators will be ignored.

Keyboard layout

Specify the country-specific keyboard layout for the emulation of the PC
keyboard. This setting must match the setting on the barcode reader (see
documentation for the barcode reader).

Selection English US | German DE | French FR | Spanish
ES | German CH

Default value English US
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12 File manager

Main dialog: System ▶ File manager

The saved methods, determinations, sample tables, etc. are managed in
the file manager. You can also create a backup of your system (all data
and settings). Also, an existing backup can be reloaded.

The file memory is organized as follows:

￭ Internal memory
The following files can be stored in the internal memory:

– Methods
￭ External memory

You can use a USB flash drive as an auxiliary storage medium, for
instance. The following files can be stored on an external memory:

– Backup
– Methods
– Determinations
– Sample tables
– Result tables
– Reports as *.pdf
– PC/LIMS report

12.1 Managing files

File manager: Internal memory / External memory 1 / External
memory 2

The saved files can be organized into groups. These groups are compara-
ble to file directories on your PC, although unlike your PC, only one level is
possible.

NOTE

The file names must be unique for each memory location, i.e. you can-
not save two files with the same name, even if they are in different
groups.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 12 File manager

900 Touch Control ￭￭￭￭￭￭￭￭ 127

NOTE

If you use an external storage medium with the FAT or FAT32 file sys-
tem, then you can save a maximum of 999 files per group. If you find it
necessary to store more than 999 files in a single group, then you must
reformat the storage medium with the file system ExFAT (see chapter
32.10.3, page 532).

[Show all]

Display the list of all the files in the selected memory location.

[Show files]

Display the list of all the files in the selected group.

[Rename]

Rename the selected file (see chapter 12.1.2, page 128).

[Properties]

Display the file properties (see chapter 12.1.3, page 129).
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[Copy]

Copy the selected file to a different memory location (see chapter 12.1.1,
page 128).

[Delete]

Delete the selected file.

[Load]

Load the selected file.

12.1.1 Copying a file
Proceed as follows to copy a file:

 

1 Selecting the file

￭ Select the desired file.
￭ Tap on [Copy].

The selection of memory locations is displayed.

 

2 Copy the file

￭ Tap on the desired memory location.
Only memory locations currently being accessible are active.

The file is copied. The file group is retained, i.e. the group will be cre-
ated again in the new memory location if it does not already exist
there.

12.1.2 Renaming a file
Proceed as follows to rename a file:

 

1 Selecting the file

￭ Select the desired file.
￭ Tap on [Rename].

The Show files / Rename dialog is displayed.

 

2 Change the file name

￭ Tap on the input field File name.
The text editor opens.

￭ Enter a new file name (max. 32 characters) and confirm with
[OK].

￭ Tap on [OK].

The file is saved under the new name.
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12.1.3 File properties
File manager: Internal memory / External memory 1 / External
memory 2 ▶ Show all / Show files ▶ Properties

Detailed information concerning the file is displayed in the Show files /
Properties dialog. They can be edited to a certain extent.

￭ File name
Name of the file.

￭ File group
Entry or selection of the group in which the file will be saved. If you
enter a new name, then the file will be moved into the new group.

￭ Write protection
If this option is activated, then the file cannot be saved, deleted,
moved or renamed. This is only an internal write protection feature and
is independent of the write protection of the operating system on your
computer.

￭ Created by
User who saved the file initially.

￭ Created on
Date and time at which the file was saved for the first time.

￭ Last saved by
User who saved the file most recently.

￭ Last saved on
Date and time at which the file has been saved most recently. Addition-
ally, the version of the file is displayed. The version number will be
increased by one each time the file is saved.

￭ Size
File size.

￭ Program version
Program version of the software with which the file was last saved.
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12.2 External storage medium

[Backup]

Creating a backup of all data and settings on this storage medium (see
chapter 12.3, page 132).

[Restore]

Load the backup. This function is active only if a backup is available (see
chapter 12.3, page 132).

[Memory info]

Display information on the storage medium, see following chapter.

Storage medium – Information

Detailed information about the storage medium is displayed in the dialog
External memory 1/2 / Memory info:

￭ Name
Designation of the storage medium.

￭ Write protection
If this option is activated, then the file cannot be saved, deleted,
moved or renamed. This is only an internal write protection feature and
is independent of the write protection of the operating system on your
computer.

￭ Storage capacity
Total capacity of the storage medium.

￭ Used memory
Storage capacity used on the storage medium.

￭ Free memory
Free storage capacity on the storage medium.
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Directory structure

The directory structure appears as follows on the external storage
medium:

Figure 10 Directory structure on the external storage medium

Backup All of the files of the backup are stored in this
directory. The directory will be created the first
time a backup is created.

Files This directory contains all of the groups as well
as the files contained in them (methods, deter-
minations, etc.).

pc_lims_report PC/LIMS reports are stored in this directory as
TXT files. The directory will be created the first
time a PC/LIMS report is printed out.

PDF_Report PDF reports are stored in this directory. The direc-
tory will be created the first time a report is
saved as a PDF file.

Profiles The identification profile is stored in this direc-
tory. The directory will be created the first time
an identification profile is generated.

SwUpdates Files for software updates must be saved in this
directory.
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12.3 Creating backups / Restoring data

File manager: External memory 1 / External memory 2

You can use the [Backup] function to easily create a backup containing
all the data and settings of your system. You should make a backup at
regular intervals in order to avoid data loss.

NOTE

Only one backup can be created on a storage medium.

If a backup has already been stored on the medium, then it will be
overwritten when this function is carried out again.

12.3.1 Restoring data
You can use the function [Restore] to restore either a complete backup
or only certain data.

CAUTION

All of the methods in the internal memory will be deleted.

Backups are not backward compatible, i.e. backups of the latest version
cannot be restored using earlier versions.

Proceed as follows to restore backed-up data:

 

1 Select the storage medium

￭ Connect the storage medium on which the backup is located.
￭ Select the storage medium under System ▶ File manager.

 

2 Select data

￭ Tap on [Backup].
The selection of the data that can be restored separately is dis-
played (see the following).

￭ Deselect the data sets which are not to be restored.
￭ Tap on [Load data].

The selected data blocks are restored.

 

3 Complete the restoration

￭ Switch the Touch Control off and on again.
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Restorable data blocks

The following data blocks can be loaded individually:

￭ Methods
All of the methods stored in the internal memory.

￭ Sample table
Current sample table.

￭ Result table
Current result table.

￭ Current determination data
All the data for the current determination (including the method with
which the determination was carried out).

￭ Control
Settings in the control dialog.

￭ User list
Settings for each user under System settings / User administra-
tion.

￭ System settings / User admin.
All of the system settings, including device-specific dialog configuration
and dialog options for the command list and fixed keys, device-specific
settings for the user administration (login options, password options
and Audit Trail).

￭ Titrants
All titrants with all their data.

￭ Sensors
All sensors with all their data.

￭ Device data
All of the devices configured in the device manager, with all of the
data.

￭ GLP data
All data from the GLP manager.
Deactivate if the backup is to be loaded onto a different system.

￭ Common variables
All common variables.

￭ Templates
All templates for sample data, result calculations, calibration buffers,
etc.

￭ Routine dialog settings
Current routine dialog settings (see Dialog options / Routine dia-
log).

￭ Sample racks
The sample racks present in the properties of the USB sample pro-
cessor.

￭ Own subsequences
All subsequences created and stored by the user.
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13 GLP manager

Main dialog: System ▶ GLP manager

In the GLP manager you can document data for various GLP tests. The
results of the automatic system tests carried out after switching on are
also documented.

The following tests can be documented:

￭ GLP test "Measurement" (see chapter 13.3, page 136)
￭ GLP test "Titration" (see chapter 13.3, page 136)
￭ System validation (see chapter 13.4, page 140)

In addition, you can also:

￭ Create a list with your test tools (see chapter 13.2, page 135).
￭ Define a service interval for having routine maintenance carried out by

a Metrohm service technician (see chapter 13.5, page 144).
￭ Define an interval for the regular performance of backups (see chapter

13.5, page 144).

Further information about quality management and validation is also given
in the documentation series Quality Management with Metrohm and
Application Bulletin AB 252 (Validation of Metrohm titrators (potentio-
metric) in accordance with GLP/ISO 9001).

The table shows the last time that each test was carried out and when the
next test is to be carried out. A test is entered in the list the first time that
it is documented.

[Test tools]

Configuring the test tools for GLP tests (see chapter 13.2, page 135).
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[GLP tests HW/SW]

Document the GLP tests "Measurement" and "Titration" (see chapter
13.3, page 136).

[System validation]

Document the system validation (see chapter 13.4, page 140).

[Monitoring]

Defining the time intervals for system maintenance and backups (see
chapter 13.5, page 144).

[View test data]

Display the data of the selected test.

13.1 Automatic system test

The system test is carried out automatically when the Touch Control is
switched on. The result of each individual test is shown in green if no error
has occurred. If a result is shown in red, then an error occurred when the
respective test was carried out. Switch the Touch Control off and back on
again. If the error still occurs pleased notify Metrohm Service.

Print report at system start

on | off (Default value: off)

If this parameter is activated, then the result of the system test will be
printed out automatically when the Touch Control is switched on.

13.2 Test tools

Main dialog: System ▶ GLP manager ▶ Test tools

You can create a list of test tools to be used in the tests in the GLP man-
ager.

The following test tools have already been defined:

￭ 767 Calibrated Reference: Device for checking measuring inputs
and electrode cable.

￭ 822 Titr.Curve Simulator: Curve simulator for checking the hard-
ware and software.

￭ 773 pH/mV Simulator: Device for checking measuring inputs and
electrode cable.

￭ 868 UR Generator: Device for checking measuring inputs and elec-
trode cable.

[New]

Add a new test tool to the list.
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[Delete]

Delete the selected test tool from the list.

[Edit]

Change the designation of the selected test tool.

13.3 GLP tests for measurement and titration

Main dialog: System ▶ GLP manager ▶ GLP tests HW/SW ▶ GLP
test "Measurement" / GLP test "Titration"

You can document the GLP tests for measurements and titrations in the
dialog GLP manager / GLP tests Hardware/Software and its subdia-
logs. The following procedure describes the GLP test "Measurement," but
also applies for the GLP test "Titration".

Proceed as follows:

 

1 Open the properties dialog

￭ In the System / GLP manager dialog, tap on the [GLP tests
HW/SW] button and then on the [GLP test "Measurement"]
button.

 

2 Edit data

￭ Define the test method, the test results, etc. (see "Dialogs "GLP
tests HW/SW / GLP test "Measurement"" and "GLP tests HW/SW /
GLP test "Titration""", page 137).

 

3 Define the hardware used

￭ Tap on [Hardware].
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￭ Select the hardware used for the test (see "Dialogs "GLP test
"Measurement" / Hardware" and "GLP test "Titration" / Hard-
ware"", page 139).

￭ Tap on the fixed key [ ].

The dialog GLP tests HW/SW / GLP test "Measurement"
appears again.

 

4 Define the test interval

￭ Tap on [GLP test interval].
￭ Enter the time interval or the date for the next GLP test (see "Dia-

logs "GLP test "Measurement" / Test interval" and "GLP test
"Titration" / Test interval"", page 138).

￭ Tap on the fixed key [ ].

13.3.1 Parameter description

Dialogs "GLP tests HW/SW / GLP test "Measurement"" and
"GLP tests HW/SW / GLP test "Titration""

Method

Method the GLP test has been carried out with.

Entry 32 characters maximum
Selection Selection of methods stored in the internal

memory

User

User who carried out the GLP test.

Entry 24 characters maximum
Selection Selection of configured users

Test date

Date on which the GLP was carried out.

Format: YYYY:MM:DD

Test result

Result of the test.

Selection Test OK | Test not OK
Default value Test OK

Comment

Entry 24 characters maximum
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[GLP test interval]

Defining the time interval for the GLP test (see "Dialogs "GLP test
"Measurement" / Test interval" and "GLP test "Titration" / Test interval"",
page 138).

[Hardware]

Documenting the hardware with which the GLP test was carried out (see
"Dialogs "GLP test "Measurement" / Hardware" and "GLP test "Titra-
tion" / Hardware"", page 139).

Dialogs "GLP test "Measurement" / Test interval" and "GLP
test "Titration" / Test interval"

Test date

Date on which the GLP was carried out.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a GLP test
has to be carried out again will be monitored.

GLP test interval

If you define a time interval for the GLP test, then the date in Next GLP
test will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next GLP test

If you define a date for the next GLP test, then the GLP test interval will
be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.
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Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

Dialogs "GLP test "Measurement" / Hardware" and "GLP test
"Titration" / Hardware"

Test tool

Selection of the test tool. Test tools are defined at GLP manager ▶ Test
tools.

Selection Selection of configured test tools

Control device

Selection of the control device with which the GLP test has been carried
out.

Selection Selection of configured control devices

Measuring input

Selection of the measuring input used for the GLP test. The selection is not
dependent on whether the control device has one or two measuring inter-
faces.

Selection 1 | 2
Default value 1

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1
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13.4 System validation

Main dialog: System ▶ GLP manager ▶ System validation

In the dialog GLP manager / System validation and its subdialogs, you
can document the system validation results and define the time interval
after which validation must be carried out again.

Proceed as follows:

 

1 Open the properties dialog

￭ In the System / GLP manager dialog, tap on the [System vali-
dation] button.

 

2 Edit data

￭ Define the method, the result, etc. (see ""GLP manager / System
validation" dialog", page 141).

 

3 Define the validation interval

￭ Tap on [Validation interval].
￭ Enter the time interval or the date for the next system validation

(see "Dialog "System validation / Validation interval"", page 142).
￭ Tap on the fixed key [ ].

The dialog GLP manager / System validation appears again.

 

4 Enter statistical data

￭ Tap on [Test statistics].
￭ Enter the statistical data for the last system validation (see ""Sys-

tem validation / Test statistics" dialog", page 143).
￭ Tap on the fixed key [ ].
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The dialog GLP manager / System validation appears again.

 

5 Insert a note

￭ Tap on [Note (SOP)].
￭ Enter a brief description, e.g. a summary of the SOP (standard

operating procedure) according to which the system validation
was carried out (see ""System validation / Note (SOP)" dialog",
page 142).

￭ Tap on the fixed key [ ].

13.4.1 Parameter description

"GLP manager / System validation" dialog

Method

Method with which the system validation has been carried out.

Entry 32 characters maximum
Selection Selection of methods stored in the internal

memory

User

User who carried out the system validation.

Entry 24 characters maximum
Selection Selection of configured users

Test date

Date on which the system validation was carried out.

Format: YYYY:MM:DD

Test result

Result of the test.

Selection Test OK | Test not OK
Default value Test OK

Comment

Entry 24 characters maximum

[Note (SOP)]

Enter a brief description, e.g. a summary of the SOP (standard operating
procedure) according to which the system validation has been carried out.

[Validation interval]

Defining the time interval for the system validation (see "Dialog "System
validation / Validation interval"", page 142).
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[Test statistics]

Documenting the statistical data of the system validation (see ""System
validation / Test statistics" dialog", page 143).

"System validation / Note (SOP)" dialog

In this dialog, you can enter a brief text, e.g. a summary of the SOP
(standard operating procedure) according to which the system validation
was carried out.

Dialog "System validation / Validation interval"

Last validation

Date on which the last system validation was carried out.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a system
validation has to be carried out again will be monitored.

Validation interval

If you define a time interval for the system validation, then the date in
Next validation will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next validation

If you define a time interval for the next system validation, then the Vali-
dation interval will be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.
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Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

"System validation / Test statistics" dialog

In the dialog System validation / Test statistics, you can document the
statistical data for the last system validation.

Number (n)

Number of determinations carried out.

Input range 1 to 9999999999 
Default value empty 

Mean value

Mean value out of single results.

Input range –999999999.00000 to 999999999.00000 
Default value empty 

s abs

Absolute standard deviation of the results.

Input range 0.00000 to 999999999.00000 
Default value empty 

s rel

Relative standard deviation of the results.

Input range 0.00000 to 100.00000 %
Default value empty %

d rel

Systematic deviation of the results.

Input range 0.00000 to 100.00000 %
Default value empty %

a sys

Systematic error.

Input range 0.00000 to 9999999999.00000 
Default value empty 
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13.5 System monitoring

13.5.1 Service interval
Main dialog: System ▶ GLP manager ▶ Monitoring ▶ Service inter-
val

In the dialog GLP manager / Service interval, you can define the time
interval for the maintenance of the system by the Metrohm Service
department. The service interval is checked each time the system is
started.

Last service

Date on which the last servicing was carried out.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which system
maintenance must be carried out again will be monitored.

Service interval

If you define a time interval for the system maintenance, then the date in
Next service will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next service

If you specify a date for the next system maintenance, then the Service
interval will be tracked automatically.

Format: YYYY:MM:DD

13.5.2 Backup interval
Main dialog: System ▶ GLP manager ▶ Monitoring ▶ Backup inter-
val

In the dialog GLP manager / Backup interval, you can define the time
interval for backups. The backup interval is checked each time the system
is started.

Last backup

Date on which the last backup was created.

Format: YYYY:MM:DD
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Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a backup
has to be created again will be monitored.

Backup interval

If you define a time interval for the creation of backups, then the date in
Next backup will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next backup

If you specify a date for the next backup, then the Backup interval will
be tracked automatically.

Format: YYYY:MM:DD
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14 Common variables

Main dialog: System ▶ Common variables

You can save 25 method-independent variables, or common variables.
These variables can be used in future calculations (as variables CV01…
CV25). Common variables are useful, e.g. for the following applications:

￭ Determination of a blank value which will be taken into account during
the content determination of the sample.

￭ Determination of the content of a standard solution, which will be
taken into account during the content determination of the sample.

The designation and the value (including the unit) are displayed for every
common variable in the list.

[Delete]

Delete the selected common variable from the list.

[Edit]

Edit the data of the selected common variable, see following chapter.
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14.1 Editing common variables

List of common variables: Common Variable ▶ Edit

The common variables can be modified as follows:

￭ Edit manually, see the following.
￭ Automatic assignment from the determination run. A calculation result

must be configured accordingly for this purpose (see chapter 14.4,
page 150).

Name

Designation of the common variable.

Entry 24 characters maximum
Default value empty

Value

Value of the common variable.

Input range –999999999 to 9999999999 
Default value empty 

Unit of the common variable.

Entry 10 characters maximum
Default value empty
Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |

 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %
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Next assignment

This parameter is displayed only if a validity has been defined for the com-
mon variable.

Date on which the validity of the common variable expires.

Format: YYYY:MM:DD

[Validity]

Defining the time interval for the validity of the common variable (see
chapter 14.3, page 149).

[Properties]

Display the properties of the common variable, see following chapter.

14.2 Properties of common variables

Common variable: Edit ▶ Properties

Detailed information concerning the common variable is displayed in the
Edit common variables / Properties dialog:

￭ Status
Status of the common variable. If the time interval for the validity has
expired, then invalid will be displayed.

￭ Method
Method with which the value has been assigned to the common varia-
ble. If the value was entered manually, then manual will be displayed.

￭ Method status (only for automatic assignment from the determina-
tion run)

￭ Determination status (only for automatic assignment from the
determination run)

￭ Last assignment
Date and time of the last assignment.

￭ User
User who assigned the value to the common variable.
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14.3 Monitoring validity

Common variable: Edit ▶ Validity

In the dialog Edit common variables / Validity, you can define the
time interval after which a new value must be assigned to the common
variable.

Last assignment

Date on which the common variable was last assigned a value.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which the com-
mon variable must be assigned a new value will be monitored.

Validity

If you define a time interval for the validity of the common variable, then
the date in Next assignment will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next assignment

If you specify a date for the next assignment, then the time interval for the
Validity will be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.
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Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

14.4 Assigning a result automatically to a common varia-
ble

NOTE

This instruction is based on the assumption that the method contains a
calculation command with a calculation.

Proceed as follows to assign a result to a common variable:

 

1 Opening the editing dialog of the result

￭ In the command list, select the command CALC.
￭ Tap on the [Edit command] button.
￭ Select the result whose value is to be assigned to a common vari-

able and tap on [Edit].

The editing dialog of the result is displayed.

 

2 Define result options

￭ Tap on the [Result options] button.

￭ Activate the parameter Save as common variable.
￭ Define Variable = CV01…CV25.
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3 Saving the settings

Tap on the fixed keys [ ] or [ ].

In the future, the calculated result will be assigned to the selected
common variable (result name, value and unit).
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15 Templates

Main dialog: System ▶ Templates

You have the option of defining system-specific templates. You can
use these templates when editing the respective data.

You can create the following templates:

￭ Sample data (see chapter 15.1, page 152)
Create sample identifications and sample assignments.

￭ Custom result templates (see chapter 15.2, page 156)
Define formulas for result calculations.

￭ Input lines (see chapter 15.3, page 160)
Define input signals on the remote interface.

￭ Output lines (see chapter 15.4, page 162)
Defining output signals on the remote interface.

￭ Custom calib. buffers (see chapter 15.5, page 165)
Define a buffer series for the calibration of pH electrodes.

￭ Report header (see chapter 15.6, page 167)
Create a system-specific report header that contains information con-
cerning the laboratory, for example.

￭ Custom electrode type (see chapter 15.7, page 168)
Define customized limit values for the electrode test of pH electrodes.

15.1 Sample data

Main dialog: System ▶ Templates ▶ Sample data

You can create the following templates in the dialog Templates / Sam-
ple data:
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￭ Sample identifications (see chapter 15.1.1, page 153)
List with sample identifications. If you must enter the sample identifica-
tion before starting a determination, then you can select the entries
contained in this list.

￭ Sample assignments (see chapter 15.1.2, page 154)
You can assign a particular method to a sample identification.

Use sample identification list

on | off (Default value: off)

Activate this parameter so that the sample identifications defined in the
list will be displayed as selections.

Use sample assignment table

on | off (Default value: off)

Activating/deactivating the use of the sample assignment table.

NOTE

If this parameter is activated, the following will no longer be possible:

￭ Carrying out determinations without their sample identification
being defined in the sample assignment table.

￭ Defining a method in the sample table. Previously defined methods
will be ignored.

Assignment ident.

Identification which is used as assignment identification to load the cor-
rect method.

Selection Identification 1 | Identification 2
Default value Identification 1

Request assignment identification

on | off (Default value: off)

If this parameter is activated, then the sample identification will be reques-
ted automatically at the start of a determination.

15.1.1 Sample identification list
Main dialog: System ▶ Templates ▶ Sample data ▶ Sample identi-
fication list
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You can create a system-specific list with sample identifications in the dia-
log Sample data / Sample identification list. This list makes it easier
for you to enter frequently used sample identifications, i.e. this list is avail-
able to you for entering them (main dialog, command REQUEST, etc.). It
may be a good idea to define the unchanging part of the identification as
a template and to add the variable part during sample data input.

[New]

Add a new sample identification to the list.

[Delete]

Delete the selected sample identification from the list.

[Edit]

Change the designation of the selected sample identification.

15.1.2 Sample assignment table
Main dialog: System ▶ Templates ▶ Sample data ▶ Sample assign-
ment table
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In the sample assignment table, a particular method is assigned to a sam-
ple identification. In this way, you ensure that your samples will be
processed with the correct method; mix-ups are not longer possible.
When you start a determination, you need only enter the sample identifi-
cation; the method is loaded automatically.

[New]

Add a new sample assignment to the list, see following chapter.

[Delete]

Delete the selected sample assignment.

[Edit]

Edit the selected sample assignment, see following chapter.

Editing the sample assignment

Identification

Identification of the sample.

NOTE

You can place an * as a wildcard at the beginning or end of the charac-
ter string. Doing so allows you to prefix or suffix a sequential number,
for example, to the identification, which will be ignored when methods
are being assigned.

Entry 24 characters maximum
Selection Selection of defined identifications in the

sample identification list

Memory

Memory location the method is loaded from. All memory locations are
selectable, even if they are currently not accessible.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
Shared directory in the network.

Method

Method that is loaded when a sample with the above-specified identifica-
tion is processed. You can also enter a method that does not yet exist in
the selected memory. When a determination is started there is a check
whether the method is available.
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Entry 32 characters maximum
Selection Selection of methods stored in the selected

memory

15.2 Custom result templates

Main dialog: System ▶ Templates ▶ Custom result templates

In the dialog Templates / Custom result templates, you can define the
result calculations which can be loaded in the calculation command
CALC. With the exception of the following points, creating a result tem-
plate is identical to editing a calculation in the command CALC (see chap-
ter 29.13.1.2, page 429):

￭ No result variable can be assigned to the template.
￭ The definition of limit values is not possible.

NOTE

Up to nine wildcards can be inserted in the calculation formula, the
Variables F1…F9. Use these variables, e.g. for the molar mass of your
analyte. If you have loaded a result template with these wildcards in the
calculation command, then you will automatically be prompted to enter
the numerical values.

[New]

Add a new result template to the list, see following chapter.

[Delete]

Delete the selected result template from the list.

[Edit]

Edit the data of the selected result template, see following chapter.
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15.2.1 Editing result templates
List of result templates: Result template ▶ New / Edit

Result name

The result name is the text which will be shown in the results display and
in the report.

Entry max. 24 characters
Default value R

Calculation formula

Shows the calculation formula. A special editor is opened for the defini-
tion (see chapter 29.13.3, page 435).

Entry max. 100 characters
Default value empty

Decimal places

Number of decimal places used to display the result.

Input range 0 to 5 
Default value 2 

Result unit

The result unit is displayed and saved together with the result.

Entry max. 10 characters
Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |

 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %

[Note]

Entering a note on the calculation.

[Note for wizard]

Enter a note on the calculation. This note is displayed when loading the
result template.

[Result options]

Defining additional settings for the calculation.

"Edit result template / Result options" dialog

In the dialog Edit result template / Result options, settings for how to
process the calculated result are defined.
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Variable for mean value

If the statistic calculations have been activated (see method options), the
mean value of the single results will be saved as variable SMN1 to SMN9.
As default value, always the first free variable is being displayed.

Selection SMN1 … SMN9 | off

off
For the result not statistic calculations are carried out.

Save as titer

The result can be saved as titer for the selected titrant.

NOTE

The titer is assigned to the titrant defined in the last titration command
before the calculation. Please note that the CALC command containing
the titer assignment is inserted after the titration command with which
the titer is determined.

Selection Single value | Mean value | off
Default value off

Single value
The result of the current determination is saved as titer.

Mean value
If statistic calculations are carried out for the result, the current mean
value of the determination series is saved.

off
The result is not saved as titer.

Save as common variable

on | off (Default value: off)

The calculated result can be saved as a method-independent variable, a
so-called common variable. The result is then also available in other
methods for calculations. In all cases, only the single value will be saved,
even if the statistics function is enabled.

Variable

Selection of the common variable to which the result is being assigned.

Selection CV01 … CV25
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Display result

on | off (Default value: on)

If you deactivate this parameter, the result is neither displayed in the result
dialog nor printed in the result report. This can be advisable for intermedi-
ate results.

Save result in result table

on | off (Default value: off)

The calculated result can be saved in the result table. This may be advisa-
ble if e.g. the results of all determinations carried out on a particular day
are to be displayed clearly. A maximum of nine results from a determina-
tion can be saved in the result table.

Precision

Setting, with which accuracy the result is used in additional calculations.

Selection Round | Truncate | Full precision
Default value Round

Round
The result is rounded to the defined number of decimal places (com-
mercial rounding, in accordance with the US Pharmacopeia USP). If the
digit at the first dropped decimal place is 1, 2, 3 or 4, then it will be
rounded off; if this digit is 5, 6, 7, 8 or 9, then it will be rounded up.
Negative digits will be rounded in accordance with their amount, i.e.
away from zero.

Truncate
The result is cut to the number of decimal places defined.

Full precision
The result is used with full accuracy (floating point number either in
"single precision" (32 bit) or in "double precision" (64 bit), according to
the standard IEEE 754).
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15.3 Input lines

Main dialog: System ▶ Templates ▶ Input lines

In the dialog Templates / Input lines, you can define the input signals at
the remote interface as a template. You can select these templates in the
command SCAN. The list can contain a maximum of 20 templates.

Table 7 List of predefined input signals

Signal name Input signal Function

Cond OK ******1* queries "Cond OK" condition of device.

End1 ****1*** waits for the EOD pulse from Device 1 (Titrino,
Titrando).

End2 *1****** waits for the EOD pulse from Device 2.

EndMeter ***11*** waits for the EOD pulse from 780/781 pH/Ion
meter (stirrer 1 will be switched on during the
waiting period).

Ready* **1****1 queries the "Ready" condition of Devices 1 and 2
(Titrino, Titrando).

The status of devices working in parallel can be
scanned with this signal. In this case the "Ready"
line of both devices must be statically set (i.e. con-
stantly) at the end of a determination. Devices
which only transmit a brief impulse cannot be
controlled in parallel.

Ready1 *******1 queries the "Ready" condition of Device 1.

Ready2 **1***** queries the "Ready" condition of Device 2.
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Signal name Input signal Function

Sample ready ***1**** waits for a stepping pulse, of, for instance, a
connected Sample Processor, as soon as it is
ready.

[New]

Add a new input signal to the list, see following chapter.

[Delete]

Delete the selected input signal from the list.

[Edit]

Edit the data of the selected input signal, see following chapter.

15.3.1 Editing the input signal
List of input signals: Input signal ▶ New / Edit

Signal name

Designation of the template.

Entry 24 characters maximum

Input signal

Entering the desired bit pattern:

Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status

The input lines are always numbered from right to left, i.e. with the signal
*******1 line 0 is expected to be active.

NOTE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).

Entry Bit pattern of exactly 8 characters
Default value ********
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15.4 Output lines

Main dialog: System ▶ Templates ▶ Output lines

In the dialog Templates / Output lines, you can define the output sig-
nals at the remote interface as a template. You can select these templates
in the command CTRL. The list can contain a maximum of 20 templates.

Table 8 List of predefined output signals

Signal name Output signal Function

Continue *********p**** sends a stepping pulse to the connected Sample
Processor.

Init 00000000000000 initializes the remote interface.

Meter Cal C *********1001* switches the 781 pH/Ion meter to concentration
calibration.

Meter Cal pH *********0101* switches the 780/781 pH/Ion meter to pH calibra-
tion and starts the calibration.

Meter enter *********1111* simulates the [Enter] key of the 780/781 pH/Ion
meter; mandatory for pH calibration in order to
start the measurement of the second buffer.

Meter Mode C *********1000* switches the 781 pH/Ion meter to concentration
measurement.

Meter Mode I *********0100* switches the 780/781 pH/Ion meter to voltametric
measurement with polarization current and starts
the measurement.

Meter Mode pH *********0001* switches the 780/781 pH/Ion meter to pH
measurement and starts the measurement.
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Signal name Output signal Function

Meter Mode T *********0010* switches the 780/781 pH/Ion meter to temp-
erature measurement and starts the measure-
ment.

Meter Mode U *********0011* switches the 780/781 pH/Ion meter to voltage
measurement and starts the measurement.

Start device* ********p****p starts Devices 1 and 2 (e.g. Titrino, Titrando, etc.)
*).

The signal is transmitted as a short pulse of 200
ms.

Start device1 *************p starts Device 1 (e.g. Titrino, Titrando, etc.) *).

The signal is transmitted as a short pulse of 200
ms.

Start device2 ********p***** starts Device 2 (e.g. Titrino, Titrando, etc.) *).

The signal is transmitted as a short pulse of 200
ms.

Start Dos* *****p*p****** starts Dosimat at Devices 1 and 2 (Titrino via "acti-
vate").

The signal is transmitted as a short pulse of 200
ms.

Start Dos1 *******p****** starts Dosimat at Device 1 (Titrino via "activate").

The signal is transmitted as a short pulse of 200
ms.

Start Dos2 *****p******** starts Dosimat at Device 2 (Titrino via "activate").

The signal is transmitted as a short pulse of 200
ms.

*) In the case of the 780/781 pH/Ion meter, a result report is triggered.

[New]

Add a new output signal to the list, see following chapter.

[Delete]

Delete the selected output signal from the list.

[Edit]

Edit the data of the selected output signal, see following chapter.
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15.4.1 Editing the output signal
List of input signals: Output signal ▶ New / Edit

Signal name

Designation of the template.

Entry 24 characters maximum

Output signal

Entering the desired bit pattern:

Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set.

NOTE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).

Entry Bit pattern of exactly 14 characters
Default value **************

Pulse length

Duration of the sent pulses.

Input range 100 to 1000 ms
Default value 200 ms
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15.5 Custom calibration buffers

Main dialog: System ▶ Templates ▶ Custom calib. buffers

In the Templates / Custom calibration buffers dialog, you can define
a buffer series of your own for pH calibrations with a maximum of five cal-
ibration buffers. Automatic buffer recognition is active for this buffer.

Buffer 1 pH

pH value of the first calibration buffer.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Input range –20.000 to 20.000 
Selection off
Default value off

Buffer 2...5 pH

See Buffer 1 pH.

[Temp. table]

Display the temperature table for the selected buffer, see following chap-
ter.
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15.5.1 Defining calibration buffers
The Custom calibration buffers / Temperature table dialog lists the
pH values of the buffer in the temperature range 0 - 95 °C.

[Edit pH value]

Enter the pH value for the selected temperature.

"Temperature table / Edit pH value" dialog

In this dialog, the pH values of the buffer are defined at various tempera-
tures. Enter the pH values for the temperature range in which you will
carry out your pH calibration and pH measurement. If you do not know
the pH values at individual temperatures, they will be calculated automat-
ically by means of linear interpolation.

Temperature in °C

Input range 0.0 to 95.0 °C (Increment: 5.0)

pH value

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Input range –20.000 to 20.000 
Selection off
Default value off
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15.6 Report header

Main dialog: System ▶ Templates ▶ Report header

In the dialog Templates / Report header, you can create a system-spe-
cific report header that contains information concerning the laboratory,
for example. The report header can contain a maximum of four lines of 46
characters each and will always be printed out in front of the standard
report header. The standard report header contains the instrument type,
serial number and program version of the software, instrument name and
printing date.

Print logo

on | off (Default value: off)

If this parameter is activated, then the logo defined below will be printed
out in the right margin.

Logo

Selection Metrohm logo | Custom logo
Default value Metrohm logo

Custom logo
Select this setting if your logo is to be printed out in the report header.
How to create a logo is described below.

Applying the custom logo

You can create a graphics file of your own and use it as a logo in the
report header in place of the Metrohm logo.

NOTE

Observe the size of the graphics object. The maximum size of your
graphics file is 64 kB. We recommend a maximum of 500 × 200 pixels.

Proceed as follows to create your own logo:

 

1 Creating the logo

￭ Create a graphics file with the desired logo in an image process-
ing program.

￭ Save the graph as a JPG file under the file name
"CustomImage.jpg".



15.7 Custom electrode type ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

168 ￭￭￭￭￭￭￭￭ 900 Touch Control

 

2 Copying the file to an external storage medium

￭ Copy the file "CustomImage.jpg" to the directory "900".
If this structure is not maintained, the file will not be found
because the software directly accesses the "900" directory.

￭ Plug in the external storage medium at the Touch Control.

 

3 Loading the graphics file

￭ In the Templates / Report header dialog, tap on the [Load]
button.
The file is copied to the internal memory.

￭ Switch the instrument off and back on again.

 

4 Applying the custom logo

￭ In the Templates / Report header dialog, activate the Print
logo option.

￭ Define Logo = Custom logo.

Your logo will now be printed in the report header of all reports in
the future.

15.7 Custom electrode type

Main dialog: System ▶ Templates ▶ Custom electrode type

For the electrode test of pH electrodes, you can define your own values
instead of using the limit values that are saved. This can be helpful for spe-
cial applications, e.g. when other quality requirements are demanded of
the pH electrode or when working with a reference electrode that pushes
the offset potential Uoff beyond the required –15 to +15 mV (standard
electrode).

Limit values can be defined for the following electrode ratings:

￭ Excellent electrode
￭ Good electrode
￭ Usable electrode

Lower limit Uoff

Lower limit value for the offset voltage, i.e. the voltage at pH = 7.0. The
value applies for all ratings.

Input range –999 to 999 mV
Default value –15 mV
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Upper limit Uoff

Upper limit value for the offset voltage, i.e. the voltage at pH = 7.0. The
value applies for all ratings.

Input range –999 to 999 mV
Default value 15 mV

15.7.1 Limit values for the electrode rating
You can define limit values for the three electrode ratings Excellent elec-
trode, Good electrode and Usable electrode. These values represent
maximum values that may not be exceeded (exception: Min. slope =
minimum value).

Streaming potential

The streaming potential is the difference between the measured voltages
in stirred and unstirred solution.

for very good electrodes:
Input range –999.9 to 999.9 mV
Default value 2.5 mV

for good electrodes:
Input range –999.9 to 999.9 mV
Default value 3.0 mV

for usable electrodes:
Input range –999.9 to 999.9 mV
Default value 4.0 mV

Drift

The drift in stirred solution is determined for each buffer. The sum of these
values is compared with this value here.

for very good electrodes:
Input range 0.1 to 9.9 mV/min
Default value 2.0 mV/min

for good electrodes:
Input range 0.1 to 9.9 mV/min
Default value 2.5 mV/min

for usable electrodes:
Input range 0.1 to 9.9 mV/min
Default value 3.0 mV/min
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Min. slope

Minimum slope of the pH electrode.

for very good electrodes:
Input range 0.1 to 999.9 %
Default value 96.5 %

for good electrodes:
Input range 0.1 to 999.9 %
Default value 96.0 %

for usable electrodes:
Input range 0.1 to 999.9 %
Default value 95.0 %

Max. slope

Maximum slope of the pH electrode.

for very good electrodes:
Input range 0.1 to 999.9 %
Default value 101.0 %

for good electrodes:
Input range 0.1 to 999.9 %
Default value 102.0 %

for usable electrodes:
Input range 0.1 to 999.9 %
Default value 103.0 %

Response time

The voltage measured after three minutes in stirred solution serves as a
comparison value for determining the response time. The response time is
the time after which the measured voltage is within ±1 mV of this com-
parison value.

for very good electrodes:
Input range 0 to 999 s
Default value 45 s

for good electrodes:
Input range 0 to 999 s
Default value 50 s
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for usable electrodes:
Input range 0 to 999 s
Default value 60 s
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16 Methods

16.1 Creating a new method

Proceed as follows to create a new method:

 

1 Opening the method table

￭ In the main dialog, tap on [Load method].
￭ Tap on [New method].

The method table with the stored templates opens:

 

2 Loading the method

￭ Tap on [Empty method].

or

￭ Select the desired template and tap on [Load template].

The method is now loaded. New method is displayed in the main
dialog in the title line.

If a new method has been created, then the individual parameters can be
modified with [Edit parameters].
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16.2 Saving a method

If you modify method parameters, then you can save these as your own
method.

To save a method, proceed as follows:

 

1 Open the command sequence

￭ In the main dialog, tap on [Edit parameters].

The command sequence of the method is displayed:

 

2 Modifying/applying the method name

￭ Tap on [Save method].
A method name will be suggested for new methods. If the
method has already been saved once, then the method name will
be displayed.

Applying the name:
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￭ Tap on [Save].

The method will be saved and the command sequence is displayed.

Entering a new name:

￭ Tap on the input field File name.
The text editor opens.

￭ Enter a new file name (max. 32 characters) and confirm with
[OK].

￭ Tap on [Save].

The method will be saved and the command sequence is displayed.

16.3 Loading a method

Proceed as follows to load a method:

 

1 Opening the method table

￭ In the main dialog, tap on [Load method].
The selection of memory locations is displayed. This selection will
be skipped if only the internal memory is accessible.

￭ Select the memory location where the desired method is saved.
The selection of file groups is displayed (see chapter 12.1, page
126). If only one group is available, then the method table will be
displayed directly.

￭ Select the group with the desired method.
￭ Tap on [Show files].

The method table with the stored methods opens:

 

2 Selecting the method

￭ Select the desired method.
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3 Loading the method

￭ Tap on [Load].

The method is now loaded. The method name is displayed in the
main dialog in the title line.

NOTE

The data of the current determination will be deleted when you load a
method.

16.4 Editing a method

Main dialog: Edit parameters

In the dialog Parameters / Sequence, you can define and edit the
method commands which are executed successively during a determina-
tion.

The following data is displayed in the command list for each command:

￭ Line number
￭ Name
￭ Comment

You can adjust the comment in accordance with your requirements.

[Save method]

Save the current method (see chapter 16.2, page 173).

[Method options]

Define various settings which refer to the entire method, e.g. statistics,
automatic saving of determinations, settings for sample data, etc. (see
chapter 16.5, page 177).
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[Insert command]

Insert a new method command. It is inserted before the selected com-
mand.

NOTE

Not all commands are available for subsequences. Commands which
cannot be inserted into subsequences are disabled.

[Delete command]

Delete the selected method command.

[Edit command]

Edit the selected method command.

16.4.1 Inserting a command
A method is comprised of individual commands. When you start a deter-
mination, the commands are executed one after the other.

The following constraints apply:

￭ Maximum of 99 commands
￭ Maximum of nine commands for titrations, measurements and calibra-

tions

Inserting a command

To insert a command in a method, proceed as follows:

 

1 Open the command overview

￭ In the main dialog, tap on [Edit parameters].
￭ Tap on the [Insert command] button.
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This dialog contains all of the commands which can be inserted into
a method run, organized into thematic groups.

 

2 Select a command group

￭ Tap on the desired command group.

In the case of [Report], the command is inserted directly into the
command list. For all other command groups, the available com-
mands will be displayed (titration / measuring commands, etc.).

 

3 Inserting a command

Tap on the desired command.

The dialog is closed and the command is displayed in the command
list.

16.5 Method options

Main dialog: Edit parameters ▶ Method options

Method options are settings which apply to the method as a whole and
not to an individual command.

The following settings are available:

￭ Activate/deactivate statistics calculations
￭ Save determination automatically
￭ Sign a method electronically
￭ Check the method when the determination starts
￭ Define a fixed sample size
￭ etc.
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Statistics

on | off (Default value: off)

If this parameter is activated, then statistics calculations will be carried out
for all of the defined results. The prerequisite here, however, is that a vari-
able for the mean value is defined in the result options (see "Dialog "Edit
calculation / Result options"", page 431).

Number of determinations

The number of determinations that are carried out for the statistics calcu-
lations.

If an additional determination has to be added to the determination
series, because one determination has been incorrect, for example, then
this can be accomplished in the statistical overview (see chapter 25, page
236).

Input range 2 to 20 
Default value 3 

[Save automat.]

Define the settings for automatically saving the determination (see chap-
ter 16.5.6, page 187).

[Properties]

Display the properties of the current method and sign electronically (see
chapter 16.5.4, page 185).

[Note]

Enter a note on the method (see chapter 16.5.5, page 187).

[Start/Stop options]

Edit functions which are carried out immediately after the method is
started or stopped, see chapter Start options, page178 and chapter Stop
options, page 180.

[Sample data]

Specify method-specific settings for the sample data, e.g. designation of
the sample identifications, limits for the sample size (see chapter 16.5.3,
page 181).

16.5.1 Start options
Main dialog: Edit parameters ▶ Method options ▶ Start/Stop
options ▶ Start options

In the dialog Method options / Start options, you can configure the
functions which are carried out when a determination is started.
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Method check at start

on | off (Default value: on)

If this option is activated, then the following tests are carried out at the
method start.

￭ Are the required control and peripheral devices connected?
￭ Are the titrant and the sensor on hand?
￭ Have the monitoring intervals expired?
￭ etc.

NOTE

We recommend that the method check only be deactivated if the titra-
tion must begin immediately after the start of the determination (e.g.
with very rapid reactions such as enzyme-catalyzed reactions). If the
method check is deactivated, it could happen that the determination
run will be interrupted, e.g. because devices, titrants or sensors are not
on hand.

The following settings can be implemented for a connected Sample Pro-
cessor:

Rack reset

on | off (Default value: off)

If this option is activated, then the sample rack is initialized at the time of
the method start. The following actions are carried out:

￭ The lift is moved upwards.
￭ The sample rack is rotated to the starting position.
￭ The rack code of the rack attached is being read out and the corre-

sponding rack data is transferred to the Sample Processor.
￭ The sample variable is reset to the value 1.

Check rack

Definition of the sample rack which must be attached at the time of the
method start. This ensures that the method will be carried out only with
this sample rack.

NOTE

The sample rack can, however, only be checked if the Rack reset
option is activated.

For methods for the 885 Compact Oven SC, this parameter must be set
to no as it has a fixed rack.
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Selection no | Selection of the configured sample racks
Default value no

Increase sample variable automatically

on | off (Default value: on)

The sample variable describes the current position of the sample on the
rack of the Sample Processor. If this option is activated, then the sample
variable is automatically increased by 1 at the end of each determination.

This option must be deactivated if the sample variable is to be altered spe-
cifically with a SAMPLE command.

Request rack position at start

on | off (Default value: off)

If this option is activated, then the rack position of the first sample to be
processed is requested.

16.5.2 Stop options
Main dialog: Edit parameters ▶ Method options ▶ Start/Stop
options ▶ Stop options

In the dialog Method options / Stop options, you can define the
actions which are carried out when a method is canceled.

The method can be canceled as follows:

￭ Manual stop with the fixed key [ ]
￭ Stop because of an error
￭ Stop by remote signal via the Control Remote Box

Switch off pumps

on | off (Default value: on)

If this option is activated, then all of the connected pumps will be
switched off.

Switch off stirrers

on | off (Default value: on)

If this option is activated, then all of the connected stirrers will be
switched off.
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NOTE

Do not fail to deactivate this option for the currently loaded method if
you are conditioning a titration cell at the same time in manual control.
Otherwise, the stirrer of the titration cell will also be switched off if the
currently loaded method is canceled. This would result in an overtitra-
tion of the working medium.

Set remote lines

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.

NOTE

A line set active is not being reset automatically, not even at the end of
the determination.

Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set. With a pulse, the length is set to 200 ms.
If you wish to set pulses with other lengths, you have to define a corre-
sponding template.

Entry Bit pattern containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value **************
Selection Selection of the templates defined

16.5.3 Sample data
Main dialog: Edit parameters ▶ Method options ▶ Sample data

You can define the following method-specific settings in the dialog
Method options / Sample data:

￭ Modify the designation for the sample identifications
￭ Define a fixed sample size
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￭ Define limits for the sample size
If you define limits, these will be monitored at the start and at the end
of the determination.

Below you will find an example demonstrating the effects on the main
dialog of the settings in this dialog (see "Modifying sample data", page
183).

Identification 1, Identification 2

on | off (Default value: on)

If this option is activated, then the input field for the sample identification
in the main dialog will be displayed.

Designation

A designation of your own choosing can be defined for the input field for
each method.

Entry 16 characters maximum

Fixed sample size

on | off (Default value: off)

Activate this parameter if the same sample amount is always to be used
for all determinations. If this is case, then you can define the sample size
here. It will be displayed in the main dialog, but it can no longer be
changed there.

Sample size

This parameter can only be edited when Fixed sample size is activated.

Input range –999999999 to 9999999999 
Default value 1.0 

Unit of sample size.

Selection g | mg | µg | mL | µL | pieces
Default value g
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NOTE

You can also use the parameter Fixed sample size if you would like to
establish a default for the sample size.

Example: For a particular determination, you require 10 mL of sample.
Now and again, however, you have too little sample available and you
must perform the determination with 5 mL, for instance. In this case,
proceed as follows:

1. Activate the parameter Fixed sample size.
2. Define the value and unit for the sample size, in the above exam-

ple, for instance, [10 mL].
3. Deactivate the parameter Fixed sample size again.
4. Save method.

⇨ Each time you load this method, 10 mL is entered as the sample size,
but in the example mentioned you can enter the lesser quantity of 5
mL.

[Sample size limits]

This button is accessible only ifFixed sample size is deactivated.

Define the limit values for the sample size (see "Defining limit values for
the sample size", page 184).

Modifying sample data

This instruction is for the purpose of clarifying the settings which are pos-
sible in this dialog. The following settings should be made:

￭ Change the designation for the input field of the first sample identifica-
tion.

￭ Hide the input field for the second sample identification.
￭ Define a fixed sample size.

Proceed as follows:

 

1 Change the designation for the input field

￭ Tap on the input field Identification 1.
The text editor opens.

￭ Change the designation in Batch and confirm with [OK].
￭ Deactivate the parameter Identification 2.

 

2 Define a fixed sample size

￭ Activate the parameter Fixed sample size.
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￭ Enter the value 10 mL as Sample size.

 

3 Displaying the main dialog

Tap on the fixed key [ ].

The data is saved and the adjusted main dialog appears.

Only Identification 1 is shown with the title "Batch." The fixed sample
size "10 mL" is shown, but cannot be edited.

Defining limit values for the sample size

In the dialog Sample data / Sample size limits, you can define the limit
values for the sample size. These values are not monitored during sample
data input, but rather:

￭ when the determination is started.
￭ when the determination is finished.
￭ upon automatic sample data query via the command REQUEST.
￭ when the determination is being recalculated.

An entry is made in the message list automatically when these limits are
infringed (see chapter 24.2, page 223).

Monitoring sample size limits

on | off (Default value: off)

If this parameter is activated, then the sample size will be monitored.

Lower limit

Input range –999999999 to 9999999999 
Default value 0 



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 16 Methods

900 Touch Control ￭￭￭￭￭￭￭￭ 185

Upper limit

Input range –999999999 to 9999999999 
Default value 9999999999 

Display message

on | off (Default value: off)

If this parameter is activated, a message is displayed in case the limits are
infringed. You can select whether you want to continue with the determi-
nation or cancel the run.

If this parameter is deactivated, then the message will be entered only in
the message list of the determination.

Timeout

The message is displayed during this time. Afterwards, the determination
is continued automatically.

Input range 0 to 999999 s
Default value 30 s
Selection off

off
The determination will not be continued until after the message has
been confirmed.

16.5.4 Method properties
Main dialog: Edit parameters ▶ Method options ▶ Properties

Detailed information concerning the method is displayed in the Method
options / Properties dialog and the methods can be signed electroni-
cally here:

￭ Method status
Current status of the method.

– new
The method has been newly created and not yet saved.

– saved
The current method has been saved.

– modified
The current method has been modified.

– reviewed
The current method has been signed at level 1.

– released
The current method has been signed at level 2.

￭ Created by
User who created the method.
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￭ Created on
Date and time at which the method was created.

￭ Last saved by
User who saved the method most recently.

￭ Last saved on
Date and time at which the method was most recently saved. The ver-
sion of the method is displayed as well. The version number will be
increased by one each time the file is saved.

The following data is displayed only if the option Saving modified
method under Login options / Modification options is activated:

￭ Modified by
User who modified and saved the method most recently.

￭ Modified on
Date and time at which the method was most recently modified and
saved.

￭ Reason
Reason for the modification of the method.

￭ Comment
Comment for the modification of the method.

The following information is only shown if the method has been signed at
level 1:

￭ Reviewed by
User who signed the method at level 1.

￭ Reviewed on
Date and time at which the method has been signed at level 1.

￭ Reason
Reason for the signing of the method.

￭ Comment
Comment for the signing of the method.

The following information is only shown if the method has been signed at
level 2:

￭ Released by
User who signed the method at level 2.

￭ Released on
Date and time at which the method has been signed at level 2.

￭ Reason
Reason for the signing of the method.

￭ Comment
Comment for the signing of the method.

[Delete signature]

Delete all of the signatures for the method or the determination. This but-
ton is inactive if level 2 has not yet been signed (see chapter 17.2, page
190).
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[Sign]

Sign the method or determination. This button is active only when work-
ing with activated login function and password (see chapter 17.1, page
189).

16.5.5 Note
Main dialog: Edit parameters ▶ Method options ▶ Note

In this dialog, you can enter a short text, e.g. important information about
carrying out the determination.

[Display options]

Definition when the note is being displayed.

Automatically after loading the method

on | off (Default value: off)

If this parameter is activated, the note is displayed when loading the
method. It can otherwise only be read in this dialog.

16.5.6 Saving a determination automatically
Main dialog: Edit parameters ▶ Method options ▶ Save automat.

In the dialog Method options / Save automatically, you can specify
whether the determination is to be saved automatically and/or whether a
PC/LIMS report is to be created.

Save determination automatically

on | off (Default value: off)

If this parameter is activated, then the determination will be saved auto-
matically.

Memory

Memory location where the determination will be saved.

Selection External memory 1 | External memory 2 |
 Shared memory

Default value External memory 1

Shared memory
The determination will be saved in a shared directory on the network.
The shared directory is selected in the Edit device / Shared memory
dialog (see chapter 11.3.3, page 87).

Group

Directory where the determination will be saved.

Entry 32 characters maximum
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Selection Selection of available directories | empty
Default value empty

File name

File name of the determination. The file name is always extended to
include the date and the time of day (YYYYMMDD-hhmmss) in order to
ensure that the file names are unique for all determinations.

Entry max. 16 characters
Selection Identification 1 | Identification 2 | Method
Default value Identification 1

Identification 1
The first 16 characters of the text which was entered in the main dia-
log for Identification 1 + YYYYMMDD-hhmmss.

Identification 2
The first 16 characters of the text which was entered in the main dia-
log for Identification 2 + YYYYMMDD-hhmmss.

Method
The first 16 characters of the text, of the method name +
YYYYMMDD-hhmmss.

Write protection

on | off (Default value: on)

If this parameter is activated, then the file cannot be saved, deleted, or
renamed. This is only an internal write protection feature and is independ-
ent of the write protection of the operating system on your computer.
This write protection feature protects the saved determination data
against accidental modifications or modifications by unauthorized per-
sons.

Create PC/LIMS report

on | off (Default value: off)

If this parameter is activated, then a machine-readable report with all of
the important data for the determination is created, a so-called PC/LIMS
report.

The settings are implemented in the device manager (see chapter 11.3.2,
page 85).

When you save the PC/LIMS report as a file, the file name will be gener-
ated automatically as follows: PC_LIMS_Report-first 16 characters of the
value of the parameter File name-Date-Time.txt. If the value of the
parameter File name contains one or more of the following characters,
then these will be automatically converted in the file name into the char-
acter "_": / \ : * ? " < > |.
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17 Electronic signatures

17.1 Signing methods/determinations electronically

Methods: Main dialog ▶ Edit parameters ▶ Method
options ▶ Properties ▶ Sign

Determinations: Results dialog ▶ More data ▶ Properties ▶ Sign

You can sign methods or determinations in the dialog Electronic signa-
ture. The following information is saved along with each electronic signa-
ture:

￭ User (complete name)
￭ Date and time
￭ Reason
￭ Comment

Methods can only be signed if they have the status saved. The status of a
method can be found in the dialog Method options / Properties.

Signature

Selection of the level at which the determination should be signed.

Selection Review (signature level 1) | Release (signature
level 2)
A maximum of three signatures from up to three
different users can given at each level. However, it is
not possible for a user to sign at both level 1 and
level 2.

Review (signature level 1)
If the method has never been signed before, then only level 1 can be
selected.

Release (signature level 2)
If the method has been signed three times at level 1 or already once at
level 2 then only level 2 can be selected.

User

Identification of the user who signs.

Password

Password of the user.
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Reason

Selection of the reasons for the signature. The list with reasons is compiled
in the user administration (see chapter 7.3.6, page 40).

Selection Selection of configured reasons

Comment

Entry 24 characters maximum

[Change password]

Change the current password.

[Sign]

Sign the method or determination with the data entered above.

17.2 Deleting electronic signatures

If a released method must be revised, e.g. in order to adapt to altered
conditions, then the signatures must be deleted. The method can other-
wise not be modified. In the case of released determinations, the signa-
tures can also be deleted. Signatures, however, cannot be deleted until
after the method/determination has been signed at Level 2.

Signatures are deleted automatically in the following cases:

￭ A method signed at Level 1 is being altered.
￭ A determination signed at Level 1 is being recalculated.

User

Identification of the user who deletes the signatures.

Password

Password of the user.

Reason

Selection of the reasons for the deletion of the signature. The list with rea-
sons is compiled in the user administration (see chapter 7.3.6, page 40).

Selection Selection of configured reasons

Comment

Entry 24 characters maximum

[Delete signature]

Delete all the signatures for the method or the determination. The method
is assigned the status saved.
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18 Control

Main dialog: Control

In the dialog Control, the settings for the execution of a single determi-
nation or of one sample series are defined.

If you work with the login function activated, you can log off the system
in this dialog. The login dialog will then be shown immediately.

Statistics

on | off (Default value: off)

With this option, you can enable or disable the statistics calculations for
individual determinations (see "Statistics", page 193).

NOTE

The parameter Statistics in the method options will not be changed as
a result. This setting here will be adjusted automatically to match the
one in the method options.

Sample table

on | off (Default value: off)

If this option is activated, the sample data for a sample series can be
entered in a table (see chapter 21, page 202).
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Autostart

on | off (Default value: off)

If this option is activated, a new determination is started automatically at
the end of a determination. This continues until the number specified has
been reached (siehe Number of autostarts).

NOTE

If you deactivate this option while a determination is running, then that
determination will be ended, although the next one will however also
not be started. This can be used to cancel a sample series.

Number of autostarts

Number of automatic starts.

Input range 1 to 9999 
Selection Table
Default value Table

Table
The number of automatic starts corresponds to the number of samples
in the sample table.

Sample number

The sample number is primarily used for documentation. Each time a
determination is started, it is increased by one. The sample number can,
however, also be entered manually. Each time the Touch Control is
switched on, the value is reset to zero.

Input range 0 to 9999 
Default value 0 

[Logout]

User logout (visible only when work is done with activated login function).

[Favorites]

Save methods/sample tables as a favorite (see chapter 19, page 195).
Depending on whether you are working with or without login function,
user-specific or common favorites can be created. On the main dialog, a
button is created for each favorite. This way, a method or a sample table
can be started with one single mouse click.

[Delete table]

Delete the sample table completely.

[Reset autostart]

Reset the value of the autostart counter to zero.
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[Delete statistics] 

Delete all statistics data.

The statistics data should be deleted manually if a sample series has been
canceled and a new sample series is to be started.

The statistics data is deleted automatically in following cases:

￭ when all of the determinations of the determination series have been
carried out and a new determination has been started afterwards.

￭ when a new method is loaded.
￭ when a determination is loaded (the method with which the determi-

nation was carried out is loaded simultaneously with the determina-
tion).

Statistics

In the dialog Control, you can deactivate the statistics calculations for
individual determinations. This option is required primarily in order to
insert the processing of an "urgent sample" during the processing of a
sample series when the urgent sample is not to be included in the statis-
tics calculations.

Interrupting a determination series for an "urgent sample"

If the same method is required for the "urgent sample" as is being used
for the sample series, then you need only deactivate the option Statistics
and then reactivate it after the determination is completed. Proceed as fol-
lows if you need to process the "urgent sample" with a different method:

 

1 Deactivate statistics calculation

￭ Deactivate the option Statistics.

 

2 Saving the determination

￭ Save the current determination of the sample series (see chapter
24.6, page 232).

 

3 Carrying out the determination

￭ Load the method for the "urgent sample".
￭ Carry out the determination.

 

4 Load the last determination of the sample series

￭ Reload the previously saved last determination.

The determination, the method used for it and the current statistical
data are loaded. The option Statistics is activated again and the
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value of the statistics counter corresponds to that in effect before the
interruption.

 

5 Continuing the sample series

￭ Carry out the remaining determinations in the sample series.
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19 Favorites

Main dialog: Control ▶ Favorites

Main dialog: System ▶ System settings ▶ User
admin. ▶ Edit ▶ Favorites

This chapter describes how you can create favorites. Favorites are compa-
rable to the favorites/bookmarks in your Internet browser. In the main dia-
log, a button is created for each favorite. By pressing a single key, you can
trigger an action without having to navigate through different dialogs.

The following objects can be saved as favorites:

￭ Methods
￭ Sample tables

User-specific or common favorites can be created, depending on whether
you are working with or without the login function.

￭ Operation with login function:
If you are working with the login function activated, user-specific
favorites can be created. These can only be used by a certain user.
User-specific favorites are created as follows:

– in the user administration by a user with administrator rights
(System ▶ System settings ▶ User admin. ▶ Edit).

– in the dialog Control for the user who is logged in.
￭ Operation without login function:

If you are working without the login function, common favorites can
be created. These favorites are available for all users. Common favor-
ites are created in the Control dialog.
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19.1 Creating favorites

The list of favorites gives the designation and position of the button on
the main dialog of each favorite configured.

[New]

Add a new favorite to the list, see following chapter.

[Delete]

Delete the selected favorite from the list.

[Edit]

Edit the properties of the selected favorite, see following chapter.

19.1.1 Editing favorites
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Position

On the main dialog, a button is created for each favorite. These buttons
are ordered in three rows at fixed positions. The position 1 can be found
top left.

Input range 1 to 14 
Default value 1 

Name

The designation of the favorite is used for unambiguous identification.

Entry 24 characters maximum

Type

Definition as to whether the favorite represents a single method or a com-
plete sample table.

Selection Method | Sample table
Default value Method

Memory

Memory location the method or the sample table is loaded from. Only the
currently accessible memory locations are selectable.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
The favorite will be saved in a shared directory on the network. The
shared directory is selected in the Edit device / Shared memory dia-
log (see chapter 11.3.3, page 87).

Method / Sample table

Method or sample table of the favorite.

Selection Selection of stored methods/sample tables

[More options]

Parameterize the autostart function, see following chapter.

More options

The autostart function is parameterized under [More options].
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Autostart

on | off (Default value: off)

If this option is activated, a new determination is started automatically at
the end of a determination. This continues until the number specified has
been reached (siehe Number of autostarts).

Number of autostarts

This option can only be edited when Autostart is activated.

Number of automatic starts.

Input range 1 to 9999 
Default value 1 
Selection Table

Table
The number of automatic starts corresponds to the number of samples
in the sample table.
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20 Sample data

You can enter the sample data (identification, sample size, etc.) in a variety
of ways:

￭ Directly in the main dialog.
￭ Using the sample table. This is particularly useful with sample series.

The sample table is a table in which the sample data for up to 999
samples can be entered (see chapter 21, page 202).

￭ Automatic request immediately after the start of the determination (see
chapter 20.2, page 200).

You can also send the sample size and the unit from a connected balance
in any case. With some balances, the sample identification and method
can be also sent (see chapter 32.5, page 506).

20.1 Entering sample data in the main dialog

For a sample, you can enter the sample data directly in the main dialog,
even while the determination is running (see chapter 23, page 213).

Identification 1

Sample identification. The sample identification can be used in calculations
as the variable CI1. If you have defined a sample identification list (see
chapter 15.1.1, page 153) then the entries can be selected here.

Entry 24 characters maximum
Default value empty



20.2 Requesting sample data at the start of the determination ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

200 ￭￭￭￭￭￭￭￭ 900 Touch Control

Identification 2

Sample identification. The sample identification can be used in calculations
as the variable CI2. If you have defined a sample identification list (see
chapter 15.1.1, page 153) then the entries can be selected here.

Entry 24 characters maximum
Default value empty

Sample size

Sample size. The value of the sample size can be used in calculations as
the variable C00.

Input range –99999999 to 9999999999 
Default value 1.0 

Unit of sample size.

Entry 6 characters maximum
Selection g | mg | µg | mL | µL | pieces
Default value g

Unit defined in method:
The unit defined in the method is ignored. The unit entered in the sample
table is used.

Balance connected and configured:
Value from the connected balance.

Fixed sample size defined in method:
The value will be entered in the corresponding line when the method is
loaded. The existing entry will be overwritten.

20.2 Requesting sample data at the start of the determi-
nation

The sample data can be automatically requested immediately after the
start of the determination in order to ensure that the sample data entry is
not forgotten. This automatic inquiry is requisite for reweighing.
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To accomplish this, you must insert and configure the command
REQUEST in the method (see chapter 29.18.3, page 490).

If the Hold sequence parameter is activated, then the run will be paused
and must be continued with [Continue] after the sample data has been
entered. If the Hold sequence parameter is deactivated, then the deter-
mination will continue in the background until the measured data is
required for further processing. This dialog will be displayed until the
entering of the sample data is confirmed with [Continue], even if the
titration/measurement is already completed. This ensures that the sample
data is available for calculations.

If a fixed sample size has been defined in the method (see chapter 16.5.3,
page 181), then it will be displayed at the time of the entry but it will not
be editable.
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21 Sample table

21.1 General

Main dialog: Sample table

The sample table is a table in which the sample data for up to 999 sam-
ples can be entered. If you are processing larger-sized sample series, it
makes sense to enter the sample data in this table.

Activating the sample table

Proceed as follows to enable the sample table:

 

1 Opening the control dialog

￭ In the main dialog, tap on [Control].

The control dialog is displayed:

 

2 Activating the sample table

￭ Activate the Sample table option.

￭ Tap on the fixed key [ ].

The main dialog is displayed:
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The display will show the number of determinations already carried
out and the total number of sample lines containing data. The sam-
ple table is still empty in this example.

The sample table contains numbered lines; each line represents one deter-
mination. In the standard settings, the first sample identification and the
sample size of each sample are displayed. In the properties, you define the
columns to be displayed (see chapter 21.3, page 207).

[Load/ Save]

Load a saved sample table (see "Loading a sample table", page 205) or
save the current sample table (see "Saving a sample table", page 204).

[Properties]

Edit the properties of the sample table (see chapter 21.3, page 207).

[Insert line]

Insert a new line above the line selected.

[Delete]

Delete the selected line from the sample table.
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[Edit]

Edit the data of the selected line (see chapter 21.2, page 205).

Saving a sample table

NOTE

Sample tables can only be saved on external storage media or on a
shared file system.

Proceed as follows to save a sample table:

 

1 Opening the dialog

￭ In the Sample table dialog, tap on the [Load/ Save] button.

The Sample table / Load/Save dialog is displayed.

If no external storage medium is plugged in or if no file system is
shared, then [Save] is disabled.

 

2 Modify/apply a name

￭ Tap on [Save].
A name is suggested for new sample tables. If the sample table
has already been saved, the previous name will be displayed.

Applying the name:

￭ Tap on [Save].

The sample table is saved.

Entering a new name:

￭ Tap on the input field File name.
The text editor opens.

￭ Enter a new file name (max. 32 characters) and confirm with
[OK].

￭ Tap on [Save].

The sample table is saved.
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Loading a sample table

Proceed as follows to load a sample table:

 

1 Display the list of saved sample tables

￭ In the Sample table dialog, tap on the [Load/ Save] button.
The Sample table / Load/Save dialog is displayed.
If no external storage medium is plugged in or if no file system is
shared, then [Load] is disabled.

￭ Tap on [Load].
The selection of memory locations is displayed. This selection will
be skipped if only one memory can be accessed.

￭ Select the memory location where the desired sample table is
stored.
The selection of file groups is displayed (see chapter 12.1, page
126). If only one group is available, then the list of the saved sam-
ple tables will be displayed directly.

￭ Select the group with the desired sample table.
￭ Tap on [Show files].

The list with the saved sample table is opened.

 

2 Select the sample table

￭ Select the desired sample table.

 

3 Loading a sample table

￭ Tap on [Load].

The sample table is now loaded.

21.2 Editing sample data
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At the very top you will see the line number of the selected line. In this
example, the sample data of the first line is displayed. You can scroll
between individual data sets with the keys [–] and [+].

Method

Method used for processing the sample.

If you use the sample assignment table (see chapter 15.1.2, page 154),
then the method can no longer be defined here.

Selection Selection of stored methods | empty
Default value empty

empty
The currently loaded method is used.

Identification 1

Sample identification. The sample identification can be used in calculations
as the variable CI1. If you have defined a sample identification list (see
chapter 15.1.1, page 153) then the entries can be selected here.

Entry 24 characters maximum
Default value empty

Identification 2

Sample identification. The sample identification can be used in calculations
as the variable CI2. If you have defined a sample identification list (see
chapter 15.1.1, page 153) then the entries can be selected here.

Entry 24 characters maximum
Default value empty

Sample size

Sample size. The value of the sample size can be used in calculations as
the variable C00.

Input range –99999999 to 9999999999 
Default value 1.0 

Unit of sample size.

Entry 6 characters maximum
Selection g | mg | µg | mL | µL | pieces
Default value g

Unit defined in method:
The unit defined in the method is ignored. The unit entered in the sample
table is used.
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Balance connected and configured:
Value from the connected balance.

Fixed sample size defined in method:
The value will be entered in the corresponding line when the method is
loaded. The existing entry will be overwritten.

NOTE

The sample size limits defined in the method are not monitored when
the sample data is being entered in the sample table.

21.3 Properties

Method memory

Memory location the method is loaded from. All memory locations are
selectable, even if they are currently not accessible.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
Shared directory in the network.

Display in table

Selection of the columns to be displayed in the sample table.

Selection Method | Identification 1 | Identification 2
Default value Identification 1
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Method
Only the assigned method is displayed for each sample.

Identification 1
The first sample identification and the sample size are displayed for
each sample.

Identification 2
The second sample identification and the sample size are displayed for
each sample.

Number of lines

Maximum number of lines which can be present in the sample table.

Input range 2 to 999 
Default value 99 

Lock editing

on | off (Default value: off)

If this option is activated, then the sample data can no longer be altered.

Display options

Configure the sample data to be displayed in the dialogSample table /
Edit (see ""Properties / Display options" dialog", page 208).

Editing options

Specify the settings for the processing of the sample data (see ""Proper-
ties / Editing options" dialog", page 208).

Identifications

Define the designations for the input fields of Identification 1 and Identifi-
cation 2 (see "Dialog "Properties / Identifications"", page 209).

"Properties / Display options" dialog

Sample table: Properties ▶ Display options

In this dialog, you can configure which of the following sample data can
be edited in the sample table:

￭ Method
￭ Identification 1
￭ Identification 2
￭ Sample size

"Properties / Editing options" dialog

Sample table: Properties ▶ Editing options

In this dialog, you can define the settings so that the input of the sample
data becomes simpler and faster.
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End line with

Selection as to with which input the editing dialog for the next sample is
automatically displayed.

Selection Sample size | Identification 1 | Identification
2 | manual

Default value Sample size

manual
The editing dialog for the next sample can be displayed with the [New
sample] button in the editing dialog.

If, for example, you have to enter similar data for each sample, then you
can automatically copy the data which is identical for each sample into
the next line:

￭ Method
￭ Identification 1
￭ Identification 2
￭ Sample size

Dialog "Properties / Identifications"

Sample table: Properties ▶ Identifications

In the dialog Properties / Identifications, you can alter the designations
for the sample identifications in accordance with specific methods.
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22 Determination run

This chapter provides a description of how to carry out a determination,
i.e. how to process a single sample or a sample series. The current sample
data is used for calculations.

22.1 Carrying out a single determination

When you carry out a determination, you can enter the sample data in
various ways (see chapter 20, page 199). The following instructions
describe how to enter the sample data in the main dialog.

To carry out a single determination, proceed as follows:

 

1 Loading the method

￭ See Chapter "Loading a method", Page 174.

 

2 Preparing the sample

NOTE

Calculate the amount of the sample in such a way that a titrant
consumption of 10…90% of the cylinder volume will result.

￭ Weigh in or measure the sample in a sample vessel.
￭ Add solvent.
￭ Place the sample vessel on the stirrer.
￭ Immerse the electrode and buret tip in the solution.

 

3 Entering the sample size

￭ Tap on the input field Sample size in the dialog.
The number editor opens.

￭ Enter the sample size and confirm with [OK].

 

4 Starting a determination

￭ Tap on the fixed key [ ].
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Sequence of the determination

￭ After a determination is started, a check is made as to
– whether all of the devices required are connected and ready for

operation.
– whether all titrants and sensors are present.
– whether the monitoring intervals for titrants, sensors and com-

mon variables are still valid.
– if a sample assignment table is activated (see chapter 15.1.2,

page 154):
whether the entered sample identification is defined in the sam-
ple assignment table. If this is the case, then the assigned
method will be loaded automatically and the actual determina-
tion will be started.

NOTE

Manual titrations (MAT command):

Start of titration: Because of the technical implementation involved, a
few microliters are already dosed at the start of a manual titration. The
possibility of deviation from the actual endpoint volume is excluded,
however, because the already dosed volume is taken into account.

End of titration: A manual titration must always be ended with the
[Cancel command] button (NOT with the [ ] fixed key) or with the
[FILL] key on the Manual Dosing Controller. This is the only way to
ensure that subsequent method commands will be carried out.

22.2 Performing a sample series

You can use the following functions with sample series:

￭ Statistics for multiple determinations
The statistics calculations are enabled in the method options (see chap-
ter 16.5, page 177).

￭ Sample table
You can enter the sample data for an entire sample series in the sample
table (see chapter 21, page 202).
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Sequence of the sample series

￭ After a determination is started, a check is made as to
– whether all of the devices required are connected and ready for

operation.
– whether all titrants and sensors are present.
–
– whether the monitoring intervals for titrants, sensors and com-

mon variables are still valid.
–
– if a sample assignment table is activated (see chapter 15.1.2,

page 154):
whether the entered sample identification appears in the sample
assignment table. If this is the case, then the assigned method
will be loaded automatically and the actual determination will be
started. If a different method has been entered in the sample
table, then it will be ignored.

￭ At the end of the determination,
– the line in the sample table is deleted.
– the next determination is started (if you are working with the

autostart function enabled (see chapter 18, page 191)).

22.3 Canceling determinations manually

You can cancel a determination at any time with the fixed key [ ]. The
command being carried out at that moment is canceled and only calcula-
tions and reports are executed or created.

If you are working with the autostart function activated (see chapter 18,
page 191), the entire series will be canceled.

NOTE

If you do not wish to cancel the entire determination, but only the cur-
rent command, use the function [Cancel command] in the live display.

The subsequent method commands are carried out normally.
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23 Live modifications

23.1 Editing the sample data of the running determina-
tion

The sample data can be entered or modified in the main dialog while a
determination is running. The sample data entered at the end of the
determination is always used in calculations.

Proceed as follows to edit the sample data:

 

1 Display the main dialog

￭ Tap on the fixed key [ ].

The main dialog is displayed. The determination continues to run in
the background.

 

2 Edit the sample data

￭ Edit the sample data and apply with [OK].

 

3 Display the live dialog

￭ Tap on [Live display].

The live dialog is displayed once again.

NOTE

Make sure that the input dialogs are closed before the determination is
ended. Otherwise the determination will have to be recalculated.
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23.2 Editing the sample table while a determination is
running

You can insert new lines or delete existing ones or edit sample data while
a determination is running.

NOTE

To ensure that no problems arise during the run and that the current
data is always available for the calculation, we recommend that the
input dialogs always be closed.

Editing the sample table

Proceed as follows to edit the sample table:

 

1 Display the main dialog

￭ Tap on the fixed key [ ].

The main dialog is displayed. The determination continues to run in
the background.

 

2 Select the sample data

￭ Tap on Sample table.
The sample table is displayed. The first line always contains the
sample data of the running determination.

￭ Select the desired line.
￭ Tap on the button [Edit].

 

3 Edit the sample data

￭ Edit the sample data and apply with [OK].

NOTE

In addition to the sample data, the method can also be modified,
except in cases where the determination is running.

 

4 Display the live dialog

￭ Tap on the fixed key [ ].
The main dialog is displayed.

￭ Tap on [Live display].
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The live dialog is displayed once again.

23.3 Live display

Main dialog: Live display

The current method and the system status are displayed in the title line.
The currently running command is displayed directly underneath the title
line.

The following functions are available to you while a determination is run-
ning:

￭ [Hold]
Pause the determination. The label changes to [Continue]. This can be
used to continue the run.

￭ [Cancel command]
Cancel the current method command. The next command is started.

￭ [View] (only for titrations/measurements)
To modify the settings for the curve and measured value display, see
below.

￭ [Sample data] (visible only if a titration or a measurement is not cur-
rently running)
Switch to the main dialog in order to edit the sample data.

￭ [Edit parameters]
Edit the method options and live parameters (see chapter 23.4, page
217).

￭ [Results]
Display the results dialog (see chapter 24, page 219).

Dialog "View"

Main dialog: Live display ▶ View
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View

Type of curve display.

Selection Curve | Curve & meas. values | Measured val-
ues | Curve & sample data

Default value Curve & meas. values

Curve
Only the curve is displayed.

Curve & meas. values
The measured values are displayed to the right next to the curve.

Measured values
Only the measured values are displayed.

Curve & sample data
The sample data is displayed to the right next to the curve.

[Meas. value options]

Define settings for the display of the measured values.

A maximum of three different values can be displayed at the same time.
The selection depends on the titration/measuring mode. The settings are
saved separately for each mode.

[Curve options]

Define the settings for the curve display (see "Curve options", page 233).
The settings are saved separately for each titration/measuring mode and
apply not only for the live display but also for the curve display in the
results dialog.
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23.4 Live parameters

Live display: Edit parameters

Certain method parameters can be edited while a determination is being
carried out. The modified parameters are taken into account at once. If
you modify, for instance, the start conditions after the start volume has
been dosed, then these modifications will not be taken into account until
the next determination.

NOTE

If the live modifications are also to be used in the future, then the
method must be saved after the determination has been completed.
The live modifications are discarded as soon as you load a new method.

If you are working with the sample table and a different method is used
for the next sample, then the live modifications will be discarded.

Proceed as follows to modify method parameters during an ongoing
determination:

 

1 Select the method command

￭ Tap on Edit parameters.
The command sequence is displayed.

[Edit command] is enabled only for those commands for which
the live parameters can be edited.
All of the functions except for the method properties can be
edited with [Method options].

￭ Select the desired method command.
￭ Tap on [Edit command].
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2 Edit the method parameters

￭ Change the desired parameters accordingly.

 

3 Display the live dialog

￭ Tap on the fixed key [ ].
The main dialog is displayed.

￭ Tap on [Live display].

The live dialog is displayed once again.
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24 Results and more determination data

Main dialog: Results

Detailed specifications concerning the current determination are displayed
in the Results dialog:

￭ Current method
Method with which the determination was carried out.

￭ Determination
Name of the determination. Displayed only if the determination has
been saved.

￭ Determination time
Date and time at which the determination was carried out.

￭ Results
Calculated results. If monitoring of the result limits is activated, then
the result will be highlighted in color:

– Green lettering: The result is within the limits
– Red lettering: The result is outside the limits

￭ Commands
List of the data-generating commands (titrations, measurements, etc.).
The most important data is displayed for each command.

[Result table]

Open result table (see chapter 26, page 241). The result table is a table in
which the results for several determinations can be saved.

[Statistics]

Display the statistical overview of a determination series (see chapter 25,
page 236).
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[Recalculate]

Recalculate the determination. The procedure will be executed immedi-
ately. Recalculation cannot be undone (see chapter 24.8, page 234).

[Sign]

Sign the current determination.

If the method contains a command SIGN, then this button will be dis-
played instead of [Recalculate]. The determination can be signed directly
on level 1 (with a second command also on level 2).

[Curve]

Display the curve of the current determination (see chapter 24.7, page
232).

[More data]

Display detailed specifications for the determination (determination prop-
erties, measuring point list, endpoint details, etc.), save determination (see
chapter 24.1, page 220).

24.1 More determination data

Results dialog: More data

All of the commands for which you can display other data (titrations,
measurements, evaluations, etc.) are listed in the Results / More deter-
mination data dialog.

[Load/ Save]

Load saved determinations(see chapter 24.5, page 227) and save current
determination (see chapter 24.6, page 232).

[Properties]

Display the properties of the current determination (see chapter 24.4,
page 224).
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[Local com. var.]

(available only with loaded determinations)

Display the list of the common variables defined at the time of the deter-
mination (see chapter 24.3, page 224).

[Messages]

Display list with all of the messages which occurred during the determina-
tion (see chapter 24.2, page 223).

[View data]

Display all of the details for the selected command.

24.1.1 Details
Results dialog: More data ▶ View data

All of the variables generated by the determination are listed in the More
determination data / View data dialog. These can be used in calcula-
tions.

[Calibration data]

(available only with loaded determinations)

Display calibration data of the sensor used which was valid at the time of
the determination (see "Calibration and titrant data", page 223).

[Titrant data]

(available only with loaded determinations)

Display titrant data which was valid at the time of the determination (see
"Calibration and titrant data", page 223).

[Endpoint details]

Display details for each endpoint found (see "Endpoint details", page
222).
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[Measuring point list]

Display measuring point list of titrations and measurements (see "Measur-
ing point list", page 222).

Measuring point list

Results dialog: More data ▶ View data ▶ Measuring point list

Results dialog: Curve ▶ Display curve ▶ Measuring point list

The individual measured values are listed in the View data / Measuring
point list dialog. You can configure which columns are displayed ([View]
button). These settings are saved separately for each mode (DET, MET,
etc.).

Column 1 / Column 2 / Column 3

Quantity displayed in the columns 1, 2 and 3. Both the selection of the
quantities and the default setting depend on the mode.

Selection Volume | Measured value | Water | Bromine |
 ERC | Delta meas.value | Time | Temperature |
 Drift | Volume drift | Signal drift | Index | Mon-
itoring

Endpoint details

Results dialog: More data ▶ View data ▶ Endpoint details

Results dialog: Curve ▶ Display curve ▶ Endpoint details

Detailed information concerning each equivalence point or endpoint
determined is displayed in the View data / Endpoint details dialog.

The volume, the measured value, the equivalence point criterion ERC (only
DET, MET), the time and the temperature are specified for each equiva-
lence point or endpoint determined.
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The equivalence point criterion determined (ERC = Equivalence point Rec-
ognition Criterion) is a measure for the size of the jump in the titration
curve. The ERC determined is compared with the EP criterion defined in
the method for the evaluation of the titration curve see "Evaluation and
equivalence point criterion with DET", page 298 and "Evaluation and
equivalence point criterion with MET", page 314). The ERC is thus an
important quantity when you need to adjust the parameters for the evalu-
ation of the equivalence points.

Calibration and titrant data

Results dialog: More data ▶ View data ▶ Calibration data

Results dialog: More data ▶ View data ▶ Titrant data

The calibration data or titrant data which was current at the time the
determination was performed is displayed in the dialogs View data / Cal-
ibration data and View data / Titrant data.

NOTE

Recalculation:

The concentration and titer of the titrant can be modified retroactively.
The values displayed here are used for the recalculation of a loaded
determination. The values saved in the dialog System / Titrants are
not changed as a result.

24.2 Messages

Results dialog: More data ▶ Messages

If messages occurred during a determination, they will be displayed in the
More determination data / Messages dialog. The following data for
the message is indicated under [Details]:

￭ Message number
Unique identification number.

￭ Time
Moment that the message occurred.

￭ Message
Message text.
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24.3 Local common variables

Results dialog: More data ▶ Local com. var.

The list of common variables as it existed at the time of the determination
is displayed in the More determination data / Local common varia-
bles dialog.

NOTE

Recalculation:

The common variables can be modified retroactively. The values dis-
played here are used for the recalculation of a loaded determination.
The list of common variables in the System / Common variables dia-
log is not changed as a result.

24.4 Determination properties

Results dialog: More data ▶ Properties

Detailed information concerning the determination is displayed in the
More determination data / Properties dialog:

￭ User
User who carried out the determination.

￭ Sample number
Number which was entered in the dialog Control at the start of the
determination.

￭ Start counter
This value, just like the sample number, is increased by one each time a
determination starts. In contrast to the sample number, this value can-
not be modified by the user.

￭ Duration determ.
Duration of the entire determination.
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￭ Method status
Current status of the method.

– new
The method has been newly created and not yet saved.

– saved
The current method has been saved.

– modified
The current method has been modified but not saved yet (e.g
live modification).

– reviewed
The current method has been signed at level 1.

– released
The current method has been signed at level 2.

￭ Determination
Name of the determination. Displayed only with saved determinations.

￭ End of determin.
Way in which the determination was ended.

– Regular without errors
The determination was automatically ended at the end of the
method.

– Manual stop
The determination has been canceled with the fixed key [ ].

– Error
The determination has been canceled due to an error.

￭ Status of deter.
– original

The determination has not been recalculated.
– recalculated

The determination has been recalculated.
– loaded

The determination has been loaded.
– saved

The determination has been saved. The version number indicates
how many times the file has been saved.

– reviewed
The determination has been signed at level 1.

– released
The determination has been signed at level 2.

The following data is displayed only if the option Recalculating deter-
mination under Login options / Modification options is activated:

￭ Recalculated by
User who recalculated the determination.

￭ Recalculated on
Date and time at which the determination was recalculated.
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￭ Reason
Reason for the recalculation of the determination.

￭ Comment
Comment for the recalculation of the determination.

The following information is displayed only if the determination has been
signed at level 1:

￭ Reviewed by
User who signed the determination at level 1.

￭ Reviewed on
Date and time at which the determination was signed at level 1.

￭ Reason
Reason for the signing of the determination.

￭ Comment
Comment for the signing of the determination.

The following information is displayed only if the determination has been
signed at level 2:

￭ Released by
User who signed the determination at level 2.

￭ Released on
Date and time at which the determination was signed at level 2.

￭ Reason
Reason for the signing of the determination.

￭ Comment
Comment for the signing of the determination.

￭ Used devices
Hardware that was used for the determination.

– Touch Control with program version of the software and the
serial number.

– Control instrument with the program version of the device soft-
ware and the serial number.

– Measuring inputs with ADC type und serial number.
– MSB connector with peripheral devices connected to it (dosing

device, stirrer).

[Delete signature]

Delete all of the signatures for the method or the determination. This but-
ton is inactive if level 2 has not yet been signed (see chapter 17.2, page
190).

[Sign]

Sign the method or determination. This button is active only when work-
ing with activated login function and password (see chapter 17.1, page
189).
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24.5 Loading a determination

Proceed as follows to load a determination:

 

1 Opening the determination list

￭ In the results dialog, tap on [More data].
￭ Tap on [Load/ Save].
￭ Tap on [Load].

The selection of memory locations is displayed. This selection will
be skipped if only one external storage medium is available.

￭ Select the memory location where the desired determination is
saved.
The selection of file groups is displayed (see chapter 12.1, page
126). If only one group is available, then the determination list will
be displayed directly.

￭ Select the group with the desired determination.
￭ Tap on [Show files].

The determination list with the stored determination opens:

 

2 Selecting a determination

￭ Select the desired determination.

 

3 Loading the determination

￭ Tap on [Load].

The determination is now loaded. The properties are displayed in the
results dialog.
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NOTE

When you load a determination, the method with which the
determination was carried out will be loaded automatically.

For this reason, save any modifications which may have been
made to the method currently loaded before you load a determi-
nation.

24.5.1 Determination list
Results dialog: More data ▶ Load/ Save ▶ Load ▶ Show
files ▶ View

In the Show files / View dialog you can depict the individual determina-
tions in greater detail. The sorting criterion and the number of saved
determinations are displayed at the very top. The list contains numbered
lines; each line represents one determination. In the default settings, the
first sample identification and the first calculated result of each determina-
tion are displayed. In the properties, you define which data is displayed in
the columns and the criteria according to which the determinations are
sorted (see "Properties", page 229). In addition, you can define search fil-
ters to aid you in finding the desired determinations (see "Filter criteria",
page 230).

[Previous 100]

Display the previous 100 determinations.

[Next 100]

Display the next 100 determinations.

[Properties]

Configure the display of the columns and define filter criteria.
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[Delete]

Delete the selected file.

[Load]

Load the selected file.

Properties

Determination list: Properties

In the View / Properties dialog, you can define which data is displayed
in the columns and the criteria according to which the determinations are
to be sorted.

Column 1

Selection of what is to be displayed in the first column.

Selection Identification 1 | Identification 2 | Determ.
time | Result name | Method | Sample size |
 User

Default value Identification 1

Column 2

Selection of what is to be displayed in the second column.

Selection Result 1…9
The numbering of the results corresponds to the
order in which the results were calculated in the
determination run.

Sort by

Selection according to which criterion the list is to be sorted.
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Selection Identification 1 | Identification 2 | Determ.
time | Result | Method | Sample size | User

Default value Determ. time

Identification 1
Sort alphabetically according to the first sample identification.

Identification 2
Sort alphabetically according to the second sample identification.

Determ. time
Sort chronologically according to the determination time.

Result
Sort according to the numerical value of the result.

Method
Sort alphabetically according to the method name.

Sample size
Sort according to the numerical value of the sample size.

User
Sort alphabetically according to the user who carried out the determi-
nation.

Sort sequence

Selection ascending | descending
Default value descending

[Filter]

Specify the filter criteria for the list.

Filter criteria

Determination list: Properties ▶ Filter

You can set filters in the Properties / Filter dialog. A filter is a rule defin-
ing what is to be displayed in the determination list. If a filter has been set,
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this is indicated with a corresponding symbol in the Show files / View
dialog.

Filter

Define the criterion according to which the list is to be filtered. The only
lines which will be displayed are those which fulfil the filter criterion.

Selection no filter | Identification 1 | Identification 2 |
 Date | Result | Method | Sample size | User

Default value no filter

no filter
The list itself will not be filtered.

Identification 1
In the input field is equal to, select or enter the first sample identifica-
tion according to which filtering is to be carried out.

Identification 2
In the input field is equal to, select or enter the second sample identi-
fication according to which filtering is to be carried out.

Date
In the input fields Date from … to, specify the period of time accord-
ing to which filtering is to be carried out.

Result
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.

Method
In the field is equal to, select or enter the method name according to
which filtering is to be carried out.

Sample size
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.

User
In the field is equal to, select or enter the user according to whom
filtering is to be carried out.

NOTE

The filter can be applied to empty fields as well, for example, if no sam-
ple identification has been entered. In this case, select only the desired
filter criterion and leave the fields below empty.
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24.6 Saving a determination

Results dialog: More data ▶ Load/ Save ▶ Save

Determinations can be saved as follows:

￭ Manually in this dialog.
The suggested default setting for file names is the first 16 characters of
Identification 1, followed by the determination time in the format
YYYYMMDD-hhmmss. Extending the file name with the determination
time has the advantage that the file names of all determinations are
unique.

￭ Automatically at the end of the determination (see chapter 16.5.6,
page 187).

The following data is stored for each determination:

￭ Calculated results
￭ Measuring point lists, equivalence points, curves and variables which

were generated during the determination
￭ Determination properties
￭ Statistics (if carried out)
￭ Method with which the determination was carried out
￭ Common variables (values and properties of all common variables at

the time of the determination)
￭ Titrant data of the titrant used
￭ Calibration data of the sensor used

24.7 Curves

Results dialog: Curve

The curve of the current determination is displayed in the Results / Curve
dialog. You can configure the curve display.
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[Endpoint details]

Display details for each endpoint found (see "Endpoint details", page
222).

[Measuring point list]

Display measuring point list of titrations and measurements (see "Measur-
ing point list", page 222).

[Curve options]

Define the settings for the curve display (see "Curve options", page 233).
The settings are saved separately for each titration/measuring mode and
apply not only for the live display but also for the curve display in the
results dialog.

Curve options

Results dialog: Curve ▶ Curve options

You can make the settings for the curve display in the Curve / Options
dialog. These settings are saved separately for each mode (DET, MET, etc.)
and also apply for the live display. Both the selection of the quantities and
the default setting depend on the mode.

x axis

Quantity which is shown on the x axis of the graph.

Selection Volume | Measured value | ERC | Delta
meas.value | Time | Temperature | Volume
drift | Signal drift

y1 axis

Quantity which is shown on the y1 axis of the graph.
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Selection Volume | Measured value | ERC | Delta
meas.value | Time | Temperature | Volume
drift | Signal drift

y2 axis

Quantity which is shown on the y2 axis of the graph.

Selection none | Volume | Measured value | ERC | Delta
meas.value | Time | Temperature | Volume
drift | Signal drift

Default value none

Color

Selection of a color for the curves.

Grid

on | off (Default value: on)

If this parameter is activated, grid lines are shown.

Display measuring points

on | off (Default value: off)

If this parameter is activated, the curve is shown with the single measured
values.

24.8 Recalculation and reevaluation

Results dialog: Recalculate

You can use the [Recalculate] function to recalculate and reevaluate
determinations. This is necessary in the following cases:

￭ If you have modified the evaluation parameters in a way that changes
the recognized endpoints or equivalence points.

￭ If you have modified the calculations.
￭ If you have modified the variables used in calculations, e.g. sample size,

titer or common variables.

NOTE

Neither the recalculation nor the reevaluation can be undone.

We therefore recommend that the original determination be saved
beforehand (see chapter 24.6, page 232). The best way of doing this is
to use the Save determination automatically function (see chapter
16.5.6, page 187).
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The following method commands are executed once again with the
[Recalculate] function:

￭ DET and MET titrations:
The potentiometric evaluation will be carried out again.

￭ EVAL commands:
All evaluations are carried out again. You can also insert new evalua-
tions retroactively.

￭ CALC command:
All calculations are carried out again. You can also define new calcula-
tions retroactively.
If you subsequently modify the titrant in a method, then the variables
TITER and CONC of the "new" titrant will be used. If a result is assigned
to the variable TITER in a calculation, then the titer of the "new" titrant
will also be overwritten.

NOTE

If you modify the calibration data of the sensor used in the System /
Sensors dialog, these modifications will not be taken into account.
Changing the sensor in the method also has no influence on the
measured data.

If a determination has been recalculated, this will be documented in the
determination properties (see chapter 24.4, page 224).

Recalculation/reevaluation of loaded determinations

With loaded determinations, it is assumed that they were carried out a
long time ago and that the titrant data and common variables of the
system no longer correspond to those of the determination. This is why
the most important titrant data of the titrants used and the list of com-
mon variables are stored with each determination. This data will be used
if you recalculate a loaded determination. If you wish to recalculate the
result with a corrected common variable or with a corrected titer, you
must therefore modify the respective values in the More determination
data / Local common variables or More determination data / View
data dialog.

If a result is assigned to the variable TITER or to a common variable,
then the titer or common variable which is currently valid in the system
will not be overwritten until after a query has been confirmed.

If you modify the titrant retroactively in the method, this will not be taken
into account.

The recalculated results of loaded determinations are not saved in the
result table.
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25 Statistics

Main dialog: Results ▶ Statistics

In the dialog Results, you can use [Statistics] to display the statistical
overview of a determination overview. You can statistically evaluate a
maximum of nine results calculated in a determination. A statistical series
can contain a maximum of 20 determinations.

Activating the statistics function

Proceed as follows to activate the statistics function:

 

1 Editing the method options

￭ In the main dialog, tap on [Edit parameters].
￭ Tap on [Method options].

￭ Activate the Statistics option.
￭ Under Number of determinations, enter the desired number of

determinations.

The results for which statistical calculations are performed are
defined in the calculation command CALC (see "Variable for mean
value", page 158).
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In this dialog, the method with which the determination was carried out is
displayed in the first line. The second line shows how many determina-
tions have already been carried out and the total number of determina-
tions to be carried out. The name of the result and the mean value are
shown for each result.

[Add determ.]

Add a further determination to the determination series (see chapter 25.3,
page 239).

[Details]

Display the statistics results for the selected result and the single results
from all determinations, see next chapter.

NOTE

If you recalculate a determination, the statistics for this determination
are also recalculated.
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25.1 Displaying details for a result

Results dialog: Statistics ▶ Details

In the dialog Statistics / Details, the following details are displayed:

￭ Result name
￭ Mean value

On the right-hand side of the dialog the number of single results from
which the mean value was calculated is displayed. In this example, it is
3.

￭ Absolute standard deviation (s abs)
￭ Relative standard deviation (s rel)
￭ Result and sample size of each single determination

Results that could not be calculated are indicated with invalid and
ignored.

[Sample data]

Display the sample data of the selected determination.

[Determ. on/off]

Remove all of the results of the selected determination from the statistics.
All of the entries of this line are marked with an asterisk (*), the statistics
will be recalculated automatically.

[Result on/off]

Remove the selected result from the statistics. The result is marked with an
asterisk (*), the statistics will be recalculated automatically.
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NOTE

If the mean value has been assigned to a common variable or to the
variable TITER (see command CALC), then the determination must be
recalculated manually (see chapter 24.8, page 234).

25.2 Deleting statistical data

In the dialog Control, you can delete all of the statistics data manually
with the function [Delete statistics]. The statistics data is deleted auto-
matically in the following cases:

￭ when all of the determinations of the determination series have been
carried out and a new determination has been started afterwards.

￭ when a new method is loaded (even if it is the same method)
If the sample table or the sample assignment table is used, the
statistics data is only deleted when another method is loaded.

25.3 Adding a determination to a determination series

You can use the function [Add determ.] to add an additional sample to a
determination series, e.g. because a determination was faulty and had to
be removed from the statistics.

The number of determinations by which the set statistics counter has been
increased is shown above the list in brackets. This modification is also dis-
played in the main dialog and in the statistics report.
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NOTE

The number of samples defined in the method options does not, how-
ever, change as a result.
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26 Result table

Main dialog: Results ▶ Result table

The result table is suitable for displaying in detail the results of all of the
determinations performed on a single day, for instance. You can save the
results of up to 200 determinations. A maximum of 9 results from a single
determination can be saved in the result table. You define which results
from this table are to be saved using the CALC command. Because the
size of the display is not sufficient to display all of the data at the same
time, it is practical to print out the result table.

The sorting criterion and the number of determinations from which results
are saved in the result table are displayed at the top. The list contains
numbered lines; each line represents one determination. In the default set-
tings, the first sample identification and the first calculated result of each
determination are displayed. In the properties, you define which data is
displayed in the columns and the criteria according to which the determi-
nations are sorted (see chapter 26.1, page 242). In addition, you can
define search filters to aid you in finding the desired determinations (see
"Filter criteria", page 244).

[Load/ Save]

Load a saved result table (see chapter 26.3, page 246) or save the current
result table (see chapter 26.2, page 246).

[Properties]

Configure the display of the columns and define filter criteria.

[Delete all]

Delete the result table completely.



26.1 Properties ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

242 ￭￭￭￭￭￭￭￭ 900 Touch Control

[Delete]

Delete the selected line from the result table.

[Details]

Display details concerning the selected determination.

"Result table / Details" dialog

The following determination data is displayed in this dialog:

￭ User
User who carried out the determination.

￭ Method
Method with which the determination was carried out.

￭ Determ. time
Date and time at which the determination was carried out.

￭ Sample data (Identification 1 and 2 and sample size).
￭ All of the results of this determination saved in the result table.

26.1 Properties

Result table: Properties

In the Result table / Properties dialog, you can select the data to be
displayed with each determination as well as the sorting criterion for the
list.

Column 1

Selection of what is to be displayed in the first column.

Selection Identification 1 | Identification 2 | Determ.
time | Result name | Method | Sample size |
 User

Default value Identification 1
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Column 2

Selection of what is to be displayed in the second column.

Selection Result 1…9
The numbering of the results corresponds to the
order in which the results were calculated in the
determination run.

Sort by

Selection according to which criterion the list is to be sorted.

Selection Identification 1 | Identification 2 | Determ.
time | Result | Method | Sample size | User

Default value Determ. time

Identification 1
Sort alphabetically according to the first sample identification.

Identification 2
Sort alphabetically according to the second sample identification.

Determ. time
Sort chronologically according to the determination time.

Result
Sort according to the numerical value of the result.

Method
Sort alphabetically according to the method name.

Sample size
Sort according to the numerical value of the sample size.

User
Sort alphabetically according to the user who carried out the determi-
nation.

Sort sequence

Selection ascending | descending
Default value descending

Max. number of lines

If the result table contains the quantity of lines defined here, then no fur-
ther results can be saved. If this is the case, save the result table and cre-
ate a new one.

Input range 10 to 200 
Default value 100 

[Filter]

Specify the filter criteria for the list.
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[Delete automat.]

Define the settings for the automatic deletion of the result table (see
"Deleting the result table automatically", page 245).

Filter criteria

Result table: Properties ▶ Filter

You can set filters in the Properties / Filter dialog. A filter is a rule defin-
ing what is to be displayed in the result table. If a filter has been set, this is
indicated with a corresponding symbol in the Results / Result table dia-
log.

Filter

Define the criterion according to which the list is to be filtered. The only
lines which will be displayed are those which fulfil the filter criterion.

Selection no filter | Identification 1 | Identification 2 |
 Date | Result | Method | Sample size | User

Default value no filter

no filter
The list itself will not be filtered.

Identification 1
In the input field is equal to, select or enter the first sample identifica-
tion according to which filtering is to be carried out.

Identification 2
In the input field is equal to, select or enter the second sample identi-
fication according to which filtering is to be carried out.

Date
In the input fields Date from … to, specify the period of time accord-
ing to which filtering is to be carried out.
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Result
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.

Method
In the field is equal to, select or enter the method name according to
which filtering is to be carried out.

Sample size
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.

User
In the field is equal to, select or enter the user according to whom
filtering is to be carried out.

NOTE

The filter can be applied to empty fields as well, for example, if no sam-
ple identification has been entered. In this case, select only the desired
filter criterion and leave the fields below empty.

Deleting the result table automatically

Result table: Properties ▶ Delete automat.

In the Properties / Delete automatically dialog, you define when the
contents of the result table is to be automatically deleted.

Delete oldest line only

on | off (Default value: off)

If this option is activated at the same time that the result table is full, the
oldest entry will be deleted as soon as the results of a new determination
are saved.

Time when result table is deleted:

Switch on

on | off (Default value: off)

If this option is activated, then the result table will be deleted each time
you switch on the Touch Control.

Start a new sample series

on | off (Default value: off)

If this option is activated, then the result table will be deleted when you
start a new sample series (with activated autostart function!).
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Save result table

on | off (Default value: on)

If this option is activated, the result table will be deleted as soon as you
have saved it.

26.2 Saving the result table

NOTE

When you save the result table, the complete determination will not be
saved with each entry. If you wish to save the determination data for
each determination, use the Save determination automatically
function (see chapter 16.5.6, page 187).

26.3 Loading the result table

Proceed as follows to load a result table:

 

1 Opening the current result table

￭ In the results dialog, tap on [Result table].
￭ Tap on [Load/ Save].
￭ Tap on [Load].

The selection of memory locations is displayed. This selection will
be skipped if only one external storage medium is available.

￭ Select the memory location where the desired result table is
saved.
The selection of file groups is displayed (see chapter 12.1, page
126). If only one group is available, then the list of the saved
result tables will be displayed directly.

￭ Select the group with the desired result table.
￭ Tap on [Show files].

The list with the saved result tables opens.

 

2 Selecting the result table

￭ Select the desired result table.

 

3 Loading the result table

￭ Tap on [Load].

The result table is now loaded and will be displayed immediately.
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27 Printing

Reports can be printed out as follows:

￭ Manually with the [ ] fixed key in this dialog.
The fixed key is disabled while a determination is running.

￭ Automatically in the determination run with the command REPORT
(see chapter 29.14, page 441).

The Titrando manual describes how to connect a printer to a Titrando sys-
tem. The configuration of the printer is described in Chapter 11.8, page
114.

This screenshot shows the printing dialog associated with the main dialog.
The sample data is entered in the main dialog, which is why you can print
out the sample data from there in a context-sensitive manner with [Cur-
rent sample data].

The following buttons are also available in the other print dialogs:

[Report seq. as def. in method]

Print out all of the reports which are defined in the loaded method.

[Print screenshot]

Activate the "Print Screen" function. The current screen contents will be
printed out the next time the fixed key [ ] is tapped on.

[Report options]

Defining the general settings for the report output.

[Clear spooler]

Delete all outstanding printing orders.
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[More reports]

Open the list of available reports.

More reports

Fixed key [ ]: More reports

The dialog Print / More reports displays a list of all of the available
reports.

NOTE

If you are using a CUSTOM Neos printer, you can print only the
reports marked with a #. The designation on the reports is only visible
once the CUSTOM NEOS printer is selected (see screenshot above).

[System reports]

Opening the list of reports for the system settings.

NOTE

If you are using a CUSTOM NEOS printer, you cannot print system
reports.

[Method reports]

Opening the list of reports for the current method.

NOTE

If you are using a CUSTOM NEOS printer, you cannot print method
reports.
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[Send]

Create a PC/LIMS report.

[Edit]

Edit the settings of the selected report.

[Print]

Print the selected report.

27.1 General report options

Fixed key [ ]: Report options

The settings for the report printout can be adjusted in the dialog Print /
Report options to indicate, for example, whether a report header, a sig-
nature line or a frame is to be printed.

Report header

Defining the output of the report header. The report header contains gen-
eral information such as device type, serial number, program version and
the printing date.

NOTE

You can also define your own report header, which is printed in addi-
tion to this report header (System ▶ Templates ▶ Report header).

Selection off | once | on each page
Default value on each page

off
The report header will not be printed.

once
The report header will only be printed on the first page.

on each page
The report header will be printed on every page.

Signature line

Output of a special line for date and signature. This line will be printed at
the very bottom of every page.

Selection off | once | on each page
Default value off

off
No signature line will be printed.
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once
The signature line will only be printed on the last page.

on each page
The signature line will be printed on every page.

Frame

on | off (Default value: on)

If this parameter is activated, a frame is printed as lateral marking.

27.2 Settings of the individual reports

Fixed key [ ]: More reports ▶ Report ▶ Edit

Command REPORT: Report ▶ Edit

Settings can be edited for the following reports (for details, see online
help):

￭ Result report
￭ Curve

Definition of the curve size, display of the individual measuring points
and grid lines, etc.

￭ Measuring point list
Definition of the method command to which the measuring point list is
to be printed.

￭ Calculations
Definition of the accuracy with which the variables used as well as the
results calculated are printed.

￭ Statistics short
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Statistics overview
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Sample table
￭ Result table

Definition of the time at which the report is to be printed (with each
determination, at the end of a sample series or at the end of the sam-
ple table).

￭ Used devices
￭ Variables
￭ Monitoring
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27.3 List of all printable reports

The following reports can be printed out with the fixed key [ ]:

NOTE

If you have selected a CUSTOM NEOS printer, you can print only the
reports that are marked with a # on the display.

Report Contents

Result report # Report with determination properties, sample data, calcu-
lated results, etc. If there are multiple determinations, the
statistics will also be printed out.

Curve # Curve report. The settings for the curve print-out are adop-
ted from the curve options of the live display.

Measuring point list # Measuring point list report.

Calculations # Details concerning the calculations carried out (parameter
settings in accordance with the CALC command and the
calculated results).

Used devices  The devices used for the determination, as displayed in the
More determination data / Properties dialog.

Variables  All determination variables, as displayed in the results dia-
log.

Monitoring  Details for the monitored quantities (STAT, DOS only).

Statistics

Statistics short # Summary of the statistics calculations. The number of
determinations, the mean value, and the absolute and rela-
tive standard deviations are printed out for each result.

Statistics overview # Detailed statistical overview. The sample data and all indi-
vidual results are printed out for each determination. The
number of determinations, the mean value, and the abso-
lute and relative standard deviations are printed out for
each result.

PC/LIMS
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Report Contents

PC/LIMS report  Machine-readable report with all of the important data for
a determination. This report can be saved as a TXT or
UTF-8 file or sent to a terminal program or a LIMS via an
RS-232 interface. The definition is carried out in the device
manager (see chapter 11.3.2, page 85).

Sample data

Current sample data  Sample data of the current determination, context-sensi-
tive only from the main dialog.

Sample table  List of all determinations in the sample table with the
respective sample data, as entered in the sample table.

Result table

Result table  List of all determinations in the result table with results and
with the determination data, as saved in the result table.

More reports ▶ Method reports

Method sequence  Method properties and the list of all method commands.

Parameters full  Method properties and options, all method commands
with all parameters.

All parameters which no longer have their default settings
will be printed in bold. All parameters which have been
modified in comparison to the stored version of the
method are indicated by an *.

Titration & measuring
param.

 Method properties; titration, measurement and calibration
commands with all parameters.

All parameters which no longer have their default settings
will be printed in bold. All parameters which have been
modified in comparison to the stored version of the
method are indicated by an *.

Modified parameters  Method properties, all method parameters which have
been modified in comparison to the stored version of the
method.

Non default parameters  Method properties, all method parameters which no longer
have any default settings.

More reports ▶ System reports

System settings

System settings  Settings for acoustic signals and accuracy of the measured
value display.
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Report Contents

Dialog options  Settings for routine dialog and expert dialog.

User list  List with all of the users configured in the system, together
with their data, context-sensitive only from the user list.

Login options  Login options, context-sensitive only from the respective
dialog.

Titrants

Titrant list  List of all the titrants configured in the system.

All titrant data short  The most important titrant data of all titrants (name, con-
centration, titer, last titer determination).

All titrant data full  All of the titrant data of all of the titrants (working life, titer
options, data concerning the exchange unit/dosing unit).

Titrant data short  The most important titrant data of the selected titrant,
context-sensitive only from the editing dialog.

Titrant data full  All titrant data of the selected titrant, context-sensitive
only from the editing dialog.

Sensors

Sensor list  List of all the sensors configured in the system.

All sensor data short  The most important sensor data for all sensors (name, cali-
bration data).

All sensor data full  All of the sensor data for all of the sensors (working life,
complete calibration data, calibration interval).

Sensor data short  The most important sensor data of the selected sensor,
context-sensitive only from the editing dialog.

Sensor data full  All of the sensor data of the selected sensor, context-sensi-
tive only from the editing dialog.

Device manager

Device list  List of all devices configured in the system.

All device properties  Properties of all the devices configured in the system.

Device properties  Properties of the selected device, context-sensitive only
from the editing dialog.

GLP manager

GLP data  All data stored in the GLP manager.

Common variables
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Report Contents

Common variable list  List of all the common variables defined in the system,
together with their most important data (name, value, sta-
tus).

All common variable proper-
ties

 Properties of all common variables (name, value, validity,
status).

Common variable properties  Properties of the selected common variable (name, value,
validity, status), context-sensitive only from the editing dia-
log.

Local Common variable list  List with the common variables available at the time of the
determination, together with their most important data
(name, value, status), context-sensitive only from the dia-
log "More determination data / Local common variables".

Local common var. proper-
ties

 Properties of the selected common variable (name, value,
validity, status), context-sensitive only from the dialog
"More determination data / Local common variables".

Templates

Templates sample data  Sample identification list and sample assignment table.

Result template list  List with all of the user-generated result templates.

All result templates details  Details of the all of the user-generated result templates
(calculation formula, result options, note).

Result template details  Details of the selected result template, context-sensitive
only from the editing dialog.

Input/Output lines  List with all of the defined input and output lines at the
remote interface (name, bit pattern).

Custom calibration buffers  Temperature tables for all defined custom calibration buf-
fers.

Rack tables

Sample rack list  List with all of the sample racks configured in the system,
together with designation, number of positions and rack
code.
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28 Manual control

The following functions are available in the manual control:

[Measure]

Carrying out manual measurements (see chapter 28.2, page 257).

Measuring modes:

￭ pH (potentiometric pH measurement)
￭ U (potentiometric voltage measurement)
￭ Ipol (voltametric measurement with selectable polarization current)
￭ Upol (amperometric measurement with selectable polarization voltage)
￭ T (temperature measurement)
￭ Conc (concentration measurement)
￭ Cond (conductivity measurement)

[Dosing]

NOTE

Only active if a Dosino or dosing unit is connected.

Manual dosing (see chapter 28.3, page 261).

The following dosing functions are available:

￭ Preparing the exchange unit or dosing unit
￭ Emptying the dosing unit
￭ Filling the dosing cylinder of the exchange unit/dosing unit
￭ Dosing a specified volume
￭ Dosing continuously
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[Conditioning]

Conditioning the volumetric or coulometric titration cell manually (see
chapter 28.5, page 271).

[Stir]

Controlling the stirrer manually (see chapter 28.4, page 270).

[Remote]

Scanning the input lines on the remote interface and setting the output
lines (see chapter 28.6, page 272).

[Sample Processor]

Controlling the Sample Processor manually (see chapter 28.7, page 273).

28.1 Opening and closing the manual control

Opening the manual control

 

1 Opening the dialog window

￭ Tap on the fixed key [ ].

Manual control opens:

 

2 Select the function

￭ Tap on the button for the desired function.

If the function can be carried out by several devices, a dialog to
select the device will appear first; otherwise the dialog for the
selected function will appear immediately.
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Closing the manual control

 

1 ￭ Tap on the fixed key [ ].

NOTE

Manual control can also be exited when a manual sequence has been
started but has not yet ended. The fact that a sequence has been
started in manual control can be recognized by the corresponding sym-
bol in the title line (see chapter 6.2.3, page 20).

28.2 Measuring

Manual control ▶ Measure

Manual measurements can be carried out with the function [Measure].

Proceed as follows:

 

1 Selecting a sensor

￭ Select the desired sensor from the sensor list.
All of the sensors available in the sensor list are displayed. Sensors
are defined under System ▶ Sensors.

￭ Select the measuring input at which the sensor is connected.

 

2 Select a measuring mode

￭ Select the desired measuring mode.
Only those measuring modes are displayed which are advisable
for the selected sensor.
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3 Enter a measuring temperature

￭ Enter the measuring temperature if no temperature sensor is
connected. If a temperature sensor is connected, then the temp-
erature will be measured automatically.
This temperature is used for automatic temperature compensation
with pH measurements.

 

4 Starting the measurement

￭ Tap on [Start].

The measured value display is opened:

The ongoing measurement is canceled with [Stop]. The label
switches once again to [Start].

28.2.1 Parameter description

"Manual control / Measure" dialog

Sensor

Selection of the sensor from the sensor list. Sensors are defined under
System ▶ Sensors.

Selection Selection of configured sensors

Measuring input

Selection of the measuring input the sensor is connected to. The selection
depends on whether the control device has one or two measuring interfa-
ces.

Selection 1 | 2
Default value 1
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Measuring mode

Selection of the measuring mode. Only those measuring modes are dis-
played which are advisable for the selected sensor.

Selection pH | U | Ipol | Upol | Conc | Cond | T

pH
potentiometric pH measurement

U
potentiometric voltage measurement

Ipol
voltametric measurement with selectable polarization current

Upol
amperometric measurement with selectable polarization voltage

Conc
concentration measurement as direct measurement

Cond
conductivity measurement

T
temperature measurement

Temperature

This parameter is not available for conductivity measuring cells.

Temperature entered manually. If a temperature sensor is connected, then
the temperature will be measured continuously. This value is used for
temperature correction in pH and concentration measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Measuring temp.

This parameter is available only with conductivity measurements.

Temperature entered manually. If a temperature sensor is connected then
the temperature will be measured continuously.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

[Temp. compens.]

This button is available only with conductivity measurements.

Edit the parameters for converting the measured conductivity to a refer-
ence temperature.

[Info sensor]

Display information on the sensor.
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"Measure / Temperature compensation" dialog

The parameters for converting the measured conductivity to a reference
temperature are defined under [Temp. compens.].

Reference temp.

The measured conductivity is converted to this temperature.

Input range –20.0 to 150.0 °C
Default value 25.0 °C
Selection off

off
The temperature compensation is disabled.

Temp. compensation

Type of temperature compensation.

Selection constant | ISO / DIN

constant
The temperature compensation is carried out with the value entered
for the temperature coefficient.

ISO / DIN
For ground water, spring water and surface water, the temperature
coefficients according to standard ISO 7888:1985 (German version:
DIN EN 27888:1993) are stored in the system.

Temp. coefficient

This parameter can only be edited with Temp. compensation = con-
stant.

Temperature coefficient belonging to the reference temperature entered
above. With this temperature coefficient, the conductivity is converted to
the reference temperature.

Input range 0.00 to 9.99 %/°C
Default value 0.00 %/°C
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28.3 Dosing

Manual control ▶ Dosing

The following dosing functions are available:

￭ Preparing the exchange or dosing unit (see chapter 28.3.3, page 267)
￭ Emptying the dosing unit (see chapter 28.3.4, page 268)
￭ Filling the dosing cylinder of the exchange unit/dosing unit (see chap-

ter 28.3.5, page 269)
￭ Dosing a specified volume (see chapter 28.3.2, page 265)
￭ Dosing continuously (see chapter 28.3.1, page 263)

Selecting the dosing device

If several dosing devices are connected to a control instrument, then the
dialog for selecting a dosing device will be opened.

[Dosing device X]

Selection of the dosing device. The MSB connector and the type of the
connected dosing device are displayed.

Various information is shown next to the button:

￭ Titrant
For dosing devices of the type 8XX with an intelligent exchange unit or
dosing unit the titrant name is read off the data chip.

￭ Cylinder volume
For dosing devices of the type 6XX or 7XX only the cylinder volume is
displayed.

￭ ---
For exchange or dosing units which are not or not correctly attached.

￭ Manual busy
When a dosing function is being carried out.
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[All dosing devices]

Carrying out the functions [Prepare], [Empty] and [Fill] at the same time
with several dosing devices of the control device.

Selecting the dosing function

If only one dosing device is connected, then the properties of this dosing
device will be shown directly. This information varies according to the type
of dosing device:

￭ Type 8XX with integrated data chip:
If an exchange or dosing unit with integrated data chip is attached, the
data stored on the data chip is displayed.

￭ Type 8XX without integrated data chip:
If an exchange unit without integrated data chip is attached, then the
titrant can be selected from the titrant list. We recommend always
selecting the titrant. This ensures that the parameters defined for the
titrant for the preparing are used. Titrants are defined under Sys-
tem ▶ Titrants.
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[Empty]

Empty the cylinder and the tubings of the dosing unit (see chapter 28.3.4,
page 268).

[Prepare]

Rinse the cylinder and the tubings of the exchange / dosing unit (see
chapter 28.3.3, page 267).

[Fill]

Fill the cylinder of the exchange / dosing unit (see chapter 28.3.5, page
269).

[Dosing fixed vol.]

Dose a specified volume (see chapter 28.3.2, page 265).

[Dosing]

Dose continuously (see chapter 28.3.1, page 263).

28.3.1 Continuous dosing
Manual control: Dosing ▶ Dosing

With the function [Dosing], dosing is continuous for as long as you hold
the button [Dose] pressed down.
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Proceed as follows:

 

1 Configure the dosing function

NOTE

￭ The dosing and filling rates should be decreased for viscous liq-
uids.

￭ The maximum dosing and filling rates depend on the cylinder
volume (see chapter 32, page 503).

￭ Enter the dosing rate.
￭ Enter the filling rate.

 

2 Start dosing

￭ Tap on [Dose].

The volume dosed is displayed. When the volume of one cylinder has
been dosed, the dosing cylinder will be refilled automatically.

 

3 Fill the cylinder

￭ Tap on [Fill].

The dosing cylinder is filled. The displayed volume value will be reset
to 0.0000 mL.

NOTE

If you exit the dialog with the fixed key [ ], the dosing cylinder is
filled automatically.

Parameter description

Dosing rate

Rate at which it is dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum | dynamic
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).
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dynamic
This setting can only be selected when the dosing cylinder is filled. The
dosing is being carried out faster and faster until the maximum dosing
rate is reached (starting with 1 mL/min and then doubling the dosing
rate every 1.5 s).

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

28.3.2 Dosing fixed volumes
Manual control: Dosing ▶ Dosing fixed vol.

You can dose a particular volume with the [Dosing fixed vol.] function.

Proceed as follows:

 

1 Configure the dosing function

NOTE

￭ The dosing and filling rates should be decreased for viscous liq-
uids.

￭ The maximum dosing and filling rates depend on the cylinder
volume (see chapter 32, page 503).

￭ Enter the desired volume.
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￭ Enter the dosing rate.
￭ Enter the filling rate.

 

2 Start dosing

￭ Tap on [Start].

The volume display is shown. When the volume of one cylinder has
been dosed, the dosing cylinder will be refilled automatically.

Continuous dosing is paused with [Hold]. The label changes to
[Continue]. It can be used to resume the run.

 

3 Fill the cylinder

With the default settings (see "Fill automatic.", page 267) the dosing
cylinder is filled automatically.

Otherwise:

￭ Tap on [Fill].

The dosing cylinder is filled. The displayed volume value will be reset
to 0.0000 mL.

Parameter description

Volume

Volume which is dosed.

Input range 0.00000 to 99999.9 mL
Default value 0.10000 mL

Dosing rate

The rate at which dosing takes place.

Input range 0.01 to 166.00 mL/min
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Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

Fill automatic.

on | off (Default value: on)

If this parameter is activated, then the dosing cylinder is being automat-
ically filled at the end of the dosing.

28.3.3 Preparing
Manual control: Dosing ▶ Prepare

The Prepare function is used to rinse and fill the cylinder and tubings of
the exchange or dosing unit air bubble-free. You should carry out this
function before the first determination or once a day.

If the titrant is selected (see "Selecting the dosing function", page 262),
the parameters defined for the titrant for preparing/emptying and the tub-
ing parameters will be used (dosing unit only). If the titrant is not selected,
default parameters will be used (see Chapter 32.2.2, page 504 and Chap-
ter 32.3.2, page 505).

The following two figures show the live display of an exchange unit and a
dosing unit:
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Figure 11 Live display "Preparing the dosing unit"

Figure 12 Live display "Preparing the exchange unit"

28.3.4 Emptying
Manual control: Dosing ▶ Empty

NOTE

The function Empty is possible only with dosing units.

The cylinders and the tubings of the dosing unit are emptied with this
function.

If the titrant is selected (see "Selecting the dosing function", page 262),
the parameters defined for the titrant for preparing/emptying and the tub-
ing parameters will be used. If the titrant is not selected, default parame-
ters will be used (see Chapter 32.3.2, page 505 and Chapter 32.2.2, page
504).
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28.3.5 Filling
Manual control: Dosing ▶ Fill

You can use the function [Fill] to fill the dosing cylinder of the exchange
unit/dosing unit manually. The filling rate cannot be configured; the maxi-
mum filling rate will be used.

28.3.6 Replacing reagent

NOTE

You can easily change the reagent in a dosing unit without no contact
with the chemicals using the functions Prepare and Empty.

Proceed as follows:

 

1 Execute the function [Empty].

 

2 Attach the dosing unit to the bottle with a suitable solvent.

 

3 Execute the function [Prepare].

The last traces of the reagent in the cylinder and tubings are removed
with the solvent.

 

4 Execute the function [Empty] again.

 

5 Attach the dosing unit to the bottle with the new reagent.

 

6 Execute the function [Prepare].

The dosing unit can now be used.
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28.4 Stirring

Manual control ▶ Stir

The MSB connector and type of stirrer is indicated for each connected stir-
rer.

You can control a connected stirrer manually with the function [Stir].

Proceed as follows:

 

1 Setting the stirring rate

￭ Tap on the [–] or [+] button.
Each time one of the buttons is tapped, the stirring rate is reduced
or increased by one level.

 

2 Switching on the stirrer

￭ Tap on [Start].

The stirrer is started.

 

3 Switching off the stirrer

￭ Tap on [Stop].

The stirrer is stopped.

Parameter description

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 28 Manual control

900 Touch Control ￭￭￭￭￭￭￭￭ 271

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

NOTE

If a stirrer is used in the determination run, it can still be manually con-
trolled at the same time. For example, you can use the manual control
to reduce the stirring rate of a stirrer which has been started in the
determination run.

28.5 Conditioning a titration cell

Manual control ▶ Conditioning

In manual control, you have the option of permanently conditioning one
titration cell for Karl Fischer titrations while carrying out a Karl Fischer titra-
tion in a second titration cell.

Proceed as follows:

 

1 Create a method

￭ Create a Karl Fischer method.
￭ Save the method.

 

2 Load the method

￭ Select the memory location where the desired method is saved.
￭ Tap on the input field File name.

The method table with the saved methods is opened.
￭ Select the desired method.

 

3 Start the conditioning

￭ Tap on [Start].

The working medium is titrated to the endpoint. The status is kept
stable.
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28.5.1 Parameter description

Memory

Memory location the method is loaded from. All memory locations are
selectable, even if they are currently not accessible.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
Shared directory in the network.

File name

Selection of the method.

Selection Selection of stored methods

28.6 Remote

Manual control ▶ Remote

With the function [Remote], you can define manual output signals to the
remote interface of a connected Remote Box. It is not possible to define
input signals; the current status of the input lines is, however, displayed.

Inputs

Current status of the input lines.

Outputs

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.
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Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal 00000000000001 line 0 is set. With a pulse, the length is set to 200
ms. If you wish to set pulses with other lengths, you have to define a cor-
responding template.

Entry Bit pattern containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value 00000000000001
Selection Selection of the templates defined

[Set]

Set a defined output signal.

28.7 Sample Processor

Manual control ▶ Sample Processor

With the function [Sample Processor], you can control a connected
Sample Processor manually. The following functions are available:

￭ Rotating the sample rack
￭ Moving the lift
￭ Defining specific lift positions (work position, rinse position, etc.)
￭ Switching pumps on and off
￭ Initializing the rack
￭ Defining external positions outside of the sample rack (only with Swing

Head)



28.7 Sample Processor ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

274 ￭￭￭￭￭￭￭￭ 900 Touch Control

Tower for the manual control.

Selection Tower 1 | Tower 2

Tower 1
View from the front, the right tower.

Tower 2
View from the front, the left tower. This selection is only available for
Sample Processors with two towers.

Lift position

Current lift position.

Rack position

Current rack position. If the rack is not set to a valid position, e.g. after a
rack reset, -- is displayed to indicate this.

NOTE

Note that the rack has to be set to a valid position for all lift move-
ments! Otherwise a corresponding error message will be displayed.

Move to a valid rack position with [Previous] or [Next]. Alternatively,
you can carry out a MOVE command.

[Home position]

Move the lift to the home position (corresponds to lift position 0 mm).

[Work position]

Move the lift to the work position of the current rack position or the exter-
nal position.

The work position can directly be defined here (see "Assigning lift posi-
tions", page 276) or in the device manager (see "Lift positions Tower 1/2",
page 106).

[↑]
Continuously move the lift upwards as long as the button is pressed
down. The lift rate used is defined in the dialog Sample Processor / Lift.

[↓]
Continuously move the lift downwards as long as the button is pressed
down. The lift rate used is defined in the dialog Sample Processor / Lift.

[Previous]

Move to the previous rack position.

[Next]

Move to the next rack position.
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[Reset rack]

Initialize the rack. This function is identical with the command RACK. The
following actions are carried out:

￭ The lift is moved upwards.
￭ The sample rack is rotated to the starting position.
￭ The rack code of the rack attached is being read out and the corre-

sponding rack data is transferred to the Sample Processor.
￭ The sample variable is being reset to the value 1.

[Pump]

Switch on and off the pumps mounted or connected to the tower.

[Lift]

Move the lift to any or a specific lift position and assigning lift positions
(see chapter 28.7.1, page 275).

[Rack position]

Move the rack to any sample position or to defined positions which are
defined as special beakers (see chapter 28.7.2, page 277).

[External position]

This button is only enabled when a Swing Head is mounted to the Sample
Processor.

Swing the robotic arm to an external position outside the sample rack and
assign the swing angle and the lift position (see chapter 28.7.3, page
279).

28.7.1 Moving the lift
Manual control: Sample Processor ▶ Lift

In the dialog Sample Processor / Lift, you can move the lift to any lift
position. You can also define frequently used positions (work position,
rinse position, etc.) as specific lift positions and then to move to them with
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ease (see "Assigning lift positions", page 276). This definition is possible in
this dialog for the attached rack, and in the device manager for all of the
racks in the list.

Current lift pos.

Current lift position.

Move to lift pos.

Selecting a predefined lift position or enter any lift position.

Input range 0 to 'maximum stroke path' mm
A lift position of 0 mm corresponds to the "home
position", i.e. the lift is located at the upper stop
position. The maximum stroke path is defined in the
properties of the tower (see "Maximum stroke
path", page 96). If a higher value is entered, an
error message will be displayed.

Selection Work position | Shift position | Rinse position |
 Special position

Default value Work position

Lift rate

Rate at which the lift is moved in the manual control.

Input range 5 to 25 mm/s
Default value 25 mm/s

[Assign lift pos.]

Assign the current lift position to a preset lift position.

Assigning lift positions

Specific lift position are stored separately for every sample rack used as
well as for tower 1 and tower 2. The following specific lift positions are
available:

￭ General rack positions
For general rack positions you can define one work position, one shift
position and one rinse position as well as one special position.

￭ Special beaker positions
A specific work position can be defined for each special beaker. The
definitions of the general rack positions are used for the shift position,
rinse position and special position of the affected tower.
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￭ External positions (only with robotic arm and mounted Swing Head,
see Chapter 28.7.3, page 279)
For each of the four possible external positions, a specific work posi-
tion can be defined. Shift position and rinse position can only be
defined for all four external positions commonly. A special position is
not possible.

Proceed as follows to assign the current lift position to a specific lift posi-
tion:

 

1 Move to lift position

￭ Enter the desired lift position in mm and tap on [Start].

The lift moves to the desired lift position.

 

2 Assign lift position

￭ Tap on [Assign lift pos.].
The Lift / Assign lift position dialog is displayed:

￭ Select the desired specific lift position and tap on [Assign].

The current lift position is assigned to the specific lift position.

28.7.2 Moving to a rack position
Manual control: Sample Processor ▶ Rack position
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In the dialog Sample Processor / Rack position, you can move to any
position on the attached rack.

Current rack pos.

Current rack position. If the rack is not set to a valid position, e.g. after a
rack reset, -- is displayed to indicate this.

Rack position

Desired rack position.

Input range 1 to Number of positions on the rack
attached. 

Default value 1 
Selection Special beaker 1…16

Special beaker 1…16
The selection depends on how many rack positions are defined as spe-
cial beakers (see "Editing special beakers", page 107).

Shift rate

Rate at which the sample rack is moved.

Input range 3 to 20 °/s
Default value 20 °/s

Shift direction

Direction in which the rack is moved.

Selection auto | + | -
Default value auto

auto
A shift direction, with which the shorter way has to be passed, is auto-
matically selected.
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+
Counterclockwise rotation.

-
Clockwise rotation.

Swing rate

Rate at which the robotic arm is swung in the manual control.

Input range 10 to 55 °/s
Default value 55 °/s

28.7.3 External positions
Manual control: Sample Processor ▶ External position

NOTE

This dialog is accessible only if you have a Swing Head with robotic arm
attached to the Sample Processor.

In the dialog Sample Processor / External position, you can swivel the
robotic arm to an external position outside of the sample rack. As with the
rack positions, here you can also define up to four frequently used exter-
nal positions as specific positions. You can assign specific lift positions to
these positions, analogous to the rack positions.

External positions are required if you have, for example, a measuring ves-
sel or a titration cell mounted in addition to the rack.

Lift position

Current lift position.

Angle

Current angle position of the robotic arm.
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[↑]
Only enabled, when the robotic arm has been moved to a specific external
position with [Start].

Continuously move the lift upwards as long as the button is pressed
down. The lift rate used is defined in the dialog Sample Processor / Lift.

[↓]
Only enabled, when the robotic arm has been moved to a specific external
position with [Start].

Continuously move the lift downwards as long as the button is pressed
down. The lift rate used is defined in the dialog Sample Processor / Lift.

[⇦]

Swing the robotic arm in clockwise direction as long as the button is
pressed down.

[⇨]

Swing the robotic arm in counterclockwise direction as long as the button
is pressed down.

Swing rate

Rate at which the robotic arm is swung in the manual control.

Input range 10 to 55 °/s
Default value 55 °/s

Move to ext. pos.

Selecting a predefined position or entering any swing angle.

Input range (Offset) to (Offset + max. swing range) °
The offset is made up of a design-dependent angle
(approx. 8...9°) together with the robotic arm offset
from the robotic arm properties. The maximum
swing range is also defined under the robotic arm
properties (see "Properties – Robotic arm", page
99).

Selection External position 1…4

[Assign Ext. pos.]

Assign the current angle position of the robotic arm to an external posi-
tion as swing angle.

[Assign lift pos.]

Assign the current lift position to a preset lift position.
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Assigning swing angles and lift positions

For each of the four possible external positions, a specific work position
can be defined. Shift position and rinse position can only be defined for all
four external positions commonly. A special position is not possible.

Proceed as follows to assign a swing angle to an external position and to
assign the current lift position to a specific lift position:

 

1 Move to the external position

￭ Swing the robotic arm to the desired position with the arrow keys
[⇦] or [⇨].

 

2 Assign the external position

￭ Tap on [Assign Ext. pos.].
The External position / Assign swing angle dialog is dis-
played:

￭ Select the desired external position and tap on [Assign].

The current angle position of the robotic arm is assigned to the exter-
nal position.

 

3 Move to the external position

￭ Tap on [ ].
The next higher-level dialog is displayed.

￭ Select Move to ext. pos. = External position X (X = 1…4) and
tap on [Start].

The robotic arm swings to the desired position.

 

4 Move to lift position

￭ Move the lift to the desired height with the arrow keys [⇧] or [⇩].
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5 Assign lift position

￭ Tap on [Assign lift pos.].
The Lift / Assign lift position dialog is displayed:

￭ Select the desired specific lift position.
￭ Tap on [Assign].

The current lift position is assigned to the specific lift position.

28.8 885 Compact Oven SC

Manual control ▶ Sample Processor

You can control a connected 885 Compact Oven SC manually with the
[Sample Processor] function. The following functions are available:

￭ Initializing the rack
￭ Settings for the heating and the gas flow

Lift position

Current lift position.
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Rack position

Current rack position. If the rack is not set to a valid position, e.g. after a
rack reset, -- is displayed to indicate this.

NOTE

Note that the rack has to be set to a valid position for all lift move-
ments! Otherwise a corresponding error message will be displayed.

Move to a valid rack position with [Previous] or [Next]. Alternatively,
you can carry out a MOVE command.

[Home position]

Move the lift to the home position (corresponds to lift position 0 mm).

[Work position]

Move the lift to the work position of the current rack position.

The work position for sample beakers and conditioning beakers is defined
in the device manager (see chapter 11.7.2, page 112).

[↑]
Move the lift continuously upwards as long as the button is pressed down.
The lift moves in 6 mm steps.

[↓]
Move the lift continuously downwards as long as the button is pressed
down. The lift moves in 6 mm steps.

[Previous]

Move to the previous rack position.

[Next]

Move to the next rack position.

[Reset rack]

Initialize the rack. This function is identical with the command RACK. The
following actions are carried out:

￭ The lift is moved upwards.
￭ The sample rack is rotated to the starting position.
￭ The sample variable is reset to the value 1.

[Heater Gas flow]

Display, control and settings of the current temperature and current gas
flow.
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28.8.1 Controlling the heating/gas flow
Manual control: Sample Processor ▶ Heater Gas flow

You can see, control and set the current temperature and current gas flow
in the Sample Processor / Heater Gas flow dialog.

[Gas flow]

Edit parameters for the gas flow.

[Heater]

Edit parameters for the heater.

[Start / Stop Gas flow]

Starts or stops the gas flow.

[Start / Stop Heater]

Starts or stops the heater.

Settings for the gas flow

Flow rate

Flow rate for the gas flow.

Input range 10 to 150 mL/min (Increment: 1)
Default value 50 mL/min

Gas supply

Selection of the gas supply.

Selection pump | valve
Default value pump

pump
The integrated air pump is used for the gas flow.
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valve
The integrated inlet valve is used for the gas flow. The inlet valve in the
885 Compact Oven SC is connected to compressed air or nitrogen.

Gas type

Gas type of the carrier gas used.

Selection air | nitrogen
Default value air

Settings for the oven temperature

Temperature

Temperature to which the oven is heated.

Input range 50 to 250 °C (Increment: 1)
Default value 110 °C
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29 Parameters

NOTE

For most of the numerical parameters, the result of a calculation can
also be utilized in place of a number. A description of this can be found
in the appendix (see chapter 32.6, page 507).

29.1 Dynamic equivalence point titrations (DET)

29.1.1 Start conditions
The parameters that are carried out before the start of titration are
defined under [Start conditions]. The start conditions are processed in
the following sequence:

1. Start volume
2. Start measured value
3. Start slope
4. Pause

Start volume

Volume that is dosed prior to the start of the titration.

Input range 0.00000 to 9999.99 mL
Default value 0.00000 mL

Dosing rate

Rate at which the start volume is dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Pause

Waiting time, e.g. for the electrode to settle down after the start or a
reaction time after the dosing of a start volume. The time entered here is
only running when all start conditions have been fulfilled.

Input range 0 to 999999 s
Default value 0 s
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More start conditions

Start meas. value

Before starting the titration, it will be dosed until this measured value is
reached. If the start measured value is reached by the dosing of a start
volume, then the titration starts directly.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U, Ipol:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Measuring mode Upol:
Input range –200.0 to 200.0 µA
Selection off
Default value off

Start slope

Before starting the titration, it will be dosed until this slope (measured
value per volume) is reached. If the start slope is reached by the dosing of
a start volume, then the titration starts directly.

Measuring mode pH:
Input range 00.000 to 9,999 pH/mL
Selection off
Default value off

Measuring mode U, Ipol:
Input range 0 to 999 mV/mL
Selection off
Default value off

Measuring mode Upol:
Input range 0 to 99 µA/mL
Selection off
Default value off
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Dosing rate

Rate to be dosed with until the start measured value or the start slope is
reached.

Input range 0.01 to 166.00 mL/min
Default value 5.00 mL/min
Selection maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Initial measured value

The [Initial meas. value] is measured before carrying out the start con-
ditions. This value is used for the titration direction determination,
which is necessary for the start measured value and stop measured
value parameters.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.

Measuring mode pH, U and Ipol:
Input range 0.1 to 999.0 mV/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.
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Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 1 s

29.1.2 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For titrations in which the finest details are also to be visible. This could
however also lead to an increase in noise, which could result in unwan-
ted equivalence points.

optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For fast and less critical titrations.

user
The individual titration parameters can be modified.

NOTE

Select optimal as titration rate when you are developing a new titra-
tion method. This parameter is suitable for virtually all titrations and
only needs adaptation in special cases.

The settings of the individual titration rates are listed in table 9, page 292.

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
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of the command). This value is used for temperature correction in pH
measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

User-defined parameters

These parameters are only accessible when Titration rate = user.

Meas. point density

A small value means small volume increments, i.e. a high measuring point
density. The curve then shows all the finest details which also include
noise; this could cause unwanted equivalence points to be found. A larger
value, i.e. a smaller measuring point density, permits quicker titrations. If
you are using a dosing device with a small cylinder volume then a smaller
measuring point density value may be beneficial. However, you should
also set a smaller signal drift and a higher EP criterion at the same time.

Input range 0 to 9 
Default value 4 

Min. increment

This smallest permitted volume increment is added at the start of the titra-
tion and with steep curves in the region of the equivalence point. Very
small values should only be used if a low titrant consumption is expected;
otherwise unwanted equivalence points could be evaluated.

Input range 0.05 to 999.90 µL
Default value 10.00 µL

Max. increment

A maximum volume increment should be selected in the following cases:

￭ when titration consumption is very low up until the equivalence point
is reached.

￭ when a start volume is dosed up until shortly before the equivalence
point is reached.

￭ when the change of direction in the jumping range is very abrupt,
because otherwise it could easily happen that an excessively large vol-
ume will be dosed in the region of the equivalence point.

The value should not be less than 1/100 cylinder volume.

Input range 0.1 to 9999.9 µL
Selection off
Default value off
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NOTE

It is not advisable to select similar volumes for the minimum and the
maximum increment. Monotonic equivalence point titration (MET) is
appropriate for these applications.

Dosing rate

Rate at which the volume increments are dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. This type of titration is
often referred to as equilibrium titration. For this value, a suitable maxi-
mum waiting time is automatically calculated except you already have
modified this waiting time.

NOTE

A constant measured value is often only reached after a certain time, as
mixing and the reaction itself require a certain time. The response time
of an electrode can also increase with time, i.e. reaching a constant
measured value takes longer and longer. Drift-controlled measured
value acceptance is particularly advisable in such cases, as the measured
values are only accepted when equilibrium has almost been reached.

Measuring mode pH, U and Ipol:
Input range 0.1 to 999.0 mV/min
Default value 50.0 mV/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed. This can be useful when the titration reaction pro-
ceeds slowly or the electrode is slow to respond.
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Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Default value 50.00 µA/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed. This can be useful when the titration reaction pro-
ceeds slowly or the electrode is slow to respond.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 26 s

Table 9 Default values of the predefined titration rates for DET

 Titration rate

slow optimal fast

Meas. point density 2 4 6

Min. increment 10.00 µL 10.00 µL 30.00 µL

Max. increment off off off

Dosing rate maximum maximum maximum

Signal drift

– pH, U and Ipol

– Upol

20.0 mV/min

20.0 µA/min

50.0 mV/min

50.0 µA/min

80.0 mV/min

80.0 µA/min

Min. waiting time 0 s 0 s 0 s

Max. waiting time 38 s 26 s 21 s
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29.1.3 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions].

Stop volume

The titration is stopped when the specified volume has been dosed since
the start of the titration. This volume should be adjusted to the size of the
titration vessel in order to prevent the contents from running over.

Input range 0.00000 to 9999.99 mL
Default value 100,000 mL
Selection off

Stop meas. value

The titration is canceled when the specified measured value has been
reached since the start of the titration.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U, Ipol:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Measuring mode Upol:
Input range –200.0 to 200.0 µA
Selection off
Default value off

Stop EP

The titration is stopped when the specified number of equivalence points
has been found.

Input range 1 to 9 
Default value 9 
Selection off
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Volume after EP

This volume will be added when the number of equivalence points
defined under Stop EP has been found. The curve shape after the equiva-
lence point can also be seen this way.

Input range 0.01000 to 9999.99 mL
Selection off
Default value off

Stop time

The titration is stopped when the specified time has elapsed since the start
of the titration.

Input range 0 to 999999 s
Selection off
Default value off

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

29.1.4 Potentiometric evaluation
The parameters for the evaluation of the titration curve are defined under
[Potentiometr. evaluation].

EP criterion

The Equivalence point Recognition Criterion (ERC) found is compared with
this value. Equivalence points whose ERC is less than the value defined
here will be ignored.

Input range 0 to 200 
Default value 5 

EP recognition

This parameter allows you to filter out only the equivalence points that are
being sought.

Selection all | greatest | last | ascending | descending |
 off

Default value all
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all
All equivalence points will be recognized.

greatest
Only the equivalence point with the greatest ERC value, i.e. the steep-
est jump, will be recognized.

last
Only the last equivalence point will be recognized.

ascending
Only equivalence points with a positive slope of the titration curve will
be recognized.

descending
Only equivalence points with a negative slope of the titration curve will
be recognized.

off
No evaluation takes place.

Set windows

This parameter allows to recognize equivalence points only in a particular
range (so-called window) of the curve. Equivalence points outside this
window will not be recognized. A maximum of 9 windows can be
defined. Setting windows is advisable when interference and unnecessary
equivalence points are to be suppressed.

Selection Measured value | Volume | off
Default value off

Measured value
The windows are defined on the measured value axis.

Volume
The windows are defined on the volume axis.

off
The entire titration curve is being evaluated.

Setting windows

The list of defined windows is opened with [Set window].

When the list is opened for the first time, a window over the entire
measured value range or volume range is already defined. The windows
must not overlap, they only may lie next to one another. For each win-
dow, own criteria can be defined for the equivalence point recognition.
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NOTE

When you define a result variable instead of a numerical value as limit
value (see chapter 32.6, page 507), then just one window can be
defined.

[New]

Define a new window. This is only possible when not the entire range is
covered yet.

[Delete]

Delete the selected window.

[Edit]

Edit the settings of the selected window.

Lower limit

Measured value or volume for the lower limit.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measured value (measuring mode pH):
Input range –20.000 to 20.000 
Default value –20.000 

Measured value (measuring mode U, Ipol):
Input range –2000.0 to 2000.0 mV
Default value –2000.0 mV

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Default value –200.00 µA

Volume:
Input range 0.00000 to 9999.99 mL
Default value 0.00000 mL

Upper limit

Measured value or volume for the upper limit.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.
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Measured value (measuring mode pH):
Input range –20.000 to 20.000 
Default value 20.000 

Measured value (measuring mode U, Ipol):
Input range –2000.0 to 2000.0 mV
Default value 2000.0 mV

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Default value 200.00 µA

Volume:
Input range 0.00000 to 9999.99 mL
Default value 9999.99 mL

EP criterion

The Equivalence point Recognition Criterion (ERC) found is compared with
this value. Equivalence points whose ERC is less than the value defined
here will be ignored.

Input range 0 to 200 
Default value 5 

EP recognition

This parameter allows you to filter out only the equivalence points that are
being sought.

Selection first | greatest | last | ascending | descending
Default value first

first
Only the first equivalence point will be recognized.

greatest
Only the equivalence point with the greatest ERC value, i.e. the steep-
est jump, will be recognized.

last
Only the last equivalence point will be recognized.

ascending
Only equivalence points with a positive slope of the titration curve will
be recognized.

descending
Only equivalence points with a negative slope of the titration curve will
be recognized.

Only one equivalence point will be recognized in a window. The number-
ing of the equivalence points (EP) is defined by the numbering of the win-
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dows (e.g. EP2 in window 2), so that even if EPs are missing, the calcula-
tions will still be carried out with the correctly assigned EP volumes.

EP1

EP window 2

EP window 1

EP2

U/mV

V/mL

EP window 1

EP1

+

U/mV

V/mL

lower limit 1

upper limit 1

Figure 13 Equivalence point recognition and equivalence point num-
bering within windows

In the first example in the above figure, two equivalence points are recog-
nized in two different windows (EP1 in window 1 and EP2 in window 2).
In the second example, two equivalence points are found in one window,
but only the first one is recognized. In order to ensure that the user recog-
nizes that more than one equivalence point was found in the set window,
EP1 is marked with a "+" in the result view. In addition, a corresponding
message is entered in the message list.

Evaluation and equivalence point criterion with DET

The equivalence points (EP) are localized in a way similar to the Tubbs
method [1][2]. The volume value of the equivalence point (VE) is shifted
from the inflection point (see arrow) towards the smaller circle of curva-
ture for real asymmetric titration curves.

[1] C. F. Tubbs, Anal. Chem. 1954, 26, 1670–1671.

[2] E. Bartholomé, E. Biekert, H. Hellmann, H. Ley, M. Weigert, E. Weise,
Ullmanns Encyklopädie der technischen Chemie, Vol. 5, Verlag Chemie,
Weinheim, 1980, p. 659.

VE

pH

V/mL

Figure 14 Tubbs method for determining the equivalence point
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The figure shows that the evaluation still requires measured values from
the measuring point list even after the equivalence point.

For the recognition of the EPs found, the set EP criterion is compared to
the ERC (Equivalence point Recognition Criterion) found. The ERC is the
first derivative of the titration curve combined with a mathematical func-
tion that is more sensitive for flat jumps than for steeper ones. EPs whose
ERC is smaller than the defined EP criterion will not be recognized. The
ERC is displayed in the results dialog for each discovered and recognized
EP. If you adjust the EP criterion later in order to recognize more or fewer
EPs, then you can reevaluate the determination ([Recalculate] function in
the results dialog).

29.1.5 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.1.6 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
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determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement. This parameter is available only
with I(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Default value 5.0 µA
Selection –1.0 µA | 1.0 µA

U(pol)

The polarization voltage is the voltage applied to the polarizable electrode
during an amperometric measurement. This parameter is available only
with U(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –1,250 to 1,250 mV (Increment: 25)
Default value 400 mV

Electrode check

on | off (Default value: off)

For the following electrodes, an electrode check can be carried out:

￭ pH electrodes
￭ Metal electrodes
￭ Ion-selective electrodes

A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started. Note that this electrode check has nothing to do with the
electrode test (command ELT).

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic
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continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.1.7 Dosing device
The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.
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29.1.8 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.2 Monotonic equivalence point titrations (MET)

29.2.1 Start conditions
The parameters that are carried out before the start of titration are
defined under [Start conditions]. The start conditions are processed in
the following sequence:

1. Start volume
2. Start measured value
3. Start slope
4. Pause

Start volume

Volume that is dosed prior to the start of the titration.
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Input range 0.00000 to 9999.99 mL
Default value 0.00000 mL

Dosing rate

Rate at which the start volume is dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Pause

Waiting time, e.g. for the electrode to settle down after the start or a
reaction time after the dosing of a start volume. The time entered here is
only running when all start conditions have been fulfilled.

Input range 0 to 999999 s
Default value 0 s

More start conditions

Start meas. value

Before starting the titration, it will be dosed until this measured value is
reached. If the start measured value is reached by the dosing of a start
volume, then the titration starts directly.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U, Ipol:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Measuring mode Upol:
Input range –200.0 to 200.0 µA
Selection off
Default value off
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Start slope

Before starting the titration, it will be dosed until this slope (measured
value per volume) is reached. If the start slope is reached by the dosing of
a start volume, then the titration starts directly.

Measuring mode pH:
Input range 00.000 to 9,999 pH/mL
Selection off
Default value off

Measuring mode U, Ipol:
Input range 0 to 999 mV/mL
Selection off
Default value off

Measuring mode Upol:
Input range 0 to 99 µA/mL
Selection off
Default value off

Dosing rate

Rate to be dosed with until the start measured value or the start slope is
reached.

Input range 0.01 to 166.00 mL/min
Default value 5.00 mL/min
Selection maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Initial measured value

The [Initial meas. value] is measured before carrying out the start con-
ditions. This value is used for the titration direction determination,
which is necessary for the start measured value and stop measured
value parameters.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.

Measuring mode pH, U and Ipol:
Input range 0.1 to 999.0 mV/min
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Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 1 s

29.2.2 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For titrations in which the finest details are also to be visible. This could
however also lead to an increase in noise, which could result in unwan-
ted equivalence points.
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optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For fast and less critical titrations.

user
The individual titration parameters can be modified.

NOTE

Select optimal as titration rate when you are developing a new titra-
tion method. This parameter is suitable for a lot of titrations and only
needs adaptation in special cases.

The settings of the individual titration rates are listed in table 10, page
308.

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command). This value is used for temperature correction in pH
measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

User-defined parameters

These parameters are only accessible when Titration rate = user.

Volume increment

The volume that is dosed at each dosing step. High accuracy requires
using the correct volume increment.

A good guideline for the volume increment is 0.1 mL. A total of 20 dosing
steps is recommended until the equivalence point is reached.

With greater consumption, the titration time can be optimized using the
start conditions. Smaller volume increments (smaller than 0.1 mL) are
required to determine blank values or to ensure accuracy with highly
asymmetric curves. Larger volume increments are advisable for flatter
curves.
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NOTE

The accuracy of the evaluation cannot be increased by using smaller
increments as the measured value changes between two measuring
points are then of the same order of magnitude as the noise.

Input range 0.00005 to 999.900 mL
Default value 0.10000 mL

Dosing rate

Rate at which the volume increments are dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. This type of titration is
often referred to as equilibrium titration. For this value, a suitable maxi-
mum waiting time is automatically calculated except you already have
modified this waiting time.

NOTE

A constant measured value is often only reached after a certain time, as
mixing and the reaction itself require a certain time. The response time
of an electrode can also increase with time, i.e. reaching a constant
measured value takes longer and longer. Drift-controlled measured
value acceptance is particularly advisable in such cases, as the measured
values are only accepted when equilibrium has almost been reached.

Measuring mode pH, U and Ipol:
Input range 0.1 to 999.0 mV/min
Default value 50.0 mV/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed. This can be useful when the titration reaction pro-
ceeds slowly or the electrode is slow to respond.
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Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Default value 50.00 µA/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed. This can be useful when the titration reaction pro-
ceeds slowly or the electrode is slow to respond.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 26 s

Table 10 Default values of the predefined titration rates for MET

 Titration rate

slow optimal fast

Volume increment 0.05000 mL 0.10000 mL 0.20000 mL

Dosing rate maximum maximum maximum

Signal drift

– pH, U and Ipol

– Upol

20.0 mV/min

20.0 µA/min

50.0 mV/min

50.0 µA/min

80.0 mV/min

80.0 µA/min

Min. waiting time 0 s 0 s 0 s

Max. waiting time 38 s 26 s 21 s
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29.2.3 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions].

Stop volume

The titration is stopped when the specified volume has been dosed since
the start of the titration. This volume should be adjusted to the size of the
titration vessel in order to prevent the contents from running over.

Input range 0.00000 to 9999.99 mL
Default value 100,000 mL
Selection off

Stop meas. value

The titration is canceled when the specified measured value has been
reached since the start of the titration.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U, Ipol:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Measuring mode Upol:
Input range –200.0 to 200.0 µA
Selection off
Default value off

Stop EP

The titration is stopped when the specified number of equivalence points
has been found.

Input range 1 to 9 
Default value 9 
Selection off
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Volume after EP

This volume will be added when the number of equivalence points
defined under Stop EP has been found. The curve shape after the equiva-
lence point can also be seen this way.

Input range 0.01000 to 9999.99 mL
Selection off
Default value off

Stop time

The titration is stopped when the specified time has elapsed since the start
of the titration.

Input range 0 to 999999 s
Selection off
Default value off

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

29.2.4 Potentiometric evaluation
The parameters for the evaluation of the titration curve are defined under
[Potentiometr. evaluation].

EP criterion

The Equivalence point Recognition Criterion (ERC) found is compared with
this value. Equivalence points whose ERC is less than the value defined
here will be ignored.

Measuring mode pH:
Input range 0.10 to 9.99 
Default value 0.50 

Measuring mode U, Ipol:
Input range 1 to 999 mV
Default value 30 mV
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Measuring mode Upol:
Input range 0.1 to 99.9 µA
Default value 2.0 µA

EP recognition

This parameter allows you to filter out only the equivalence points that are
being sought.

Selection all | greatest | last | ascending | descending |
 off

Default value all

all
All equivalence points will be recognized.

greatest
Only the equivalence point with the greatest ERC value, i.e. the steep-
est jump, will be recognized.

last
Only the last equivalence point will be recognized.

ascending
Only equivalence points with a positive slope of the titration curve will
be recognized.

descending
Only equivalence points with a negative slope of the titration curve will
be recognized.

off
No evaluation takes place.

Set windows

This parameter allows to recognize equivalence points only in a particular
range (so-called window) of the curve. Equivalence points outside this
window will not be recognized. A maximum of 9 windows can be
defined. Setting windows is advisable when interference and unnecessary
equivalence points are to be suppressed.

Selection Measured value | Volume | off
Default value off

Measured value
The windows are defined on the measured value axis.

Volume
The windows are defined on the volume axis.

off
The entire titration curve is being evaluated.
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Setting windows

The list of defined windows is opened with [Set window].

When the list is opened for the first time, a window over the entire
measured value range or volume range is already defined. The windows
must not overlap, they only may lie next to one another. For each win-
dow, own criteria can be defined for the equivalence point recognition.

NOTE

When you define a result variable instead of a numerical value as limit
value (see chapter 32.6, page 507), then just one window can be
defined.

[New]

Define a new window. This is only possible when not the entire range is
covered yet.

[Delete]

Delete the selected window.

[Edit]

Edit the settings of the selected window.

Lower limit

Measured value or volume for the lower limit.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measured value (measuring mode pH):
Input range –20.000 to 20.000 
Default value –20.000 

Measured value (measuring mode U, Ipol):
Input range –2000.0 to 2000.0 mV
Default value –2000.0 mV

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Default value –200.00 µA

Volume:
Input range 0.00000 to 9999.99 mL
Default value 0.00000 mL



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 29 Parameters

900 Touch Control ￭￭￭￭￭￭￭￭ 313

Upper limit

Measured value or volume for the upper limit.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measured value (measuring mode pH):
Input range –20.000 to 20.000 
Default value 20.000 

Measured value (measuring mode U, Ipol):
Input range –2000.0 to 2000.0 mV
Default value 2000.0 mV

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Default value 200.00 µA

Volume:
Input range 0.00000 to 9999.99 mL
Default value 9999.99 mL

EP criterion

The Equivalence point Recognition Criterion (ERC) found is compared with
this value. Equivalence points whose ERC is less than the value defined
here will be ignored.

Measuring mode pH:
Input range 0.10 to 9.99 
Default value 0.50 

Measuring mode U, Ipol:
Input range 1 to 999 mV
Default value 30 mV

Measuring mode Upol:
Input range 0.1 to 99.9 µA
Default value 2.0 µA

EP recognition

This parameter allows you to filter out only the equivalence points that are
being sought.

Selection first | greatest | last | ascending | descending
Default value first
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first
Only the first equivalence point will be recognized.

greatest
Only the equivalence point with the greatest ERC value, i.e. the steep-
est jump, will be recognized.

last
Only the last equivalence point will be recognized.

ascending
Only equivalence points with a positive slope of the titration curve will
be recognized.

descending
Only equivalence points with a negative slope of the titration curve will
be recognized.

Only one equivalence point will be recognized in a window. The number-
ing of the equivalence points (EP) is defined by the numbering of the win-
dows (e.g. EP2 in window 2), so that even if EPs are missing, the calcula-
tions will still be carried out with the correctly assigned EP volumes.

EP1

EP window 2

EP window 1

EP2

U/mV

V/mL

EP window 1

EP1

+

U/mV

V/mL

lower limit 1

upper limit 1

Figure 15 Equivalence point recognition and equivalence point num-
bering within windows

In the first example in the above figure, two equivalence points are recog-
nized in two different windows (EP1 in window 1 and EP2 in window 2).
In the second example, two equivalence points are found in one window,
but only the first one is recognized. In order to ensure that the user recog-
nizes that more than one equivalence point was found in the set window,
EP1 is marked with a "+" in the result view. In addition, a corresponding
message is entered in the message list.

Evaluation and equivalence point criterion with MET

The equivalence points (EPs) are localized by a method based on the For-
tuin method which has been adapted by Metrohm for numerical methods.

A search is made for the largest measured value change ( ). The exact EP
is determined by using an interpolation factor  which depends on the

Δ values before and after .
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: EP volume

: Dosed total volume before 

: Volume increment

: Interpolation factor according to Fortuin

For the recognition of the EPs found, the set EP criterion is compared to
the ERC (Equivalence point Recognition Criterion) found. The ERC is the
sum of the measured value changes before and after the jump:

In certain cases only three or only one summand is taken into account.

EPs whose ERC is smaller than the defined EP criterion will not be recog-
nized. The ERC is displayed in the results dialog for each discovered and
recognized EP. If you adjust the EP criterion later in order to recognize
more or fewer EPs, then you can reevaluate the determination ([Recalcu-
late] function in the results dialog).

29.2.5 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.2.6 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.
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Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement. This parameter is available only
with I(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Default value 5.0 µA
Selection –1.0 µA | 1.0 µA

U(pol)

The polarization voltage is the voltage applied to the polarizable electrode
during an amperometric measurement. This parameter is available only
with U(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –1,250 to 1,250 mV (Increment: 25)
Default value 400 mV

Electrode check

on | off (Default value: off)

For the following electrodes, an electrode check can be carried out:

￭ pH electrodes
￭ Metal electrodes
￭ Ion-selective electrodes

A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started. Note that this electrode check has nothing to do with the
electrode test (command ELT).
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Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.2.7 Dosing device
The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.
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29.2.8 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.3 Endpoint titrations (SET)

29.3.1 Start conditions
The parameters that are carried out before the start of titration are
defined under [Start conditions].

Pause 1

Waiting time, e.g. for the electrode to settle down before a start volume is
added.

Input range 0 to 999999 s
Default value 0 s
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Start volume

Volume that is dosed prior to the start of the titration.

Input range 0.00000 to 9999.99 mL
Default value 0.00000 mL

Dosing rate

Rate at which the start volume is dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Pause 2

Waiting time, e.g. for the electrode to settle down after the start or a
reaction time after the dosing of a start volume.

Input range 0 to 999999 s
Default value 0 s

Initial measured value

The [Initial meas. value] is measured before carrying out the start con-
ditions. This value is used for the titration direction determination
when the titration direction is set to auto and only 1 EP is defined.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.

Measuring mode pH, U and Ipol:
Input range 0.1 to 999.0 mV/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Selection off
Default value off
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off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 1 s

29.3.2 Control parameters
The control parameters for endpoint 1 and endpoint 2 are defined under
[Control parameters].

Endpoint 1 at

Measured value for the first endpoint.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U and Ipol:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Measuring mode Upol:
Input range –200.00 to 200.00 µA
Selection off
Default value off
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Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For steep titration curves for which dosing must be carried out in small
steps at the endpoint.

optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For flat titration curves for which the endpoint is reached only slowly.

user
The individual titration parameters can be modified.

The settings of the individual titration rates are listed in table 11, page
322.

User-defined parameters

These parameters are only accessible when Titration rate = user.

Dynamics

This parameter defines the control range before the specified endpoint.
Individual volume steps are dosed in the control range; the dosing is finely
controlled. The closer the endpoint, the slower the dosing until the dosing
rate defined under Min. rate has been reached. The larger the control
range, the slower the titration. Outside of the control range, dosing is car-
ried out continuously; the dosing rate is defined under Max. rate.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range 0.001 to 20.000 
Default value 2.000 
Selection off

Measuring mode U and Ipol:
Input range 0.1 to 2000.0 mV
Default value 100.0 mV
Selection off
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Measuring mode Upol:
Input range 0.01 to 200.00 µA
Default value 10.00 µA
Selection off

Max. rate

Rate at which dosing is carried out outside of the control range.

Input range 0.01 to 166.00 mL/min
Default value 10.00 mL/min
Selection maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Min. rate

Rate at which dosing is carried out at the very beginning of the titration
and in the control range at the end of the titration. This parameter has a
decisive influence on the titration rate and thus also on the accuracy. The
smaller the selected minimum rate, the slower the titration.

Input range 0.01 to 9999.00 µL/min
Default value 25.00 µL/min

Table 11 Default values of the predefined titration rates for SET

 Titration rate

slow optimal fast

Dynamics

– pH

– U und Ipol

– Upol

5.000

300.0 mV

40.00 µA

2.000

100.0 mV

10.00 µA

0.500

30.0 mV

5.00 µA

Max. rate 1.00 mL/min 10.00 mL/min maximum

Min. rate 5.00 µL/min 25.00 µL/min 50.00 µL/min

Stop criterion

Stop criterion

The titration is stopped when the endpoint has been reached and this
stop criterion has been fulfilled. If no stop criterion has been selected then
the titration will not be stopped. The stop conditions (see chapter 29.3.4,
page 325) always lead to a stop, even if the stop criterion has not been
reached.
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NOTE

In older instructions the delay time was usually defined as the stop cri-
terion. The same delay time may however result in different stopping
time points – because of different smallest possible volume increments
(depending on the cylinder volume). In contrast, if the stop drift is used,
the titration will always be stopped at the same curve slope dV/dt.

Selection drift | time | off
Default value drift

drift
The titration is stopped when the stop drift has been reached.

time
The titration is stopped when the endpoint has been exceeded during
a certain period of time (Delay time).

off
The titration will not be stopped until the stop conditions have been
fulfilled.

Stop drift

This parameter can only be edited with Stop criterion = drift.

The titration is stopped when the endpoint and the stop drift have been
reached.

Input range 1 to 999 µL/min
Default value 20 µL/min

Delay time

This parameter can only be edited with Stop criterion = time.

When the endpoint has been reached, the specified time is allowed to
elapse after the last dosing and the titration is then stopped.

Input range 0 to 999 s
Default value 10 s

Endpoint 2

The control parameters for the second endpoint are defined under [End-
point 2]. The parameters and input ranges are identical with those for the
first endpoint.
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29.3.3 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Titration direction

With the setting "auto", the titration direction is determined automatically
from the initial measured value and the set endpoint. It is recommended
that you specify whether the titration direction is positive or negative. If
two endpoints have been set, then the titration direction will be defined
automatically. In this case, the setting will be ignored.

Selection + | - | auto
Default value auto

+
Positive measured value change by the addition of titrant, i.e. in the
direction of a higher pH value, greater voltage or greater current.

-
Negative measured value change by the addition of titrant, i.e. in the
direction of a lower pH value, lesser voltage or lesser current.

auto
The titration direction is determined automatically from the initial
measured value and the set endpoint.

Extraction time

Minimum duration of the titration. The titration will not be stopped during
the extraction time, even if the endpoint has already been reached. The
titration is however stopped if a stop condition is fulfilled during this time
(see chapter 29.3.4, page 325). The entry of an extraction time may be
advisable, e.g. for the titration of sparingly soluble samples.

Input range 0 to 999999 s
Default value 0 s

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command). This value is used for temperature correction in pH
measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.
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Input range 0.1 to 999999.0 s
Default value 2.0 s

29.3.4 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions], if this does not occur automatically. This could be the case when
the endpoint set is not reached or if the stop criterion (see "Stop crite-
rion", page 322) is not fulfilled.

Stop volume

The titration is stopped when the specified volume has been dosed since
the start of the titration. This volume should be adjusted to the size of the
titration vessel in order to prevent the contents from running over.

Input range 0.00000 to 9999.99 mL
Default value 100,000 mL
Selection off

Stop time

The titration is stopped when the specified time has elapsed following the
termination of the start conditions.

Input range 1 to 999999 s
Selection off
Default value off

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

29.3.5 Conditioning
The conditions required for conditioning are defined under [Condition-
ing].

Conditioning

on | off (Default value: off)

If this parameter is activated, then the first time the titration is started the
working medium will be titrated to the endpoint with the specified control
parameters. The status is kept stable. The actual method run does not
begin until [ ] has been pressed once more.
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Start drift

Conditioning OK will be displayed as soon as this drift has been reached
and the titration can be started.

Input range 1 to 999 µL/min
Default value 20 µL/min

Drift correction

The endpoint volume can be corrected by taking the drift value into
account. For this, the drift is multiplied with the drift correction time and
this value is then subtracted from the endpoint volume. The drift correc-
tion time is the time interval between the end of conditioning and the end
of the determination.

Selection auto | manual | off
Default value off

auto
The value of the current drift is automatically applied at the start of the
titration.

manual
If the drift is known throughout a longer period of time, this can be
entered manually.

off
No drift correction takes place.

Drift value

This parameter can only be edited with Drift correction = manual.

Drift for manual drift correction.

Input range 0.0 to 99.9 µL/min
Default value 0.0 µL/min

Measured value display

on | off (Default value: off)

If this parameter is activated, the currently measured value is displayed
during the conditioning.

Conditioning options [Cond. options]

Cond. stop volume

Maximum permissible volume that can be dosed during conditioning.
Conditioning is stopped when the specified volume is dosed. If condition-
ing is continued by pressing [ ] once again, then the titrant volume that
has already been dosed will not be taken into account; i.e. the dosing
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starts again at zero. The stop volume should be adjusted to the size of the
titration cell in order to prevent any overflow.

Input range 0.00000 to 9999.99 mL
Default value 20.0000 mL
Selection off

Cond. stop time

Maximum permissible time over which conditioning may take place. Con-
ditioning is stopped when the specified time has elapsed.

Input range 1 to 999999 s
Selection off
Default value off

Delay reconditioning

on | off (Default value: off)

If this parameter is activated, the conditioning will not start before all the
method commands have been processed. Otherwise, the conditioning will
immediately start after the titration command.

NOTE

This parameter must be activated if commands follow which must not
run simultaneously with the conditioning.

Example: Emptying the titration cell followed by adding new working
medium.

29.3.6 Cell
The monitoring of the reagent used is activated or deactivated under
[Cell].

Reagent monitoring

Selection of the reagent from the list of reagents. The selection depends
on the titration mode. Reagents are defined under System ▶ Reagents.

Selection Selection of configured reagents | off
Default value off

off
The reagent monitoring is not active.
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29.3.7 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.3.8 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement. This parameter is available only
with I(pol) determinations.
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The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Default value 5.0 µA
Selection –1.0 µA | 1.0 µA

U(pol)

The polarization voltage is the voltage applied to the polarizable electrode
during an amperometric measurement. This parameter is available only
with U(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –1,250 to 1,250 mV (Increment: 25)
Default value 400 mV

Electrode check

on | off (Default value: off)

For the following electrodes, an electrode check can be carried out:

￭ pH electrodes
￭ Metal electrodes
￭ Ion-selective electrodes

A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started. Note that this electrode check has nothing to do with the
electrode test (command ELT).

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).
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29.3.9 Dosing device
The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

29.3.10 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
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tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.4 Volumetric Karl Fischer titrations (KFT)

29.4.1 Start conditions
The parameters that are carried out before the start of titration are
defined under [Start conditions].

Pause 1

Waiting time, e.g. for the electrode to settle down before a start volume is
added.

Input range 0 to 999999 s
Default value 0 s

Start volume

Volume that is dosed prior to the start of the titration.

Input range 0.00000 to 9999.99 mL
Default value 0.00000 mL

Dosing rate

Rate at which the start volume is dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).
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Pause 2

Waiting time, e.g. for the electrode to settle down after the start or a
reaction time after the dosing of a start volume.

Input range 0 to 999999 s
Default value 0 s

Initial measured value

The [Initial meas. value] is measured before carrying out the start con-
ditions. This value is used for the titration direction determination
when the titration direction is set to auto.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.

Measuring mode Ipol:
Input range 0.1 to 999.0 mV/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
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elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 1 s

29.4.2 Control parameters
The control parameters for the endpoint are defined under [Control
parameters].

Endpoint at

Measured value for the endpoint.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Measuring mode Ipol:
Input range –2,000.0 to 2,000.0 mV
Default value 250.0 mV
Selection off

Measuring mode Upol:
Input range –200.00 to 200.00 µA
Default value 25.00 µA
Selection off

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For samples with a low water content or samples which release their
moisture only slowly.

optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For uncritical samples with high water content.

user
The individual titration parameters can be modified.

The settings of the individual titration rates are listed in table 12, page
335.
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User-defined parameters

These parameters are only accessible when Titration rate = user.

Dynamics

This parameter defines the control range before the specified endpoint.
Individual volume steps are dosed in the control range, the dosing is finely
controlled. The closer the endpoint, the slower the dosing until the vol-
ume increment defined under Min. increment has been reached. The
larger the control range, the slower the titration. Outside the control
range, dosing is carried out continuously, and the dosing rate is defined
under Max. rate.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Measuring mode Ipol:
Input range 0.1 to 2,000.0 mV
Default value 100.0 mV
Selection off

Measuring mode Upol:
Input range 0.01 to 200.00 µA
Default value 10.00 µA
Selection off

Max. rate

Rate at which dosing is carried out outside of the control range.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Min. increment

Minimum volume increment that is dosed at the beginning of the titration
and in the control range at the end of the titration. This parameter has a
decisive influence on the titration rate and thus also on the accuracy. The
smaller the selected minimum increment, the slower the titration.

Input range 0.10 to 99.90 µL
Selection minimum
Default value minimum
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Table 12 Default values of the predefined titration rates for KFT

 Titration rate

slow optimal fast

Dynamics

– Ipol

– Upol

300.0 mV

40.00 µA

100.0 mV

10.00 µA

30.0 mV

5.00 µA

Max. rate 1.00 mL/min maximum maximum

Min. increment minimum (= cylinder
volume/10,000)

minimum (= cylinder
volume/10,000)

5.00 µL

Stop criterion

Stop criterion

The titration is stopped when the endpoint has been reached and this
stop criterion has been fulfilled. If no stop criterion has been selected then
the titration will not be stopped. The stop conditions (see chapter 29.4.4,
page 337) always lead to a stop, even if the stop criterion has not been
reached.

NOTE

In older instructions the delay time was usually defined as the stop cri-
terion. The same delay time may however result in different stopping
time points – because of different smallest possible volume increments
(depending on the cylinder volume). In contrast, if the stop drift is used,
the titration will always be stopped at the same curve slope dV/dt.

Selection drift | time | rel. drift | off
Default value drift

drift
The titration is stopped when the stop drift has been reached.

time
The titration is stopped if the endpoint has been exceeded during a
certain time period (Delay time).

rel. drift
The titration is stopped when the sum of the drift at the start of the
titration and the relative stop drift has been reached.

off
The titration will not be stopped until the stop conditions have been
fulfilled.
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Stop drift

This parameter can only be edited with Stop criterion = drift.

The titration is stopped when the endpoint and the stop drift have been
reached.

Input range 1 to 999 µL/min
Default value 20 µL/min

Delay time

This parameter can only be edited with Stop criterion = time.

When the endpoint has been reached, the specified time is allowed to
elapse after the last dosing and the titration is then stopped.

Input range 0 to 999 s
Default value 10 s

Relative stop drift

This parameter can only be edited with Stop criterion = rel. drift.

The titration is stopped when the endpoint and the sum of the drift at the
start of the titration and the relative stop drift have been reached.

Input range 1 to 999 µL/min
Default value 10 µL/min

29.4.3 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Titration direction

Selection + | - | auto
The default value depends on the measuring mode:
Ipol = -, Upol = +

+
Positive measured value change by the addition of titrant, i.e. in the
direction of a greater voltage or greater current.

-
Negative measured value change by the addition of titrant, i.e. in the
direction of a lesser voltage or lesser current.

auto
The titration direction is determined automatically from the initial
measured value and the set endpoint.
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Extraction time

Minimum duration of the titration. The titration will not be stopped during
the extraction time, even if the endpoint has already been reached. The
titration is however stopped if a stop condition is fulfilled during this time
(see chapter 29.4.4, page 337). The entering of an extraction time is e.g.
recommended with samples that release water slowly or if a Karl Fischer
oven is used.

Input range 0 to 999999 s
Default value 0 s

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s

29.4.4 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions], if this does not occur automatically. This could be the case when
the endpoint set is not reached or if the stop criterion (see "Stop crite-
rion", page 335) is not fulfilled.

Stop volume

The titration is stopped when the specified volume has been dosed since
the start of the titration. This volume should be adjusted to the size of the
titration vessel in order to prevent the contents from running over.

Input range 0.00000 to 9999.99 mL
Default value 100,000 mL
Selection off

Stop time

The titration is stopped when the specified time has elapsed following the
termination of the start conditions.

Input range 1 to 999999 s
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Selection off
Default value off

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

29.4.5 Conditioning
The conditions required for conditioning are defined under [Condition-
ing].

Conditioning

on | off (Default value: on)

If this parameter is activated, then the first time the titration is started the
working medium will be titrated to the endpoint with the specified control
parameters. The status is kept stable. The actual method run does not
begin until [ ] has been pressed once more.

Start drift

Conditioning OK will be displayed as soon as this drift has been reached
and the titration can be started.

Input range 1 to 999 µL/min
Default value 20 µL/min

Drift correction

The endpoint volume can be corrected by taking the drift value into
account. For this, the drift is multiplied with the drift correction time and
this value is then subtracted from the endpoint volume. The drift correc-
tion time is the time interval between the end of conditioning and the end
of the determination.

Selection auto | manual | off
Default value off

auto
The value of the current drift is automatically applied at the start of the
titration.

manual
If the drift is known throughout a longer period of time, this can be
entered manually.
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off
No drift correction takes place.

Drift value

This parameter can only be edited with Drift correction = manual.

Drift for manual drift correction.

Input range 0.0 to 99.9 µL/min
Default value 0.0 µL/min

Measured value display

on | off (Default value: off)

If this parameter is activated, the currently measured value is displayed
during the conditioning.

Conditioning options [Cond. options]

Cond. stop volume

Maximum permissible volume that can be dosed during conditioning.
Conditioning is stopped when the specified volume is dosed. If condition-
ing is continued by pressing [ ] once again, then the titrant volume that
has already been dosed will not be taken into account; i.e. the dosing
starts again at zero. The stop volume should be adjusted to the size of the
titration cell in order to prevent any overflow.

Input range 0.00000 to 9999.99 mL
Default value 20.0000 mL
Selection off

Cond. stop time

Maximum permissible time over which conditioning may take place. Con-
ditioning is stopped when the specified time has elapsed.

Input range 1 to 999999 s
Selection off
Default value off

Delay reconditioning

on | off (Default value: off)

If this parameter is activated, the conditioning will not start before all the
method commands have been processed. Otherwise, the conditioning will
immediately start after the titration command.
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NOTE

This parameter must be activated if commands follow which must not
run simultaneously with the conditioning.

Example: Emptying the titration cell followed by adding new working
medium.

29.4.6 Cell
The monitoring of the reagent used is activated or deactivated under
[Cell].

Reagent monitoring

Selection of the reagent from the list of reagents. The selection depends
on the titration mode. Reagents are defined under System ▶ Reagents.

Selection Selection of configured reagents | off
Default value off

off
The reagent monitoring is not active.

29.4.7 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments
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29.4.8 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement. This parameter is available only
with I(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
"Technical specifications" chapter for the control instrument used.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Default value 50.0 µA
Selection –1.0 µA | 1.0 µA

U(pol)

The polarization voltage is the voltage applied to the polarizable electrode
during an amperometric measurement. This parameter is available only
with U(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –1,250 to 1,250 mV (Increment: 25)
Default value 400 mV
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Electrode check

on | off (Default value: off)

For the following electrodes, an electrode check can be carried out:

￭ pH electrodes
￭ Metal electrodes
￭ Ion-selective electrodes

A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started. Note that this electrode check has nothing to do with the
electrode test (command ELT).

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.4.9 Dosing device
The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.
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For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

29.4.10 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.
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29.5 Coulometric Karl Fischer titrations (KFC)

29.5.1 Control parameters
The control parameters for the endpoint are defined under [Control
parameters].

Endpoint at

Measured value for the endpoint.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Input range –1250.0 to 1250.0 mV
Default value 50.0 mV
Selection off

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For samples with a low water content or samples which release their
moisture only slowly.

optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For uncritical samples with high water content.

user
The individual titration parameters can be modified.

The settings of the individual titration rates are listed in table 13, page
345.

User-defined parameters

These parameters are only accessible when Titration rate = user.

Dynamics

This parameter defines the control range before the specified endpoint.
Within the control range, the iodine is generated step by step, the genera-
tion is finely controlled. The closer the endpoint, the slower the iodine is
generated until the rate defined under Min. rate is reached. The larger
the control range, the slower the titration. Outside the control range,
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iodine is being continuously generated, the rate is defined under Max.
rate.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Input range 0.1 to 1250.0 mV
Default value 70.0 mV
Selection off

Max. rate

Rate at which iodine is generated outside the control range.

Input range 1.5 to 2241.0 µg/min
Selection maximum
Default value maximum

Min. rate

Rate at which iodine is generated at the very beginning of the titration
and in the control range at the end of the titration. This parameter has a
vital influence on the titration rate and thus also on the accuracy. The
smaller the selected minimum rate, the slower the titration.

Input range 0.3 to 999.0 µg/min
Default value 15.0 µg/min

Table 13 Default values of the predefined titration rates for KFC

 Titration rate

slow optimal fast

Dynamics 120.0 mV 70.0 mV 30.0 mV

Max. rate 1000.0 µg/min maximum maximum

Min. rate 0.3 µg/min 15.0 µg/min 30.0 µg/min

Stop criterion

Stop criterion

The titration is stopped when the endpoint has been reached and this
stop criterion has been fulfilled. If no stop criterion has been selected then
the titration will not be stopped. The stop conditions (see chapter 29.5.3,
page 347) always lead to a stop, even if the stop criterion has not been
reached.

Selection drift | time | rel. drift | off
Default value rel. drift
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drift
The titration is stopped when the stop drift has been reached.

time
The titration is stopped if the endpoint has been exceeded during a
certain time period (Delay time).

rel. drift
The titration is stopped when the sum of the drift at the start of the
titration and the relative stop drift has been reached.

off
The titration will not be stopped until the stop conditions have been
fulfilled.

Stop drift

This parameter can only be edited with Stop criterion = drift.

The titration is stopped when the endpoint and the stop drift have been
reached.

Input range 1 to 999 µg/min
Default value 5 µg/min

Delay time

This parameter can only be edited with Stop criterion = time.

When the endpoint has been reached, the specified time is allowed to
elapse after the last dosing and the titration is then stopped.

Input range 0 to 999 s
Default value 10 s

Relative stop drift

This parameter can only be edited with Stop criterion = rel. drift.

The titration is stopped when the endpoint and the sum of the drift at the
start of the titration and the relative stop drift have been reached.

Input range 1 to 999 µg/min
Default value 5 µg/min

29.5.2 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Pause

Waiting time, for example for dissolving the sample. During this time no
iodine is generated.

Input range 0 to 999999 s
Default value 0 s
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Extraction time

Minimum duration of the titration. The titration will not be stopped during
the extraction time, even if the endpoint has already been reached. The
titration is however stopped if a stop condition is fulfilled during this time
(see chapter 29.5.3, page 347). Entering an extraction time may e.g. be
advisable if a Karl Fischer oven is used.

Input range 0 to 999999 s
Default value 0 s

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s

29.5.3 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions], if this does not occur automatically. This could be the case when
the endpoint set is not reached or if the stop criterion (see "Stop crite-
rion", page 345) is not fulfilled.

Stop time

The titration is stopped when the specified time has elapsed since the start
of the titration.

Input range 1 to 999999 s
Selection off
Default value off

29.5.4 Conditioning
The conditions required for conditioning are defined under [Condition-
ing].
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Conditioning

on | off (Default value: on)

If this parameter is activated, then the first time the titration is started the
working medium will be titrated to the endpoint with the specified control
parameters. The status is kept stable. The actual method run does not
begin until [ ] has been pressed once more.

Start drift

If the measured drift is smaller than this value for a certain time (so-called
stabilizing time), Conditioning OK is displayed and the titration can be
started. The stabilizing time is defined in the dialog Conditioning / Con-
ditioning options.

Input range 1 to 999 µg/min
Default value 20 µg/min

Drift correction

The endpoint amount can be corrected taking the drift value into account.
For this, the drift is multiplied with the drift correction time and this value
is then subtracted from the endpoint amount. The drift correction time is
the time interval between the end of conditioning and the end of the
determination.

Selection auto | manual | off
Default value auto

auto
The value of the current drift is automatically applied at the start of the
titration.

manual
If the drift is known throughout a longer period of time, this can be
entered manually.

off
No drift correction takes place.

Drift value

This parameter can only be edited with Drift correction = manual.

Drift for manual drift correction.

Input range 0.0 to 99.9 µg/min
Default value 0.0 µg/min

Measured value display

on | off (Default value: off)

If this parameter is activated, the currently measured value is displayed
during the conditioning.
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Automatic start [Automatic start]

NOTE

If you use the automatic start function, then we recommend that the
start drift be reduced and that a stabilizing time be defined.

Recommendation: start drift ≤ 10 µg/min / stabilizing time ≥ 30 s

Automatic start

on | off (Default value: off)

If this parameter is activated, the determination is automatically started
when the measured voltage suddenly changes. This setting will be ignored
as long as the working medium has not been conditioned.

Threshold value

If the change in voltage is higher than this value, the determination will
automatically be started.

Input range 0 to 999 mV
Default value 50 mV

Conditioning options [Cond. options]

Stabilizing time

Waiting time, during which the measured drift has to be smaller than the
start drift defined until Conditioning OK is displayed. The start drift is
defined in the dialog Edit command / Conditioning.

Input range 0 to 999999 s
Default value 0 s

Cond. stop time

Maximum permissible time over which conditioning may take place. Con-
ditioning is stopped when the specified time has elapsed.

Input range 1 to 999999 s
Selection off
Default value off

Delay reconditioning

on | off (Default value: off)

If this parameter is activated, the conditioning will not start before all the
method commands have been processed. Otherwise, the conditioning will
immediately start after the titration command.
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NOTE

This parameter must be activated if commands follow which must not
run simultaneously with the conditioning.

Example: Emptying the titration cell followed by adding new working
medium.

29.5.5 Cell
The parameters for the titration cell are defined under [Cell].

Generator electrode

Type of generator electrode.

Selection without diaphragm | with diaphragm
Default value without diaphragm

without diaphragm
Generator electrode without diaphragm.

with diaphragm
Generator electrode with diaphragm.

Generator current

Polarization current at the generator electrode.

Selection 100 mA | 200 mA | 400 mA | auto

400 mA
Default value, when Generator electrode = without diaphragm.

auto
The current is adapted to the conductivity of the reagent and automat-
ically reduced near the endpoint. Default value, when Generator
electrode = with diaphragm.

Reagent monitoring

Selection of the reagent from the list of reagents. The selection depends
on the titration mode. Reagents are defined under System ▶ Reagents.

Selection Selection of configured reagents | off
Default value off

off
The reagent monitoring is not active.
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29.5.6 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.5.7 Sensor
The parameters for the sensor are edited under [Sensor].

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during the voltametric measurement.

Selection 5 µA | 10 µA | 20 µA | 30 µA
Default value 10 µA

Electrode check

on | off (Default value: off)

For polarizable electrodes and the generator electrode, an electrode check
can be carried out. The following will be tested:
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￭ Polarizable electrodes
– Is the electrode connected?
– Is there a short circuit?

The electrode check is carried out when this command is started.
￭ Generator electrode:

– Is the electrode connected?
– Is the generator system defective?
– Is the resistance of the sample solution very high?

The electrode check is carried out continuously during the execution of
this command.

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.5.8 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.
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The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.6 Bromine index determination (BRC)

29.6.1 Control parameters
The control parameters for the endpoint are defined under [Control
parameters].

Endpoint at

Measured value for the endpoint.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Input range –1,250.0 to 1,250.0 mV
Default value 200.0 mV
Selection off

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For samples with slow bromine addition.

optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For uncritical samples with fast bromine addition.

user
The individual titration parameters can be modified.
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The settings of the individual titration rates are listed in table 14, page
354.

User-defined parameters

These parameters are only accessible when Titration rate = user.

Dynamics

This parameter defines the control range before the specified endpoint.
Within the control range, the bromine is generated step by step, the gen-
eration is finely controlled. The closer the endpoint, the slower the bro-
mine is generated until the rate defined under Min. rate is reached. The
larger the control range, the slower the titration. Outside the control
range, bromine is continuously generated, the rate is defined under Max.
rate.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Input range 0.1 to 1250.0 mV
Default value 400.0 mV
Selection off

Max. rate

Rate at which bromine is generated outside the control range.

Input range 10.0 to 19876.0 µg/min
Default value 1000.0 µg/min
Selection maximum

Min. rate

Rate at which bromine is generated at the very beginning of the titration
and in the control range at the end of the titration. This parameter has a
vital influence on the titration rate and thus also on the accuracy. The
smaller the selected minimum rate, the slower the titration.

Input range 1.0 to 999.0 µg/min
Default value 25.0 µg/min

Table 14 Default values for the predefined titration rates for BRC

 Titration rate

slow optimal fast

Dynamics 400.0 mV 400.0 mV 400.0 mV

Max. rate 500.0 µg/min 1000.0 µg/min 2000.0 µg/min

Min. rate 15.0 µg/min 25.0 µg/min 50.0 µg/min
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Stop criterion

Stop criterion

The titration is stopped when the endpoint has been reached and this
stop criterion has been fulfilled. If no stop criterion has been selected then
the titration will not be stopped. The stop conditions (see chapter 29.6.3,
page 357) always lead to a stop, even if the stop criterion has not been
reached.

Selection drift | time | rel. drift | off | drift & time
Default value drift & time

drift
The titration is stopped when the stop drift has been reached.

time
The titration is stopped if the endpoint has been exceeded during a
certain time period (Delay time).

rel. drift
The titration is stopped when the sum of the drift at the start of the
titration and the relative stop drift has been reached.

off
The titration will not be stopped until the stop conditions have been
fulfilled.

drift & time
The titration is stopped when the stop drift has been exceeded during
the time set and the endpoint has been reached.

Stop drift

This parameter can only be edited with Stop criterion = drift or drift &
time.

The titration is stopped when the endpoint and the stop drift have been
reached.

Input range 1 to 999 µg/min
Default value 15 µg/min

Delay time

This parameter can only be edited with Stop criterion = time or drift &
time.

When the endpoint has been reached, the specified time is allowed to
elapse after the last dosing and the titration is then stopped.

Input range 0 to 999 s
Default value 40 s
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Relative stop drift

This parameter can only be edited with Stop criterion = rel. drift.

The titration is stopped when the endpoint and the sum of the drift at the
start of the titration and the relative stop drift have been reached.

Input range 1 to 999 µg/min
Default value 5 µg/min

29.6.2 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Pause

Waiting time, for example for dissolving the sample. During this time no
bromine is generated.

Input range 0 to 999999 s
Default value 0 s

Extraction time

Minimum duration of the titration. The titration will not be stopped during
the extraction time, even if the endpoint has already been reached. The
titration is however stopped if a stop condition is fulfilled during this time
(see chapter 29.6.3, page 357).

Input range 0 to 999999 s
Default value 0 s

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s
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29.6.3 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions], if this does not occur automatically. This could be the case when
the endpoint set is not reached or if the stop criterion (see "Stop crite-
rion", page 355) is not fulfilled.

Stop time

The titration is stopped when the specified time has elapsed since the start
of the titration.

Input range 1 to 999999 s
Selection off
Default value off

29.6.4 Conditioning
The conditions required for conditioning are defined under [Condition-
ing].

Conditioning

on | off (Default value: on)

If this parameter is activated, then the first time the titration is started the
working medium will be titrated to the endpoint with the specified control
parameters. The status is kept stable. The actual method run does not
begin until [ ] has been pressed once more.

Start drift

If the measured drift is smaller than this value for a certain time (so-called
stabilizing time), Conditioning OK is displayed and the titration can be
started. The stabilizing time is defined in the dialog Conditioning / Con-
ditioning options.

Input range 1 to 999 µg/min
Default value 20 µg/min

Drift correction

The endpoint amount can be corrected taking the drift value into account.
For this, the drift is multiplied with the drift correction time and this value
is then subtracted from the endpoint amount. The drift correction time is
the time interval between the end of conditioning and the end of the
determination.

Selection auto | manual | off
Default value off
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auto
The value of the current drift is automatically applied at the start of the
titration.

manual
If the drift is known throughout a longer period of time, this can be
entered manually.

off
No drift correction takes place.

Drift value

This parameter can only be edited with Drift correction = manual.

Drift for manual drift correction.

Input range 0.0 to 999.9 µg/min
Default value 0.0 µg/min

Measured value display

on | off (Default value: off)

If this parameter is activated, the currently measured value is displayed
during the conditioning.

Conditioning options [Cond. options]

Stabilizing time

Waiting time, during which the measured drift has to be smaller than the
start drift defined until Conditioning OK is displayed. The start drift is
defined in the dialog Edit command / Conditioning.

Input range 0 to 999999 s
Default value 0 s

Cond. stop time

Maximum permissible time over which conditioning may take place. Con-
ditioning is stopped when the specified time has elapsed.

Input range 1 to 999999 s
Selection off
Default value off

Delay reconditioning

on | off (Default value: off)

If this parameter is activated, the conditioning will not start before all the
method commands have been processed. Otherwise, the conditioning will
immediately start after the titration command.
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NOTE

This parameter must be activated if commands follow which must not
run simultaneously with the conditioning.

Example: Emptying the titration cell followed by adding new working
medium.

29.6.5 Cell
The parameters for the titration cell are defined under [Cell].

Generator electrode

Type of generator electrode.

Selection without diaphragm | with diaphragm
Default value with diaphragm

without diaphragm
Generator electrode without diaphragm.

with diaphragm
Generator electrode with diaphragm.

Generator current

Polarization current at the generator electrode.

Selection 100 mA | 200 mA | 400 mA | auto
Default value auto

auto
The current is adapted to the conductivity of the reagent and automat-
ically reduced near the endpoint.

Reagent monitoring

Selection of the reagent from the list of reagents. The selection depends
on the titration mode. Reagents are defined under System ▶ Reagents.

Selection Selection of configured reagents | off
Default value off

off
The reagent monitoring is not active.
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29.6.6 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.6.7 Sensor
The parameters for the sensor are edited under [Sensor].

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
"Technical specifications" chapter for the control instrument used.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Selection –1.0 µA | 1.0 µA
Default value 1.0 µA
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Electrode check

on | off (Default value: off)

For polarizable electrodes and the generator electrode, an electrode check
can be carried out. The following will be tested:

￭ Polarizable electrodes
– Is the electrode connected?
– Is there a short circuit?

The electrode check is carried out when this command is started.
￭ Generator electrode:

– Is the electrode connected?
– Is the generator system defective?
– Is the resistance of the sample solution very high?

The electrode check is carried out continuously during the execution of
this command.

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.6.8 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.
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Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.7 STAT titrations (STAT)

29.7.1 Start conditions
The parameters that are carried out before the start of titration are
defined under [Start conditions].

Pause 1

Waiting time, e.g. for the electrode to settle down before a start volume is
added.

Input range 0 to 999999 s
Default value 0 s

Start volume

Volume that is dosed prior to the start of the titration.

Input range 0.00000 to 9999.99 mL
Default value 0.00000 mL

Dosing rate

Rate at which the start volume is dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum
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maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Pause 2

Waiting time, e.g. for the electrode to settle down after the start or a
reaction time after the dosing of a start volume.

Input range 0 to 999999 s
Default value 0 s

Initial measured value

The [Initial meas. value] is measured before carrying out the start con-
ditions. This value is used for the titration direction determination
when the titration direction is set to auto.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.

Input range 0.1 to 999.0 mV/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 1 s
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29.7.2 Control parameters
The parameters for the control point are defined under [Control
parameters].

Control point at

Measured value for the control point.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection 50 µL/min | 100 µL/min | 500 µL/min | user
Default value 100 µL/min

50 µL/min
For reactions with an expected reaction rate in the range of 50 µL/min.

100 µL/min
For reactions with an expected reaction rate in the range of
100 µL/min.

500 µL/min
For reactions with an expected reaction rate in the range of
500 µL/min.

user
The individual titration parameters can be modified.

The settings of the individual titration rates are listed in table 15, page
366.

User-defined parameters

These parameters are only accessible when Titration rate = user.
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Dynamics

The control range defines the measured value range before the specified
control point. This control point has a vital influence on the titration rate
and thus also on the measuring accuracy.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range 0.001 to 20.000 
Default value 1.000 
Selection off

Measuring mode U:
Input range 0.1 to 2,000.0 mV
Default value 60.0 mV
Selection off

Max. rate

The maximum permissible rate at which dosing takes place.

Rule of thumb for the maximum rate in mL/min:

0.005 · expected reaction rate in µL/min

Input range 0.01 to 166.00 mL/min
Default value 0.75 mL/min
Selection maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Min. rate

The rate at which dosing is carried out at the very beginning of the titra-
tion and in the control range at the end of the titration. This parameter
has a decisive influence on the behavior at the control point. The mini-
mum rate also has a decisive influence on how exactly the control point
can be kept constant. The smaller the selected minimum rate, the longer it
takes until the control point is reached for the first time.

The following rule of thumb should be considered in order to obtain a
dosing at the control point as constant (regular) as possible:

Min. rate in µL/min = 0.1 · expected reaction rate in µL/min

Input range 0.01 to 9999.00 µL/min
Default value 10.00 µL/min



29.7 STAT titrations (STAT) ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

366 ￭￭￭￭￭￭￭￭ 900 Touch Control

Table 15 Default values of the predefined titration rates for STAT

 Reaction rate

50 µL/min 100 µL/min 500 µL/min

Dynamics

– pH

– U

1.000

60.0 mV

1.000

60.0 mV

1.000

60.0 mV

Max. rate 0.25 mL/min 0.75 mL/min 2.00 mL/min

Min. rate 5.00 µL/min 10.00 µL/min 40.00 µL/min

Dosing and control range

Outside the control range the dosing rate is mainly characterized by the
maximum rate. The parameters Max. rate and Dynamics should be opti-
mized together in such a way that the titration does not overshoot too
much when the control point is reached. The Dynamics should be selected
in such a way that the measured value remains within the control range
while the control point is maintained. A slightly larger control range
should be defined for slow reactions (e.g. pH = 3, U = 180 mV). The set-
point value is often set with a SET pretitration before the substrate is
added. This means that the STAT titration can be started already with a
small deviation from the control point.

29.7.3 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Titration direction

With the setting "auto", the titration direction is determined automatically
from the initial measured value and the set control point. It is
recommended that you specify whether the change of the measured
value is positive or negative.

Selection + | - | auto
Default value auto

+
Positive measured value change by the addition of titrant, i.e. in the
direction of a higher ph value or greater voltage.

-
Negative measured value change by the addition of titrant, i.e. in the
direction of a lower pH value or lesser voltage.

auto
The titration direction is determined automatically from the initial
measured value and the set control point.
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Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command). This value is used for temperature correction in pH
measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s

Start time

The measured values are not entered in the measuring point list until this
time has elapsed since the start of the titration.

Input range 0 to 999999 s
Default value 0 s

Start meas. value

The measured values are not entered in the measuring point list until this
start measured value has been reached.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Start rate

The measured values are not entered in the measuring point list until the
dosing rate has fallen below this value. Checking this parameter is not
started until 10 s after the start of the command.
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Input range 0.01 to 166.00 mL/min
Selection off
Default value off

NOTE

If several of the parameters Start time, Start meas. value or Start
rate have been defined, then all of them must be fulfilled for measured
values to be entered in the measuring point list.

29.7.4 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions].

Stop volume

The titration is stopped when the specified volume has been dosed since
the start of the titration. This volume should be adjusted to the size of the
titration vessel in order to prevent the contents from running over.

Input range 0.00000 to 9999.99 mL
Default value 100,000 mL
Selection off

Stop time

The titration is stopped when the specified time has elapsed.

Input range 0 to 999999 s
Selection off
Default value off

Since

This parameter can only be edited when a stop time has been defined.

This parameter defines the start of the stop time.

Selection Start | Control point | Last dosing

Start
The stop time starts after the start volume has been dosed and the fol-
lowing pause time has elapsed.

Control point
The stop time starts as soon as the control point has been reached for
the first time.

Last dosing
The stop time starts after the last increment has been dosed, i. e. the
stop time is reset to zero again after each dosing step.
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Stop rate

The titration is stopped when the current titration rate is lower than the
value entered. Checking this parameter is not started until 10 s after the
start of the command.

Input range 0.01 to 166.00 µL/min
Selection off
Default value off

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

29.7.5 Monitoring
Under [Monitoring], the parameters for monitoring the following quanti-
ties are defined:

￭ Measured value
￭ Dosing rate (an average rate)
￭ Temperature

Monitoring is not used for parameterization of the control behavior.
Remote signals or RS-232 commands can be assigned to the monitored
quantities (see "Communication", page 373). These remote signals or
RS-232 commands are sent if a limit has been infringed. This can be used,
for example, to switch a thermostat on/off if necessary.

The parameters are identical for all monitored quantities.

Monitoring

on | off (Default value: off)

Enabling and disabling the monitoring function. The monitoring of the
dosing rate is not started until 10 s after the start of the titration.

Lower limit

When the monitored quantity falls below this value, the action defined in
the following is triggered.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
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can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Default value –20.000 

Measuring mode U:
Input range –2000.0 to 2000.0 mV
Default value –2000.0 mV

Dosing rate:
Input range 0.00 to 166.00 mL/min
Default value 0.00 mL/min

Temperature:
Input range –20.0 to 150.0 °C
Default value –20.0 °C

Lower hysteresis

The lower hysteresis represents the tolerance range for the lower limit (see
figure 18, page 373). When Action = Wait the dosing does not continue
until the monitored quantity has once again exceeded the lower limit incl.
the value entered here.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range 0.000 to 20.000 
Default value 0.020 

Measuring mode U:
Input range 0.0 to 2000.0 mV
Default value 2.0 mV

Dosing rate:
Input range 0.00 to 166.00 mL/min
Default value 0.20 mL/min

Temperature:
Input range 0.0 to 150.0 °C
Default value 0.2 °C



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 29 Parameters

900 Touch Control ￭￭￭￭￭￭￭￭ 371

Upper limit

When this value is exceeded, the action defined in the following is trig-
gered.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Default value 20.000 

Measuring mode U:
Input range –2000.0 to 2000.0 mV
Default value 2000.0 mV

Dosing rate:
Input range 0.00 to 166.00 mL/min
Default value 166.00 mL/min

Temperature:
Input range –20.0 to 150.0 °C
Default value 150.0 °C

Upper hysteresis

The upper hysteresis represents the tolerance range for the upper limit
(see figure 18, page 373). When Action = Wait, the dosing does not
continue until the monitored quantity has once again fallen below the
upper limit incl. the value entered here.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range 0.000 to 20.000 
Default value 0.020 

Measuring mode U:
Input range 0.0 to 2000.0 mV
Default value 2.0 mV

Dosing rate:
Input range 0.00 to 166.00 mL/min
Default value 0.20 mL/min
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Temperature:
Input range 0.0 to 150.0 °C
Default value 0.2 °C

Action

Selection of the action which is carried out when the limits of the moni-
tored quantity are infringed.

Selection None | Exit method | Cancel command |
 Pause | Wait

None
No action will be taken.

Exit method
The method is stopped immediately.

Cancel command
The current command is stopped und the next command in the
method will be started.

Pause
Adding reagent is stopped until the dosing is continued manually with
[Continue]. If several quantities are monitored, the other quantities
will still be monitored in the background.

Wait
Adding reagent is stopped until the value of the monitored quantity is
within the limits again (incl. hysteresis). The dosing is continued auto-
matically. If several quantities are monitored, the other quantities will
still be monitored in the background.

NOTE

If the lower limit is infringed while monitoring the dosing rate, the set-
tings Action = Pause and Action = Wait do not make sense because
the average dosing rate becomes smaller and smaller during the waiting
time. The valid range can never be reached again.
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Upper limit

Lower limit

Stop

Monitored
quantity

Time

Figure 16 Action "Exit method" or "Cancel command"

[Continue]
Upper limit

Lower limit

Pause

Monitored
quantity

Time

Figure 17 Action "Pause"

Upper hysteresis

Lower hysteresis

Upper limit

Lower limit

Wait

Monitored
quantity

Time

Figure 18 Action "Wait"

Communication

Under [Communication], remote signals or RS-232 commands can be
assigned to the monitored quantities. These remote signals or RS-232
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commands are always sent, independent of the action defined for a limit
infringement (see "Action", page 372).

[New]

Define a new assignment.

[Delete]

Delete the selected assignment.

[Edit]

Edit the settings for the selected assignment.

Monitored quantity

Selection of the monitored quantity to which a remote signal or an
RS-232 command is to be assigned.

Selection Measured value | Temperature | Dosing rate |
 any

any
If several quantities are monitored, the remote signal or RS-232 com-
mand set is sent as soon as a limit of one of the monitored quantities is
exceeded.

Infringed limit

Indicating the limit whose infringement causes the remote signal or
RS-232 command defined in the following to be sent.

Selection upper | lower | any | back in range

upper
The remote signal or the RS-232 command is sent when the upper
limit is exceeded.

lower
The remote signal or the RS-232 command is sent when the lower limit
is exceeded.

any
The remote signal or the RS-232 command is sent when the upper or
the lower limit is infringed.

back in range
The remote signal or the RS-232 command is sent when the value of
the monitored quantity is within the limits again (incl. hysteresis).

Interface

Selection of the Remote Box or the serial interface via which the remote
signal or the RS-232 command is sent.

Selection Remote Box 1…4 | COM1…8



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 29 Parameters

900 Touch Control ￭￭￭￭￭￭￭￭ 375

Output signal

This parameter can only be edited when a Remote Box is selected under
Interface.

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.

NOTE

A line set active is not being reset automatically, nor at the end of the
determination nor when the monitored quantity is in the range again.

Entering a bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set. With a pulse, the length is set to 200 ms.
If it is required to set pulses with other lengths, you have to define a corre-
sponding template.

Entry Bit patterns containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value **************
Selection Selection of the templates defined

Character string

This parameter can only be edited when a serial interface (COM) is
selected under Interface.

Input of the RS-232 command as character string. All characters of the
ASCII code page can be used. Control characters (Esc, FF etc.) have to be
entered as a three-place, decimal ASCII code, starting with a slash. Each
command is automatically terminated with the ASCII characters CR and
LF.

Entry ASCII string with a max. of 24 characters
Default value empty



29.7 STAT titrations (STAT) ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

376 ￭￭￭￭￭￭￭￭ 900 Touch Control

29.7.6 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.7.7 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

Electrode check

on | off (Default value: off)

For the following electrodes, an electrode check can be carried out:

￭ pH electrodes
￭ Metal electrodes
￭ Ion-selective electrodes
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A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started. Note that this electrode check has nothing to do with the
electrode test (command ELT).

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.7.8 Dosing device
The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.
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Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Tandem dosing

A second dosing device can be defined under [Tandem dosing] in order
to enable uninterrupted dosing. Dosing is carried out with a combination
of two dosing devices so that the second dosing device is dosing while
the first one is being filled and vice versa.

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value off

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. Titrants are defined under System ▶ Titrants. You can
also enter a name which is not contained in the titrant list. When a deter-
mination is started there is a check whether the solution is contained in
list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, only the time interval for the GLP test of the buret unit
is checked at the start of the determination.

NOTE

The concentration, validity of the titer and the working life of the titrant
are ignored.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
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Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

However, in order to ensure uninterrupted dosing, the following points
must be taken into account:

￭ Use the highest possible filling rate in order to keep the filling times as
short as possible. The filling rate should be decreased for viscous liq-
uids.

￭ When you use two buret units with different dosing cylinders, the fill-
ing rate for the larger sized cylinder must be at the minimum:

= filling rate in mL/min for the larger sized cylinder

= filling rate in mL/min for the smaller cylinder

= cylinder volume in mL of the buret unit of the second dosing
device

= cylinder volume in mL of the buret unit of the first dosing
device

Example:

Dosing device 1: volume = 20 mL, filling rate = 50 mL/min

Dosing device 2: volume = 50 mL

Filling rate 2 ≥ 50 mL/min · 50 mL / 20 mL ≥ 125 mL/min

￭ The dosing rate must not exceed 75% of the filling rate of the smaller
cylinder. These values are listed in the following table, valid at maxi-
mum filling rate:

Table 16 Maximum dosing rate for different dosing cylinders

Cylinder volume maximum dosing rate

Exchange unit Dosing unit

1 mL 2.25 mL/min –

2 mL – 5.00 mL/min

5 mL 11.25 mL/min 12.50 mL/min

10 mL 22.50 mL/min 25.00 mL/min
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Cylinder volume maximum dosing rate

Exchange unit Dosing unit

20 mL 45.00 mL/min 50.00 mL/min

50 mL 112.50 mL/min 124.50 mL/min

29.7.9 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.
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29.8 Manual titrations (MAT)

A manual titration can be carried out with a Manual Dosing Controller or
with the buttons [Dose] and [Cancel command].

In order for the manual titration to be carried out with the 6.2107.120
Manual Dosing Controller, the latter must be connected to the MSB con-
nector of the Titrando via the 6.2148.010 Remote Box MSB.

Manual titration using the Manual Dosing Controller

 

1 Press the [GO] key to start the method.

 

2 Press the [GO] key during the MAT command for dosing.

 

3 End the MAT command with the [FILL] key.

Manual titration using the buttons

 

1 Press the  key to start the method.

 

2 Press the [Dose] button during the MAT command for dosing.

 

3 End the MAT command with the [Cancel command] button.

NOTE

Start of titration: Because of the technical implementation involved, a
few microliters are already dosed at the start of a manual titration. The
possibility of deviation from the actual endpoint volume is excluded,
however. The already dosed volume is taken into account.

End of titration: A manual titration must always be ended with the
[Cancel command] button (NOT with the [ ] fixed key) or with the
[FILL] key on the Manual Dosing Controller. This is the only way to
ensure that subsequent method commands will be carried out.
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29.8.1 Dosing parameters
Under [Dosing parameters], the parameters influencing the run of the
manual titration are defined.

Dosing ramp

The dosing ramp is a delay in the dosing rate at the time of the start of a
dosing step. It is advantageous primarily for manual titrations with indica-
tor, when small volume steps are to be dosed before the equivalence
point. The selectable delay time determines after which amount of time
the defined dosing rate is to be reached.

Input range 0 to 10 s
Default value 2 s

Dosing rate

The rate at which dosing takes place.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 5.0 s

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
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of the command). This value is used for temperature correction in pH
measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

29.8.2 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.8.3 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

Temp. measurement

Type of temperature measurement.
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Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.8.4 Dosing device
The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.
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Tandem dosing

A second dosing device can be defined under [Tandem dosing] in order
to enable uninterrupted dosing. Dosing is carried out with a combination
of two dosing devices so that the second dosing device is dosing while
the first one is being filled and vice versa.

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value off

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. Titrants are defined under System ▶ Titrants. You can
also enter a name which is not contained in the titrant list. When a deter-
mination is started there is a check whether the solution is contained in
list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, only the time interval for the GLP test of the buret unit
is checked at the start of the determination.

NOTE

The concentration, validity of the titer and the working life of the titrant
are ignored.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).
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However, in order to ensure uninterrupted dosing, the following points
must be taken into account:

￭ Use the highest possible filling rate in order to keep the filling times as
short as possible. The filling rate should be decreased for viscous liq-
uids.

￭ When you use two buret units with different dosing cylinders, the fill-
ing rate for the larger sized cylinder must be at the minimum:

= filling rate in mL/min for the larger sized cylinder

= filling rate in mL/min for the smaller cylinder

= cylinder volume in mL of the buret unit of the second dosing
device

= cylinder volume in mL of the buret unit of the first dosing
device

Example:

Dosing device 1: volume = 20 mL, filling rate = 50 mL/min

Dosing device 2: volume = 50 mL

Filling rate 2 ≥ 50 mL/min · 50 mL / 20 mL ≥ 125 mL/min

￭ The dosing rate must not exceed 75% of the filling rate of the smaller
cylinder. These values are listed in the following table, valid at maxi-
mum filling rate:

Table 17 Maximum dosing rate for different dosing cylinders

Cylinder volume maximum dosing rate

Exchange unit Dosing unit

1 mL 2.25 mL/min –

2 mL – 5.00 mL/min

5 mL 11.25 mL/min 12.50 mL/min

10 mL 22.50 mL/min 25.00 mL/min

20 mL 45.00 mL/min 50.00 mL/min

50 mL 112.50 mL/min 124.50 mL/min
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29.8.5 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.9 Measurements (MEAS)

29.9.1 Measuring parameters
Under [Measuring parameters], the parameters influencing the run of
the entire measurement are defined.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.
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NOTE

A constant measured value is often only reached after a certain time, as
mixing and the reaction itself require a certain time. The response time
of an electrode can also increase with time, i.e., reaching a constant
measured value takes longer and longer. Drift-controlled measured
value acceptance is particularly advisable in such cases, as the measured
values are only accepted when equilibrium has almost been reached.

Measuring mode pH, U, Ipol and Conc:
Input range 0.1 to 999.0 mV/min
Default value 10.0 mV/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Default value 10.00 µA/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode T:
Input range 0.1 to 999.0 °C/min
Default value 0.5 °C/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode Cond:
Input range 0.001 to 999.000 (mS/cm)/min
Selection off
Default value off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.
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Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
The default value depends on the measuring mode.

Selection off

off
The measurement is continued endlessly.

Stop meas. value

The measurement is canceled when the specified measured value has
been reached since the start of the measurement.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measuring mode pH:
Input range –20.000 to 20.000 
Selection off
Default value off

Measuring mode U, Ipol:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Measuring mode Upol:
Input range –200.00 to 200.00 µA
Selection off
Default value off

Measuring mode T:
Input range –20.0 to 150.0 °C
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Selection off
Default value off

Measuring mode Conc:
Input range 0.001 to 999999.999 

The unit corresponds to the one of the standards
with which the calibration of the sensor has been
carried out.

Selection off
Default value off

Measuring mode Cond:
Input range 0.0001 to 999.9999 mS/cm
Selection off
Default value off

Temperature

This parameter is not available with the MEAS T (temperature measure-
ment) and MEAS Cond (conductivity measurement) commands.

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command). This value is used for temperature correction in pH and
concentration measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 29 Parameters

900 Touch Control ￭￭￭￭￭￭￭￭ 391

NOTE

The algorithm is only valid for direct measurements (MEAS Conc) if the
following conditions are fulfilled:

￭ The sample preparation must be identical for standard solutions and
sample. In other words, if aqueous standard solutions were used for
calibration, for example, then the sample must also be produced in
aqueous medium.

￭ The ratio sample volume / volume auxiliary solution must be identical
with the ratio volume standard solution / volume auxiliary solution
when calibrating the sensor.

Temperature compensation [Temp. compens.]

The parameters for converting the measured conductivity to a reference
temperature are defined under [Temp. compens.]. This button is avail-
able only with the MEAS Cond command (conductivity measurement).

Measuring temp.

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Reference temp.

The measured conductivity is converted to this temperature.

Input range –20.0 to 150.0 °C
Default value 25.0 °C
Selection off

off
The temperature compensation is disabled.

Temp. compensation

Type of temperature compensation.

Selection constant | ISO / DIN

constant
The temperature compensation is carried out with the value entered
for the temperature coefficient.
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ISO / DIN
For ground water, spring water and surface water, the temperature
coefficients according to standard ISO 7888:1985 (German version:
DIN EN 27888:1993) are stored in the system.

Temp. coefficient

This parameter can only be edited with Temp. compensation = con-
stant.

Temperature coefficient belonging to the reference temperature entered
above. With this temperature coefficient, the conductivity is converted to
the reference temperature.

Input range 0.00 to 9.99 %/°C
Default value 0.00 %/°C

29.9.2 Standard addition
Under [Standard addition], the parameters for the concentration
measurement by means of standard addition are defined. This button is
available only with the MEAS Conc command (concentration measure-
ment).

Addition

Selection of the addition mode.

Selection off | auto | auto dos | manual
Default value off

off
The concentration measurement is carried out without standard addi-
tion, i.e. as a direct measurement.

auto
The standard solution is dosed automatically. The individual volume
steps are calculated in the way that a certain voltage difference is
reached. This voltage difference (Delta U) is defined under Standard
addition ▶ Dosing device.

auto dos
The standard solution is dosed automatically. The individual volume
steps are defined under Standard addition ▶ Addition incre-
ments.

manual
The standard solution is dosed manually. The individual volume steps
are defined under Standard addition ▶ Addition increments.
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Concentration standard

Concentration of the standard solution used. When Addition = manual
is defined, a numerical value has to be entered here, the selection from
list creates an error message when starting the determination.

Input range 0.00001 to 99999.9 
Selection from list
Default value from list

from list
The standard solution selected under Standard addition ▶ Dosing
device is used.

Unit of the standard solution used.

Entry max. 24 characters
Selection mol/L | mmol/L | ppm | % | g/L | mg/L | µg/L
Default value ppm

Number of additions

Number of standard additions. The more addition steps you carry out the
more accurate the evaluation becomes.

Input range 1 to 19 
Default value 3 

Stop volume

Maximum permissible volume for the volume steps. If the sum of the vol-
ume steps is higher than this volume, an error message is displayed when
starting the determination.

Input range 0.00 to 9999.90 mL
Default value 99.99 mL

Volume aux. solution

Volume of the buffer solution etc. which has to be added to the sample
before the measurement can be started.

Input range 0.00 to 9999.90 mL
Default value 0.00 mL

Stirrer control

The parameters for the stirrer control during the standard addition are
edited under [Stirrer control]. Ensure that a stirrer has been selected in
the Edit command / Stirrer dialog.
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Stir solution during measurement

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched on and off auto-
matically at the start or end of the measurement.

Stir before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If the stirrer is switched off during the measurement, it will be stirred for
the time entered before measuring.

Input range 0 to 999999 s
Default value 0 s

Pause before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If it is stirred before the measurement, a waiting time can be defined here
before starting the measurement. No stirring or measuring occurs during
this time.

Input range 0 to 999999 s
Default value 0 s

Dosing device

The parameters for the dosing device are edited under [Dosing device].
This button is enabled only with Addition = auto or auto dos.

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Standard

Selection of the standard solution from the titrant list. We recommend
always selecting the standard solution. This ensures that the correct data
(titer, concentration, etc.) is always used for the calculation. Standard solu-
tions are defined under System ▶ Titrants. You can also enter a name
which is not contained in the titrant list. When a determination is started
there is a check whether the solution is contained in list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct standard solution has been attached and
whether the type of dosing drive matches. For buret units without integra-
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ted data chip, the cylinder volume and the type of dosing drive are
checked. For the selected standard solution, the validity of the titer, the
working life of the standard solution and the time interval for the GLP test
of the buret unit are checked at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Dosing rate

Three predefined sets of parameters can be selected for the dosing rate.
The maximum dosing rate depends on the cylinder volume (see chapter
32, page 503).

Selection slow | medium | fast
Default value fast

slow
The dosing rate is at 10 % of the maximum dosing rate.

medium
The dosing rate is at 50 % of the maximum dosing rate.

fast
The dosing rate is equivalent to the maximum dosing rate.

Delta U

This parameter can only be edited with Addition = auto.

The individual volume steps are calculated in the way that the voltage dif-
ference entered is reached.

Input range 1 to 999 mV
Default value 10 mV

Addition increments

The volume of the individual volume steps is defined under [Addition
increments]. This button is enabled only with Addition = auto dos or
manual.

Volume

Volume of a single volume step.

Input range 00.000 to 9999.900 mL
Default value 00.100 mL
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Apply this value for all increments

on | off (Default value: off)

If you activate this parameter, the entered volume is applied for all volume
steps.

29.9.3 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.9.4 Sensor
The parameters for the sensor are edited under [Sensor].

The parameters are valid for all measuring modes except for Temp.
measurement. This parameter is not available with the MEAS T com-
mand (temperature measurement).

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.
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Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement. This parameter is available only
with I(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Default value 5.0 µA
Selection –1.0 µA | 1.0 µA

U(pol)

The polarization voltage is the voltage applied to the polarizable electrode
during an amperometric measurement. This parameter is available only
with U(pol) determinations.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
Technical specifications chapter for the control instrument used.

Input range –1,250 to 1,250 mV (Increment: 25)
Default value 400 mV

Electrode check

on | off (Default value: off)

For the following electrodes, an electrode check can be carried out:

￭ pH electrodes
￭ Metal electrodes
￭ Ion-selective electrodes

A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started. Note that this electrode check has nothing to do with the
electrode test (command ELT).

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.
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automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.9.5 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.
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29.10 Calibration of sensors (CAL)

29.10.1 Calibration parameters (CAL pH)
Under [Calibration parameters], the parameters influencing the run of
the entire calibration are defined.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.

Input range 0.1 to 999.0 mV/min
Default value 2.0 mV/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 10 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 110 s
Selection off

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C
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Sample Processor

If the calibration is carried out with a Sample Processor, the buffers or
standards are automatically changed. This is why no request for the cali-
bration temperature appears when starting the calibration. The value
entered above is used.

Selection off | Remote | USB
Default value off

off
For calibrations without Sample Processor. During the calibration, a
request for changing the buffer/standard is displayed.

Remote
For automatic calibrations with Sample Processors, which are
connected via the Remote Box.

USB
For automatic calibrations with a Sample Processor that is connected
via USB(see "Definition of the calibration positions", page 509).

Buffers

The buffer type and the number of buffers is defined under [Buffers].

Buffer type

Selection of a predefined buffer series or definition of special buffers. In
the case of predefined buffer series, the instrument automatically recogni-
zes which buffer is involved.

Selection Metrohm | NIST | DIN | Fisher | Fluka Basel |
 Mettler | Merck Tit. | Beckman | Radiometer |
 Custom | Special | Merck Cer. | Baker | Hamil-
ton | Precisa

Default value Metrohm

Custom
Definition of a custom buffer series. The buffer series is defined under
System ▶ Templates ▶ Custom calib. buffers.

Special
Up to five calibration buffers can be defined in the method. The auto-
matic buffer detection is not activated in this case. The buffers must be
measured precisely in the specified sequence.

Merck Cer.
Reference temperature = 25 °C. When using Merck CertiPUR buffers
(20 °C) the buffer type Merck Tit. must be selected.

Number of buffers

This parameter is not visible when Buffer type = Special is defined.
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Number of buffers that are used for calibration. If calibration is accom-
plished with more than two buffers, then they can be used repeatedly in
order to give them more statistical weight. The first two buffers must
however always be different from one another.

Selection 1 | 2 | 3 | 4 | 5
Default value 2

Buffer 1 pH

This parameter is visible only when Buffer type = Special.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Input range –20.000 to 20.000 
Default value 7.000 

Buffer 2 pH

This parameter is visible only when Buffer type = Special.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Input range –20.000 to 20.000 
Default value 4.000 
Selection off

Buffer 3 pH

This parameter is visible only when Buffer type = Special.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Input range –20.000 to 20.000 
Selection off
Default value off

Buffer 4 pH

See Buffer 3 pH.

Buffer 5 pH

See Buffer 3 pH.
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Stirrer control

The parameters for the stirrer control during the calibration are edited
under [Stirrer control]. Ensure that a stirrer has been selected in the Edit
command / Stirrer dialog.

NOTE

Deactivate the Stir solution during measurement parameter when
you carry out the calibration with a Sample Processor. The stirrer control
for the tower stirrer is ineffective with these instruments.

Stir solution during measurement

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched on and off auto-
matically at the start or end of the measurement.

Stir before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If the stirrer is switched off during the measurement, it will be stirred for
the time entered before measuring.

Input range 0 to 999999 s
Default value 0 s

Pause before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If it is stirred before the measurement, a waiting time can be defined here
before starting the measurement. No stirring or measuring occurs during
this time.

Input range 0 to 999999 s
Default value 0 s

29.10.2 Calibration parameters (CAL Conc)
Under [Calibration parameters], the parameters influencing the run of
the entire calibration are defined.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
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maximum waiting time is automatically calculated except you already have
modified this waiting time.

Input range 0.1 to 999.0 mV/min
Default value 2.0 mV/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 10 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
Default value 110 s
Selection off

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Sample Processor

If the calibration is carried out with a Sample Processor, the buffers or
standards are automatically changed. This is why no request for the cali-
bration temperature appears when starting the calibration. The value
entered above is used.

Selection off | Remote | USB
Default value off

off
For calibrations without Sample Processor. During the calibration, a
request for changing the buffer/standard is displayed.
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Remote
For automatic calibrations with Sample Processors, which are
connected via the Remote Box.

USB
For automatic calibrations with a Sample Processor that is connected
via USB(see "Definition of the calibration positions", page 509).

Standards

The concentrations of the standards as well as their units are defined
under [Standards].

Unit

Unit of the standard solutions used. For concentration measurements
without standard addition, this unit will be used.

Selection mol/L | mmol/L | ppm | % | g/L | mg/L | µg/L
Default value ppm

Concentration standard 1

Concentration of the standard solution used.

Input range 00.001 to 999999.999 
Default value 1,000 

Concentration standard 2

Concentration of the standard solution used.

Input range 00.001 to 999999.999 
Selection off
Default value off

Concentration standard 3

See Concentration standard 2.

Concentration standard 4

See Concentration standard 2.

Concentration standard 5

See Concentration standard 2.

Stirrer control

The parameters for the stirrer control during the calibration are edited
under [Stirrer control]. Ensure that a stirrer has been selected in the Edit
command / Stirrer dialog.
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NOTE

Deactivate the Stir solution during measurement parameter when
you carry out the calibration with an 814 USB Sample Processor or with
an 815 Robotic USB Sample Processor XL. The stirrer control for the
tower stirrer is ineffective with these instruments.

Stir solution during measurement

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched on and off auto-
matically at the start or end of the measurement.

Stir before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If the stirrer is switched off during the measurement, it will be stirred for
the time entered before measuring.

Input range 0 to 999999 s
Default value 0 s

Pause before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If it is stirred before the measurement, a waiting time can be defined here
before starting the measurement. No stirring or measuring occurs during
this time.

Input range 0 to 999999 s
Default value 0 s

29.10.3 Calibration parameters (CAL Cond)
Under [Calibration parameters], the parameters influencing the run of
the entire calibration are defined.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute.

Input range 00.001 to 999,000 (mS/cm)/min
Selection off
Default value off
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off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed.

Input range 0 to 999999 s
Default value 10 s
Selection off

off
The measurement is continued endlessly.

Measuring temp.

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Standard

The characteristics of the calibration standard used are defined under
[Standard]. These values will be suggested in the request after the start
of the calibration.

Request at calibration start

on | off (Default value: off)

When this parameter is activated, then entering the following parameters
will be requested after the start.

Conductivity standard

Conductivity of the calibration standard used.

Input range 0.00000 to 2000.00 mS/cm
Default value 12.8800 mS/cm
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Reference temp. standard

Reference temperature at which the calibration standard has the conduc-
tivity entered above.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Temp. coefficient

Temperature coefficient belonging to the reference temperature entered
above. With this temperature coefficient, the conductivity is converted to
the reference temperature.

Input range 0.00 to 9.99 %/°C
Default value 1.90 %/°C

Stirrer control

The parameters for the stirrer control during the calibration are edited
under [Stirrer control]. Ensure that a stirrer has been selected in the Edit
command / Stirrer dialog.

Stir solution during measurement

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched on and off auto-
matically at the start or end of the measurement.

Stir before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If the stirrer is switched off during the measurement, it will be stirred for
the time entered before measuring.

Input range 0 to 999999 s
Default value 0 s

Pause before meas.

This parameter can only be edited when the parameter Stir solution
during measurement is deactivated.

If it is stirred before the measurement, a waiting time can be defined here
before starting the measurement. No stirring or measuring occurs during
this time.

Input range 0 to 999999 s
Default value 0 s
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29.10.4 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.10.5 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

Electrode check

on | off (Default value: off)

This parameter is available only for the command CAL pH.

For the following electrodes, an electrode check can be carried out:

￭ pH electrodes
￭ Metal electrodes



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 29 Parameters

900 Touch Control ￭￭￭￭￭￭￭￭ 409

￭ Ion-selective electrodes

A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started. Note that this electrode check has nothing to do with the
electrode test (command ELT).

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the calibration temperature entered
manually will be used.

off
The temperature will not be measured. The calibration temperature
entered manually is used. The temperature is requested after the start,
except the determination is carried out with a Sample Processor.

29.10.6 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation
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Input range –15 to 15 
Default value 8 

29.11 Electrode test for pH electrodes (ELT)

An automatic electrode test can be carried out for pH electrodes which
will permit a qualification of the electrode used. Differentiated specifica-
tions regarding characteristic measurement properties of your pH elec-
trode (slope, response time, etc.) will be obtained as the result. The con-
cluding evaluation of the electrode is carried out by testing these results
against the specified limit values. Once the electrode test has been suc-
cessfully completed, the calibration data is stored with the sensor data of
the sensor used.

These limit values are saved in the software for the following types of pH
electrodes:

￭ Standard electrodes
￭ Gel electrodes
￭ Electrodes with a nonaqueous reference electrolyte

You can, however, also define limits of your own choosing (see chapter
15.7, page 168). The precise classification of the measuring chain is deter-
mined by the reference system used. You will find an overview of these
electrode types and the corresponding limit values in table 18, page 414.

Faulty electrodes often exhibit certain combinations of measurement
results of the electrode test which fall outside the intended limits. This
makes it possible to have more precise data concerning possible causes of
errors and recommended remedial measures.

Buffers

You will require flawless buffers in the pH values 4, 7 and 9 for carrying
out the electrode test. We recommend for this purpose the appropriate
Metrohm buffers. The electrode test can, however, in principle also be car-
ried out with any of the buffer sets contained in the memory.

The buffers must be measured in the following sequence:

1. pH 9
2. pH 4
3. pH 7

NOTE

Ensure in particular the flawlessness of the pH 9 buffer. It can readily
deviate from its specified pH value as the result of absorption of CO2

from the ambient atmosphere, thus leading to incorrect test results.
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Stirrer

A stirrer has to be connected to the titrator for the electrode test.

Temperature

Take care to ensure that the entire electrode test is carried out at a consis-
tently uniform temperature. Work should be accomplished at room temp-
erature wherever possible, in light of the fact that temperature exercises a
great influence on response time. The preset limit values are calibrated to
25 °C.

29.11.1 Electrode test parameters
Under [Electrode test param.], the parameters influencing the sequence
of the electrode test are defined.

Buffer type

Selecting a predefined buffer series.

Selection Metrohm | NIST | DIN | Fluka Basel | Mettler |
 Merck Tit. | Radiometer | Merck Cer. | Baker |
 Hamilton | Precisa

Default value Metrohm

Merck Cer.
Reference temperature = 25 °C. When using Merck CertiPUR buffers
(20 °C) the buffer type Merck Tit. must be selected.

Sample Processor

If the calibration is carried out with a Sample Processor, the buffers or
standards are automatically changed. This is why no request for the cali-
bration temperature appears when starting the calibration. The value
entered above is used.

Selection off | Remote | USB
Default value off

off
For calibrations without Sample Processor. During the calibration, a
request for changing the buffer/standard is displayed.

Remote
For automatic calibrations with Sample Processors, which are
connected via the Remote Box.

USB
For automatic calibrations with a Sample Processor that is connected
via USB(see "Definition of the calibration positions", page 509).

Electrode type

Selection of the electrode type.
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Selection Standard | Gel | Non-aqueous | Custom
Default value Standard

Standard
Electrodes which contain e.g. KCl solution as reference electrolyte.

Gel
Electrodes which contain Idrolyte as reference electrolyte.

Non-aqueous
Electrodes, which contain a non-aqueous reference electrolyte, e.g.
TEABr in ethylene glycol or LiCl in ethanol.

Custom
Under System ▶ Templates a custom electrode type can be defined.

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

29.11.2 Control instrument
The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments
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29.11.3 Sensor
The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the calibration temperature entered
manually will be used.

off
The temperature will not be measured. The calibration temperature
entered manually is used. The temperature is requested after the start,
except the determination is carried out with a Sample Processor.

29.11.4 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1
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Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

29.11.5 Additional information

Table 18 Limit values of the three electrode types

 Rating

Excellent electrode Good electrode Usable electrode

Electrode type "Standard"

Streaming potential 2.5 mV 3.0 mV 4.0 mV

Drift 2.0 mV/s 2.5 mV/s 3.0 mV/s

Min. slope 96.5% 96.0% 95.0%

Max. slope 101.0% 102.0% 103.0%

Response time 45 s 50 s 60 s

Lower limit Uoff –15 mV

Upper limit Uoff 15 mV

Electrode type "Gel"

Streaming potential 3.0 mV 3.5 mV 4.5 mV

Drift 2.5 mV/s 3.0 mV/s 4.0 mV/s

Min. slope 96.5% 96.0% 95.0%

Max. slope 101.0% 102.0% 103.0%

Response time 60 s 75 s 90 s

Lower limit Uoff –20 mV

Upper limit Uoff 20 mV

Electrode type "Non-aqueous"

Streaming potential 3.0 mV 4.5 mV 6.0 mV

Drift 5.0 mV/s 7.0 mV/s 9.0 mV/s
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 Rating

Excellent electrode Good electrode Usable electrode

Min. slope 88.0% 80.0% 70.0%

Max. slope 120.0% 130.0% 140.0%

Response time 60 s 75 s 90 s

Lower limit Uoff –50 mV

Upper limit Uoff 100 mV

Table 19 Possible errors during the electrode test

Test criterion Message Remedy

Buffer pH 9:

The drift in stirred solution is > 1 mV.

General problem ￭ Connect an electrode.
￭ Replace the defective electrode

cable.
￭ Clean the diaphragm (see leaflet

for the electrode).
￭ Replace the electrode.

Buffer pH 9:

–10 mV < U(not stirred) < 10 mV

and

The sum of the drift values after 1, 2,
3 and 4 min is < 12 mV/min.

Short circuit Replace the electrode.

A response time does not fulfill the
limit value for the rating Usable
electrode.

Glass membrane / Diaphragm Clean the diaphragm (see leaflet for
the electrode).

The pH values are not defined for all
the buffers at the temperature
measured.

No buffer data Repeat the electrode test at a temp-
erature at which the pH values of all
the buffers are defined.

All the slopes fulfill the limit values
for the rating Usable electrode.

and

Uoff is outside the preset limits.

Unsuitable reference electrode ￭ Repeat the electrode test with a
suitable reference system.

￭ Replace the contaminated refer-
ence electrolyte.

￭ Select Electrode type = Cus-
tom and adjust the limits for
Uoff.

The streaming potential is too high. Contaminated diaphragm Clean the diaphragm (see leaflet for
the electrode).

Two slopes do not fulfill the limit val-
ues for the rating Usable electrode.

Wrong buffer Repeat the electrode test with buf-
fers pH 4, 7 and 9.

All the slopes do not fulfill the limit
values for the rating Usable elec-
trode.

Partial short circuit ￭ Check the temperature sensor.
￭ Enter the correct calibration

temperature.
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29.12 Evaluations (EVAL)

Various additional evaluations (EVAL commands) can be carried out for
titrations and measurements. The evaluation always refers to the last titra-
tion or measurement prior to the EVAL command. Only those evaluation
commands which are available for the last titration or measurement prior
to the EVAL command can be inserted in the command list. If a titration or
measuring command is deleted before the EVAL command, then it will be
shown in red in the list of commands, as the reference is missing.

EVAL commands can also be inserted in the method run at a later time
and the determination can be reevaluated ([Recalculate] function in the
results dialog).

Additional evaluations for DET titrations

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Volume

￭ EVAL pK/HNP (pK value / half neutralization potential HNP)
This evaluation is only possible for the measuring modes pH and U.

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL BREAK (break points)

Additional evaluations for MET titrations

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Volume

￭ EVAL pK/HNP (pK value / half neutralization potential HNP)
This evaluation is only possible for the measuring modes pH and U.

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL BREAK (break points)

Additional evaluations for SET titrations

The following additional evaluations are possible:
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￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Volume

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL RATE (average dosing rate)

Additional evaluations for KFT titrations

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Volume

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL RATE (average dosing rate)

Additional evaluations for KFC titrations

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Amount of generated iodine

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL RATE (average dosing rate)

Additional evaluations for BRC titrations

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Amount of generated bromine

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL RATE (average dosing rate)

Additional evaluations for STAT titrations

The following additional evaluations are possible:
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￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Volume

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL RATE (average dosing rate)

Additional evaluations for measurements

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL BREAK (break points)

NOTE

The commands EVAL are not available for concentration measurements
(MEAS Conc).

29.12.1 Fixed endpoint evaluation (EVAL FIX-EP)
For the fixed endpoint evaluation, the associated values are interpolated
from the measuring point list for one quantity (measured value, volume,
etc.). Up to nine fixed endpoints can be evaluated with one command.

Fixed quantity

Selection of the quantity to which the associated value is interpolated
from the measuring point list.

Selection Measured value | Time | Volume | Quantity
Default value Measured value

Quantity
Amount of iodine/bromine created (only for KFC/BRC).

Fixed EP1 at

The fixed endpoint must lie between the first and the final entry in the
measuring point list.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.
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Measured value (measuring mode pH):
Input range –20.000 to 20.000 
Selection off
Default value off

Measured value (measuring mode U, Ipol):
Input range –2,000.0 to 2,000.0 mV
Selection off
Default value off

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Selection off
Default value off

Measured value (measuring mode T):
Input range –20.0 to 150.0 °C
Selection off
Default value off

Measured value (measuring mode Cond):
Input range 0.0001 to 999.9999 mS/cm
Selection off
Default value off

Time:
Input range 0.0 to 999,999.9 s
Selection off
Default value off

Volume:
Input range 0.00000 to 9,999.99 mL
Selection off
Default value off

Quantity:
Input range 0.0 to 99,999.9 µg
Selection off
Default value off

Fixed EP2 at…Fixed EP9 at

See Fixed EP1 at.
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29.12.2 pK value and half neutralization potential evaluation (EVAL pK/
HNP)

The pK value (pH measuring mode) or the half neutralization potential (U
measuring mode) can be determined for DET and MET titrations.

The activities of conjugated acid-base pairs are linked by the so-called
Henderson-Hasselbalch equation:

pH = pKa + log (aB/aA)

If the activities of the acid and the conjugated base are equal (aA = aB),
then pH=pKa. This is the value at the half neutralization point and can be
extrapolated from the titration curve. A careful pH calibration is necessary
for pK evaluations. Nonetheless, the determined pK value is only an
approximation, as the ionic strength is not taken into account. In order to
obtain more accurate values, titrations must be carried out with decreas-
ing ionic strength and the results extrapolated to the ionic strength zero.
pK evaluation in aqueous solution is limited to the range 3.5 < pK < 10.5
because of the leveling effect of strong acids and the lack of jumps with
very weak acids. pK values of mixtures of acids and polyvalent acids can
also be determined.

1/2 Volume1/2 1/21/2

EP2

pK2

EP1

pK1

Measured value

Figure 19 Evaluation of pK value / half neutralization potential

In non-aqueous solutions the half neutralization potential (HNP) is fre-
quently used instead of the pK value. The HNP is evaluated in the same
way as the pK value.

No parameters can be edited for the command EVAL pK/HNP.

NOTE

If a start volume is to be added then it must be smaller than the half
endpoint volume.
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29.12.3 Minimum and maximum evaluation (EVAL MIN/MAX)
For the minimum or maximum measured value the associated volume,
time and temperature are interpolated from the measuring point list. The
evaluation begins as soon as the slope of the curve exceeds a particular
threshold value.

Threshold value

Minimum

Maximum

Measured value

Volume / Time

Figure 20 Evaluation of minimum and maximum

Evaluation

Selection whether the minimum or the maximum of the titration curve is
being evaluated. With a command either the minimum or the maximum
can be evaluated. If both values are needed, a second command has to be
defined in the method.

Selection Minimum | Maximum
Default value Maximum

Threshold value

The evaluation of the minimum or maximum begins as soon as the slope
of the curve exceeds the set threshold value. Use a lower threshold value
if the minimum or maximum is not found.

Measuring mode pH:
Input range 0.1 to 20 
Default value 1.0 

With titrations, the unit is pH/mL, with measure-
ments pH/s.

Measuring mode U, Ipol:
Input range 1.0 to 2,000.0 
Default value 25.0 

With titrations the unit is mV/mL, with measure-
ments mV/s.
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Measuring mode Upol:
Input range 0.5 to 10.0 
Default value 5.0 

With titrations the unit is µA/mL, with measure-
ments µA/s.

Measuring mode T:
Input range 0.1 to 20.0 °C/s
Default value 1.0 °C/s

Measuring mode Cond:
Input range 0.5 to 999.9 (mS/cm)/s
Default value 5.0 (mS/cm)/s

29.12.4 Break point evaluation (EVAL BREAK)
A break point evaluation is used to determine sharp changes of direction
in the titration curve. This evaluation is primarily used for photometric and
conductivity titrations. The method is based on the search for extremes in
the second derivative of the curve.

2nd derivative

Break point

Measured value

Volume / Time

Figure 21 Evaluation of a break point

EP criterion

Measure of the minimum sharpness of the break point. The smaller the EP
criterion set, the more break points will be found. As this is a relative value
related to the total measured value modification, even small changes in
the measured value can be evaluated as a break point for a small
measured value range.

Input range 0.0 to 1.0 
Default value 0.3 
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Slope

Minimum difference between the slope before and after the break point.
The smaller the difference, the more break points will be found.

Input range 0.0 to 10.0 
Default value 0.9 

Smoothing factor

The higher the smoothing factor, the fewer break points will be found.

Input range 2 to 20 
Default value 5 

Set windows

This parameter allows to evaluate break points only in a certain range (so-
called window) of the curve. Break points outside this window will not be
evaluated. Only one window can be defined. Within this window how-
ever, all break points are evaluated.

Selection off | Measured value | Time | Volume
Default value off

off
The entire titration curve is being evaluated.

Measured value
The window is defined on the measured value axis.

Time
The window is defined on the time axis.

Volume
The window is defined on the volume axis.

Setting windows

The lower and upper limit of the window is defined under [Set window].

Lower limit

Measured value, time or volume for the lower limit.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
instrument used.

Measured value (measuring mode pH):
Input range –20.000 to 20.000 
Default value –20.000 
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Measured value (measuring mode U, Ipol):
Input range –2,000.0 to 2,000.0 mV
Default value –2,000.0 mV

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Default value –200.00 µA

Measured value (measuring mode T):
Input range –20.0 to 150.0 °C
Default value –20.0 °C

Measured value (measuring mode Cond):
Input range 0.0001 to 999.9999 mS/cm
Default value 0.0001 mS/cm

Time:
Input range 0.0 to 999999.9 s
Default value 0.0 s

Volume:
Input range 0.00000 to 9,999.99 mL
Default value 0.00000 mL

Upper limit

Measured value, time or volume for the upper limit.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Measured value (measuring mode pH):
Input range –20.000 to 20.000 
Default value 20.000 

Measured value (measuring mode U, Ipol):
Input range –2,000.0 to 2,000.0 mV
Default value 2,000.0 mV

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Default value 200.00 µA
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Measured value (measuring mode T):
Input range –20.0 to 150.0 °C
Default value 150.0 °C

Measured value (measuring mode Cond):
Input range 0.0001 to 999.9999 mS/cm
Default value 999.9999 mS/cm

Time:
Input range 0.0 to 999,999.9 s
Default value 999,999.9 s

Volume:
Input range 0.00000 to 9,999.99 mL
Default value 9,999.99 mL

29.12.5 Rate evaluation (EVAL RATE)
The rate evaluation provides the median dosing rate in a defined range
(so-called window). The median dosing rate is determined by means of lin-
ear regression through a minimum of three measuring points. If the dos-
ing is carried out with only one dosing device and if more than one cylin-
der volume is dosed, then the median dosing rate will be reduced as a
result of the filling time.

When the command is opened for the first time, a window over the entire
time range is already defined. In contrary to the potentiometric evaluation
of a DET/MET titration the individual windows may overlap. A maximum
of 9 windows can be defined.

[New]

Define a new window.

[Delete]

Delete the selected window.

[Edit]

Edit the settings of the selected window.

Lower limit

Time for the lower limit.

Input range 0 to 999999 s
Default value 0 s

Upper limit

Time for the upper limit.
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Input range 0 to 999999 s
Default value 999999 s

29.13 Calculations

The following calculation commands are available:

CALC Defining calculations of a determination.

CALC LIVE Defining the calculation whose result will be dis-
played in the live display (so-called live result)
during a titration or measurement.

29.13.1 Calculations (CALC)
Calculations are defined with the command CALC. A method may contain
a maximum of nine calculation commands. A maximum of nine calcula-
tions can be defined per command. A series of variables (raw data from
the determination, previously calculated results, etc.) is available for the
calculations.

The command contains the following options, among others:

￭ Save result as titer
￭ Save result as common variable
￭ Save result in result table
￭ Define result limits

The result name is specified in the list for each calculation.

[New]

Define a new calculation or load an existing template, see following chap-
ter.

[Delete]

Delete the selected calculation from the list.
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[Edit]

Edit the data of the selected calculation (see chapter 29.13.1.2, page
429).

29.13.1.1 Loading a result template

The most common calculations are already available, the so-called result
templates, in order to facilitate the definition of a new calculation. You
also have the option, however, of defining templates of your own (see
dialog System / Templates).

Proceed as follows to load an existing template:

 

1 Select a result template

￭ In the Sequence / Edit command dialog, tap on the [New]
button.
The list of Metrohm result templates is displayed:

￭ Select the desired Metrohm result template and tap on [Load
template].
or
Tap on [Custom templates] and select a template you gener-
ated yourself.

If a statistic variable SMN# (# = 1…9) is defined in the template
which is already used in another calculation, then the following mes-
sage will be displayed:
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2 Confirm the message

￭ Tap on [OK].

The Note dialog is displayed. This note is defined in the dialog Edit
result template / Note for wizard.

 

3 Enter the numerical values of the wildcards

￭ Tap on [Next].
The list of wildcards is displayed:
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￭ Enter the numerical values of the wildcards.
￭ Tap on [Next].

The editing dialog of the new calculation is displayed:

The calculation can now be edited further, e.g. define result limits,
see following chapter.

29.13.1.2 Editing a calculation

Result name

The result name is the text which will be shown in the result display and in
the report. The default name corresponds to the result variable.

Entry max. 24 characters
Default value R1…R9

Calc. formula R1...R9

Shows the calculation formula. A special editor is opened for the defini-
tion (see chapter 29.13.3, page 435). The designation R1...R9 corre-
sponds to the result variable. Under [Result variable] this can later be
modified.

Entry max. 100 characters
Default value empty

Decimal places

Number of decimal places used to display the result.

Input range 0 to 5 
Default value 2 

Result unit

The result unit is displayed and saved together with the result.

Entry max. 10 characters
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Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |
 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %

[Note]

Entering a note on the calculation.

[Result variable]

Modifying the result variable.

[Result limits]

Defining the limits for the monitoring of the result.

[Result options]

Defining additional settings for the calculation.

Dialog "Edit calculation / Note"

In this dialog you can enter a short text, e.g. to describe the variables
used.

Dialog "Edit calculation / Result variable"

When a new calculation is created, the result variable will be automatically
issued. In this dialog, however, it can be modified at any time.

Result variable

To each calculation belongs an unambiguous result variable. With this
result variable you can use this result in additional calculations.

Selection R1 | R2 | R3 | R4 | R5 | R6 | R7 | R8 | R9
The selection contains only those result variables
which are not issued in this calculation command
yet.

Dialog "Edit calculation / Result limits"

For each result, limit values can be defined. These result limits are moni-
tored when the calculation is carried out. If monitoring is activated, the
results are shown as follows in the result display:

￭ Green, if the result falls within the limit values
￭ Red, if the result lies outside the limit values

Monitoring result limits

on | off (Default value: off)

Enabling and disabling the monitoring function.
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Lower limit

When the monitored quantity falls below this value, the action defined in
the following is triggered.

Input range 0 to 9999999999 
Default value 0 

Upper limit

When this value is exceeded, the action defined in the following is trig-
gered.

Input range 0 to 9999999999 
Default value 9999999999 

Action

Selection of the action, which is carried out when the result limits are
exceeded.

Selection Display message | Document message | Cancel
determination

Default value Display message

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the result limits
have been exceeded.

Cancel determination
The determination is stopped.

Dialog "Edit calculation / Result options"

In the dialog Edit calculation / Result options, settings for how to
process the calculated result are defined.

Variable for mean value

If the statistic calculations have been activated (see method options), the
mean value of the single results will be saved as variable SMN1 to SMN9.
As default value, always the first free variable is being displayed.

Selection SMN1 … SMN9 | off

off
For the result not statistic calculations are carried out.

Save as titer

The result can be saved as titer for the selected titrant.
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NOTE

The titer is assigned to the titrant defined in the last titration command
before the calculation. Please note that the CALC command containing
the titer assignment is inserted after the titration command with which
the titer is determined.

Selection Single value | Mean value | off
Default value off

Single value
The result of the current determination is saved as titer.

Mean value
If statistic calculations are carried out for the result, the current mean
value of the determination series is saved.

off
The result is not saved as titer.

Save as common variable

on | off (Default value: off)

The calculated result can be saved as a method-independent variable, a
so-called common variable. The result is then also available in other
methods for calculations. In all cases, only the single value will be saved,
even if the statistics function is enabled.

Variable

Selection of the common variable to which the result is being assigned.

Selection CV01 … CV25

Display result

on | off (Default value: on)

If you deactivate this parameter, the result is neither displayed in the result
dialog nor printed in the result report. This can be advisable for intermedi-
ate results.

Save result in result table

on | off (Default value: off)

The calculated result can be saved in the result table. This may be advisa-
ble if e.g. the results of all determinations carried out on a particular day
are to be displayed clearly. A maximum of nine results from a determina-
tion can be saved in the result table.
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Precision

Setting, with which accuracy the result is used in additional calculations.

Selection Round | Truncate | Full precision
Default value Round

Round
The result is rounded to the defined number of decimal places (com-
mercial rounding, in accordance with the US Pharmacopeia USP). If the
digit at the first dropped decimal place is 1, 2, 3 or 4, then it will be
rounded off; if this digit is 5, 6, 7, 8 or 9, then it will be rounded up.
Negative digits will be rounded in accordance with their amount, i.e.
away from zero.

Truncate
The result is cut to the number of decimal places defined.

Full precision
The result is used with full accuracy (floating point number either in
"single precision" (32 bit) or in "double precision" (64 bit), according to
the standard IEEE 754).

29.13.2 Calculations (CALC LIVE)
The command CALC LIVE can be used to define a calculation, the result
of which will be shown in the live display during a titration or measure-
ment. The current volume or measured value, respectively, is used for this
purpose. This is helpful, e.g. for Karl Fischer titrations, in order to be able
to track the water content directly during the titration.

CAUTION

The command must be inserted directly before the corresponding titra-
tion or measuring command.

This command is identical with the CALC command except for the follow-
ing differences:

￭ The number of variables is limited.
￭ There are no result options.
￭ The result cannot be monitored.
￭ The result variable cannot be modified.
￭ The result will only be displayed in the live display. It appears neither in

the results dialog nor in a report.

Result name

With live calculations no custom result name can be defined, the designa-
tion LR cannot be modified.
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Calculation formula

Shows the calculation formula. A special editor is opened for the defini-
tion (see chapter 29.13.3, page 435).

Entry max. 100 characters
Default value empty

Decimal places

Number of decimal places used to display the result.

Input range 0 to 5 
Default value 2 

Result unit

The result unit is displayed and saved together with the result.

Entry max. 10 characters
Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |

 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %

[Note]

Entering a note on the calculation.

Dialog "Edit calculation / Note"

In this dialog you can enter a short text, e.g. to describe the variables
used.

Displaying the live result

Proceed as follows to display the live result in the live display:

 

1 Starting a determination

￭ Tap on [ ].

The determination starts and the live display is shown:

 

2 Define the display options

￭ Tap on the [View] button.
￭ Tap on the [Meas. value options] button.

A maximum of three measured values can be shown in the live
display.

￭ Select the option Live result at one of the three parameters.
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3 Display the live display

￭ Tap twice on [ ].

The current result is displayed,

29.13.3 Formula editor
The formulas for the calculations are entered with the formula editor. The
maximum formula length is 100 characters.

The formula editor contains buttons for entering numbers, mathematical
operators and variables. The variables can be selected from lists. This is
advisable in order to avoid spelling mistakes. The formula editor is
equipped with an automatic syntax check, which is activated when apply-
ing the formula. The standard rules of priority apply for the calculation
operations.

Key Description

C00 Sample size

CI Sample identification CI# (# = 1 - 2)

EP Volume of endpoint EP# (# = 1…9)

CV Common Variable CV# (# = 1…25)

R Result R# (# = 1 - 9)

TITER Titer of the titrant selected in the previous command

CONC Concentration of the titrant selected in the previous
command

⌫ The character in front of the cursor is deleted.

Delete entry The content of the input field is deleted completely.
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Key Description

⇦ The cursor within the input field is shifted to the left by
one character.

⇨ The cursor within the input field is shifted to the right by
one character.

If the method contains more than one data-generating command (titra-
tion, measurement etc.) before the calculation command, then you will
have to indicate the command identification in front of the variable:

Variable Description

#M. Titration or measuring command

#C. Calculation command

#E. Evaluation command

"#" stands for a sequential number that you must enter manually. The
number for each command identification will be counted separately and
does not necessarily correspond to the number of the command line.

Example: The variable 1M.TITER corresponds to the titer of the titrant
selected in the first titration command.

CAUTION

The command identifications are not adjusted automatically when addi-
tional commands are subsequently inserted into the method. Check the
formula for correctness in such cases.

[Variables]

Opening the list of additional variables (see chapter 29.13.3.1, page 436).

[Math. functions]

Opening the list with mathematical functions (see chapter 29.13.3.2,
page 437).

29.13.3.1 Variables

All of the variables which can be used for calculations are divided up
according to subject in the dialog Calculation formula / Variables:

￭ System variable
List of the system-specific variables. These variables describe the cur-
rent status of the system.

￭ Result and statistics variables
List of the variables which are required for calculating results and statis-
tics for the current determination.
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￭ Common variables
List of common variables. All of the common variables are listed, no
matter whether they possess a value or not.

You will find a detailed description of all of the variables in chapter
29.13.3.3, page 438.

29.13.3.2 Mathematical functions

The following mathematical functions can be utilized in a calculation for-
mula:

Function Description

y^z Power function

Example: 4^2 = 16

SQRT(X) Square root of X

Example: √(EP1)

ABS(X) Absolute value of X

Example: ABS(C00); in order, e.g. with weighing by dif-
ference, to convert the negative sample size to a positive
value for later calculations.

LN(X) natural logarithm of X

LOG(X) Decimal logarithm of X

FRAC(X) Fraction of X

Example: FRAC(2.5971) = 0.5971

INT(X) integer part of X

Example: INT(2.5971) = 2

TST(X,Y) Test function

If invalid variables (e.g. missing endpoints) occur in a
calculation, then these can be replaced with a valid value
by using this function. In this way invalid results can be
avoided.

￭ Syntax:
– X = variable to be tested
– Y = substitute value
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29.13.3.3 Variable list

The following table contains all of the variables which can be used for cal-
culations. For variables having an index (e.g. 'EP1'), the index must be
entered manually. In the following table, this index is characterized with
the character "#".

Variable Description

C00 Sample size

CI1, CI2 Sample identifications

The sample identifications can be used in calculations only if numerical values are entered.

DD Duration of the entire determination

Titrants

TITER Titer of the titrant selected in the titration command

CONC Concentration of the titrant selected in the titration command

Titrations, measurements, calibrations

EP# Volume/quantity of endpoint EP# (# = 1 - 9)

EC# Charge at endpoint EP# (# = 1 - 9)

EM# Measured value of endpoint EP# (# = 1…9)

EF# ERC of endpoint EP# (# = 1 - 9)

ET# Temperature at endpoint EP# (# = 1…9)

ED# Time at endpoint EP# (# = 1…9)

ESI# Recognition of endpoint EP# (# = 1 - 9)

Endpoint found = 1, no endpoint = 0

FMN Mean gas flow during MEAS T/F ON to MEAS T/F OFF

TMN Mean temperature during MEAS T/F ON to MEAS T/F OFF

TMI Minimum temperature during MEAS T/F ON to MEAS T/F OFF

TMA Maximum temperature during MEAS T/F ON to MEAS T/F OFF

MIM Initial measured value, i.e. measured value prior to the processing of the start conditions

MIT Initial temperature, i.e. temperature prior to the processing of the start conditions

MSA Volume for start volume

MSP Volume for start measured value

MSS Volume for start slope

MSV Volume for all the start conditions

MSD Duration of start conditions

MSM Start measured value, i.e. measured value after the processing of the start conditions

MST Start temperature, i.e. temperature after the processing of the start conditions
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Variable Description

MCD Total duration of the titration, measurement or calibration

MTM Type of temperature measurement (Pt1000, NTC or manually)

Format = Text

MDD Duration of effective dosing, i.e. without filling times, pauses

MDC Drift for drift correction

DDC Time for drift correction

MCV End volume, i.e. total dosed volume at the end of the titration

MCQ End quantity, i.e. total amount of removed water or of generated bromine, respectively, at the end
of the titration (in µg)

MCC Final charge, i.e. total charge in mAs at the end of the titration

MCM End measured value

MCT End temperature

MMP Number of measuring points in measuring point list

MTS Stop type

Format = Text

LV Currently dosed volume of the ongoing determination

LM Current measured value of the ongoing determination

LD Current duration of the ongoing titration or measuring command

LT Current temperature of the ongoing determination

Sensor

MEN Electrode zero point pH(0) or E(0)

MSL Electrode slope

MVA Electrode variance (mathematically only defined for 3 standards or more);

CAL Conc: calculated only if calibration is carried out with a minimum of four standards

MCL Cell constant of conductivity measuring cell

Evaluations

FP# Volume/amount of fixed endpoint FP# (# = 1–9)

FM# Measured value of fixed endpoint FP# (# = 1 - 9)

FT# Temperature at fixed endpoint FP# (# = 1 - 9)

FD# Time at fixed endpoint FP# (# = 1 - 9)

HP# Volume of pK value / half neutralization potential HP#

HM# Measured value of pK value / half neutralization potential HP#

HT# Temperature at pK value / half neutralization potential HP#

HD# Time at pK value / half neutralization potential HP#
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Variable Description

XIP Volume/quantity of minimum measured value

XIM Minimum measured value

XIT Temperature at minimum measured value

XID Time at minimum measured value

XAP Volume/quantity of maximum measured value

XAM Maximum measured value

XAT Temperature at maximum measured value

XAD Time at maximum measured value

BP# Volume of break point BP# (# = 1 - 9)

BM# Measured value of break point BP# (# = 1 - 9)

BT# Temperature at break point BP# (# = 1 - 9)

BD# Time at break point BP# (# = 1 - 9)

RD# Mean rate in time slot # (# = 1 - 9)

RDS# Standard deviation for RD# (# = 1 - 9)

RDC# Correlation coefficient for RD# (# = 1 - 9)

RM Mean rate for whole range

RMS Standard deviation for RM

RMC Correlation coefficient for RM

Results, statistics

R# Result (# = 1–9)

SMN# Mean value of result R# (# = 1–9)

SSA# Absolute standard deviation of SMN# (# = 1 - 9)

SSR# Relative standard deviation of SMN# in % (# = 1 - 9)

SNR# Number of results from which the mean value SMN# was calculated (# = 1 - 9)

SSD Number of determinations that are carried out for the statistics calculations

SNT Statistics status (statistics activated = 1, statistics deactivated = 0)

Common variables

CV# Common variable (# = 1…25)

System variables

%RN Sample number, i.e. number that is increased by one at each start of a determination

%SC Start counter, see dialog More determination data / Properties

%AS Autostart status (autostart activated = 1, autostart deactivated = 0)

%AC Autostart counter, i.e. number of autostarts already carried out
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Variable Description

%AD Autostart setpoint counter, i.e. number of autostarts to be carried out

%SS Status of the sample table (sample table activated = 1, sample table deactivated = 0)

%SL Number of the current sample table line

%SE Last sample in the sample table processed (yes = 1, no = 0)

29.14 Reports (REPORT)

The reports to be printed out are defined with the command REPORT. A
maximum of ten reports can be defined for each command. The following
reports can be inserted, among others:

￭ Result report
￭ Calculation report
￭ Parameter report
￭ System reports (system settings, sensor list, GLP data etc.)
￭ Method reports (method run, method parameters etc.)

[Report options]

Defining the general settings for the report output.

[Insert]

Add a new report to the list.

[Delete]

Delete the selected report from the list.

[Edit]

Edit the settings of the selected report.
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29.14.1 General report options
The settings for the report printout can be adjusted in the dialog Edit
command / Report options to indicate, for example, whether a report
header, a signature line or a frame is to be printed.

Report header

Defining the output of the report header. The report header contains gen-
eral information such as device type, serial number, program version and
the printing date.

NOTE

You can also define your own report header, which is printed in addi-
tion to this report header (System ▶ Templates ▶ Report header).

Selection off | once | on each page
Default value on each page

off
The report header will not be printed.

once
The report header will only be printed on the first page.

on each page
The report header will be printed on every page.

Signature line

Output of a special line for date and signature. This line will be printed at
the very bottom of every page.

Selection off | once | on each page
Default value off

off
No signature line will be printed.

once
The signature line will only be printed on the last page.

on each page
The signature line will be printed on every page.

Frame

on | off (Default value: on)

If this parameter is activated, a frame is printed as lateral marking.
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29.14.2 Settings of the individual reports

Fixed key [ ]: More reports ▶ Report ▶ Edit

Command REPORT: Report ▶ Edit

Settings can be edited for the following reports (for details, see online
help):

￭ Result report
￭ Curve

Definition of the curve size, display of the individual measuring points
and grid lines, etc.

￭ Measuring point list
Definition of the method command to which the measuring point list is
to be printed.

￭ Calculations
Definition of the accuracy with which the variables used as well as the
results calculated are printed.

￭ Statistics short
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Statistics overview
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Sample table
￭ Result table

Definition of the time at which the report is to be printed (with each
determination, at the end of a sample series or at the end of the sam-
ple table).

￭ Used devices
￭ Variables
￭ Monitoring

29.14.3 List of reports
The following reports can be inserted in the command REPORT:

NOTE

If you are using a CUSTOM NEOS printer, you can print only the
reports that are marked with a # on the display.

Report Contents

Result report # Report with determination properties, sample data, calculated results,
etc. If there are multiple determinations, the statistics will also be printed
out.
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Report Contents

Curve # Curve report.

Measuring point list # Measuring point list report.

Calculations # Details concerning the calculations carried out (parameter settings in
accordance with the CALC command and the calculated results).

Used devices  The devices used for the determination, as displayed in the More
determination data / Properties dialog.

Variables  All determination variables, as displayed in the results dialog.

Monitoring  Details for the monitored quantities (STAT, DOS only).

Statistics

Statistics short # Summary of the statistics calculations. The number of determinations,
the mean value, and the absolute and relative standard deviations are
printed out for each result.

Statistics overview # Detailed statistical overview. The sample data and all individual results
are printed out for each determination. The number of determinations,
the mean value, and the absolute and relative standard deviations are
printed out for each result.

Sample data

Sample table  List of all determinations in the sample table with the respective sample
data, as entered in the sample table.

Result table

Result table  List of all determinations in the result table with results and with the
determination data, as saved in the result table.

More reports ▶ Method reports

Method sequence  Method properties and the list of all method commands.

Parameters full  Method properties and options, all method commands with all parame-
ters.

All parameters which no longer have their default settings will be prin-
ted in bold. All parameters which have been modified in comparison to
the stored version of the method are indicated by an *.

Titration & measuring param.  Method properties; titration, measurement and calibration commands
with all parameters.

All parameters which no longer have their default settings will be prin-
ted in bold. All parameters which have been modified in comparison to
the stored version of the method are indicated by an *.

Modified parameters  Method properties, all method parameters which have been modified in
comparison to the stored version of the method.

Non default parameters  Method properties, all method parameters which no longer have any
default settings.

More reports ▶ System reports
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Report Contents

System settings

System settings  Settings for acoustic signals and accuracy of the measured value display.

Dialog options  Settings for routine dialog and expert dialog.

Titrants

Titrant list  List of all the titrants configured in the system.

All titrant data short  The most important titrant data of all titrants (name, concentration, titer,
last titer determination).

All titrant data full  All of the titrant data of all of the titrants (working life, titer options,
data concerning the exchange unit/dosing unit).

Sensors

Sensor list  List of all the sensors configured in the system.

All sensor data short  The most important sensor data for all sensors (name, calibration data).

All sensor data full  All of the sensor data for all of the sensors (working life, complete cali-
bration data, calibration interval).

Device manager

Device list  List of all devices configured in the system.

All device properties  Properties of all the devices configured in the system.

GLP manager

GLP data  All data stored in the GLP manager.

Common variables

Common variable list  List of all the common variables defined in the system, together with
their most important data (name, value, status).

All common variable properties  Properties of all common variables (name, value, validity, status).

Templates

Templates sample data  Sample identification list and sample assignment table.

Result template list  List with all of the user-generated result templates.

All result templates details  Details of the all of the user-generated result templates (calculation for-
mula, result options, note).

Input/Output lines  List with all of the defined input and output lines at the remote interface
(name, bit pattern).

Custom calibration buffers  Temperature tables for all defined custom calibration buffers.

Rack tables

Sample rack list  List with all of the sample racks configured in the system, together with
designation, number of positions and rack code.

Miscellaneous   

Form feed  If this entry is inserted between two reports, then these will each be
printed out on a separate page.
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29.15 Dosing and Liquid Handling

The following dosing commands are available:

Preparing the
exchange unit or
dosing unit (PREP)

Rinsing the cylinder and the tubings of the
exchange unit / dosing unit.

Emptying the dos-
ing unit (EMPTY)

Emptying the cylinder and the tubings of the
dosing unit.

Dosing a fixed vol-
ume (ADD)

Dosing a specified volume.

Liquid Handling
(LQH)

Carrying out complex dosing tasks with a Dos-
ino.

Monitored dosing
(DOS)

Dosing with simultaneous monitoring of
measured value and temperature.

29.15.1 Preparing an exchange or dosing unit (PREP)
The PREP command is used to rinse and fill air bubble-free the cylinder
and tubings of the exchange or dosing unit. You should carry out this
function before the first determination or once a day.

Control device

This parameter is only displayed when several control devices are config-
ured. Control devices are defined under System ▶ Device manager.

Selection of the control device from the list of devices. The control devices
do not have to be connected. This allows to transfer methods more easily
from one system to another.

Selection Selection of configured control devices

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the parameters defined for the titrant for
the preparing as well as the tubing parameters (dosing unit only) are used.
Titrants are defined under System ▶ Titrants. You can also enter a name
which is not contained in the titrant list. When a determination is started
there is a check whether the solution is contained in the list.
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For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, the validity of the titer, the working life of the titrant
and the time interval for the GLP test of the buret unit are checked at the
start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place. The command is carried out with default
parameters (see Chapter 32.2.2, page 504 and Chapter 32.3.2, page
505).

Cylinder volume to

This parameter can only be edited with Titrant = not defined.

Selection of the port via which the titrant is ejected. This setting is only rel-
evant for dosing units, in case of preparing an exchange unit, this setting
is ignored.

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 1

29.15.2 Emptying a dosing unit (EMPTY)
The EMPTY command is used to empty the cylinder and tubings of the
dosing unit.

Control device

This parameter is only displayed when several control devices are config-
ured. Control devices are defined under System ▶ Device manager.

Selection of the control device from the list of devices. The control devices
do not have to be connected. This allows to transfer methods more easily
from one system to another.

Selection Selection of configured control devices

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1



29.15 Dosing and Liquid Handling ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

448 ￭￭￭￭￭￭￭￭ 900 Touch Control

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the parameters defined for the titrant for
the preparing as well as the tubing parameters (dosing unit only) are used.
Titrants are defined under System ▶ Titrants. You can also enter a name
which is not contained in the titrant list. When a determination is started
there is a check whether the solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, the validity of the titer, the working life of the titrant
and the time interval for the GLP test of the buret unit are checked at the
start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place. The command is carried out with default
parameters (see Chapter 32.2.2, page 504 and Chapter 32.3.2, page
505).

Air inlet

This parameter can only be edited with Titrant = not defined.

Selection of the port via which air is aspirated. This setting is only relevant
for dosing units, in case of preparing an exchange unit, this setting is
ignored.

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 4

29.15.3 Dosing a specified volume (ADD)
You can dose a specified volume with the command ADD.

29.15.3.1 Dosing parameters

The parameters for the dosing are defined under [Dosing parameters].

Volume

Volume which is dosed.

Input range 0.00000 to 99999.9 mL
Default value 10.0000 mL

Dosing rate

The rate at which dosing takes place.
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Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

29.15.3.2 Control instrument

The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.15.3.3 Dosing device

The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1
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Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Tandem dosing

A second dosing device can be defined under [Tandem dosing] in order
to enable uninterrupted dosing. Dosing is carried out with a combination
of two dosing devices so that the second dosing device is dosing while
the first one is being filled and vice versa.

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value off

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. Titrants are defined under System ▶ Titrants. You can
also enter a name which is not contained in the titrant list. When a deter-
mination is started there is a check whether the solution is contained in
list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, only the time interval for the GLP test of the buret unit
is checked at the start of the determination.
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NOTE

The concentration, validity of the titer and the working life of the titrant
are ignored.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

However, in order to ensure uninterrupted dosing, the following points
must be taken into account:

￭ Use the highest possible filling rate in order to keep the filling times as
short as possible. The filling rate should be decreased for viscous liq-
uids.

￭ When you use two buret units with different dosing cylinders, the fill-
ing rate for the larger sized cylinder must be at the minimum:

= filling rate in mL/min for the larger sized cylinder

= filling rate in mL/min for the smaller cylinder

= cylinder volume in mL of the buret unit of the second dosing
device

= cylinder volume in mL of the buret unit of the first dosing
device

Example:

Dosing device 1: volume = 20 mL, filling rate = 50 mL/min

Dosing device 2: volume = 50 mL

Filling rate 2 ≥ 50 mL/min · 50 mL / 20 mL ≥ 125 mL/min
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￭ The dosing rate must not exceed 75% of the filling rate of the smaller
cylinder. These values are listed in the following table, valid at maxi-
mum filling rate:

Table 20 Maximum dosing rate for different dosing cylinders

Cylinder volume maximum dosing rate

Exchange unit Dosing unit

1 mL 2.25 mL/min –

2 mL – 5.00 mL/min

5 mL 11.25 mL/min 12.50 mL/min

10 mL 22.50 mL/min 25.00 mL/min

20 mL 45.00 mL/min 50.00 mL/min

50 mL 112.50 mL/min 124.50 mL/min

29.15.3.4 Stirrer

The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 
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Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.15.4 Liquid Handling (LQH)
The command LQH can be used to carry out Liquid Handling tasks with a
dosing device of the type Dosino (700 or 800). The manifold options of
the Dosino can be exploited in full in combination with a Sample Pro-
cessor. The four ports of the dosing units can be used at will as output or
input ports. This means that not only simple dosing and filling procedures
are possible. Complex Liquid Handling tasks such as pipetting or sample
transfers can be carried out without difficulty. Several LQH and automa-
tion commands are required for this purpose which are best combined
into subsequences.

29.15.4.1 Liquid Handling parameters

The parameters for the Liquid Handling function are defined under [Liq-
uid Handling param.].

Function

Type of Liquid Handling function.

Selection Dose | Fill | Aspirate | Eject | Exchange posi-
tion | Change port | Compensate | End volume

Dose
The given volume is dosed. The dosing cylinder neither is automatically
filled before nor afterwards.

Fill
The dosing cylinder is filled. The valve disc then remains at the selected
port.

Aspirate
Liquid is aspirated. The dosing cylinder neither is automatically filled
before nor afterwards. The aspirating volume has to be aspirated with
a single piston stroke.

Eject
The whole cylinder content is ejected. The piston is, in contrast to the
function End volume, lowered to the stop point, i.e. past the maxi-
mum volume mark. This function should only be carried out for prepar-
ing a dosing unit before the pipetting procedure.

Exchange position
The dosing cylinder is filled. This means that, for example, air can be
aspirated via Port 4. The valve disc is then rotated to Port 2 and the
dosing drive can be removed from the dosing unit.
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Change port
The stopcock is moved to the given port, but no piston movement
takes place.

Compensate
Because of the fact that the dosing units are interchangeable, the cou-
pling of the Dosino piston rod (spindle) exhibits a low mechanical toler-
ance that can be noticed when the piston changes its direction of
movement. This tolerance can be compensated with this function. A
short piston movement is first made in the same direction as the previ-
ous movement, which is then followed by a piston movement in the
reverse direction.

End volume
The whole cylinder content is ejected. The piston is lowered to the
maximum volume mark i.e. until 10'000 pulses have been dosed. This
command should be used for pipetting functions for emptying the cyl-
inder.

In-/Outlet

Selection of the port via which the Liquid Handling command is carried
out.

Selection Port 1 | Port 2 | Port 3 | Port 4

Port 1
Default value, when Function = Dose, Aspirate and End volume.

Port 2
Default value, when Function = Fill, Exchange position and
Change port.

Port 4
Default value, when Function = Eject and Compensate.

Volume

This parameter can only be edited with Function = Dose and Aspirate.

Volume which is dosed or aspirated.

Function = Dose:
Input range 0.00000 to 99999.9 mL
Default value 1.00000 mL

Function = Aspirate:
Input range 0.00000 to 50.0000 mL
Default value 1.00000 mL

Flow rate

This parameter can only be edited with Function = Dose, Fill, Aspirate,
Eject, Exchange position and End volume.
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Rate at which it is dosed or filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing and filling rates depend on the cylinder volume
(see chapter 32, page 503).

29.15.4.2 Control instrument

The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.15.4.3 Dosing device

The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.
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For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

29.15.5 Monitored dosing (DOS)
With the DOS command, you can dose and at the same time monitor the
measured value and/or the temperature.

29.15.5.1 Dosing parameters

The parameters for the dosing are defined under [Dosing parameters].

Dosing criteria

Three different dosing types can be selected for the dosing. Two of the
following parameters can be specified:

￭ Volume
￭ Dosing rate
￭ Dosing time

The third parameter is calculated according to the following formula:

Volume = Dosing rate · Dosing time

If continuous dosing is necessary, tandem dosing can be used (see chapter
29.7.8, page 377). Tandem dosing is carried out with a combination of
two dosing devices so that the second dosing device is dosing while the
first one is being filled and vice-versa.

Selection Volume/Dosing rate | Volume/Dosing time |
 Dosing rate/Dosing time

Volume/Dosing rate
Defining the volume to be dosed and and the dosing rate.

Volume/Dosing time
Defining the volume to be dosed and the dosing time.

Dosing rate/Dosing time
Defining the dosing rate and the dosing time.
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Dosing criterion "Volume/Dosing rate"

Single dosing Tandem dosing

Dosing rate

t/s

V/mL

Dosing rate

V/mL

t/s

Filling time

Figure 22 Dosing criterion "Volume/Dosing rate"

Dosing criterion "Volume/Dosing time"

Single dosing Tandem dosing

V/mL

t/s

Filling time

t1 t2 t/s

V/mL

t1 2 + t

Figure 23 Dosing criterion "Volume/Dosing time"

CAUTION

The defined time corresponds to the net dosing time t1+t2, i.e. the fill-
ing time is not included in the total.

If the dosing rate resulting from the settings cannot be reached, then dos-
ing will be carried out at the highest possible rate.

The following formula can be used to estimate whether the maximum
dosing rate is being used or not:

: Dosing rate in mL/min

: Desired flow rate in mL/min
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NOTE

This formula applies only for using a single dosing device. The dosing
rate is equal to the flow rate in the case of tandem dosing.

If the required dosing rate exceeds the maximum dosing rate for the
selected exchange unit or dosing unit (see chapter 32, page 503), then a
larger cylinder volume must be selected.

Dosing criterion "Dosing rate/Dosing time"

Single dosing Tandem dosing

V/mL

t/s

Dosing rate

Filling time

t1 t2 t/s

V/mL

Dosing rate

t1 2 + t

Figure 24 Dosing criterion "Dosing rate/Dosing time"

Volume

Volume which is dosed.

Input range 0.00000 to 99999.9 mL
Default value 10.0000 mL

Dosing rate

The rate at which dosing takes place.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 32, page 503).

Dosing time

Time while dosing is carried out, i.e. the filling time is not taken into
account.

Input range 0 to 999999 s
Default value 100 s
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More parameters

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command). This value is used for temperature correction in pH
measurements.

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 5.0 s

Pause

Waiting time, e.g. for the electrode to settle down after the start.

Input range 0 to 999999 s
Default value 0 s

Flow rate of a single dosing device

The cylinder volume and the filling time of the exchange unit or dosing
unit must be taken into account for the calculation of the effective flow
rate.

Table 21 Maximum flow rates for different cylinder volumes

Cylinder volume Maximum flow rate

Exchange unit Dosing unit

1 mL approx. 80 mL/h –

2 mL – approx. 180 mL/h

5 mL approx. 400 mL/h approx. 450 mL/h

10 mL approx. 800 mL/h approx. 900 mL/h

20 mL approx. 1.6 L/h approx. 1.8 L/h

50 mL approx. 4 L/h approx. 4.5 L/h

Filling times

Filling times are not included in the calculation of the dosing rate by the
Titrando. The filling times (including valve switching) can be estimated
according to the following formula:
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: Filling time in s

: maximum filling rate in mL/min

: current filling rate in mL/min

: Filling time for one cylinder volume:

￭ 20 s (exchange unit)
￭ 18 s (dosing unit)

The maximum filling rate depends on the cylinder volume of the exchange
unit / dosing unit attached (see chapter 32, page 503). The approximate
filling times (including valve switching) are given in the table below for var-
ious cylinder volumes (exchange unit and dosing unit) at different filling
rates:

Cylinder vol-
ume

Filling time in s

max. 100 mL/min 50 mL/min 10 mL/min

1 mL 24 / – – – –

2 mL – / 22 – – –

5 mL 24 / 22 – – 34

10 mL 24 / 22 – – 64

20 mL 24 / 22 – 28 124

50 mL 24 / 22 34 64 304

Application example

1 L reagent is to be dosed within 1 hour with a 50 mL exchange unit.
How large is the dosing rate?

Conditions:

: Total duration = 60 min

: Dosing volume = 1,000 mL

: Filling time = 24 s (assumption: max. filling rate)

: Cylinder volume = 50 mL

Calculation of the number of filling procedures:
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: maximum number of filling procedures of the dosing cylin-
der

: Dosing volume = 1,000 mL

: Cylinder volume = 50 mL

In accordance with this formula, the dosing cylinder must be filled 20
times.

If the division results in a whole number, then the last filling procedure
need not be taken into account. In our example, the dosing cylinder must
be filled 19 times. There is no dosing during this time, i.e. the actual dos-
ing time is:

Calculation of the actual dosing time:

effective dosing time

: Total duration = 60 min

: Number of required filling procedures of the dosing cylinder =
19

: Filling time = 24 s (assumption: max. filling rate)

According to this formula, the actual dosing time is 52.4 min.

This results in the following dosing rate:

Calculation of the required dosing rate:

: required dosing rate in mL/min

: Dosing volume = 1,000 mL

: Total duration = 60 min

: Number of required filling procedures of the dosing cylinder =
19

: Filling time = 24 s (assumption: max. filling rate)

According to this formula, dosing must proceed at a dosing rate of 19.1
mL/min.

Parameterization:
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29.15.5.2 Stop conditions

The conditions for canceling the dosing are defined under [Stop condi-
tions].

Stop volume

The dosing is stopped when the specified volume has been dosed since
the start of the dosing. This volume should be adjusted to the size of the
titration vessel in order to prevent the contents from running over.

Input range 0.00000 to 99999.9 mL
Selection off
Default value off

Stop time

The dosing is stopped when the specified time has elapsed since the start
of the dosing.

Input range 0 to 999999 s
Selection off
Default value off

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).
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29.15.5.3 Monitoring

Under [Monitoring], the parameters for monitoring the following quanti-
ties are defined:

￭ Measured value
￭ Temperature

Remote signals or RS-232 commands can be assigned to the monitored
quantities (see "Communication", page 466). These remote signals or
RS-232 commands are sent if a limit has been infringed. This can be used,
for example, to switch a thermostat on/off if necessary.

The parameters are identical for all monitored quantities.

Measuring mode

Selection of the measuring mode to be monitored.

Selection pH | U
Default value pH

pH
Dosing with monitoring the pH value.

U
Dosing with monitoring the voltage.

Monitoring

on | off (Default value: off)

Enabling and disabling the monitoring function.

Lower limit

When the monitored quantity falls below this value, the action defined in
the following is triggered.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Measuring mode pH:
Input range –20.000 to 20.000 
Default value –20.000 

Measuring mode U:
Input range –2,000.0 to 2,000.0 mV
Default value –2,000.0 mV
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Temperature:
Input range –20.0 to 150.0 °C
Default value –20.0 °C

Lower hysteresis

The lower hysteresis represents the tolerance range for the lower limit (see
figure 27, page 466). When Action = Wait the dosing does not continue
until the monitored quantity has once again exceeded the lower limit incl.
the value entered here.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Measuring mode pH:
Input range 0.000 to 20.000 
Default value 0.020 

Measuring mode U:
Input range 0.0 to 2,000.0 mV
Default value 2.0 mV

Temperature:
Input range 0.0 to 150.0 °C
Default value 0.2 °C

Upper limit

When this value is exceeded, the action defined in the following is trig-
gered.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Measuring mode pH:
Input range –20.000 to 20.000 
Default value 20.000 

Measuring mode U:
Input range –2,000.0 to 2,000.0 mV
Default value 2,000.0 mV

Temperature:
Input range –20.0 to 150.0 °C
Default value 150.0 °C
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Upper hysteresis

The upper hysteresis represents the tolerance range for the upper limit
(see figure 27, page 466). When Action = Wait, the dosing does not
continue until the monitored quantity has once again fallen below the
upper limit incl. the value entered here.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Measuring mode pH:
Input range 0.000 to 20.000 
Default value 0.020 

Measuring mode U:
Input range 0.0 to 2,000.0 mV
Default value 2.0 mV

Temperature:
Input range 0.0 to 150.0 °C
Default value 0.2 °C

Action

Selection of the action which is carried out when the limits of the moni-
tored quantity are infringed.

Selection None | Exit method | Cancel command |
 Pause | Wait

None
No action will be taken.

Exit method
The method is stopped immediately.

Cancel command
The current command is stopped und the next command in the
method will be started.

Pause
Adding reagent is stopped until the dosing is continued manually with
[Continue]. If several quantities are monitored, the other quantities
will still be monitored in the background.

Wait
Adding reagent is stopped until the value of the monitored quantity is
within the limits again (incl. hysteresis). The dosing is continued auto-
matically. If several quantities are monitored, the other quantities will
still be monitored in the background.
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Upper limit

Lower limit

Stop

Monitored
quantity

Time

Figure 25 Action "Exit method" or "Cancel command"

[Continue]
Upper limit

Lower limit

Pause

Monitored
quantity

Time

Figure 26 Action "Pause"

Upper hysteresis

Lower hysteresis

Upper limit

Lower limit

Wait

Monitored
quantity

Time

Figure 27 Action "Wait"

Communication

Under [Communication], remote signals or RS-232 commands can be
assigned to the monitored quantities. These remote signals or RS-232
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commands are always sent, independent of the action defined for a limit
infringement (see "Action", page 372).

[New]

Define a new assignment.

[Delete]

Delete the selected assignment.

[Edit]

Edit the settings for the selected assignment.

Monitored quantity

Selection of the monitored quantity to which a remote signal or an
RS-232 command is to be assigned.

Selection Measured value | Temperature | any

any
If several quantities are monitored, the remote signal or RS-232 com-
mand set is sent as soon as a limit of one of the monitored quantities is
exceeded.

Infringed limit

Indicating the limit whose infringement causes the remote signal or
RS-232 command defined in the following to be sent.

Selection upper | lower | any | back in range

upper
The remote signal or the RS-232 command is sent when the upper
limit is exceeded.

lower
The remote signal or the RS-232 command is sent when the lower limit
is exceeded.

any
The remote signal or the RS-232 command is sent when the upper or
the lower limit is infringed.

back in range
The remote signal or the RS-232 command is sent when the value of
the monitored quantity is within the limits again (incl. hysteresis).

Interface

Selection of the Remote Box or the serial interface via which the remote
signal or the RS-232 command is sent.

Selection Remote Box 1…4 | COM1…8
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Output signal

This parameter can only be edited when a Remote Box is selected under
Interface.

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.

NOTE

A line set active is not being reset automatically, nor at the end of the
determination nor when the monitored quantity is in the range again.

Entering a bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set. With a pulse, the length is set to 200 ms.
If it is required to set pulses with other lengths, you have to define a corre-
sponding template.

Entry Bit patterns containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value **************
Selection Selection of the templates defined

Character string

This parameter can only be edited when a serial interface (COM) is
selected under Interface.

Input of the RS-232 command as character string. All characters of the
ASCII code page can be used. Control characters (Esc, FF etc.) have to be
entered as a three-place, decimal ASCII code, starting with a slash. Each
command is automatically terminated with the ASCII characters CR and
LF.

Entry ASCII string with a max. of 24 characters
Default value empty
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29.15.5.4 Control instrument

The control instrument the determination is carried out with is selected
under [Control device]. Control instruments are defined under Sys-
tem ▶ Device manager.

NOTE

This button is only displayed when several control instruments have
been configured.

Control device

Selection of the control instrument from the list of devices. Only those
devices are displayed which are able to carry out the command. The con-
trol instruments do not have to be connected. This allows to transfer
methods more easily from one system to another.

Selection Selection of configured control instruments

29.15.5.5 Sensor

The parameters for the sensor are edited under [Sensor].

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.
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automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

29.15.5.6 Dosing device

The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, concentration, etc.)
is always used for the calculation. Titrants are defined under Sys-
tem ▶ Titrants. You can also enter a name which is not contained in the
titrant list. When a determination is started there is a check whether the
solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Tandem dosing

A second dosing device can be defined under [Tandem dosing] in order
to enable uninterrupted dosing. Dosing is carried out with a combination
of two dosing devices so that the second dosing device is dosing while
the first one is being filled and vice versa.
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Dosing device

Selection of the MSB connector to which the dosing device is connected.
Every MSB connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value off

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. Titrants are defined under System ▶ Titrants. You can
also enter a name which is not contained in the titrant list. When a deter-
mination is started there is a check whether the solution is contained in
list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, only the time interval for the GLP test of the buret unit
is checked at the start of the determination.

NOTE

The concentration, validity of the titer and the working life of the titrant
are ignored.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
32, page 503).

However, in order to ensure uninterrupted dosing, the following points
must be taken into account:

￭ Use the highest possible filling rate in order to keep the filling times as
short as possible. The filling rate should be decreased for viscous liq-
uids.
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￭ When you use two buret units with different dosing cylinders, the fill-
ing rate for the larger sized cylinder must be at the minimum:

= filling rate in mL/min for the larger sized cylinder

= filling rate in mL/min for the smaller cylinder

= cylinder volume in mL of the buret unit of the second dosing
device

= cylinder volume in mL of the buret unit of the first dosing
device

Example:

Dosing device 1: volume = 20 mL, filling rate = 50 mL/min

Dosing device 2: volume = 50 mL

Filling rate 2 ≥ 50 mL/min · 50 mL / 20 mL ≥ 125 mL/min

￭ The dosing rate must not exceed 75% of the filling rate of the smaller
cylinder. These values are listed in the following table, valid at maxi-
mum filling rate:

Table 22 Maximum dosing rate for different dosing cylinders

Cylinder volume maximum dosing rate

Exchange unit Dosing unit

1 mL 2.25 mL/min –

2 mL – 5.00 mL/min

5 mL 11.25 mL/min 12.50 mL/min

10 mL 22.50 mL/min 25.00 mL/min

20 mL 45.00 mL/min 50.00 mL/min

50 mL 112.50 mL/min 124.50 mL/min

29.15.5.7 Stirrer

The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4 | off
Default value 1
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off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

29.16 Communication

The following communications commands are available:

Scanning remote
lines (SCAN)

Defining remote signals which are awaited
before the next method command is started.

Setting remote
lines (CTRL)

Defining remote signals.

Receiving RS-232
commands (SCAN
RS)

Defining RS-232 commands which are awaited
before the next method command is started.

Sending RS-232
commands (CTRL
RS)

Defining the RS-232 commands which are sent.

29.16.1 Scanning remote lines (SCAN)
The command SCAN can be used to define input signals at the remote
interface which are awaited before the next method command is started.

Control device

This parameter is only displayed when several control devices are config-
ured. Control devices are defined under System ▶ Device manager.



29.16 Communication ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

474 ￭￭￭￭￭￭￭￭ 900 Touch Control

Selection of the control device from the list of devices. The control devices
do not have to be connected. This allows to transfer methods more easily
from one system to another.

Selection Selection of configured control devices

Remote Box

Selection of the MSB connector the Remote Box is connected to. Every
MSB connector will always be displayed. The remote signal defined is
requested on this Remote Box.

Selection 1 | 2 | 3 | 4
Default value 1

Input signal

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Input
lines.

Entering a bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status

The input lines are always numbered from right to left, i.e. with the signal
*******1 line 0 is expected to be active.

NOTE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).

Entry Bit patterns containing exactly 8 characters
or a max. of 24 characters for the name of
the template

Default value ********
Selection Selection of the templates defined

Timeout

When this time interval has expired without recognizing the remote signal,
the action defined in the following is triggered.

Input range 0 to 999 s
Default value 0 s

Action

Selection of the action which is carried out when the time interval has
expired.
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Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

29.16.2 Setting remote lines (CTRL)
The command CTRL can be used to define output signals at the remote
interface.

Control device

This parameter is only displayed when several control devices are config-
ured. Control devices are defined under System ▶ Device manager.

Selection of the control device from the list of devices. The control devices
do not have to be connected. This allows to transfer methods more easily
from one system to another.

Selection Selection of configured control devices

Remote Box

Selection of the MSB connector the Remote Box is connected to. Every
MSB connector will always be displayed. The remote signal defined is sent
via this Remote Box.

Selection 1 | 2 | 3 | 4
Default value 1

Output signal

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.
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NOTE

A line set active is not being reset automatically, not even at the end of
the determination.

Entering a bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set. With a pulse, the length is set to 200 ms.
If it is required to set pulses with other lengths, you have to define a corre-
sponding template.

NOTE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).

Entry Bit patterns containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value **************
Selection Selection of the templates defined

29.16.3 Scanning the RS-232 interface (SCAN RS)
The command SCAN RS can be used to define RS-232 commands which
are awaited before the next method command is started.

Serial port

Selection of the serial interface the peripheral device is connected to. The
RS-232 command defined is requested on this interface.

Selection COM1 | COM2 | COM3 | COM4 | COM5 |
 COM6 | COM7 | COM8

Default value COM1

Character string

Input of the RS-232 command as character string. All characters of the
ASCII code page can be used. Control characters (Esc, FF etc.) have to be
entered as a three-place, decimal ASCII code, starting with a slash. Each
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command is automatically terminated with the ASCII characters CR and
LF. The * can be used for one or more characters.

Entry ASCII string with a max. of 24 characters
Default value !*.R

Timeout

When this time interval has expired without recognizing the RS-232 com-
mand, the action defined in the following is triggered.

Input range 0 to 999 s
Default value 0 s

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

29.16.4 Defining RS-232 commands (CONTROL RS)
The command CONTROL RS can be used to define the RS-232 com-
mands which are sent.

Serial port

Selection of the serial interface the peripheral device is connected to. The
RS-232 command defined is sent via this interface.

Selection COM1 | COM2 | COM3 | COM4 | COM5 |
 COM6 | COM7 | COM8

Default value COM1



29.17 Automation ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

478 ￭￭￭￭￭￭￭￭ 900 Touch Control

Character string

Input of the RS-232 command as character string. All characters of the
ASCII code page can be used. Control characters (Esc, FF etc.) have to be
entered as a three-place, decimal ASCII code, starting with a slash. Each
command is automatically terminated with the ASCII characters CR and
LF.

Entry ASCII string with a max. of 24 characters
Default value &M;$G

29.17 Automation

29.17.1 Rotating sample rack (MOVE)
The command MOVE is used to move to a rack position or an external
position.

Tower

Selection of the tower, with which the command is carried out. Both
Tower 1 and Tower 2 can always be selected, even if your Sample Pro-
cessor has only one tower.

Selection 1 | 2
Default value 1

1
View from the front, the right tower.

2
View from the front, the left tower.

Destination

Selection of the required target position.

Selection Sample | Ext. position | Special beaker | Rack
position | Current sample + | Current sample - |
 Next position | Prev. position | Calibration
pos. | rotate + | rotate - | swing + | swing -

Default value Sample

Sample
Rack position, which is defined by the sample variable. The sample vari-
able is automatically increased by 1 after every method run or it can
selectively be modified with the command SAMPLE.

Ext. position
One of the four external positions which can be moved to with the
Swing Head. Enter the number of the external position (1…4) in the
field to the right.
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Special beaker
Special beakers, which are defined in the rack table, can be directly
moved to. Enter the number of the special beaker (1…16) in field to
the right.

Rack position
Any rack position. Enter the number of the rack position (1…999) in
the field to the right.

Current sample +
Starting from the current sample (defined by the sample variable) the
rack is moved forward by the number of rack positions (1…999)
entered in the field to the right.

Current sample -
Starting from the current sample (defined by the sample variable) the
rack is moved backward by the number of rack positions (1…999)
entered in the field to the right.

Next position
Starting from the current rack position, the rack is moved forward by
one position.

Prev. position
Starting from the current rack position, the rack is moved backward by
one position.

Calibration pos.
For automatic calibrations with a Sample Processor(see "Definition of
the calibration positions", page 509).

rotate +
Moving the rack forward by a certain increment. The rotation incre-
ment is defined in the properties of the tower.

rotate -
Moving the rack backward by a certain increment. The rotation incre-
ment is defined in the properties of the tower.

swing +
Swinging the robotic arm outward by a certain increment (towards
higher angular degrees). The swing increment is defined in the proper-
ties of the Swing Head.

swing -
Swinging the robotic arm towards the center of the rack by a certain
increment (towards lower angular degrees). The swing increment is
defined in the properties of the Swing Head.

Beaker test action

This parameter can only be edited with Destination = Sample, Next
position or Prev. position.
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Selection of the action which is carried out when the beaker sensor does
not detect any vessel at the sample position moved to. In addition, enable
the beaker sensor in the rack table.

Selection Rotate rack | Display message
Default value Display message

Rotate rack
The rack is moved to the next vessel on a sample position. Exception:
If the sample variable is newly defined in the method before this com-
mand (command SAMPLE), then the option Display message is
automatically valid.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

NOTE

This parameter is ignored with the 885 Compact Oven SC.

Options

Shift rate

Rate at which the sample rack is moved.

Input range 3 to 20 °/s
Default value 20 °/s

NOTE

This parameter is ignored with the 885 Compact Oven SC.

Shift direction

Direction in which the rack is moved.

Selection auto | + | -
Default value auto

auto
A shift direction, with which the shorter way has to be passed, is auto-
matically selected.

+
Counterclockwise rotation.

-
Clockwise rotation.
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Swing rate

Rate at which the robotic arm is swung.

Input range 10 to 55 °/s
Default value 55 °/s

29.17.2 Moving the lift (LIFT)
The lift of a Sample Processor is moved with the command LIFT. The
movement can, however, only be carried out if the Sample Processor is
located at a valid rack position. This will not be the case, for example,
after a Rack Reset.

Tower

Selection of the tower, with which the command is carried out. Both
Tower 1 and Tower 2 can always be selected, even if your Sample Pro-
cessor has only one tower.

Selection 1 | 2
Default value 1

1
View from the front, the right tower.

2
View from the front, the left tower.

Lift position

Selecting a predefined lift position or enter any lift position. The prede-
fined lift positions are defined in the device properties of the Sample Pro-
cessor. They can, however, also be assigned in the manual control.

Input range 0 to 235 mm
Selection Work position | Shift position | Rinse position |

 Special position | Home position
Default value Work position

Home position
The lift is being located at the upper stop position, i.e. at the position 0
mm.

For the 885 Compact Oven SC, the position 0 mm is approached when
Shift position, Rinse position and Special position is selected.

Lift rate

Speed at which the lift is moved.

Input range 5 to 25 mm/s
Default value 20 mm/s
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NOTE

This parameter is ignored with the 885 Compact Oven SC.

29.17.3 Controlling pumps (PUMP)
The PUMP command is used to control the pumps mounted on or
connected to the tower of the sample changer.

Tower

Selection of the tower, with which the command is carried out. Both
Tower 1 and Tower 2 can always be selected, even if your Sample Pro-
cessor has only one tower.

Selection 1 | 2
Default value 1

1
View from the front, the right tower.

2
View from the front, the left tower.

Pump

Selection of the pump.

Selection 1 | 2 | 1 + 2
Default value 1

1
Pump 1 of the selected tower is switched.

2
Pump 2 of the selected tower is switched.

1 + 2
Both pumps of the selected tower are switched at the same time.

Status/Duration

Switching the pump(s) on and off.

Input range 0 to 999 s (Increment: 1)
The pump is running during this time.

Selection on | off
Default value on

on
The pump is switched on. The pump is running until it is explicitly
switched off. If the determination is canceled with the key [ ], the
pump is also switched off.
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off
The pump is switched off.

29.17.4 Resetting the rack (RACK)
The following actions are carried out with the command RACK:

￭ Rack, lift and robotic arm are being reset.
￭ The rack code of the rack attached is being read out and the corre-

sponding rack data is transferred to the Sample Processor.
￭ The sample variable is reset to the value 1.

Check rack

on | off (Default value: off)

Activate this parameter when the rack attached is to be checked. For this
you, however, have to additionally select the rack in the dialog Method
options / Start options at the option Check rack.

NOTE

This option is not available with the 885 Compact Oven SC. Therefore,
this parameter must be set to no.

29.17.5 Defining the sample variable (SAMPLE)
The sample variable describes the current position of the sample on the
rack of the Sample Processor. It is automatically increased by 1 after the
end of a method run. In the following cases, the sample variable is auto-
matically reset to the value 1:

￭ if the autostart counter is reset.
￭ if the sample rack is reset.

The sample variable can be altered specifically with the command SAM-
PLE.

Sample variable

Modifying the sample variable.

Selection = | + | -
Default value +

=
The sample variable corresponds to the number entered in the field
Value.

+
The sample variable corresponds to the current value plus the number
entered in the field Value.



29.17 Automation ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

484 ￭￭￭￭￭￭￭￭ 900 Touch Control

-
The sample variable corresponds to the current value minus the num-
ber entered in the field Value.

Value

Value by which the current sample variable is to be modified.

NOTE

The sample variable can only be set on rack positions which are not
defined as special beakers.

Input range 1 to 999 
Default value 1 

29.17.6 Creating a subsequence (SUBSEQ)
It is useful, particularly with more complex tasks, e.g. rinsing sequences or
Liquid Handling, to combine individual command sequences into a single
subsequence. Subsequences are managed the same as method com-
mands. A maximum of 99 commands can be combined to form a single
subsequence. There is no limit to the number of subsequences within one
method.

[Load/ Save]

Loading a saved subsequence or saving the current subsequence.

[Subseq. options]

Defining various settings which correspond to the entire subsequence.

[Insert command]

Insert a new method command. It is inserted before the selected com-
mand.

NOTE

Not all commands are available for subsequences. Commands which
cannot be inserted into subsequences are disabled.

[Delete command]

Delete the selected method command.

[Edit command]

Edit the selected method command.
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29.17.6.1 Loading / saving a subsequence

[Load/ Save] is used to load stored subsequences or to save new subse-
quences. This means that they are available for all methods and only have
to be created once.

Loading a subsequence

[Own subseq.]

Opening the list of own subsequences.

[Load]

Loading the selected subsequence.

Saving a subsequence

Custom-made subsequences are saved in the internal memory.

NOTE

In order to be able to use the subsequences also for other titration sys-
tems, you have to create a backup. You can only restore the subse-
quences from this backup on another system.

File name

File name of the subsequence.

Entry max. 32 characters

[Save]

Saving the subsequence to the internal memory.
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29.17.6.2 Subsequence options

In this dialog, the settings can be defined which correspond to the entire
subsequence.

Subsequence type

Selection Sample sequence | Start sequence | End
sequence | Stop sequence | Cond. sequence

Default value Sample sequence

Sample sequence
The subsequence is carried out with every determination.

Start sequence
This subsequence is only carried out at the start of a sample series
when the autostart counter = 1.

End sequence
This subsequence is only carried out at the last sample of a series when
the autostart counter has reached the setpoint value (number of autos-
tarts).

Stop sequence
The stop sequence is only carried out when canceling a method
because of one of the following cases: Manual stop with [ ], stop
because of an error, stop via remote signal.

Cond. sequence
This subsequence is carried out directly before the conditioning. This
gives you the possibility to start e.g. a connected Polytron® high-fre-
quency homogenizer before the conditioning as well as to set its stir-
ring rate. Use the command CONTROL RS for this.

Cycles

Number of directly consecutive repetitions of the subsequence.

Input range 0 to 999 
Default value 1 
Selection Calibration

Calibration
For automatic calibrations with a Sample Processor (see chapter 32.7,
page 508).

[Note]

Entering a note on the subsequence.

Dialog "Subsequence options / Note"

A short text can be entered in this dialog, e.g. for the description of the
subsequence commands or for the application purpose.
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[Display options]

Definition when the note is being displayed.

Automatically after loading the subsequence

on | off (Default value: off)

If this parameter is activated, the note is displayed when loading the sub-
sequence. It can otherwise only be read in this dialog.

29.17.7 Controlling the heating (HEATER) 
The heating on the 885 Compact Oven SC is controlled with the HEATER
command.

Status

Switch the heater on or off.

Selection on | off
Default value on

on
The heater is switched on. The command is displayed in the method
run until the specified temperature is reached. The heater runs in the
background until it is explicitly switched off. The current temperature
can be seen in the Manual control.

off
The heater is switched off.

Temperature

Temperature to which the oven is heated.

Input range 50 to 250 °C (Increment: 1)
Default value 110 °C

29.17.8 Controlling the gas flow (FLOW) 
The gas flow is controlled on the 885 Compact Oven SC with the FLOW
command.

Status

Switch the gas flow on or off.

Selection on | off
Default value on

on
The gas flow is switched on. The gas flow runs until it is switched off.
The current gas flow can be seen in the Manual control.

off
The gas flow is switched off.
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Flow rate

Flow rate for the gas flow.

Input range 10 to 150 mL/min (Increment: 1)
Default value 50 mL/min

Gas supply

Selection of the gas supply.

Selection pump | valve
Default value pump

pump
The integrated air pump is used for the gas flow.

valve
The integrated inlet valve is used for the gas flow. The inlet valve in the
885 Compact Oven SC is connected to compressed air or nitrogen.

Gas type

Gas type of the carrier gas used.

Selection air | nitrogen
Default value air

29.17.9 Starting the measurement for temperature and gas flow (MEAS
T/F ON) 

Data acquisition and evaluation of the data of the 885 Compact Oven SC
is started with the MEAS T/F ON command.

The following values are output as raw data and are available as variables:

￭ Mean gas flow (evaluation starts after 10 s).
￭ Mean temperature
￭ Minimum temperature
￭ Maximum temperature

After a MEAS T/F ON command, there must also be a MEAS T/F OFF
command present in the method run. If one of the two commands is
missing or the order is not followed, the command is depicted in red. No
parameters can be edited for this command.

29.17.10 Exiting the measurement for temperature and gas flow (MEAS
T/F OFF) 

The data acquisition evaluation of the data of the 885 Compact Oven SC
is finished with the MEAS T/F OFF command. There must be a MEAS
T/F ON command present before a MEAS T/F OFF command in the
method run. The command will be depicted in red if this is not fulfilled.
No parameters can be edited for this command.
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29.18 Miscellaneous commands

29.18.1 Controlling a stirrer (STIR)
A stirrer is controlled with the command STIR.

Control device

This parameter is only displayed when several control devices are config-
ured. Control devices are defined under System ▶ Device manager.

Selection of the control device from the list of devices. The control devices
do not have to be connected. This allows to transfer methods more easily
from one system to another.

Selection Selection of configured control devices

Stirrer

Selection of the MSB connector the stirrer is connected to. Every MSB
connector will always be displayed.

Selection 1 | 2 | 3 | 4
Default value 1

Status/Duration

Switching the stirrer on or off.

Input range 0 to 999 s (Increment: 1)
During this time the stirrer is running.

Selection on | off
Default value on

on
The stirrer is switched on. The stirrer runs until it is explicitly switched
off. If the determination is canceled with the key [ ], the stirrer is
also switched off.

off
The stirrer is switched off.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 32.4, page 505. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation
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Input range –15 to 15 
Default value 8 

29.18.2 Pausing the method run (WAIT)
The method run can be paused with the command WAIT.

Hold sequence

on | off (Default value: off)

If this parameter is activated, then the method run is paused until it is con-
tinued manually.

Waiting time

This parameter can only be edited when Hold sequence is deactivated.

The method run is automatically continued after this waiting time.

Input range 0 to 99999 s
Default value 30 s

Message

on | off (Default value: off)

If this parameter is activated, the text message defined in the following is
displayed during the waiting time.

Message text

This parameter can only be edited when Message is activated.

Text which is displayed during the waiting time.

Entry max. 28 characters
Default value empty

29.18.3 Scan data (REQUEST)
The following data can be scanned in the method run with the command
REQUEST:

￭ Sample data
– Sample identification 1
– Sample identification 2
– Sample size (value and unit)

￭ Common variable

You can select thereby whether the sequence should be paused or
resumed in the background.

Sample ident.

Selection of the sample identification that is queried in the method run.
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Selection off | Identification 1 | Identification 2 | ID1 &
ID2

Default value off

Sample size

on | off (Default value: on)

If this parameter is activated, then the value for the sample size will be
requested.

Sample size unit

on | off (Default value: off)

If this parameter is activated, then the unit for the sample size will be
requested.

Common variable

Selection of the common variable which is queried in the method run.

Selection CV01…CV25 | off
Default value off

Hold sequence

on | off (Default value: on)

If this parameter is activated, then the run will be paused during the
request. If this parameter is deactivated, then the method continues in the
background until the following measurement or titration has been com-
pleted.

29.18.4 Defining an acoustic signal (BEEP)
The BEEP command can be used to produce an acoustic signal.

Duration

Approximate playing time in seconds of the permanently stored melody.

Input range 1 to 9 
Default value 1 

29.18.5 Signing a determination (SIGN)
A determination can be signed with the SIGN command. The method run
is automatically paused as soon as this command is reached. At the same
time a switch is made to the result view. The run will not be continued
until the determination has been signed or the SIGN command has been
canceled. You can specify whether a routine user is allowed to cancel the
SIGN command in the setting System ▶ System settings ▶ Dialog
options ▶ Routine dialog. No parameters can be edited for this com-
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mand. The parameters for signing determinations are described in chapter
17.1, page 189.

NOTE

Methods with this command can only be started if you are working
with login and password protection.

The command should always be inserted at the end directly before the
REPORT command or at the end of the method sequence if a PC/LIMS
report is to be sent automatically.

29.18.6 Canceling the method run (END)
The method run will cancel as soon as the END command is reached. This
is a good idea if you wish to test only the first part of a method. No
parameters can be edited for this command.
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30 Operation and maintenance

30.1 System initialization

In very rare instances, a faulty file system (e.g. because of a program
crash) may lead to an impairment of program functioning. The internal file
system must be initialized in such cases.

CAUTION

If you carry out a system initialization, then all user data except the
methods will be deleted.

We recommend creating a backup of the system at regular intervals in
order to avoid data losses.

Proceed as follows for the system initialization:

 

1 Switching off the instrument

￭ Press the power switch at the rear.

 

2 Switching on the instrument

￭ Press the power switch at the rear.
An image with a frog will be displayed after a couple of seconds.

￭ While the image is being displayed, press the power switch again
and hold it down.

￭ Do not release the power switch until an acoustic signal sounds.

A system message is displayed.

 

3 Confirm system initialization

￭ Confirm the message with [Yes].
A second security prompt is displayed.

￭ Confirm this message with [Yes] as well.

Initialization is started. After the initialization has been completed,
the 900 Touch Control is started automatically.
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31 Troubleshooting

31.1 Editing methods

Problem Cause Remedy

The method com-

mand cannot be

inserted.

The method command is

disabled.

In the dialog Dialog options / Command

list, activate the desired command (see chap-

ter 7.2, page 26).

No control instrument

which supports the

method command is con-

figured in the device man-

ager.

Add a control instrument which supports the

desired method command to the list of devices

(see chapter 11, page 81).

The additional eval-

uations (EVAL com-

mands) cannot be

inserted.

A titration or measuring

command to which the

evaluation can be applied

is missing.

1. Insert a titration or measuring command.

2. Insert the EVAL command directly after it.

A MEAS T/F ON

command or MEAS

T/F OFF command is

depicted in red in

the command list.

The corresponding MEAS

T/F ON command or MEAS

T/F OFF command is miss-

ing or not inserted in the

correct order in the

method run. To be able to

execute a method, both

MEAS T/F commands are

needed in the method run.

Insert the missing MEAS T/F command and

observe the logical order of the commands.

An EVAL command

is depicted in red in

the command list.

The associated titration or

measuring command has

been deleted or replaced

by a different one, e.g. DET

pH by DET U.

1. Delete the EVAL command.

2. Insert a titration or measuring command.

3. Insert the EVAL command directly after it.
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31.2 Sample table

Problem Cause Remedy

The method cannot

be entered in the

sample table.

The option Use sample

assignment table is acti-

vated. The method

assigned to the sample

identification will be loa-

ded automatically at the

start of the determination.

Deactivate the option (see chapter 15.1, page

152).

31.3 Results/Statistics

Problem Cause Remedy

No statistics are car-

ried out for a result.

Statistics is not activated. In the method options, activate the option

Statistics (see chapter 16.5, page 177).

No statistics variable has

been assigned to the

calculation.

In the result options (command CALC), define

a variable for the mean value (see "Variable for

mean value", page 158).

Statistics is not activated. In the control dialog, activate the Statistics

option (see chapter 18, page 191).

A result has been

removed from the

statistics, the mean

value has not been

reassigned to the

common variable or

to the TITER varia-

ble.

Assignment is not carried

out automatically with ret-

roactive modifications.

Recalculate the determination manually (see

chapter 24, page 219).

The result is not dis-

played in the result

table.

The column display in the

result table is incorrectly

configured.

Modify the settings for the display accordingly

(see chapter 26.1, page 242).

The parameter Save result

in result table is not acti-

vated.

In the result options (command CALC), acti-

vate the parameter (see "Save result in result

table", page 159).
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31.4 Printing

Problem Cause Remedy

Tapping on the fixed

key [ ] has no

effect.

The fixed key is disabled. In the Dialog options / Fixed keys dialog,

activate the Print option (see chapter 7.2,

page 26).

A determination is running. Wait until the determination is finished.

31.5 Manual control

Problem Cause Remedy

Tapping on the fixed

key [ ] has no

effect.

The fixed key is disabled. In the Dialog options / Fixed keys dialog,

activate the Manual control option (see

chapter 7.2, page 26).

A button in the

manual control is

disabled.

The required hardware is

either not connected or

incorrectly connected.

1. Switch off the 900 Touch Control.

2. Connect the hardware correctly.

3. Switch the 900 Touch Control back on.

The required hardware is

being used in the ongoing

determination.

Wait until the determination is finished.

31.6 Miscellaneous

Problem Cause Remedy

The 900 Touch Con-

trol cannot be

switched on.

The Touch Control is

connected to an MSB

socket on the control

instrument.

Plug in the Touch Control at the Controller

connector (see manual for control instrument).

31.7 SET titration

Problem Cause Remedy

The titration will not

be finished.

The minimum dosing rate is

too low.

Define Titration rate = user and increase the

minimum rate (Min. rate) (see chapter 29.3.2,

page 320).

The stop criterion is

unsuitable.

Adjust the control parameters (see chapter

29.3.2, page 320):
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Problem Cause Remedy

￭ Increase the stop drift.

￭ Select a short delay time.

The sample is over-

titrated.

The control parameters are

unsuitable.

Adjust the control parameters (see chapter

29.3.2, page 320):

￭ Select Titration rate = slow.

￭ Define Titration rate = user and increase

the control range.

￭ Define Titration rate = user and reduce

the maximum rate (Max. rate).

￭ Define Titration rate = user and reduce

the minimum rate (Min. rate).

￭ Stir faster.

￭ Arrange the electrode and buret tip to an

optimum .

The electrode responds too

slowly.

Replace the electrode.

The titration time is

too long.

The control parameters are

unsuitable.

Adjust the control parameters (see chapter

29.3.2, page 320):

￭ Select Titration rate = optimal or fast.

￭ Define Titration rate = user and reduce

the control range.

￭ Define Titration rate = user and increase

the maximum rate (Max. rate).

￭ Define Titration rate = user and increase

the minimum rate (Min. rate).

The results are

spread widely.

The minimum dosing rate is

too high.

Define Titration rate = user and reduce the

minimum rate (Min. rate) (see chapter 29.3.2,

page 320).

The control range is too

small.

Define Titration rate = user and increase the

control range.

The electrode responds too

slowly.

Replace the electrode.

31.8 Volumetric Karl Fischer Titration

Problem Cause Remedy

The drift is very high

during conditioning.

The titration cell is leaking. ￭ Check the seals and the septum. Replace if

necessary.
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Problem Cause Remedy

￭ Replace the molecular sieve.

The drift becomes

greater after each

titration.

The sample releases water

very slowly.

￭ Adjust the method.

￭ Add solubility promoter.

￭ Increase the temperature (possibly using a

KF oven).

￭ See technical literature.

A side reaction is taking

place.

￭ Use special reagents.

￭ Adjust the method (increase/decrease the

temperature, external extraction).

￭ See technical literature.

The pH value is no longer

in the optimum range.

Add buffer, see technical literature.

The titration will not

be finished.

The titration cell is leaking. ￭ Check the seals and the septum. Replace if

necessary.

￭ Replace the molecular sieve.

The minimum increment is

too low.

Define Titration rate = user and increase the

minimum volume increment (Min. incre-

ment) (see chapter 29.4.2, page 333).

The stop criterion is

unsuitable.

Adjust the control parameters (see chapter

29.4.2, page 333):

￭ Increase the stop drift.

￭ Select a short delay time.

See also: The drift becomes

greater after each titration.

The sample is over-

titrated.

The increments at the end

of the titration are too

high.

￭ Define Titration rate = user and reduce

the dosing rate (Max. rate) (see chapter

29.4.2, page 333).

The following experiment provides a clue

for the optimum dosing rate: During condi-

tioning, display the drift and add sample

without starting the titration. Select a value

below the highest drift as dosing rate.

￭ Stir faster.

The amount of methanol in

the working medium is too

low.

￭ Replace the working medium.

￭ Reduce the amount of solubility promoter,

if working with solvent mixtures, see tech-

nical literature.
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Problem Cause Remedy

The electrode may be cov-

ered.

Wipe off the electrode with ethanol or a suit-

able solvent.

The solution

becomes darker

after each titration.

Replace the working medium.

The electrode may be cov-

ered.

Wipe off the electrode with ethanol or a suit-

able solvent.

The electrode has a short

circuit.

1. Check the Pt wires.

2. Activate the electrode check.

The endpoint is

reached too quickly.

The dosing rate outside the

control range is too high.

Define Titration rate = user and reduce the

dosing rate (Max. rate) (see chapter 29.4.2,

page 333).

The titration times

with volumetric

titration are con-

stantly longer.

The buffer capacity of the

solvent can be exhausted

for two-component

reagents.

Replace the working medium.

31.9 Coulometric Karl Fischer titration

Problem Cause Remedy

The drift is very high

during conditioning.

The titration cell is leaking. ￭ Check the septum and replace it if neces-

sary.

￭ Replace the molecular sieve.

￭ Check the ground-joint sleeves for frayed

edges. If necessary, trim the edges neatly

or replace the ground-joint sleeves.

Deposits containing water

can be found in the titra-

tion cell.

￭ Shake the titration cell.

The reagent is exhausted

or contaminated.

￭ Replace the reagent.

The catholyte is old or

moist.

￭ The catholyte must be replaced at least

once per week.

￭ Dry the catholyte with KF one-component

reagent.

The diaphragm of the gen-

erator electrode is contam-

inated.

￭ Clean the diaphragm (in accordance with

directions in the leaflet for the generator

electrode).
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Problem Cause Remedy

A side reaction is taking

place.

￭ Consider using a KF oven.

￭ See technical literature.

The molecular sieve on the

KF oven has reached its

capacity limit.

￭ Replace the molecular sieve.

The gas flow from the KF

oven into the titration cell

is too high.

￭ Reduce the gas flow (if you are working

with the oven method with sample vials,

set the gas flow between 40 and 60

mL/min).

The drift becomes

greater after each

titration.

The sample releases water

very slowly.

￭ Consider using a KF oven.

￭ See technical literature.

The drift is fluctuat-

ing.

The sample solution is

poorly stirred.

￭ Set the stirring rate in such a way that the

sample solution will become very well

mixed.

The Control parameters

are set incorrectly.

￭ Reset the Control parameters to default

values.

The titration time is

too long.

The drift during condition-

ing is not stable.

￭ Wait before starting the titration until the

drift has become stable.

The parameter Start drift

is set too high.

￭ Set the Start drift lower.

￭ Adjust the Stop drift or use the Relative

stop drift.

The parameter Stop drift

is set too low.

￭ Set the Stop drift higher or use the Rela-

tive stop drift.

The water quantity is too

high.

￭ Observe the sample size and water con-

tents in accordance with .

The Control parameters

are set incorrectly.

￭ Set the parameter Dynamics lower and

the parameter Max. rate higher.

The result is too

high.

The titration cell is not yet

correctly conditioned.

￭ Shake the titration cell and wait until the

drift is stable.

The sample contains oxi-

dizable substances.

￭ Consider using a KF oven.

￭ See technical literature.

The parameter Stop drift

is set too low.

￭ Set the Stop drift higher or use the Rela-

tive stop drift.
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Problem Cause Remedy

The drift correction is too

small (e.g. for the use of a

KF oven or for manual drift

correction).

￭ Start the titration as long as the gas flow

still exists between the conditioning vial

and the titration cell.

￭ Set the parameter Drift correction to

auto (= automatic drift correction).

The result is too

low.

The sample releases iodine. ￭ Consider using a KF oven.

￭ See technical literature.

The parameter Stop drift

is set too high.

￭ Set the Stop drift lower.

The drift correction is too

large (e.g. with excessively

high start drift, with fluctu-

ating drift or with manual

drift correction).

￭ Ensure stable and lower drift.

￭ Set the parameter Drift correction to

auto (= automatic drift correction).

The parameter Min. rate

is set too low.

￭ Set the parameter Min. rate higher.

￭ Reset the Control parameters to default

values.

The results are

spread widely.

The sample is nonhomoge-

nous.

￭ Homogenize the sample if possible.

￭ Possibly use a larger sample size.

The sample addition is diffi-

cult to reproduce.

￭ Observe the instructions in .

The drift fluctuates. ￭ Ensure stable drift.

31.10 STAT titration

Problem Cause Remedy

The control point is

not kept stable. The

measured value is at

times too high and

at times too low.

The controller "oscil-

lates".

The control parameters are

unsuitable.

Adjust the control parameters (see chapter

29.7.2, page 364):

￭ Reduce the Max. rate and possibly also

the Min. rate.

￭ Increase control range.

The stirring is not optimal. Check and optimize efficiency of the stirring.

The arrangement of elec-

trode and buret tip is not

optimum.

Arrange the electrode and buret tip to an opti-

mum (see manual of the instrument).
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Problem Cause Remedy

The cylinder volume of the

exchange/dosing unit

might be too large.

Use an exchange/dosing unit with a smaller

cylinder volume (yields a smaller volume incre-

ment per pulse).

The control point is

not reached for too

long.

The control parameters are

unsuitable.

Adjust the control parameters (see chapter

29.7.2, page 364):

￭ Reduce control range.

￭ increase Min. rate.

￭ increase Max. rate.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 32 Appendix

900 Touch Control ￭￭￭￭￭￭￭￭ 503

32 Appendix

32.1 Manual Dosing Controller, optional accessory for
manual titration

Figure 28 Manual Dosing Controller 6.2107.120 – Overview

1 Start/Dosing key [GO]
For starting the method and for dosing dur-
ing the MAT command.

2 Status LED 
Indicates whether the instrument is ready.

3 Cancel command button [FILL] 
For canceling the running command.

4 Connector plug
With 25-pin D-sub plug.
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32.2 Dosing unit

32.2.1 Maximum dosing and filling rate
The maximum dosing rate and maximum filling rate for the dosing unit
depend on the cylinder volume:

Cylinder volume Maximum rate

2 mL 6.67 mL/min

5 mL 16.67 mL/min

10 mL 33.33 mL/min

20 mL 66.67 mL/min

50 mL 166.00 mL/min

Independent of the cylinder volume, values ranging from 0.01 to 166.00
mL/min can always be entered. When the function is carried out the rate
will be, if necessary, decreased automatically to the highest possible value.

32.2.2 Default parameters for preparing (PREP) and emptying (EMPTY)
The PREP command is used to rinse and fill the cylinder and tubings of
the dosing unit air bubble-free. You should carry out this function before
the first determination or once per day.

The command EMPTY is used to empty the cylinders and the tubings of
the dosing unit.

If no titrant is selected in the command, preparing and emptying will be
carried out with the following default parameters:

￭ The entire cylinder volume is dosed at the maximum dosing rate
through Port 1.

￭ The cylinder is filled at the maximum filling rate through Port 2.
￭ The following dimensions apply for the tubings:

– Tubing at Port 1: length = 40.0 cm, diameter = 2 mm
– Tubing at Port 2: length = 25.0 cm, diameter = 2 mm
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32.3 Exchange unit

32.3.1 Maximum dosing and filling rate
The maximum dosing rate and maximum filling rate for the exchange unit
depend on the cylinder volume:

Cylinder volume Maximum rate

1 mL 3.00 mL/min

5 mL 15.00 mL/min

10 mL 30.00 mL/min

20 mL 60.00 mL/min

50 mL 150.00 mL/min

Independent of the cylinder volume, values ranging from 0.01 to 166.00
mL/min can always be entered. When the function is carried out the rate
will be, if necessary, decreased automatically to the highest possible value.

32.3.2 Default parameters for preparing (PREP)
The PREP command is used to rinse and fill the cylinder and tubings of
the exchange unit air bubble-free. You should carry out this function
before the first determination or once per day.

If no titrant is selected in the command, preparing will be carried out with
the following default parameters:

￭ The entire cylinder volume is dosed twice at the maximum dosing rate.
￭ The cylinder is filled at the maximum filling rate.

32.4 Stirring rate

The stirring rate can be adjusted in steps from –15 to +15.

The approximate rotational speed for the internal magnetic stirrer
(depends on the product version) can be calculated with the following for-
mula:

Rotational speed/min (r/min) = 125 · Stirring rate

Example:

Configured stirring rate: 8

Rotational speed in revolutions per minutes = 125 · 8 = 1,000
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Figure 29 Rotational speed depending on the stirring rate

The information on the separately connectable 802 propeller stirrer can be
found in the "802 Stirrer" manual.

32.5 Balance

The sample size and the associated unit can be sent from a connected bal-
ance. The sample size is transmitted as a number with up to ten characters
(including algebraic sign and decimal point).

Sample size and unit are sent as a single character string. They are separa-
ted by a space character. The string is terminated with the ASCII charac-
ters CR and LF.

If the balance sends a negative sample size (e.g. when you are reweighing
a sample), then the algebraic sign is adopted. The algebraic sign is, how-
ever, ignored for the calculations.

NOTE

With some balances, the sample identification and the method can be
sent in addition to the sample size.

Make sure that the balance does not send the sample size until the end.

Mettler AX

For the Mettler AX balance, the fields that contain the sample identifica-
tion or the method must be designated as follows:

￭ Designation for the field with the method name: METHOD
￭ Designation for the field with sample identification 1: ID1
￭ Designation for the field with sample identification 2: ID2
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32.6 Result variables as parameter setting

For most of the numerical parameters, the result of a calculation can also
be utilized in place of a number. This result must be calculated in a preced-
ing calculation command (command CALC). A typical application is the
use of a relative start volume.

The following example is used to explain how this method is used to
define a sample size-dependent start volume for a titration. Proceed as fol-
lows:

 

1 Create a new calculation

￭ Insert the calculation command CALC in front of the titration
command.

￭ Enter the calculation formula, e.g. R1 = C00*3.

 

2 Define a result variable as parameter setting

￭ In the titration command, enter the variable R1 as the start vol-
ume.
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The selection of the result variables is displayed in the number editor.

NOTE

If the method before the command with the result variables applied
contains more than one calculation commands (possibly with result var-
iables bearing the same name), then the result variable of the preceding
calculation command will always be used.

Please note that the result must be within the input range of the
parameter, as otherwise the determination run will be stopped when
the parameter is accessed.

32.7 Electrode calibration with Sample Processors

Basic framework for a method for automatic calibrations

If the calibration of electrodes is carried out with a Sample Processor, then
the basic framework of the method will appear as follows:

1. Subsequence with the commands required for the calibration (com-
mand SUBSEQ)

a. Command for change of buffer/standard (command MOVE)
b. Command for moving the lift (command LIFT)
c. Calibration command (command CAL pH or CAL Conc)
d. …

2. …

In the interest of general comprehensibility, other commands which are
required are not listed here. A method template is available for an auto-
matic pH calibration with subsequent measurement.

Command parameterization

The following special settings are required with the individual commands:
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￭ Command SUBSEQ:
The setting Cycles = Calibration must be adjusted in the Subse-
quence options dialog.

￭ Command MOVE for changing the buffer/standard:
The only definition made in this command is that a calibration position
is to be moved to. The setting Destination = Calibration pos. must
be adjusted for this purpose. The question of which rack positions are
used as calibration positions must be defined in the rack table (see
below).

￭ Command CAL pH or CAL Conc:
The setting Sample Processor = USB must be adjusted in the Calibra-
tion parameters dialog.

Definition of the calibration positions

The positions of the individual buffers/standards on the rack are defined in
the rack table of the rack used. The following options are available:

￭ Utilization of sample positions
The desired rack position for the first buffer/standard must be entered
in the dialog Sample rack / Edit rack data for the parameter 1. Cal-
ibration pos.. In this case, it is imperative that the remaining buffers/
standards be placed on the rack positions directly following.

￭ Utilization of special beakers
Any rack position can be defined as a special beaker. It is, however,
preferable to set them at high rack positions in order to be able to
begin sample series at rack position 1. The special beakers are moved
to in ascending order.
The list of special beakers is displayed in the dialog Sample rack /
Edit rack data by pressing [Special beakers]. The number of buf-
fers/standards used for calibration will determine the number of special
beakers to be defined. We recommend defining special beakers 1-n.
Afterwards, in the dialog Sample rack / Edit rack data, for the
parameter 1. Calibration pos., the option Special beaker 1 must be
selected for the first buffer/standard.
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32.8 Stored buffer series for pH calibration

The temperature-dependent pH values of several common pH buffers are
stored in the Touch Control for automatic buffer recognition during pH
calibration. In addition to the Metrohm buffer solutions, other reference
buffers and technical buffers are also included in the tables.

The following tables provide an overview of the stored pH(T) series.

pH values printed in bold are the values for the reference temperature of
the respective buffer set.

pH values printed in italics are interpolated or extrapolated values, all the
others correspond to the manufacturer's specifications.

32.8.1 Metrohm

Table 23 Metrohm buffer solutions

Temp.

(°C)

Metrohm

pH

4.00

pH

7.00

pH

9.00

0 3.99 7.11 9.27

5 3.99 7.08 9.18

10 3.99 7.06 9.13

15 3.99 7.04 9.08

20 3.99 7.02 9.04

25 4.00 7.00 9.00

30 4.00 6.99 8.96

35 4.01 6.98 8.93

40 4.02 6.98 8.90

45 4.03 6.97 8.87

50 4.04 6.97 8.84

55 4.06 6.97 8.81

60 4.07 6.97 8.79

65 4.09 6.98 8.76

70 4.11 6.98 8.74

75 4.13 6.99 8.73

80 4.15 7.00 8.71

85 4.18 7.00 8.70
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Temp.

(°C)

Metrohm

pH

4.00

pH

7.00

pH

9.00

90 4.20 7.01 8.68

95 4.23 7.02 8.67

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept up to date as far as possible.

However, they may be changed by the respective manufacturers.

32.8.2 NIST (according to DIN standard 19266, 2015)

Table 24 NIST buffer solutions

Temp.

(°C)

NIST (according to DIN standard 19266, 2015-05)

pH

1.679

pH

4.005

pH

6.865

pH

9.180

pH

12.454

0 1.666 4.000 6.984 9.464 -

5 1.668 3.998 6.951 9.395 13.207

10 1.670 3.997 6.923 9.332 13.003

15 1.672 3.998 6.900 9.276 12.810

20 1.675 4.000 6.881 9.225 12.627

25 1.679 4.005 6.865 9.180 12.454

30 1.683 4.011 6.853 9.139 12.289

35 1.688 4.018 6.844 9.102 12.133

40 1.694 4.027 6.838 9.068 11.984

45 1.700 4.038 6.836 9.040 11.841

50 1.707 4.050 6.833 9.011 11.705

55 1.715 4.075 6.834 8.985 11.574

60 1.723 4.091 6.836 8.962 11.449

65 1.733 4.108 6.841 8.942 -

70 1.743 4.126 6.845 8.921 -

75 1.754 4.145 6.852 8.903 -

80 1.766 4.164 6.859 8.885 -
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Temp.

(°C)

NIST (according to DIN standard 19266, 2015-05)

pH

1.679

pH

4.005

pH

6.865

pH

9.180

pH

12.454

85 1.779 4.184 6.868 8.868 -

90 1.792 4.205 6.877 8.850 -

95 1.806 4.227 6.886 8.833 -

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

The NIST buffers are identical to the buffer solutions that are used in
Chinese pharmacopoeia.

32.8.3 DIN (according to DIN standard 19267, 2012)

Table 25 DIN buffer solutions

Temp.

(°C)

DIN (according to DIN standard 19267, 2012-08)

pH

1.09

pH

3.06

pH

4.65

pH

6.79

pH

9.23

pH

12.75

0 1.08 - 4.67 6.89 9.48 -

5 1.08 - 4.66 6.86 9.43 -

10 1.09 3.10 4.66 6.84 9.37 13.37

15 1.09 3.08 4.65 6.82 9.32 13.15

20 1.09 3.07 4.65 6.80 9.27 12.96

25 1.09 3.06 4.65 6.79 9.23 12.75

30 1.10 3.05 4.65 6.78 9.18 12.61

35 1.10 3.05 4.66 6.77 9.13 12.44

40 1.10 3.04 4.66 6.76 9.09 12.29

45 1.10 3.04 4.67 6.76 9.04 12.13

50 1.11 3.04 4.68 6.76 9.00 11.98

55 1.11 3.04 4.69 6.76 8.97 11.84

60 1.11 3.04 4.70 6.76 8.92 11.69

65 1.11 3.04 4.71 6.76 8.90 11.56
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Temp.

(°C)

DIN (according to DIN standard 19267, 2012-08)

pH

1.09

pH

3.06

pH

4.65

pH

6.79

pH

9.23

pH

12.75

70 1.11 3.04 4.72 6.76 8.88 11.43

75 1.12 3.04 4.74 6.77 8.86 11.30

80 1.12 3.05 4.75 6.78 8.85 11.19

85 1.12 3.06 4.77 6.79 8.83 11.08

90 1.13 3.07 4.79 6.80 8.82 10.99

95 - - - - - -

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.4 Fisher

Table 26 Fisher buffer solutions (valid up to and including firmware ver-
sion 5.900.0043)

Temp.

(°C)

Fisher

pH

2.00

pH

4.00

pH

7.00

pH

10.00

0 - 4.01 7.13 10.34

5 1.98 3.99 7.10 10.26

10 1.98 4.00 7.07 10.19

15 2.02 3.99 7.05 10.12

20 2.00 4.00 7.02 10.06

25 2.00 4.00 7.00 10.00

30 2.00 4.01 6.99 9.94

35 2.02 4.02 6.98 9.90

40 2.01 4.03 6.97 9.85

45 2.01 4.04 6.97 9.81

50 2.01 4.06 6.97 9.78

55 - 4.07 6.97 9.74
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Temp.

(°C)

Fisher

pH

2.00

pH

4.00

pH

7.00

pH

10.00

60 - 4.09 6.98 9.70

65 - 4.11 6.99 9.68

70 - 4.13 7.00 9.65

75 - 4.14 7.02 9.63

80 - 4.16 7.03 9.62

85 - 4.18 7.06 9.61

90 - 4.21 7.08 9.60

95 - 4.23 7.11 9.60

Table 27 Fisher buffer solutions (valid from firmware version
5.900.0044)

Temp.

(°C)

Fisher

pH

2.00

pH

4.00

pH

7.00

pH

10.00

0 - 4.01 7.13 10.34

5 1.98 3.99 7.10 10.26

10 1.98 4.00 7.07 10.19

15 2.02 3.99 7.05 10.12

20 2.00 4.00 7.02 10.06

25 2.00 4.00 7.00 10.00

30 2.00 4.01 6.99 9.94

35 2.02 4.02 6.98 9.90

40 2.01 4.03 6.97 9.85

45 2.01 4.04 6.97 9.81

50 2.01 4.06 6.97 9.78

55 - 4.07 6.97 9.74

60 - 4.09 6.98 9.70
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NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.5 Honeywell Fluka

Table 28 Buffer solutions Honeywell Fluka

Temp.

(°C)

Fluka

pH

4.000

pH

7.000

pH

9.000

0 4.030 7.130 9.240

5 4.025 7.090 9.175

10 4.020 7.050 9.110

15 4.010 7.020 9.055

20 4.000 7.000 9.000

25 4.000 6.990 8.965

30 4.000 6.980 8.930

35 4.000 6.975 8.895

40 4.000 6.970 8.860

45 4.000 6.965 8.830

50 4.000 6.960 8.800

55 4.000 6.960 8.775

60 4.000 6.960 8.750

65 4.000 6.965 8.730

70 4.000 6.970 8.710

75 4.000 6.975 8.690

80 4.000 6.980 8.670

85 4.000 6.990 8.655

90 4.000 7.000 8.640
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NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.6 Mettler Toledo

Table 29 Mettler Toledo buffer solutions

Temp.

(°C)

Mettler Toledo

pH

2.00

pH

4.01

pH

7.00

pH

9.21

pH

11.00

0 2.03 4.01 7.12 9.52 11.90

5 2.02 4.01 7.09 9.45 11.72

10 2.01 4.00 7.06 9.38 11.54

15 2.00 4.00 7.04 9.32 11.36

20 2.00 4.00 7.02 9.26 11.18

25 2.00 4.01 7.00 9.21 11.00

30 1.99 4.01 6.99 9.16 10.82

35 1.99 4.02 6.98 9.11 10.64

40 1.98 4.03 6.97 9.06 10.46

45 1.98 4.04 6.97 9.03 10.28

50 1.98 4.06 6.97 8.99 10.10

55 1.98 4.08 6.98 8.96 -

60 1.98 4.10 6.98 8.93 -

65 1.98 4.13 6.99 8.90 -

70 1.99 4.16 7.00 8.88 -

75 1.99 4.19 7.02 8.85 -

80 2.00 4.22 7.04 8.83 -

85 2.00 4.26 7.06 8.81 -

90 2.00 4.30 7.09 8.79 -

95 2.00 4.35 7.12 8.77 -
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NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.7 Beckmann

Table 30 Beckmann buffer solutions (valid up to and including firm-
ware version 5.900.0043)

Temp.

(°C)

Beckmann

pH

4.00

pH

7.00

pH

10.01

0 4.00 7.12 10.32

5 4.00 7.09 10.25

10 4.00 7.06 10.18

15 4.00 7.04 10.12

20 4.00 7.02 10.06

25 4.00 7.00 10.01

30 4.01 6.99 9.97

35 4.02 6.99 9.93

40 4.03 6.98 9.89

45 4.05 6.98 9.86

50 4.06 6.97 9.83

55 4.08 6.98 -

60 4.09 6.98 -

65 4.11 6.99 -

70 4.12 6.99 -

75 4.14 7.00 -

80 4.16 7.00 -

85 4.18 7.01 -

90 4.19 7.02 -

95 4.21 7.03 -
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Table 31 Beckmann buffer solutions (valid from firmware version
5.900.0044)

Temp.

(°C)

Beckmann

pH

4.01

pH

7.00

pH

10.01

0 4.00 7.12 10.32

5 4.00 7.09 10.25

10 4.00 7.06 10.18

15 4.00 7.04 10.12

20 4.00 7.01 10.06

25 4.01 7.00 10.01

30 4.01 6.99 9.97

35 4.02 6.99 9.93

40 4.03 6.97 9.89

45 4.05 6.97 9.86

50 4.06 6.97 9.83

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.8 Radiometer Analytical

Table 32 Radiometer Analytical buffer solutions (valid up to and includ-
ing firmware version 5.900.0043)

Temp.

(°C)

Radiometer Analytical

pH

1.679

pH

4.005

pH

7.000

pH

9.180

0 1.666 4.000 7.118 9.464

5 1.668 3.998 7.087 9.395

10 1.670 3.997 7.059 9.332

15 1.672 3.998 7.036 9.276

20 1.675 4.001 7.016 9.225
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Temp.

(°C)

Radiometer Analytical

pH

1.679

pH

4.005

pH

7.000

pH

9.180

25 1.679 4.005 7.000 9.180

30 1.683 4.011 6.987 9.139

35 1.688 4.018 6.977 9.102

40 1.694 4.027 6.970 9.068

45 1.700 4.038 6.965 9.038

50 1.707 4.050 6.964 9.011

55 1.715 4.064 6.965 8.985

60 1.723 4.080 6.968 8.962

65 1.732 4.097 6.974 8.941

70 1.743 4.116 6.982 8.921

75 1.754 4.137 6.992 8.900

80 1.765 4.159 7.004 8.885

85 1.778 4.183 7.018 8.867

90 1.792 4.210 7.034 8.850

95 - 4.240 - -

Table 33 Radiometer Analytical buffer solutions (valid from firmware
version 5.900.0044)

Temp.

(°C)

Radiometer Analytical

pH

1.679

pH

4.005

pH

7.000

pH

9.180

0 1.666 4.000 7.118 9.464

5 1.668 3.998 7.087 9.395

10 1.670 3.997 7.059 9.332

15 1.672 3.998 7.036 9.276

20 1.675 4.001 7.016 9.225

25 1.679 4.005 7.000 9.180

30 1.683 4.011 6.987 9.139

35 1.688 4.018 6.977 9.102

40 1.694 4.027 6.970 9.068

45 1.700 4.038 6.965 9.038

50 1.707 4.050 6.964 9.010
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Temp.

(°C)

Radiometer Analytical

pH

1.679

pH

4.005

pH

7.000

pH

9.180

55 1.715 4.064 6.965 8.985

60 1.723 4.080 6.968 8.962

65 1.732 4.097 6.974 8.941

70 1.743 4.116 6.982 8.921

75 1.754 4.137 6.992 8.900

80 1.765 4.159 7.004 8.884

85 1.778 4.183 7.018 8.867

90 1.792 4.208 7.034 8.850

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.9 Baker

Table 34 Baker buffer solutions

Temp.

(°C)

Baker

pH

4.00

pH

7.00

pH

9.00

pH

10.00

0 4.00 7.13 9.23 10.30

5 4.00 7.09 9.17 10.24

10 4.00 7.05 9.10 10.17

15 4.00 7.03 9.05 10.11

20 4.00 7.00 9.00 10.05

25 4.00 6.98 8.96 10.00

30 4.01 6.98 8.91 9.96

35 4.02 6.98 8.88 9.93

40 4.03 6.97 8.84 9.89

45 4.04 6.97 8.81 9.86

50 4.05 6.96 8.78 9.82
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Temp.

(°C)

Baker

pH

4.00

pH

7.00

pH

9.00

pH

10.00

55 4.07 6.96 8.76 9.79

60 4.08 6.96 8.73 9.76

65 4.10 6.97 8.71 9.74

70 4.12 6.97 8.69 9.72

75 4.14 6.98 8.68 9.70

80 4.16 6.98 8.66 9.68

85 4.19 6.99 8.64 9.66

90 4.21 7.00 8.62 9.64

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.10 Hamilton DURACAL

Table 35 Hamilton DURACAL buffer solutions

Temp.

(°C)

Hamilton DURACAL

pH

4.01

pH

7.00

pH

9.21

pH

10.01

0 - - - -

5 4.01 7.09 9.45 10.19

10 4.00 7.06 9.38 10.15

15 4.00 7.04 9.32 10.11

20 4.00 7.02 9.26 10.06

25 4.01 7.00 9.21 10.01

30 4.01 6.99 9.16 9.97

35 4.02 6.98 9.11 9.92

40 4.03 6.97 9.06 9.86

45 4.04 6.97 9.03 9.83

50 4.06 6.97 8.99 9.79



32.8 Stored buffer series for pH calibration ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

522 ￭￭￭￭￭￭￭￭ 900 Touch Control

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.11 Precisa

Table 36 Precisa buffer solutions

Temp.

(°C)

Precisa

pH

4.00

pH

7.00

pH

9.00

0 3.99 7.11 9.27

5 3.99 7.08 9.18

10 3.99 7.06 9.13

15 3.99 7.04 9.08

20 3.99 7.02 9.04

25 4.00 7.00 9.00

30 4.00 6.99 8.96

35 4.01 6.98 8.93

40 4.02 6.98 8.90

45 4.03 6.97 8.87

50 4.04 6.97 8.84

55 4.06 6.97 8.81

60 4.07 6.97 8.79

65 4.09 6.98 8.76

70 4.11 6.98 8.74

75 4.13 6.99 8.73

80 4.15 7.00 8.71

85 4.18 7.00 8.70

90 4.20 7.01 8.68

95 4.23 7.02 8.67
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NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible.

However, they may be changed by the respective manufacturers.

32.8.12 Merck CertiPUR 20 / Titrisol

Table 37 Merck CertiPUR 20 / Titrisol buffer solutions (valid up to and
including firmware version 5.900.0043)

Temp.

(°C)

Merck CertiPUR 20 / Titrisol

pH

2.00

pH

4.00

pH

7.00

pH

9.00

pH

12.00

0 2.01 4.05 7.13 9.24 12.58

5 2.01 4.04 7.07 9.16 12.41

10 2.01 4.02 7.05 9.11 12.26

15 2.00 4.01 7.02 9.05 12.10

20 2.00 4.00 7.00 9.00 12.00

25 2.00 4.01 6.98 8.95 11.88

30 2.00 4.01 6.98 8.91 11.72

35 2.00 4.01 6.96 8.88 11.67

40 2.00 4.01 6.95 8.85 11.54

45 2.00 4.00 6.95 8.82 11.435

50 2.00 4.00 6.95 8.79 11.33

55 2.00 4.00 6.95 8.76 11.185

60 2.00 4.00 6.96 8.73 11.04

65 2.00 4.00 6.96 8.715 10.97

70 2.01 4.00 6.96 8.70 10.90

75 2.01 4.00 6.96 8.68 10.80

80 2.01 4.00 6.97 8.66 10.70

85 2.01 4.00 6.98 8.65 10.59

90 2.01 4.00 7.00 8.64 10.48

95 - 4.00 7.02 - -
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Table 38 Merck CertiPUR 20 / Titrisol buffer solutions (valid from firm-
ware version 5.900.0044)

 Merck CertiPUR 20 / Titrisol

Article
no.

109433 109435 109477 109476 109462

Temp.

(°C)

pH

2.00

pH

4.00

pH

7.00

pH

9.00

pH

11.00

0 2.01 4.05 7.13 9.24 11.45

5 2.01 4.04 7.07 9.16 11.32

10 2.01 4.02 7.05 9.11 11.20

15 2.00 4.01 7.02 9.05 11.10

20 2.00 4.00 7.00 9.00 11.00

25 2.00 4.01 6.98 8.95 10.90

30 2.00 4.01 6.98 8.91 10.81

35 2.00 4.01 6.96 8.88 10.72

40 2.00 4.01 6.95 8.79 10.64

45 2.00 4.00 6.95 8.82 10.56

50 2.00 4.00 6.95 - 10.48

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible. However, they may be changed
by the respective manufacturers.

32.8.13 Merck CertiPUR 25

Table 39 Merck CertiPUR 25 buffer solutions (valid up to and including
firmware version 5.900.0043)

Temp.

(°C)

Merck CertiPUR (25°C)

pH

4.00

pH

7.00

pH

9.00

pH

10.00

0 - - - -

5 4.05 7.09 9.22 10.22

10 4.04 7.08 9.16 10.16

15 4.02 7.04 9.10 10.10
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Temp.

(°C)

Merck CertiPUR (25°C)

pH

4.00

pH

7.00

pH

9.00

pH

10.00

20 4.01 7.02 9.06 10.05

25 4.00 7.00 9.00 10.00

30 3.99 6.98 8.98 9.94

35 3.98 6.98 8.93 9.90

40 3.98 6.97 8.89 9.86

45 3.98 6.97 8.86 9.80

50 3.98 6.97 8.84 9.73

Table 40 Merck CertiPUR 25 buffer solutions (valid from firmware ver-
sion 5.900.0044)

 Merck CertiPUR (25°C)

Article
no.

109445 109407 109408 109409

Temp.

(°C)

pH

4.00

pH

7.00

pH

9.00

pH

10.00

0 - - - -

5 4.05 7.09 9.22 10.22

10 4.04 7.08 9.16 10.16

15 4.02 7.04 9.10 10.10

20 4.01 7.02 9.05 10.05

25 4.00 7.00 9.00 10.00

30 3.99 6.98 8.96 9.94

35 3.98 6.98 8.93 9.90

40 3.98 6.97 8.89 9.86

45 3.98 6.97 8.86 9.80

50 3.98 6.97 8.84 9.73

NOTE

Update

The values of the individual buffers with the corresponding tempera-
tures are kept as up to date as possible. However, they may be changed
by the respective manufacturers.
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32.9 Using AuditTrailViewer

When you work in accordance with the FDA Guidance 21 CFR Part 11,
logs with detailed user activities (Audit Trail) are important. The
AuditTrailViewer supports you in your efforts to compile, filter and export
logs of this type as TXT files.

First you must install the AuditTrailViewer on your PC. Afterwards, you
must create a backup of your Touch Control (see chapter 12.3, page 132).
The Audit Trail is generated automatically when you create the backup.
The file name of the Audit Trail is log.madt. In the following you will find
detailed information about how you must proceed.

32.9.1 Installing AuditTrailViewer
You will find the file for installing the AuditTrailViewer on the USB flash
drive provided.

Proceed as follows:

 

1 Double-click on the file SetupAuditTrailViewer 1.2.3.exe.

The dialog Welcome to the AuditTrailViewer Setup Wizard is
displayed.

 

2 Click on [Next >].

The License Agreement dialog is displayed.

 

3 Click on [I Agree] to accept the contractual conditions.

The Choose Install Location dialog is displayed. A memory loca-
tion for the AuditTrailViewer is suggested in this dialog.

 

4 If you accept the suggested memory location, click on [Next >].

or

Select a different memory location and click on [Next >].

The Confirm Installation dialog is displayed.

 

5 Click on [Install] to install the AuditTrailViewer.
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As soon as the installation is completed, the dialog Installation
Complete is displayed.

 

6 Click on [Next >].

The dialog Completing the AuditTrailViewer Setup Wizard is
displayed.

 

7 If the AuditTrailViewer should not be started immediately, deactivate
the check box Run AuditTrailViewer.

 

8 Click on [Finish].

If the preceding instruction step has been skipped, then the
AuditTrailViewer will start.

32.9.2 Opening the Audit Trail
Create a backup of the data and of the settings of your Touch Control (see
chapter 12.3, page 132).

 

1 Open the backup on your PC.

 

2 Open the file log.madt with the AuditTrailViewer.
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AuditTrailViewer dialog window

32.9.3 Contents of the Audit Trail
In the following you will find a description of the dialog window and of
the menu bar of the AuditTrailViewer.

Table 41 Dialog window

Column Content

No. Each entry is numbered in sequence.
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Column Content

Symbol Classification of the entry:

￭

Actions that are neither relevant to safety nor alter the determination
data.

￭

Actions, e.g. changes to the login options and recalculation of determina-
tions.

￭

Errors that occur, e.g. entry of an incorrect password.

Date Precise time of the event.

User User who triggered the action.

Category Category to which the entry belongs.

Action Designation of the action.

Details Details of the action.

Menu bar

Print Print Audit Trail.

An Audit Trail can be printed by means of the  symbol.

Update Update view.

The list is updated automatically only at the time the dialog window is opened.

Quick filter Filter the Audit Trail.

Show all Display all entries once again.

32.9.4 Filtering the Audit Trail
The entries in the Audit Trail can be filtered. You can set the following fil-
ter criteria:

￭ Date
￭ User
￭ Category
￭ Action

Proceed as follows:

 

1 Click in a cell that contains the desired filter criterion (e.g. Category
= Method).
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2 Click on the  icon or the menu item Filter ▶ Quick filter.

The only entries which will be displayed are those which correspond
to the desired filter criterion.

 

3 Click on the  icon or the menu item Filter ▶ Show all.

All of the entries are displayed once again.

32.9.5 Exporting the Audit Trail
You can export the Audit Trail as .txt file. This way, the Audit Trail can be
archived and is available as required for inspections.

Proceed as follows:

 

1 Use the menu item File ▶ Export to open the dialog window for
the export.

 

2 Enter the path and file name with the extension .txt.

 

3 Click on [Open] and then on [Export].

The Audit Trail is exported.

32.10 Diagnosis

System ▶ Diagnosis

The electronic and mechanical functional groups of Metrohm devices can
and should be checked by specialist personnel from Metrohm as part of a
regular maintenance schedule. Please ask your regional Metrohm repre-
sentative regarding the precise terms and conditions involved in conclud-
ing a corresponding maintenance agreement.

The following functions are available:

￭ LCD test
Check the display for faulty pixels (see chapter 32.10.1, page 531).

￭ Temperature control
Measure the operating temperature of the connected control instru-
ment (see chapter 32.10.2, page 532).

￭ Format storage medium
Format the external storage medium (see chapter 32.10.3, page
532).
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￭ Remove storage medium
Remove the external storage medium safely (see chapter 32.10.4,
page 532).

￭ Touch adjustment
Adjust the touch-sensitive screen (see chapter 32.10.5, page 532).

￭ Touch screen test
Test the function of the touch-sensitive screen (see chapter 32.10.6,
page 533).

￭ Software update
Update the software of Touch Control and of the control instruments
(see chapter 32.10.7, page 534).

￭ 822 Curve Simulator
Simulate titration curves for checking titrators (see chapter 32.10.8,
page 538).

￭ Service
Special functions for the service technician (see chapter 32.10.9, page
540).

32.10.1 LCD test
System ▶ Diagnosis ▶ LCD test

You can use the LCD test to check the display for faulty pixels. To do this,
various test images are displayed one after the other.

NOTE

The [ ] fixed key is used to display the preceding test image; the test

can be stopped at any time with the [ ] fixed key.

Proceed as follows:

 

1 ￭ Tap on [LCD test].

The entire display turns white.

 

2 ￭ Check the display for pixel errors and other irregularities.
￭ Continue the test with [ ].

Other colors and patterns will be displayed one after the other.

 

3 ￭ Repeat step 2 until the System / Diagnosis dialog is displayed
again.

 

4 ￭ Contact your Metrohm representative in the event of faults or
irregularities.
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32.10.2 Temperature monitoring
System ▶ Diagnosis ▶ Temperature control

You can use temperature monitoring to display the operating temperature
of a connected control instrument. The temperature is measured in the
interior of the housing. The display is updated with the [Update] button.

32.10.3 Formatting an external storage medium
System ▶ Diagnosis ▶ Format storage medium

With this function, you have the option of formatting an external storage
medium directly on the 900 Touch Control (quick formatting).

The following file systems can be selected:

￭ FAT
￭ FAT32
￭ ExFAT

CAUTION

If you format the storage medium with the ExFAT file system, it is pos-
sible that it will no longer be recognized by a PC. Read the pertinent
information from Microsoft Support at http://support.microsoft.com.

Do not use this file system unless you need to be able to save more
than 999 files in a single group.

32.10.4 Removing an external storage medium
System ▶ Diagnosis ▶ Remove storage medium

As long as the stored data is not being accessed (reading/saving data), you
can plug in and disconnect the storage medium without difficulty at any
time. The [Remove storage medium] function offers additional protec-
tion. This ensures that the storage medium cannot be removed while any
data is being transferred.

32.10.5 Adjusting the touch screen
System ▶ Diagnosis ▶ Touch adjustment

With time the touch-sensitive screen may not register touches at their pre-
cise position. You can readjust the screen in this dialog.

Proceed as follows:

 

1 In the main dialog, tap on [System].

http://support.microsoft.com/?kbid=955704
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2 Tap on [Diagnosis].

 

3 Tap on [Touch adjustment].

A message in English and a crosshair will appear in the center of the
screen.

 

4 Touch a stylus (a special pen-shaped instrument for operating devices
with touch screens) to the center of the crosshair and maintain this
position until the cross hair moves to a new position on the screen.

 

5 Repeat this process as long as the crosshair continues to be reposi-
tioned on the screen.

A message in English will appear.

 

6 Tap at any location on the screen to confirm the adjustment.

 

7 Press [ ] to finish the adjustment.

32.10.6 Testing the touch screen
System ▶ Diagnosis ▶ Touch screen test

You can use this test to check the function of the touch-sensitive monitor
screen.

A calibration is not possible with this test. If the Touch screen does not
work correctly anymore, it will need to be replaced. For that please con-
tact your Metrohm representative.

NOTE

You can use the [ ] fixed key to stop the test at any time.

Proceed as follows:

 

1 Tap on [Touch screen test].

A red square is displayed at the upper left.

 

2 Tap on the square as close to the center as possible.

The actual detected point of contact will be displayed by a crosshair,
and the deviation from the center will also be displayed on the lower
edge of the image.
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The next red square will also be displayed.

 

3 Repeat step 2 until all of the areas in the display have been tested.

A list with fixed keys will appear.

 

4 Tap on all of the fixed keys one after the other in any sequence.

The result is displayed in each case with a short information text, e.g.
[Print] key OK.

 

5 Finish Touch screen test with [ ].

32.10.7 Software update (loading program versions and language files)
System ▶ Diagnosis ▶ Software update

New program versions or language files can be loaded from an external
storage medium (e.g. USB flash drive). The corresponding files must be
stored on the storage medium in the 900/SwUpdates directory (see
"Directory structure", page 131).

NOTE

The software update to version 5.900.0046 is possible only if version
5.900.0045 is installed. If a software version older than 5.900.0045 is
used, then the control software must first be updated to version
5.900.0045.
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NOTE

It is imperative that you first update the control software of the Touch
Control before you update the device program (firmware) of the control
device (Titrando, Dosing Interface, etc.).

NOTE

The memory will be reformatted when updating from software version
5.900.0043.

Before carrying out the software update, make a backup in order to
save your data and the system settings (see chapter 12.3, page 132).

Use a separate USB flash drive for the software update. It must be
removed from the instrument after the successful software update.

Program files

The files are instrument-specific. The file names are structured as follows:

￭ Control software for 900 Touch Control:
5XXXyyyy.BIN
5XXXyyyy.MBIN

– XXX = device type (i.e. "900" for the 900 Touch Control)
– yyyy = program version

￭ Firmware of the control instrument:
5XXXyyyy.BIN

– XXX = device type (e.g. 907 for the 907 Titrando)
– yyyy = program version

Language files

Language files may have the following content:

￭ one or more additional dialog languages
￭ the online help for one or more additional dialog languages
￭ supplements for existing dialog languages/online help documents

They can be recognized by means of the two-digit language code in the
file name. The file name has the following structure:

￭ 5XXXyZZZML.BIN
5XXXyZZZML.MBIN

– XXX = device type (i.e. "900" for the 900 Touch Control)
– y = version number of the language package
– ZZZ = program version
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32.10.7.1 Carrying out a software update

CAUTION

Make sure that the power supply is guaranteed during the entire
update process. Otherwise there is the chance that the instrument will
no longer be able to be switched on and that it will need to be sent in
for repair.

NOTE

Make sure that no USB/RS-232 adapter is connected!

Proceed as follows:

 

1 Copying files to an external storage medium

NOTE

In the case of the program versions and language files for the
Touch Control, it is imperative that both the BIN file and the asso-
ciated MBIN file be copied.

￭ Copy the files to the "SwUpdates" directory.
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￭ Copy also the "MetrohmTools" folder with the "MUpdate-
Tool.exe" file to the external storage medium.
Make sure that the file is stored at the top level of the external
storage medium. This also applies to the "900" folder.

For the program versions 5.900.0043 to 5.900.0045, an
additional folder that is on the same level as Metrohm-
Tools with the name SRVPRF900 containing the file
St900_SrPrf.cfg is required

If this structure is not maintained, then the files will not be found,
because the directories are accessed directly during the update
process.

￭ Plug in the external storage medium at the Touch Control.

 

2 Opening the update dialog

￭ Under System ▶ Diagnosis, tap on the button Software
update.

 

3 Selecting the instrument

￭ Tap on the Control device list box and select the instrument to
be updated.

 

4 Selecting file

￭ Tap on the Binary file list box.
The selection list with the BIN files saved in the "SwUpdates"
directory is opened.

￭ Select the required file.
￭ Tap on [Select].
￭ Update of the Touch Control: Continue with Step 5.

Update of the control instrument: Continue with Step 6.
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5 Starting the update (900 Touch Control)

￭ Tap on the [Start] button (NOT on the [ ] fixed key).
￭ The message 023-102 Program update is displayed.
￭ Confirm the message with [Yes].

The update process is started, it runs automatically. The device is
automatically switched off and back on during this process, possi-
bly several times. No user intervention is required.

￭ After successfully updating the software, remove the
external storage medium (USB flash drive) from the
instrument.

 

6 Starting the update (control instruments)

￭ Tap on the [Start] button (NOT on the [ ] fixed key).
If Result = No errors is displayed, then the update has been suc-
cessful.

￭ Remove the external storage medium (USB flash drive)
from the instrument.

￭ Switch the 900 Touch Control off and then back on again.

32.10.8 Simulating titration curves
System ▶ Diagnosis ▶ 822 Curve Simulator

The 822 Titration Curve Simulator (order number 2.822.0010) can be used
as a diagnostics tool for making rapid checks on titrators. The device is
connected in place of the electrode and simulates various titrations.
Details concerning the connection and operation of the curve simulator
can be found in the corresponding manual.

NOTE

A normal titration method is started. This means that the exchange unit
or dosing unit should be emptied or the corresponding buret tip should
be placed in a sufficiently large collection container.
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1 Connecting the curve simulator

NOTE

Note that the dosing device is always located as the last device,
after the curve simulator, if there is a chain of MSB devices (e.g.
Titrando-MSB – stirrer – curve simulator – dosing device).

If the internal dosing drive on the Titrando is used, then the curve
simulator must be connected to MSB connector 2.

￭ Switch off the Touch Control.
￭ Connect the analog output of the curve simulator to the electrode

connector of the Titrando.
– Use the 6.2116.020 cable.
– Electrode connector Ind.: Simulation of an acid-base titra-

tion.
– Electrode connector Pol.: Simulation of a Karl Fischer titra-

tion.
￭ Connect the curve simulator to an MSB connector on the

Titrando.

 

2 Configuring the Touch Control

￭ Switch on the Touch Control.
￭ In the System / Diagnosis dialog, tap on the [822 Curve Simu-

lator] button.
The Diagnosis / 822 Curve Simulator dialog is displayed.

￭ Activate the parameter Send dosing signals to MSB2 and con-
firm with [Set].

￭ Tap on [ ].

The signals from the dosing device will now be copied to the MSB
connector 2.

 

3 Simulating a titration

￭ Create a titration method or load an existing one.
￭ Tap on [ ].

The titration is started. After the completion of the titration, the
results dialog is displayed.

 

4 Finishing the simulation mode

￭ Switch off the Touch Control.
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32.10.9 Service
System ▶ Diagnosis ▶ Service

Access to the service functions is password-protected and only accessible
to Metrohm service technicians. We recommend that you have mainte-
nance performed on the system regularly by the Metrohm Service Depart-
ment. You can automatically monitor the time interval after which the
next service visit is due (see chapter 13.5.1, page 144).

32.11 Arithmetic algorithms in the Titrando

Some of the algorithms and numerical formats used in the device software
are explained in this chapter.

Numerical format

All floating point calculations use the IEEE 754 (1985) numerical format,
either in "single precision" (32 Bit) or "double precision" (64 Bit).

Rounding off process

Measured values and results are rounded to the defined number of deci-
mal places (commercial rounding, in accordance with the US Pharmaco-
peia USP). If the digit at the first dropped decimal place is 1, 2, 3 or 4,
then it will be rounded off; if this digit is 5, 6, 7, 8 or 9, then it will be
rounded up. Negative digits will be rounded in accordance with their
amount, i.e. away from zero.

Examples:

2.33 yields 2.3

2.35 yields 2.4

2.47 yields 2.5

–2.38 yields –2.4

–2.45 yields –2.5

Statistics

The arithmetic mean value and the absolute and relative standard devia-
tions of results R, endpoints EP and variable C are calculated:

You can statistically evaluate a maximum of nine results (1 ≤ k ≤ 9) calcu-
lated in a determination. A statistical series can contain a maximum of 20
determinations (1 ≤ n ≤ 20).

The following convention applies to the subsequent formulas:

1 ≤ n ≤ 20 and 1 ≤ k ≤ 9.
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Mean value:

Absolute standard deviation:

Relative standard deviation (in %):

Explanations

The individual values are incorporated in the statistics in the selected Preci-
sion (Round, Truncate or Full precision).

7 significant places are yielded when the 32 bit numerical format is
applied for the floating point number in decimal presentation. For the 64
bit numerical format, there are 15 significant places.

The accuracy can be controlled by the selection of the prefix of the unit
(milli, micro) and the number of decimal places.

Example (64-bit numerical format):

The result displayed, 1234.56789158763 mg/L, has 15 significant pla-
ces. It should be rounded off to three decimal places according to the
above rounding-off process:

￭ 1234.568 mg/L.

If the same result is expressed in "g/L" (1.23456789158763 g/L), and is
also rounded off to three decimal place, this yields

￭ 1.235 g/L.

I.e. you obtain the lowest losses in accuracy with rounding when you
select the application and the numerical format in such a way that the
numbers displayed have as many places before the decimal point as possi-
ble.

A complete recalculation of the statistics using a pocket calculator or PC
calculation programs may exhibit deviations. This can be explained by the
different binary numerical formats used by these computers.

NOTE

The above losses of accuracy by rounding off in the range of significant
places are only relevant theoretically. Most of the time they are lower by
several orders of magnitude than – as an example – the uncertainties
resulting from weighing out the sample.
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33 Technical specifications

33.1 Touch screen

Display VGA color display (640 pixels x 320 pixels), diagonal approx. 5.7"

Touch panel resistive

Resistance to
chemicals

resistant to the following chemicals (no visible changes after 24 h of
duration of action):
￭ without protective cover:

– Methanol
– Toluene
– Ethyl acetate
– Acetone
– Dichloromethane
– Hydrochloric acid c(HCl) = 2 mol/L

￭ with protective cover (order number 6.2723.300):
– Methanol
– Propanol
– Toluene
– Xylene
– Acetone
– Chloroform
– Formamide
– Sulfuric acid c(H2SO4) = 2 mol/L
– Hydrochloric acid c(HCl) = 2 mol/L
– Caustic soda c(NaOH) = 2 mol/L
– Composite 5.0
– 1-butanol
– 1-hexanol
– Decanol
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33.2 Interfaces

Connection cable 8-pin, 1025 mm, Mini DIN plug with lock release mechanism

USB connector For connecting USB devices.

Standard USB 1.1 (full speed), high power

Plug Type A

Ethernet connec-
tor

For connection to a data network (LAN).

Standard 10BASE-T and 100BASE-TX (IEEE 802.3)

Plug Modular 8P8C (RJ-45) with integrated status LEDs

33.3 Energy supply

Nominal voltage 5 V DC

Power consump-
tion

3.5 W (typical)

Battery 1 x lithium manganese dioxide button cell CR2032 (needs to be
replaced only in the event of servicing).
The battery must be removed and turned in for proper recycling when
the device needs to be disposed of.

33.4 Declarations of Conformity

Up-to-date information on the EU conformity and the requirements for
electromagnetic compatibility for your product can be found on the Inter-
net under https://www.metrohm.com/en-us/products-overview/.

Using the article number, you can download the Declaration of conform-
ity for ... under the documents of the product.

https://www.metrohm.com/en-us/products-overview/


33.5 Ambient conditions ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

544 ￭￭￭￭￭￭￭￭ 900 Touch Control

33.5 Ambient conditions

Nominal function
range

+5 to +45 °C
at max. 80% relative humidity, non-condensing

Storage +5 to +45 °C
at max. 80% relative humidity, non-condensing

33.6 Dimensions

Material of the
housing

Poly(butylene terephthalate) (PBT)

Touch screen film
material

Polyester

Width 193 mm

Height 71 mm

Depth approx. 180 mm (without cable)

Weight 1493 g

33.7 Storage capacity

Random access
memory

128 MB

Internal memory 1 GB of which 900 MB available.

Required memory
per method

3–6 KB
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34 Displaying accessories

Up-to-date information on the scope of delivery and on optional accesso-
ries can be found on the Metrohm website.

1 Searching for a product on the website

￭ Go to https://www.metrohm.com.

￭ Click on .
￭ Enter the article number of the product (e.g. 2.1001.0010) into

the search field and press [Enter].

The search result is displayed.

 

2 Displaying product information

￭ To display the products matching the search term, click on Prod-
uct models.

￭ Click on the desired product.

Detailed information regarding the product is displayed.

 

3 Displaying accessories and downloading the accessories list

￭ To display the accessories, scroll down to Accessories and
more.

– The scope of delivery is displayed.
– Click on [Optional parts] for the optional accessories.

￭ To download the accessories list, click on [Download accesso-
ries PDF] under Accessories and more.

NOTE

Metrohm recommends keeping the accessories list for reference
purposes.

https://www.metrohm.com
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